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INTRODUCTION 

This book provides system architects, technical consultants, and IT management the tools to 

design  system architectures to deploy SAP applications on SAP HANA. Explore production and 

non-production systems, deployment options, backup and recovery, data replication, high-

availability, and virtualization in detail. Dive into on-premise deployment options and data 

provisioning scenarios. Walk through scale-up and scale-out options and data partitioning 

considerations. Review the advantages and disadvantages of storage and system replication 

options and when to use each. Clarify how to leverage HANA for single node and distributed 

systems. Dive into a discussion on software and hardware virtualization. 
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36 Public Sector Management 

36.1 General Settings for Public Sector Management  
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36.1.1 Basic Settings: Account Assignment Elements  
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36.1.1.1 Activate Account Assignment Elements 

In this Customizing (IMG) activity, you activate the Grant, the Fund, the Functional Area  and the Funded 

Program for your client. 

Note 

If you would like to use the grant, funds, the functional area or the funded program within the budgeting 

(Budget Control System BCS), you have to activate these account assignment elements both in this IMG 

activity and in IMG activity Activate Account Assignment Elements in Budgeting. 

If you only want to use the grant, the fund or the functional area in Funds Management (PSM-FM), but 

not in CO and Asset Accounting, you can deactivate these account assignment objects in the activity 

Deactivate Account Assignment Elements in Controlling. 

The activation of the account assignment elements after the live date has a number of effects in the whole 

system. Therefore, SAP recommends integrating a migration project. 

Activating the grant, fund, functional area, and funded program has the following effects: 

- In Controlling (CO), the respective account assignment element must also be assigned to the CO 

objects and cost element. 

- In Asset Accounting (AA), the account assignment elements are available and can be defined in 

the asset master record and assigned with postings in order to manage the balances for each account 

assignment element. 

- In Payroll (HR), the account assignment element must also be assigned. 

Please note that you must enter a date with the activation for when the account assignment element 

should be assigned to an account in HR. 

As soon as the date is set, you must define the account assignment element when creating new or 

changing HR master records for all infotypes used ( 0001, 0027, 1018 (organizational management) 

0014, 0015, 2001, 2002, 2003, 2005, 2010). 

Caution 

If you have been using HR for a while, the infotypes of the HR master records are not automatically 

supplied with an FM account assignment. You cannot carryout payroll therefore because the 

account assignment element cannot be found when payroll is running. Therefore you must create in 

the HR master records from the date entered a new info record and delimit the old record. 

- In Funds Managemen (PSM-FM), in addition to the account assignment elements, commitment 

item and funds center, the respective account assignment element 

Note the following: 

- The grant, the funds, the funded program and the functional area can only be budgeted if you have 

activated these account assignment elements for the Budget Control System  in the IMG activity 

Activate Account Assignment Elements in Budgeting. The funded program cannot be entered with 

postings, it must be derived from the account assignment elements of other components, for 

example, CO objects (project and order) instead. 
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- After the activation of functional area, grant, and funded program, you cannot restrict the selection 

to individual values in all programs. The corresponding program is then executed for all values of 

the respective account assignment element. 

- Grants Management (PSM-GM) is activated by activating the account assignment element, grant. 

You can define more settings for Grants Management in the IMG of Grants Management. You 

should note that the use of Grants Management also requires you to activate the funds account 

assignment element. 

Note 

- The activation of grant, functional area and funded program has not been released for European 

Commission customers. 

Requirements 

Please note that you should only activate account assignment elements once certain prerequisites have 

been fulfilled. 

For more information, see SAP Note 518610. 

If you want to enter grant, fund and functional area when you are entering business transactions in other 

components, you must ensure that the Grant, Fund and Functional Area fields are ready for input. 

The following prerequisites apply to Asset Accounting: 

- To manage the balances for each account assignment element, you must activate grant, fund, and 

functional area in the Customizing of Asset Accounting. You must also activate the account 

assignment elements to be posted with each transaction and account assignment type (posting of 

APC values and depreciation posting). 

You define these settings in the Customizing of Asset Accounting, under Integration with 

General Ledger -> Account Assignment Elements to be Posted  -> Activate 

Account Assignment Objects and Define Account Assignment Types for Account 

Assignment Objects. You can find more information on the IMG activities in the following 

sections: 

- Activate Account Assignment Objects 

In this IMG activity, you should set the Ident indicator for grant, fund and functional area. 

This ensures that grant, fund and functional area are transferred from the asset master record 

with postings and cannot be changed thereafter. 

- Define account assignment types for account assignment objects 

You must define grant, fund and functional area in the Asset master record if you want to 

manage per account assignment element. 

Fund 

Please note that an integration of the indirect activity allocation (activity RKIL) is not possible. 

Functional Area 

You should also be aware that the following restrictions apply in the system, when you are 

working with the functional area: 
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Restrictions for the integration of other components: 

- Integration of Financial Accounting 

You cannot use the functional area when you are using cost of sales accounting. 

- Integration Controlling 

An integration of indirect activity allocation (activity RKIL) is not possible. 

- Integration of HR Funds and Position Management 

The functional area cannot be used with the HR Funds and Position Management (PA-PF-FP-

FM) component. 

Restrictions in the Component Funds Management 

- Status Management 

If you are using status management, you cannot allocate a status for the commitment item/funds 

center/fund/functional area combination, you can only do this for the commitment item/funds 

center/fund combination. If status management is active, the settings apply for all functional areas. 

- Workflow 

Role definition can only be performed according to the FM account assignment without the 

functional area (fund, funds center, commitment item). 

Grant 

Please note the following restrictions when working with grants: 

Restrictions when integrating other components: 

- Integration of HR Funds and Position Management 

Grant cannot be used with the component HR Funds and Position Management (PA-PF-FP-

FM). 

- Integration Controlling 

An integration of indirect activity allocation (transaction RKIL) is not possible. 

Restrictions in the Component Funds Management 

- Status Management 

If you are using status management, you cannot assign a status for the combination of commitment 

item/funds center/fund/grant- you can only specify one for the combination of commitment 

item/funds center/fund. If status management is active, the settings apply for all grants. 

- Workflow 

Role definition can only be performed according to the FM account assignment without the grant 

(fund, funds center, commitment item). 

Funded program 

Note that the following restrictions apply if you are working with the funded program: 
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Restrictions in the Component Funds Management 

- Status Management 

If you are using status management, you cannot assign a status for the combination of commitment 

item/funds center/fund/funded program - you can only assign one for the combination of 

commitment item/funds center/fund. If status management is active, the settings apply for all funded 

programs. 

- Workflow 

Role definition can only be performed according to the FM account assignment without the funded 

program (fund, funds center, commitment item). 

Activities 

Activate the account assignment elements you require for your clients. 

Caution 

Please note that you cannot deactivate the account assignment elements again if the commitment data and 

the actual data or budget has been posted with the account assignment elements.  
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36.1.1.2 Allow BLANK as Value for Account Assignment Elements 

Use 

In this step, you can specify that the initial value entry is allowed for account assignment elements grant, 

fund, functional area and funded program. 

In the standard system, these account assignment elements must always have a fixed value as soon as they 

are activated in the step Activate Account Assignment Elements. SPACE/BLANK is then no longer 

accepted as a value by the system. 

Note that this restriction is necessary because the following functions in the system do not accept 

BLANK/SPACE or entering BLANK/SPACE can lead to undesirable consequences: 

- In Controlling you cannot define an assessment or allocation for the BLANK/SPACE value 

separately. This means that an allocation of fund BLANK (for example) to a different fund is not 

possible. The fund BLANK is only bequeathed from sender to receiver. 

- One of the values proposed from the account assignment derivation can no longer be deleted 

through a manual entry (BLANK) when posting. 

- When selecting values, as a rule, the entry BLANK/SPACE means that all values for an account 

assignment element are selected. 

If after live date of the account assignment elements grant, fund, functional area or funded program for 

the first time with this release, you can allow the initial value (BLANK/SPACE) as value for these 

account assignment elements for your FM area in the transition period. This means that you will not have 

to make supplement account assignments for documents posted that are in old fiscal years. 

36.1.1.3 Deactivate Account Assignment Elements in Controlling 

Use 

In this IMG activity, you can deactivate the account assignment elements fund, functional area and grant 

in Controlling and Asset Accounting. 

If you want to use the fund, functional area or grant as the account assignment elements in Funds 

Management (FM), you must first activate these account assignment elements in IMG activity Activate 

Account Assignment Elements. 
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If you want to use these account assignment elements in budgeting (BCS), then you have to activate them 

in IMG activity  Activate Account Assignment Elements in Budgeting. 

If you want to use Grants Management, you must activate the fund and the grant. 

When you activate an account assignment element, you must then assign it to an account in Controlling 

and in Asset Accounting. 

Deactivating an activated account assignment element for Controlling and Asset Accounting allows you 

to use this account assignment element within Funds Management or Grants Management without 

affecting business processes in Controlling or Asset Accounting. 

Requirements 

After activating the account assignment element, no postings were made on this account assignment 

element and no planning either. 

Activities 

Deactivate the account assignment elements that you have activated in order to use Funds Management or 

Grants Management in IMG activity Activate Account Assignment Elements. 

36.1.2 Integration 

36.1.2.1 Rule-Based Account Assignment Distribution 

36.1.2.1.1 Maintain Field Profiles 

Use 

Use this step to identify which account assignment fields can be modified during the distribution process. 

Activities 

1. In the Field Profile overview, choose New Entries and enter an ID and a name for the field profile 

you want to use. 

2. Having saved the profile, select it and choose List of fields in the dialog structure. 

3. Choose New Entries and specify the fields you want to included in the field profile. 

4. Save your entries. 
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36.1.2.1.2 Maintain Action Profile 

Use 

Use this step to control actions such as messages or displaying the results of splitting in a popup window. 

The message class FMSPLIT_ACTION contains some standard messages designed for use in the action 

profiles. 

Activities 

1. In the Action Profile overview, choose New Entries and enter an ID and a name for the action 

profile you want to use. 

2. Having saved the profile, select it and choose Actions in profile in the dialog structure. 

3. Choose New Entries and enter the following for the events you require: 

- Event 

Under Actions in profile: 

- Action, selected from the input help 

- Message class 

- Message number - Up to four variables 

4. Save your entries. 

36.1.2.1.3 Maintain Authorization Groups 

Use 

Use this step to maintain a list of authorization groups to which distribution rules and rule groups may be 

assigned. 

Standard settings 

If the rule binding type "Changes require override authorization" is to be used, the authorization group 

"OVER" must be created in order to support authorization profile maintenance. 

Activities 

In the maintenance view, choose New Entries and enter a four-character ID and a descriptive text for 

each authorization group required. 
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36.1.2.1.4 Maintain Rule Groups 

Use 

Distribution rules are organized in groups for management and authorization purposes. Use this step to 

make the necessary settings. 

Activities 

1. In the overview, choose New Entries and enter the following for each group you want to use: 

- ID and name 

- Authorization group 

- Field profile - Action profile 

2. Save your entries. 

36.1.2.1.5 Maintain Derivation Strategy for Rule-Based Acct Assgnmt 

Distribution 

Use 

Use this step to determine which splitting rules to apply based on the account assignments input by the 

user. 

36.1.2.1.6 Business Add-Ins (BAdIs) 36.1.2.1.6.1 BAdI: Enhancements for 

Maintenance of Account Assignment 

Distribution Rules 

Use 

This BAdI supports the ability to add fields to the account assignment splitting Rule and Split tables, as 

well as to create custom tables related to splitting rules or splits. 

Using the methods of the BAdI, a custom application can: 

- Maintain custom fields added to the FMSPLIT_RULE database table via subscreen areas on the rule 

maintenance screen 
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- Suppress maintenance of split data in cases where a custom rule type does not require splits to be 

maintained 

- Rreplace the screen normally used for rule and split data maintenance with a customer screen 

- Include customer fields added to the FMSPLIT_SPLIT table in the ALV grid used for standard split 

maintenance 

- Change the field catalogs used to control the ALV grids used to maintain Split and Value data 

The BAdI has the following methods: 

- DELETE_RULE 

- MOVE_DATA 

- SPLIT_ALV_DATA_CHANGED 

- SPLIT_FIELDCAT 

- SPLIT_MAINT_INITIALIZE 

- SPLIT_MAINT_PBO 

- TRANSPORT_REQUEST 

- VALUES_FIELDCAT 

Requirements 

This BAdI must normally be used in conjunction with the BAdI FMSPLIT_RULE_DB, which provides 

methods to support moving custom data fields between the database tables and the editing structure used 

in rule maintenance. 

36.1.2.1.6.2 BAdI: Account Assignment Distribution Rule - User-Defined Fields 

Use 

This BAdI supports creation of user defined fields in the FMSPLIT_RULE and FMSPLIT_SPLIT 

database tables 

- LOAD_RULE_FROM_DB 

- MOVE_RULE_TO_DB 

- RENUMBER_SPLIT_ID 
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- MOVE_SPLIT_TO_DB 

- CHECK_CUSTOM_DATA_CHANGED 

- SAVE_RULE 

Requirements 

User-defined fields have been added to the appropriate database tables 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.1.2.1.6.3 BAdI: Enhancement for Derivation of Account Assignment 

Distribution Rules 
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Use 

SAP provides methods that enable you to further customize the behavior of the rule-based distribution to 

multiple account assignments derivation tool. You must create an implementation using the following 

predefined methods: 

- CHECK_DRULE_BEFORE_SAVE 

- CHECK_DRULE_ENTRY 

- GET_STRATEGY 

- STEP_ACTIVITY_CHECK 

- STEP_CHECK_ON_ENTER 

- STEP_CHECK_ON_EXIT 

- SET_DISPLAY_MODE 

- STEP_DRULE_ACTIVITY_CHECK 

- SET_STRATEGY_BUTTONS 

- DERIVE 

- FILL_CUSTOMER_FIELDS 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 
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Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.1.2.1.6.4 BAdI: Configure Control of Account Assignment Distribution 

Use 

Allows custom applications to: 

- Move user-defined field contents from COBL into the structure FM_SPLIT_DERIVE at the start of 

the distribution process. These fields are then available to influence the distribution process. 

- Move user-defined field contents from the FMSPLIT_DERIVE (structure that is used within the 

account assignment split processor) to COBL or COBL_AD at the end of the splitting process 

These functions are implemented in the following methods: 

- FILL_CUSTOM_DERIVE_FIELDS 

- FILL_CUSTOM_COBL_FIELDS 

Requirements 

Custom fields are added to structure FMSPLIT_DERIVE and/or COBL 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 
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4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.1.2.1.6.5 BAdI: Define Account Assignment Distribution Method 

Use 

This BAdI supports the implementation of a custom distribution method within account assignment 

splitting. The purpose of the distribution method is to determine which portion of an amount is to be 

allocated to a given split. 

- INITIALIZE 

- DISTRIBUTE 

Requirements 

A custom distribution method must be defined using maintenance view 

V_FMSPLIT_DIST_METHOD. Then account assignment distribution rules can be defined which 

reference this custom distribution method. When a distribution rule is processed, this BAdI is invoked to 

perform the calculation of the amount to allocate to a split. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 
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4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.1.2.1.6.6 BAdI: Configure Processing of Account Assignment Distribution 

Rules 

Use 

This BAdI allows custom processing of the filling of account assignment field values during the account 

assignment splitting process. The BAdI methods allow the takeover of the complete set of assignment 

fields population, or of individual fields. 

The following methods are available for implementation of this functionality: 

- INITIALIZE 

- ONE_FIELD_VALUE_ASSIGNMENT 

- ALL_FIELD_VALUE_ASSIGNMENT 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 
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2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.1.2.2 Principle of Prudence 

36.1.2.2.1 Define Derivation Strategy for Principle of Prudence 

Use 

Use this step to define the derivation strategy you need to apply the principle of prudence in your 

installation. 

If you set the flag for postponing a funds return to "P", document processing can be customized so that 

parked documents, such as  credit memos, do not impact the budget. Only posted documents impact the 

budget. 

Standard settings 

As a minimum, the following fields are available for use in determining whether the credit memo update 

to FM is delayed: 

- Fund 

- Fund Type 

- Trading Partner 
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- Document Type 

Activities 

You can create, change and delete steps and also change their order. 

Create Step 

1. Choose Create Step. 

If you want to add a new step to the derivation strategy, select the step before which you want to 

insert the new step and choose Create Step. 

2. Choose the derivation step type that you want from those offered to you. 

3. Enter a text and source and target field for the derivation step. For the source and target fields, you 

can determine Field characteristics. 

- Source Field 

You can determine that initial values are permitted. This means that a derivation is carried out 

if the source field is not filled. 

- Target Field 

For the target field you can determine that: 

The new value is not copied if a value from a previous derivation step already exists. The new 

value is copied even if the new value is blank (space) The new value is copied when the new 

value is filled. 

Note: If you use this setting you can determine, for example, that the derived value cannot be 

overwritten manually. 

- Source Fields and Target Fields 

In addition to the derivation step type "Derivation Rule", you can determine that either the entire 

field contents, or only a part of the field contents is included. 

4. If the derivation step should only be performed according to specific conditions, for example, only 

for specific account assignment values, enter this on the Condition tabpage. The derivation step is 

only executed when all conditions for the fields are fulfilled. 

5. Define Step Characteristics on the Characteristics tabpage, for example, if an error message should 

be issued, if no target value can be determined. 

- An error message should be issued if the derivation step is not successfully derived. Otherwise 

the strategy will not be continued. 

- The execution of the strategy should be terminated if a suitable value is found in the derivation 

step. Otherwise the strategy is completed. 

Note: If you are using derivation step type "Derivation Rule", you can make the following 

additional entries: Assignment Derivation. 

You can make additional specifications on the Characteristics tab; for example, you can allow the 

entry of a validity date for a step and therefore make it time-dependent. 

6. When you have saved the new entry, go back to the complete list. 
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7. To assign a company code to a strategy, select the strategy and choose company code assignment in 

the dialog window. 

8. Choose new entries in the overview that follows and enter the company code you want to assign to 

the strategy. 

Change/Delete Step 

- When making a change, you have all the options described under "Create Step". 

- To delete an entry, select the relevant step and choose Delete. 

Change Step Sequence 

1. Select the step you want to move. 

2. Position the cursor below the target position. 

3. Choose Move. 

36.1.3 Information System: Reconciliation 

36.1.3.1 Define Field Transactions for FI 

Use 

In this step, you define the field movements from a new general ledger (G/L) totals table to the internal 

structure of the reconciliation tool and assign them to a totals table. The field names of the internal 

structure are given in the default field movement SAPDEFAULT. Fields that do not exist in this field 

movement are added to the internal structures dynamically with the same name as in the totals table and 

do not need a field movement. 

If no field movement is assigned, the default movement SAPDEFAULT is used. 

Activities 

Assign the field movement(s) you require. 

36.1.3.2 Define Reconciliation Data Slice 
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Use 

Use this step to create the data slice(s) you need to work with the reconciliation feature. 

Standard settings 

We deliver five data providers for use in reconciliation data slices. 

Use 

Stipulate the following for each new data slice you create: 

- Slice ID 

- Which of the data providers you want to use for this rule 

- How the resulting default fields are to be processed. You can also add fields to the selection offered. 

In addition, make the following entries on the tabs in the top half of the screen: 

- Name and short name for the slice 

- Calculation settings 

- Derivation settings 

See the derivation tool documentation for details of how to do this. 

- If desired, a text with any additional information relevant to the slice or its usage. 

- Details of which rules use the data slice. 

36.1.3.3 Define Reconciliation Rule 

Use 

Use this step to create and configure the reconciliation rule(s) you need to use the reconciliation feature. 

Standard settings 

We do not deliver any standard settings. 

Activities 

In the screen for creating reconciliation rules, you enter: 
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- Basic data, consisting of a name for the new rule and the system ID of the person to be notified if the 

reconciliation finds items that do not match. 

- An equation for the reconciliation 

- Field usage details 

Here, you stipulate which fields are to appear in the selection screen for the reconciliation 

analysis report, along with the level of breakdown in each case. 

36.1.3.4 Define Subtotal Groups 

Use 

Use this step to maintain lists of subtotal texts to be used when deriving additional breakdowns in 

reconciliation data slices. 

Standard settings 

We do not deliver any standard settings. 

Activities 

Subtotal texts are managed within subtotal groups. In the screen for maintaining subtotal texts, you must 

first create one or more groups forthe texts. Then select a group and maintain the texts in that group. In 

these screens you enter the following: 

- For groups: Subtotal Group ID code and name -

 For texts: Subtotal ID and Subtotal Text 

36.2 Funds Management Government 

The Implementation Guide (IMG) for "Funds Management Government" contains all information 

necessary for configuring the "Funds Management Government" component. 

The IMG 

- lists all the activities for implementing Funds Management 

- refers to the Customizing settings in other components which are necessary for integrated use with 

Funds Management. 

36.2.1 Prepare Funds Management Installation 
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When implementing the Funds Management Government component, you should take care to carry 

out the individual steps in a particular order. You enter the required preconfigurations and functions at 

different points in the SAP System. 

Proceed as follows when implementing Funds Management: 

 1. You create company codes, FM areas, and controlling areas in the Customizing of the 

Enterprise Structure. For more information, see the implementation guide (IMG) 

Enterprise Structure, sections: 

a) Edit, Copy, Delete, Check Company Code 

b) Maintain FM Area 

c) Maintain Controlling Area 

2. You then assign an FM area to each company code and controlling area relevant to Funds 

Management. 

For more information, see sections: 

a) Assign Company Code to FM Area 

b) Assign Controlling Area to FM Area 

3. You create your G/L accounts in the General Ledger Accounting menu. For more information, read 

the chapter: Create G/L accounts in the G/L accounting IMG (FI-GL) under G/L account master 

records. 

4. Use Financial Accounting customizing to maintain the field status definition groups. These 

determine which fields in the account are ready for input, must be maintained, or are hidden, when 

you are entering business transactions. For more information, read: Define Field Status Variants in 

the Financial Accounting Basic Settings. 

Note that the additional account assignments commitment item, funds center and fund will only 

accept input if you mark the relevant fields as required or optional entries. This applies, however, 

only to G/L accounts whose commitment items are assigned with the 30 such as a revenue account. 

G/L accounts whose commitment items are assigned with a transaction other than 30 should have 

the error hidden. 

If you want to reference earmarked funds when posting a payment, you must define the additional 

account assignment Earmarked funds as a required or optional entry. 

5. Likewise for Materials Management, the additional account assignments, commitment item, funds 

center, and fund are only ready for input if they are flagged as required or optional entries when 

posting the purchase requisition and purchase order. You can find more information in the 

Purchasing IMG in section Maintain Account Assignment Categories. 

6. If you want to integrate inventory management with Funds Management, there are different ways of 

controlling this, depending on the warehouse concept you chose. For more information, see the SAP 

Library under Funds Management -> Actuals and Commitments Update -> Integration 

7. If you want to integrate Assets Accounting, you must go to the Funds Management 

implementation guide and flag as budget relevant the transaction types for the individual 

transactions (acquisitions and retirements). For more information, see the SAP Library under Funds 

Management Actuals and Commitments Update -> Integration Asset Accounting 
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8. If you want to integrate Payroll Accounting with Funds Management, you must define a funds 

center and fund for individual Infotypes. For more information, see the IMG of Funds 

Management Government, section Define Start Date for HR Integration (Scenario 2). 

9. If you want to integrate Travel Management with Funds Management, the funds center, commitment 

item, and fund fields must be ready for input when you post in Travel Expense Accounting. You 

enter these settings in the Travel Management IMG Dialogue 

and settlement control -> Screen layout for trip data input -> Set up variable construction 

for account assignment objects. 

10. You switch to the Funds Management application menu, create your master data (commitment 

items, funds centers and funds) and then define your account assignment derivation. 

For more information on account assignment derivation in Funds Management, see component 

Funds Management (PSM-FM) under Account Assignment Derivation as well as section 

Define Account Assignment Derivation. 

For more information on creating master data, see the component Master data in the component 

Funds Management (PSM-FM). 

11. You can then define the remaining settings in the IMG of Funds Management. For more 

information, read the following chapters. 

Further notes 

The Funds Management application component can not be used simultaneously with the components 

Cash Budget Management and/or Project Cash Management if you use year-dependent master data 

in Funds Management. 

If you want to use Funds Management with Cash Budget Management and/or Project Cash 

Management you must note that Cash Budget Management and Project Cash Management only 

process 10 character commitment items. 

36.2.2 Basic Settings 

In the following steps, you make the general basic settings for Funds Management. 

36.2.2.1 Activate Global Funds Management Functions (PSM-FM) 

In this step you can activate/deactivate specific functions in the system for the component Funds 

Management (PSM-FM). 

Activities 

Set the indicator to use the functions in this system. 
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36.2.2.2 Activate Multi-Year Budget Execution 

Use 

In this Customizing activity you activate multi-year budget execution. 

Activating multi-year budget execution means that business processes such as entering documents 

and payment/clearing transactions can be executed regardless of the fiscal year with reference to a Budget 

ID. A fiscal year change is no longer necessary. 

The system response changes as follows once this function has been activated: 

- In the master data maintenance, you must work with year-independent funds centers and 

commitment items. You use the budget ID to define the validity of the budget in the fund master 

record independently of the respective fiscal year. A general total budget is usually defined in the 

fund types you are using if multi-year budget execution has been activated. You can also define 

other master data for a budget as well as the identification of the respective budget in the fund key. 

- You use the Budget Control System (BCS) for budgeting in Funds Management . You enter the 

budget in the respective fiscal year and for the respective budget using the fund master data object.  

You can use BCS status management to regulate the budgeting process in the budget, which you 

have previously defined in the Customizing activity Edit Status. The availability control (AVC) 

takes place on the basis of the available overall budget for the respective budget. Accordingly, a 

checking horizon set for an annual period is no longer allowed. 

- During document entry, you can reference commitment documents (earmarked funds, purchase 

requisitions, purchase orders). Estimated revenues can be referenced when entering commitment 

documents. A commitment carryforward is then no longer necessary. You can control the 

permitted/non-permitted actual/commitment postings for the respective periods for each fiscal year 

by opening/closing the posting periods. 

- With the payment selection program RFFMS200, payments that refer to invoices from the previous 

year are converted to the current year. A fiscal year change for invoices is no longer necessary with 

the commitment carryforward and is therefore no longer supported. 

- In the information system, with an active multi-year budget you can report on the yearly totals for 

commitment/actual of Funds Management, by executing program Fund Balance Carryforward. 

This program carries forward the open balance for each value type to the new fiscal year without 

changing the FM account assignment (and without summarizing using the commitment item). You 

can branch to the respective item from the previous year with totals reporting for Funds 

Management. 

Comment 

Note that the FM information system also supports multi-year reporting. If you do not need any 

year-based reporting through your budget (for example in an individual fund), you do not need to 

execute the fund balance carryforward. Note that you must hide the data records with the amount 

type Carryover from Previous Years (actual balance) (0360) in reporting using 

commitment/actual data, otherwise the fund balance carryforward causes incorrect valuation in 

multi-year reporting. 

- You can perform yearly reporting on the residual budget by executing program Carry Over Residual 

Budget using one of the budget types intended for valuation purposes. 
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- If you want to transfer open commitments to the new budget with your closing operations, you can 

use program RFFMCCOVR. You execute the program in the menu of Funds management, under 

Additional Functions -> Closing Operations -> Commitments/Actuals -> Reassign Open 

Commitment. 

- If you want to transfer the residual budget from the old to the new budget, you can use program 

Transfer Budget Data. 

Requirements 

You have set up Period-Based Encumbrance Tracking for updating in Funds Management. 

You use an Update Profile that is based on profile 000101 and therefore supports a posting data-based 

update (such as the 000600 profile of the Federal Government). The multi-year budget is not supported 

for update profile 000500 ("availability control payment program, for example, for Canadian 

Government"). 

If you are working with year-dependent master data in your production system, note the migration steps 

to be executed for multi-year budget execution. For information about this, see Note 640452. 

Reassignment programs (programs RFFMCHA*...., especially RFFMCHAT) are not supported with this 

setting. You can use program RFFMCCOVR for this. 

Standard settings 

Multi-year budgeting is not active in the standard system. 

Activities 

If you activate this function, you must ensure the following: 

Master Data 

1. The account assignment element "fund" is activated. You do this in the Customizing activity 

Activate Account Assignment Elements. 

A budget ID is coded into the name of the fund for each new budget entered. It is advisable to use 

the Create and Define Subdivision ID in Funds Management for this. If you have to define other 

FM account assignment elements as being year-dependent, you can do this by coding the budget 

ID into the name of the account assignment elements also. 

2. Implement the Business Add-In (BAdI) Define Grouping Key ( FMKU_GROUPING_KEY) so that 

the corresponding budget ID is returned for each possible FM account assignment, to activate the 

following consistency checks: 

- If you activate posting and/or budget objects and define a corresponding account assignment 

derivation for budget addresses, the system ensures that the budget address assigned to a 

posting address has the same grouping key (the same budget ID). 

- If you define an account assignment derivation for availability control objects, the system 

ensures that an availability control object assigned to a budget address has the same grouping 

key (the same budget ID). 

For more information about this, see the documentation for this BAdI. 
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3. Specify that you want a multi-year checking horizon for availability control (AVC). To do so choose 

the Customizing activity  Select Checking Horizon for Availability Control and select a ledger for 

which you define that the checking horizon is entirely defined through the fund master record. 

You can also set the checking horizon to be used for overall checks. 

Examples 

You have activated this function. 

The name of your sponsors is coded into the first five digits, the budget ID into the last four digits of the 

fund name. The budget ID is assigned in accordance with the year the budget is entered: The budget 

adopted in fiscal year 2002 is managed under budget ID 2002 and so on. Funds 04711-2002, 04712-2002 

and so on for the budget 2002 are assigned the keys 04711-2002, 04712-2002 and so on. In the budget 

with ID 2003 the same funds have the names 04711-2003, 04712-2003, and so on. 

Notes 

For more information about this, see the SAP Library under Multi-Year Budget. 

36.2.2.3 Define Global Parameters 

In this step, you can check whether you have maintained the required parameters and assignments for 

each of your FM areas . 

For each of your FM areas, you must have maintained the following parameters at different points in the 

Implementation Guide: 

- Fiscal year variant 

- Status profile 

- Number ranges for actual transactions 

You also make the assignments at different points in the Implementation Guide. You can make any 

assignments which are still missing here. 

Authorization for Fund SPACE or BLANK 

In addition, you can use this step to define an authorization group for the Fund BLANK in each FM area, 

thereby making an authorization check possible. You define an authorization for this group and assign it 

to an authorization profile. 

Standard setup 

In the standard system, the following parameters are already maintained and assigned for FM area 0001: 

- Fiscal year variant K4 

Requirements 

1. You must have created at least one FM area. 
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For more information, read the chapter "Maintain financial management area" in the "Enterprise 

Structure" Implementation Guide. 

2. You must have assigned each company code which is relevant for Funds Management to an FM 

area. For cross-company code funds management, you can combine several company codes in one 

FM area. To do this, simply assign the company codes in question to the same FM area. 

For more information, read "Assign company code to FM area" in the "Enterprise Structure" 

Implementation Guide. 

Activities 

Check whether the necessary parameters have been maintained for each FM area. 

If any are missing, maintain them at the appropriate points in the Implementation Guide. 

Creating an authorization group for the fund BLANK 

If you want to enter an authorization check for the fund BLANK, do the following: 

1. If you are in display mode, then switch to change mode via Table View -> Display -> Change. 

2. Use the cursor to select an FM area to which you want to assign an authorization group and choose 

View -> Detail. 

3. Enter the name of the authorization group in the Authoriz. Group field, and choose Table View -> 

Save. 

36.2.2.4 Fiscal Year Variant 

A fiscal year consists of several posting periods and, if required, special periods to which you can post 

after a provisional year-end closing. 

You define how your fiscal year is to be made up in the R/3 System. You assign this definition to the FM 

areas. The definition of a fiscal year is known as the fiscal year variant and is made at client level. More 

than one FM area can use the same fiscal year variant. 

36.2.2.4.1 Define Fiscal Year Variants 

In this step, you define fiscal year variants for your FM area. 

You use a fiscal year variant to specify: 

- The number of posting periods in a fiscal year 

- The number of special periods you need 

- How the system is to determine the posting periods when making postings When making your 

definitions, you allocate your posting periods to the calendar year. 

Note 
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You can define fiscal year variants for Funds Management that differ from Cash Budget Management 

and/or Financial Accounting. 

Note the following: 

If you use fiscal year variants with special periods, the variants in Funds Management and Financial 

Accounting must match. Otherwise, the FI postings are transferred to the period of the posting date 

instead of the special period of Funds Management. 

Standard settings 

The following fiscal year variants are created in the standard system: 

- Variants for which the fiscal year corresponds to the calendar year with an additional one, two, 

three, or four special periods 

- Variants for shortened fiscal years 

For more information, read the section on special features for the shortened fiscal year in the 

Implementation Guide for "Financial Accounting". 

- Variants for non-calendar fiscal years: 

- April through March with four special periods 

- June through July with four special periods - October through September with four special 

periods 

- Variant on a weekly basis. 

This variant can only be used in the "Special Purpose Ledger FI-SL" application. 

Activities 

1. Check the standard fiscal year variants. 

2. Create your own variants. 

Additional information 

Assign the appropriate fiscal year variant to your FM areas in the next step. 

36.2.2.4.2 Assign Fiscal Year Variant to FM Area 

In this step, you assign fiscal year variants to your FM areas. 

Requirements 
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You must first have defined fiscal year variants in the previous step. For more information, read "Define 

Fiscal Year Variants". 

Standard settings 

The standard system includes FM area 0001, with fiscal year variant K4 (12 posting periods plus four 

special periods) already assigned to it. 

Activities 

Make your assignments, as necessary. 

You can assign different fiscal year variants for Funds Management than for Cash Budget Management 

and/or Financial Accounting 

If you use fiscal year variants with special periods, the variants in Funds Management and Financial 

Accounting must match. Otherwise the FI postings in a special period are transferred to the period of the 

posting date and not to the special period in Funds Management. 

36.2.2.5 Change Message Control 

In this activity you can set system messages to appear as you require them. You can 

- determine whether a message is issued as a note in the dialog box or in the footer 

- change warnings into error messages 

- switch off warnings and error messages 

Different specifications are possible for the online mode and for the batch input sessions processed in the 

background. 

You can make the corresponding specifications for a client or, if required, also for the individual user. 

Activities 

1. Enter the folowing data: 

- Message number 

By selecting the F4 key on the MsgNo field you can find out which messages are available. 

- User name 

If you enter a name here then the specifications only apply to this particular user. If 

you enter "blank", then the settings apply to all users within the client. 

- Message type 

You can find out the permitted message type by selecting F4 on the Online or BatchI fields. 

2. Save your entries. 

The accompanying message text is inserted automatically. 
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Further notes 

Integrating Human Resources 

If you have integrated Funds Management with HR (Human Resources) and specified that account 

assignments for Funds Management are to be derived from the CO -> FM account assignment, you 

should switch off message 012 "Item &: Funds Center & copied from default value". Otherwise, this 

message will appear when you are maintaining Infotypes (defining costs centers). 

36.2.2.6 Develop Enhancements for Funds Management 

You can use Customer exits to add you own functions to SAP standard applications without having to 

modify the SAP original. 

SAP organizes available exits in groups - known as SAP enhancements. Every SAP enhancement can 

contain several exits. 

You can only take advantage of customer exits if you have added these to the SAP standard application. 

The following enhancements in the Funds Management component are made available by SAP. You 

can find more information in the documentation of the enhancement and exits. 

Master Data 

- FMMD0007 

Creating/changing funds center in FM area 

- FMMD0008 

Checking values in funds center (screen 400) 

- FMMD0009 

Customer-specific screen fields for funds centers 

- FMMD0012 

Customer-specific screen fields for fund master record 

- FMMD0013 

Creating/changing fund 

- FMMD0014 

Checking fund 

- FMMD0015 

Creating/changing commitment item (new) 

- FMMD0016 

Checking commitment item (new) 

- FMMD0017 

Customer-specific screen fields for commitment items (new) 

- FMMD0018 

Copying of commitment items (new) 
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- SAPLFMDT 

Enhancement for the FM derivation tool 

Actual and Commitment Update 

- SAPLFMOI 

Update commitment 

- SAPLFMPY 

Active budget control Funds Management in payment program 

- SAPLFMCU 

CO update in Funds Management 

- SAPLFMCH 

Reassignment Funds Management 

- SAPLFMFA 

General module for update Funds Management 

- SAPLFMKN 

Assignment of Funds Management control number 

- SAPFMPM 

Online account assignment Funds Management plant maintenance 

- SAPFMSD 

Online account assignment Funds Management sales and distribution 

- SAPFMNV 

Online account assignment Funds Management network activity 

- SAPFMNP 

Online account assignment Funds Management network header 

- SAPLFMWR 

Exits for coding block 

- SAPLFMPA 

Exits for payment conversion 

Funds Management-specific postings 

- FMRESERV 

Management of earmarked funds 

- RFFMBW00 

Transfer of external document number table 

- FMITPOSM 

Transfer posting with FMITPO: validate document and bank data 

- SAPLF0KA 

User exits request determinant 
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- SAPLF0KE 

Request determinant help functions 

Closing Operation 

- SAPFMVTR 

Special update control setting balance carryforward in Funds Management 

Activities 

1. Create a project or use an existing project and then enter the enhancement. You can manage 

the enhancement and the customer exits contained in them using this program 

2. Activate the project after you have assigned the functions you require to the exits in your 

project. 

Your enhancement only has an effect after the activation. 

Further notes 

You can find the general procedure for the creation of enhancements in the enhancement transaction 

CMOD under Help -> Application Help or in the SAP Library under SAP Netweaver Components -> 

SAP Web Application Server -> ABAP Workbench (BC-DWB) -> Changes to SAP Standards -> 

Customer Exits. 

36.2.2.7 Define Central System in ALE Environment 

Use 

In this IMG activity you define the central system in the ALE environment. 

For more information on ALE distribution in Funds Management, see the documentation of IMG activity 

Create Standard ALE Customizing Settings in the IMG of the Budget Control System (BCS). 

Requirements 

You use Funds Management in a distributed environment. FM documents are posted locally and 

transferred to a central system. 

Standard settings 

Enter the central system. 

36.2.3 Master Data 

In the following sections you will be carrying out important settings which are necessary for the 

maintenance of master data. 
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36.2.3.1 Account Assignment Elements 

36.2.3.1.1 Year-Dependent Master Data 

In the follwing sections, you execute the activation of your master data maintenance for year-dependency. 

36.2.3.1.1.1 Activate Year-Dependent Master Data 

Using program RFFMMDACT you can activate the master data maintenance of an FM area to be year-

dependent, that is, valid for a single year only. 

Special feature during initial installation 

If you are using the SAP system for the first time, you should execute this program before creating master 

data. 

Special feature during changeover to year-dependency 

If you previously maintained your master data separately for each year, master data changes will be 

necessary before the activation of year-dependency is allowed in the system. 

During execution of the program, an FM area check is performed as to whether the current master 

data maintenance fulfills the prerequistes for changeover to year-dependency. In addition, the 

program will guide you as to which changes you must make in order to activate year-dependency. 

Recommendation 

In section Display activation status of year-dependent master data you can check the current 

master data maintenance for commitment items and funds centers of an FM area. 

Activities 

You can find a detailed description of the procedure in the corresponding program documentation 

RFFMMDAC. 

36.2.3.1.1.2 Display Activation Status of Year-Dependent Master Data 

In this step you can check the current maintenance status of the master data for an FM area. 
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Whether a year-independent or year-dependent maintenance exists for the funds center and commitment 

items is displayed. 

36.2.3.1.2 Commitment Item 

In the following sections, you have the following functions available for the maintenance of commitment 

items: 

- Creating/Changing of a chart of commitment items for the defining of commitment item hierarchies 

- Assignment of a chart of commitment items valid for FM area/ fiscal year 

- Definition of the commitement item input template 

- Copy tool for the simple maintenance of commitment item master records 

- Maintenance of criteria 

- Extension of the long text function with additional text types 

36.2.3.1.2.1 Create Variant in FM Area/Fiscal Year 

In this step, you create variants for maintaining commitment item hierarchies. 

In addition to the standard variant "000", you can create additional variants to use alternative commitment 

item hierarchies. 

Standard settings 

You do not have to create the standard variant "000". It is generated automatically as soon as you create 

or import new commitment items in an FM area/fiscal year. 

If you want to import an alternative commitment item hierarchy into the new fiscal year, then you have to 

first create the variant in the new fiscal year. Unlike the standard variant, the variants of alternative 

commitment items are not automatically transferred on export/import. 

Activities 

1. Create the alphanumeric code and the name of the variant for an FM area/fiscal year. 

2. Save your entry. 

36.2.3.1.2.2 Copy Commitment Items 

In these sections, you execute an export or import of commitment items of an FM area/fiscal year. 

In doing so, the commitment item data records are exported from the SAP system to a Unix or PC data 

file, or imported from this data file to the SAP system. 
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36.2.3.1.2.2.1 Export Commitment Items to External File 

In this step, you export the commitment items of an FM area/fiscal year into an external file (Unix File or 

PC File), using program RFFMBI81. 

In a extra step (importing the external file), you import the stored data into the SAP System so you can 

transfer the commitment items of an FM area/fiscal year to the following fiscal year or to another FM 

area. 

Activities 

1. Start the program. 

2. Enter the source FM area/fiscal year, from which you want to export commitment items. 

3. Select the text type and language for the export of the long text. The standard text type is text type 

01. If you do not make an entry, all long texts in all languages are transferred. 

4. Choose the data type (Unix or PC) and enter the path. 

5. Execute the program. 

Further notes 

For more information, see program documentation. 

There is an enhancement FMMD0018 that you can use to change data records to be exported or to add 

new data records for the program. 

36.2.3.1.2.2.2 Import Commitment Items from External File 

In this step, you can use program RFFMBI85 to import the commitment items stored in an external file 

(UNIX File or PC File) into the SAP system. 

You can import the master data of the commitment items into the same FM area or into a new FM area. 

Requirements 

You have performed the "Export Commitment Items to External File". 

Activities 

1. Start the Report. 

2. Enter the target FM area as well as the fiscal year. 

3. Enter the target variant. If more than one variant is to be created, the standard variant must first be 

imported. 

4. Enter the source directory as well as the file name of the data file to be imported. 

5. Set the Test run and Detail list indicators and execute the program. 

If error messages are displayed in the test run, remove the errors. Repeat the test run until no error 

messages appear. 
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6. Remove the Test run indicator and execute the program in an update run. 

Further notes 

For further information, see the Program documentation. 

36.2.3.1.2.2.3 Copy Standard Hierarchy of Commitment Items into Following 

Year 

Use 

In this step, you can copy the commitment item standard hierarchy (variant 000) of a FM area from the 

fiscal year entered to the following fiscal year. 

If you are working with year-dependent commitment items, use this program to construct the standard 

hierarchy of the old year in the new fiscal year. If there have been changes to the functional company 

structure, you can use the enhancement User Exit for Copying Commitment Items (FMMD0018) to 

change the data records to be copied during the copy process and add new data records. 

If you want to use enhancement FMMD0018, you have to set the indicator Enhancement: Copying 

Commitment Items. 

36.2.3.1.2.3 Create Additional Text Types for Commitment Items 

In this step, you can extend the long text function in the commitment item master record with additional 

text types. The additional text types allow you to maintain more long text information independent of 

each other within a commitment item. The extended long text function is valid across FM areas or clients. 

You define the additional text type with a numerical value and the corresponding meaning as a short text. 

If you are in the master data maintenance of a commitment item and select the long text function, you 

will get the intial screen for long text maintenance Maintain commitment item long text and the 

defined text types available and for maintenance are displayed. You can also maintain an individual long 

text for each language version in a text type. 

Standard settings 

The text type 01 standard text: Commitment item is delivered in the standard. 

Activities 

1. Choose New entries. 

2. Define a two digit numerical value and the meaning of the text type. 

3. Save your entries. 

Further notes 
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See the Maintain Additional Master Data Long Texts documentation for more information about this 

function. 

36.2.3.1.2.4 Mask for Commitment Item Keys 

In the following steps you can define a mask for the commitment item key. In the mask, you can specify 

which special signs should subdivide the commitment item key in the on-screen output. 

36.2.3.1.2.4.1 Define Special Character for Mask 

In this work step you specify which special character should be used for the mask of the commitment 

item key. 

In a further IMG activity you specify the mask for the commitment item. 

Activities 

Specify the special character. 

36.2.3.1.2.4.2 Define Mask for Commitment Items 

In this step you define the mask for the commitment item key. When outputting the commitment items 

on the screen, the special characters, which must previously have been defined, according to the mask, 

are inserted into the commitment item key and displayed. 

The mask defined is only valid for one client. 

Exceptions: 

The mask coding defined here is overriden, as soon as you create a commitment item that has more 

characters than the mask definition. In this case the commitment item key is displayed without special 

characters. 

Example 

You define the following mask for the key: XXX:XXX.XXX 

The commitment item key 444555666 is displayed as 444:555.666. 

Requirements 

The special characters that are to be used in the mask must be defined in step "Define special characters 

for mask". 
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Note: Before you define a mask for the commitment item, you must ensure that no commitment items 

were previously created, whose keys contain the selected special characters. To do this, generate an 

alphabetical master data directory for the commitment items, in the Funds Management information 

system, for example. 

Activities 

Define the mask. 

36.2.3.1.2.5 Reproduce Budget Structure 

This hypertext is only relevant for German local authorities. 

36.2.3.1.2.5.1 Define Structure of Commitment Item 

This hypertext is only relevant for German local authorities. 

36.2.3.1.2.5.2 Copy Commitment Item Structure from Source Client 

In this step you copy the commitment item structure you have maintained in step "Specify structure of the 

commitment item" for more than one FM area. 

Activities 

After you have maintained the commitment item structure, go into the client in which you would like to 

copy this structure and copy the structure from the source client. 

36.2.3.1.2.5.3 Maintain Structure Texts 

In this step, for each financial year and FM area, you can: 

- Create new single plans, sections and subsections and maintain the 

corresponding texts 

- Make changes to existing single plans, sections and subsections Note: 

This setting must be maintained for every financial year. 

Activities 

Enter the data you require for each FM area used. 
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36.2.3.1.2.5.4 Maintain Grouping Texts 

In this step, for each financial year and FM area, you can: 

- Create new main groups, groups and subgroups and maintain the 

corresponding texts 

- Make changes to existing main groups, groups and subgroups Note: 

This setting must be maintained for every financial year. 

Activities 

Enter the data required for each FM area used. 

36.2.3.1.2.5.5 Copy Structural and Grouping Texts 

This hypertext is only relevant for German local authorities. 

36.2.3.1.2.6 Maintain Commitment Item 

In this IMG activity, you can define additional types for master data maintenance of commitment items, 

as well as the  commitment item types delivered by SAP. 

Note: 

The programs delivered by SAP refer to the preset commitment item types in the standard delivery. Only 

make changes if you want to apply your own programs exclusively in this context. SAP advises you not 

to change the commitment types of the standard delivery. 

You can also define for each commitment item type, if a plausibility check for postings is to be carried 

out. 

Standard settings 

The standard delivery comprises the following commitment item types, numerical assignments, and 

checks: 

 Type of commit. itemType of cmmt item Verification 

1 Management commitment item X 

2 Net assets commitment item X 
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3 Deposit 

4 Advance (cash desk) 

Activities 

1. Choose the change mode, if you are in the display mode, via Table view -> Display -> Change. 

2. To create new commitment item types, make the changes in existing data or select Edit -> New 

entries, 

3. Save your entry. 

36.2.3.1.3 Funds Center 

In the following sections, you have the following functions available for the maintenance of funds 

centers: 

- Creating of hierarchy variants for the definition of funds center hierarchies 

- Assignment of a hierarchy variant valid for a FM area/fiscal year 

- Copy tool for the simple maintenance of funds center master records and hierarchy variants -

 Extension of the long text function with further text types 

36.2.3.1.3.1 Hierarchy Variant 

In these sections you will be carrying out the necessary settings in order to be able to create a hierarchical 

relationship between funds centers. 

A funds center hierarchy is displayed in a hierarchy variant in the system. 

There are 2 steps required to do this: 

1. Create a hierarchy variant in IMG. 

2. In master data maintenance, maintain the hierarchical relationship between funds centers of an FM 

area in the hierarchy variant. 

Hierarchy variants are year-independent. In assigning a hierarchy variant to an FM area/fiscal year, you 

determine the current valid funds center hierarchy of an FM area. 

36.2.3.1.3.1.1 Create/Change Hierarchy Variant 

You create new hierarchy variants in this section. These are then used to define a funds center hierarchy 

in master data maintenance. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 47 

Beyond that, you can also delete hierarchy variants in this section and in existing hierarchy variants carry 

out changes in the textual name. Changing an alphanumeric key is not possible in an existing hierarchy 

variant. 

Standard settings 

No hierarchy variants are available in new installations of the delivery system. 

If you are already working with a SAP System and funds centers exist in a hierarchical context, the 

funds center hierarchy has as a default in the standard a hierarchy variant preset with key 0000. 

Activities 

Create a 4 digit alphanumeric key and name for the hierarchy variant. 

36.2.3.1.3.1.2 Assign Hierarchy Variant to FM Area 

In this section, you determine which hierarchy variants are to be assigned to the FM area and fiscal year 

as the current valid funds center hierarchy. 

If you are working in your FM area year-dependently, you must enter the respective fiscal year. If you 

would like to work year-independently, you must make "0000" as the entry for the fiscal year. 

Requirements 

You have created a hierarchy variant and defined the funds center hierarchy in master data maintenance. 

36.2.3.1.3.1.3 Change Assignment of Hierarchy Variant 

Use 

In this IMG activity, you can remove (delete) the hierarchy variant assigned to an FM area/fiscal year and 

if necessary, replace it with an assignment to a new hierarchy. 

You can find more information in the program documentation. 

36.2.3.1.3.2 Copy Funds Centers 

In these sections, you execute an export or import program in order to copy funds centers with/without a 

hierarchy structure of an FM area. 

In doing so, the funds center data records are exported from the SAP system to a Unix or PC data file, or 

imported from this data file to the SAP system. 
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36.2.3.1.3.2.1 Export Funds Centers to an External File 

In this step, using program RFFMBI91 you export funds centers as well as the hierarchy variants of an 

FM area in an external file (Unix file or PC file). 

All funds centers of an FM area are stored. In addition, you can also export the hierarchy structure of the 

hierarchy variants into an external file. 

In another step (importing of an external file) you import a data file into the SAP system. You can 

transfer the funds centers or the hierarchy variants to another FM area, or create an identical copy of the 

existing hierarchy variants as a new hierarchy variant. 

Activities 

1. Start the program. 

2. Specify the FM area and hierarchy variant key. 

3. If you also want to export the hierarchy structure along with the funds center, then set the Save funds 

centers from hierarchy variant indicator. 

4. Choose the text types and languages for the export of the long texts. The standard text is the text 

type 01. If no entry was made, all long texts are transferred in all languages. 

5. Choose the file type (Unix or PC), the path as well as the file name. 

6. Execute the program. 

Further notes 

The enhancement FMMD0011 is available for the program for changing or adding new data records to be 

exported. 

See Program documentation for more information. 

36.2.3.1.3.2.2 Import Funds Centers from External File 

In this step, you import funds centers of an FM area or the hierarchy variants of an external file (UNIX 

file or PC file) to a new FM area or as a new hierarchy variant to the same FM area using program 

RFFMBI95. 

Requirements 

When importing funds center master data, the following prerequisites should be fulfilled in the target FM 

area: 

- a hierarchy variant key has been created for the new hierarchy variant. 

- the new hierarchy variant is not assigned to any FM area / fiscal year. 

- no funds centers exist for the target hierarchy variant. 
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- the funds are created for the target FM area that are specified in the funds centers to be imported. 

- the fiscal year variant data (first and last day) must be adapted to the validity dates (existence 

interval) of the funds centers to be imported. 

Activities 

1. Start the program. 

2. Enter the target parameters FM area as well as the hierarchy variant in which you want to save the 

data record. 

3. Enter the source directory as well as the file name of the data file to be imported. 

4. Set the test run indicator and execute the program. 

5. If error messages should be displayed during the test, correct the errors. Repeat the test run until 

there are no error messages displayed. 

6. Remove the test run indicator and execute the import. 

Should error messages occur during the "real" import you should not only correct the error but 

delete the data already imported. To do this start the Delete funds centers in FM area program in 

section Delete master data. 

7. Save your entries. 

Further notes 

Save funds centers in external file 

Delete funds centers in FM area 

36.2.3.1.3.3 Create Additional Text Types for Funds Centers 

In this step, you can extend the long text in the funds center master record with additional text types. The 

additional text types allow you to maintain more long text information items independently of each other 

within a funds center. The extended long text function is valid across FM areas or clients. 

You define the additional text type with a numerical value and the corresponding meaning as a short text. 

If you are in the master data maintenance of a funds center and select the long text function, you will get 

the initial screen for long text maintenance Maintain funds center long text and the defined text types 

available and for maintenance are displayed. On the other hand, you can maintain an individual long text 

for each language version in a text type. 

Standard settings 

The text type 01 Standard text: Commitment item is delivered in the standard. 
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Activities 

1. Choose New entries. 

2. Define a 2 digit numerical value and the meaning of the text type. 

3. Save your entry. 

Further notes 

See the  Maintain several master data long texts documentation for more information about this 

function. 

36.2.3.1.4 Fund 

36.2.3.1.4.1 Create FM Fund Types 

You create fund types in this step. 

You can classify and group a fund by defining fund types in the funds master records. 

Activities 

1. Create a six-digit alphanumeric key for the FM area and enter a name for the fund type. 

2. Save your entry. 

Further notes 

The assignment of the corresponding fund type is entered in the master data maintenance for each fund. 

36.2.3.1.4.2 Create Additional Text Types for Fund 

In this step, you can extend the long text in the fund master record with additional text types. The 

additional text types allow you to maintain further long text information independently for one fund. The 

extended long text function is valid across FM areas or clients. 

You define the additional text type with a numerical value and the corresponding meaning as a short text. 

If you are in the master data maintenance of a fund and select the long text function, you will get the 

initial screen for long text maintenance Maintain Fund Long Text and the defined text types available 

for maintenance are displayed. On the other hand, you can maintain an individual long text for each 

language version in a text type. 

Standard settings 

The text type 01 Standard text: Fund is delivered in the standard. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 51 

Activities 

1. Choose New Entries. 

2. Define a two-digit numerical value and the meaning of the text type. 

3. Save your entry. 

Further notes 

See the Maintain Several Master Data Long Texts documentation for more information about this 

function. 

36.2.3.1.5 Funded Program 

36.2.3.1.5.1 Create and Maintain Funded Program Type 

Use 

In this IMG activity, you create the funded program types you require and maintain them. 

Activities 

1. Choose New Entries. 

2. Enter a funded program type and a descriptive text for the funded program type. Save your entries. 

36.2.3.1.6 Subdivision of Master Data 

36.2.3.1.6.1 Create and Define Subdivision ID 

Create and Define Subdivision ID 

Use 

The subdivision ID is used to subdivide master data into sections, so that user-defined information can be 

included in the account assignment data. Below this subdivision ID, you have to define the 

corresponding subdivision structure, which is made up of the individual substrings of an account 

assignment element for each subdivision ID. 

Activities 

1. Create a subdivision ID for each account assignment element you want to subdivide. The name of 

the subdivision ID is user-defined, and a check is performed by the Business Add-In Check 
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Subdivision ID if implemented. You can use the same subdivision ID name for different account 

assignment elements. 

2. Define a substring for each FM account assignment element, including the number, length and 

position of the individual substrings of an account assignment element for each subdivision ID. 

When you define the subdivision structure for each account assignment element and subdivision ID, you 

can divide the fields - according to your master record data - into the following maximum number of 

substrings: 

 Account assignment element Number of substrings 
Commitment item                           5 

 Funds center   3 

 Fund                                            2 

 Functional area                               3 

For each substring, you must define the length and position within the account assignment element. 

Note that a substring can have a maximum of 10 characters. In addition, the total length of the resulting 

account assignment, including the separator (which you define in the activity Activate Subdivision) must 

not exceed the maximum length of the account assignment element. 

36.2.3.1.6.2 Activate Subdivision 

Use 

In this step, you activate the subdivision of master data and define the separator so that the individual 

substrings are separated from each other when they are displayed on the screen. The separator is saved in 

the database. 

This activation ensures that you can create the individual substrings of the account assignment elements 

in master data maintenance according to the subdivision-ID defined. 

To create the substrings, in the SAP menu, choose Public Sector Management -> Funds 

Management -> Master Data -> Tools -> Subdivision and then the account assignment element that 

you want to create the substrings for. 

To create master data, use the transactions to create the respective master record in which you can fit 

together the substrings you have created. 

The subdivided master data is then processed in the system in the same way as the master data that was 

not subdivided. 

Requirements 

If you use components other than Funds Management, you must note the following when subdividing 

fund centers and commitment items: 

The account assignment elements funds center and commitment item cannot be assigned to an account 

manually in some components; this applies to the following components: 
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- Human Resources (HR) 

- Travel Management (FI-TV) 

- Controlling (CO) 

- Treasury (CFM und CML) - Real Estate Industry (RE) 

This means that the funds center and commitment item and, if necessary, the substrings of these account 

assignment elements must be derived from other account assignment elements, such as the cost element 

or cost center. This is done using the account assignment derivation of Funds Management. 

In order to ensure that the derivation takes place, it is sometimes necessary to create the account 

assignment elements in different components so that they reflect the function of the respective substring. 

For example, if the substring of a funds center represents the region and the derivation of this substring 

should occur from the cost center, you must construct your cost center structure in such a way that a cost 

center corresponds to a region. 

SAP recommends defining these substrings as user-defined fields in the master data for the account 

assignment elements used (for example, cost element or cost center) in the derivation. 

For an example of an account assignment derivation that includes the derivation from master data of other 

account assignment elements, see the SAP library in the documentation on Funds Management under 

Actual-Commitment Update -> Account Assignment Derivation -> Example: Derivation Strategy 

for German Countries and Local Authorities. 

Activities 

You cannot deactivate the master data subdivision again if master data already exists in your production 

system which was created with active master data subdivision as it could impede the reliability of the data 

in the infomation system. 

36.2.3.1.6.3 Business Add-Ins (BAdIs) 

36.2.3.1.6.3.1 BAdI: Check Subdivision ID 

Use 

Using this Business Add-In you can check that the subdivision IDs you created are correct. 

After the necessary implementation, the system only performs a check, without modification, on the 

subdivision ID value you enter into table FMMDSTRID. 

You can implement the Business Add-In using your own functions, in order to check according to your 

preferences. 

Requirements 
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This Business Add-In is only called up if you have activated the subdivision of master data in the 

Customizing of Funds Management in step Activate Subdivision. 

Standard settings 

This Business Add In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

The following example of implementation for this Business Add-In checks the subdivision ID only 

for the commitment item. If the 7th position of the subdivision ID for the commitment item contains 

a character other than "E", "G" or "I", an error message appears: Subdivision ID = "ABCD02E   "

 This passes the test. 

 Subdivision ID = "ABCD02G1X " This passes the test. 

 Subdivision ID = "ABCD02R1X " This does not pass the test. 

Notes 

 Documentation of BAdI method CHECK_SUBID_TYPE 
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36.2.3.1.6.3.2 BAdI: Check Substrings 

Use 

This Business Add-In is used in the Funds Management Master Data (FM-MD) component. 

It enables you to check the creation of your customer-defined master data substrings. After the necessary 

implementation of the Business Add-In,  the system performs a check (without modification) on the 

substring values you have entered in the maintenance tables. 

You can implement it using your own functions in order to run your user-defined checks. 

Requirements 

Only use this Business Add-In if you have previously activated the subdivision of FM master data in 

Activate Subdivision. 

Standard settings 

This Business Add-In is not active in the standard system. 

Example 

There are two sets of examples for the implementation of this Business Add-In. 

Example  1: 

The first checks the values entered for the first substring of commitment item and fund. 

Such values pass the test only if the last position is filled with a digit and the others contain characters. 

Otherwise an error message is displayed. 

Substring = "ABCD2" This passes the test. 

Substring = "A2" This passes the test. 

Substring = "ABC2R" This does not pass the test. 

Example  2: 

The second example checks the values entered for the first substring of funds center and functional 

area. 

Such values pass the test only if the first position is filled with a digit and the others contain characters. 

Otherwise an error message is displayed. 

Substring = "3ABCD" This passes the test. 

Substring = "3A" This passes the test. 

Substring = "ABCR3" This does not pass the test. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Further notes 

Documentation of BAdI method CHECK_VALUES_CISUB1 Documentation 

of BAdI method CHECK_VALUES_CISUB2 Documentation of BAdI method 

CHECK_VALUES_CISUB3 Documentation of BAdI method 

CHECK_VALUES_CISUB4 Documentation of BAdI method 

CHECK_VALUES_CISUB5 

Documentation of BAdI method CHECK_VALUES_FCSUB1 Documentation 

of BAdI method CHECK_VALUES_FCSUB2 Documentation of BAdI method 

CHECK_VALUES_FCSUB3 

Documentation of BAdI method CHECK_VALUES_FDSUB1 Documentation 

of BAdI method CHECK_VALUES_FDSUB2 Documentation of BAdI method 

CHECK_VALUES_FNSUB1 Documentation of BAdI method 

CHECK_VALUES_FNSUB2 

Documentation of BAdI method CHECK_VALUES_FNSUB3 
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36.2.3.1.6.3.3 BAdI: Check Substrings During Master Data Creation 

Use 

Using this Business Add-In you can check the creation of your master data. 

After the necessary implementation, the BAdI only performs a check, without modification, on the 

parameters selected for the creation of master data through the concatenation of substrings. 

You can implement it using your own functions in order to check according to your preferences. 

Requirements 

This Business Add-In is called up only if you have previously activated the subdivision of master data in 

the Customizing of Funds Management in step Activate Subdivision. 

Standard settings 

This Business Add-In is not active in the standard system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 
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9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

Here are some examples of implementation for this Business Add-In, one for each type of master data, all 

checking the subdivision ID. 

Commitment item: if the subdivision ID differs from the concatenation of the FM area and the last two 

digits of the fiscal year, an error message displays. 

Example: FM area = "ABCD" fiscal year = 2002 subdivision ID = "ABCD02    " 

Funds center and fund: if the subdivision ID differs from FM area, an error message displays. 

 Example: FM area = "ABCD" subdivision ID = "ABCD      " 

Functional area: the BADI only calls the method without function modules. 

Notes 

- Documentation of BAdI method FIPOS_CHECK_SUBSTRINGS -  Documentation of 

BAdI method FISTL_CHECK_SUBSTRINGS 

- Documentation of BAdI method FUND_CHECK_SUBSTRINGS 

- Documentation of BAdI method FUNCTION_CHECK_SUBSTRINGS 

36.2.3.1.7 Edit Field Selection 

In this section, you can change the master data field selection of commitment items, funds centers and 

fund is delivered by SAP. 

By defining user-defined field selection strings for the master data of an FM area, you have the option of 

- hiding functions that are not required 

- defining fields as display fields 

- defining entry field as required or optional entries 

You are offered the selection of fields and settings allowed for a field, in the respective field status string 

maintenance. 

36.2.3.1.7.1 Edit Field Selection Strings 

In this section, you define individual field selection strings for the master data commitment item, funds 

center and fund. 

36.2.3.1.7.1.1 Edit Field Selection String for Commitment Items 
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In this step, you define an individual field selection string for the master record of commitment items. 

Activities 

1. Choose New entries, enter an alphanumeric code and a name for the field selection string and 

choose Enter. 

2. Select the field selection string and choose Maintain field status for field selection string in the 

dialog structure. 

3. Execute your required settings and save your entry. 

Further notes> 

In the step FM area: Assign field selection string you replace the field selection delivered by SAP 

with your user- defined field selection string. 

36.2.3.1.7.1.2 Edit Field Selection String for Funds Centers 

In this step, you define an individual field selection string for the master record of fund centers. 

Activities 

1. Choose New entries, enter an alphanumeric code and a name for the field selection string and 

choose Enter. 

2. Select the field selection string and choose Maintain field status for field selection string in the 

dialog structure. 

3. Execute your required settings and save your entry. 

Further notes> 

In the step FM area: Assign field selection string you replace the field selection delivered by SAP 

with your user- defined field selection string. 

36.2.3.1.7.1.3 Edit Field Selection String for Funds 

In this step, you define an individual field selection string for the fund master record. 

Activities 

1. Choose New entries, enter an alphanumeric code and a name for the field selection string and 

choose Enter. 
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2. Select the field selection string and choose Maintain field status for field selection string in the 

dialog structure. 

3. Execute your required settings and save your entry. 

Further notes> 

In the step FM area: Assign field selection string you replace the field selection delivered by SAP 

with your user- defined field selection string. 

36.2.3.1.7.1.4 Edit Field Selection String for Funded Programs 

Use 

In this step, you define a separate field selection string for the master record of the funded program. 

Requirements 

1. Choose New Entries, create an alpha-numerical code and a name for the field selection string. 

2. Select the field selection string and choose Maintain Field Status for Field Selection String from 

the dialog structure. 

3. Define the required settings and save your entries. 

Standard settings 

In step FM Area: Assign Field Selection String  you replace the field selection delivered by SAP with 

your own customer-specific field selection string. 

36.2.3.1.7.1.5 Maintain Field Selection String for Functional Area 

Use 

Use this step to define a field selection string for your functional area. The string is client-dependent and 

cannot be assigned to an FM area. 

Standard settings 

SAP delivers all groups as "Not Specified". 
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Activities 

1. In the maintenance view, choose New Entries and create an entry called FMFA. 

2. Select Field Grouping for the new entry. 

3. Modify each group of fields as required, then save your entries. 

36.2.3.1.7.2 Assign Field Selection Strings to FM Area 

In this step, you make assignments for an FM area from the field selection of commitment items, funds 

centers and fund. 

Requirements 

You want to use a user-defined field selection of master data that differs from the SAP delivery and you 

have defined the appropriate field selection string for commitment items, funds centers and/or fund. 

Standard settings 

If you make no entry ("SPACE"), the settings delivered by SAP for the master data field selection are 

retained. 

Activities 

Enter the field selection strings you defined for an FM area and save your entry. 

36.2.3.1.8 Activate Change Documents from Master Data Groups 

In this step, you can determine for each individual master data group in Funds Management whether 

changes to groups are logged in change documents. 

You can call up change documents in master data group maintenance by choosing Goto -> Change 

Documents. 

Activities 

If you want to activate change documents for a master data group, set the indicator for the relevant group 

and save your entry. 
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36.2.3.1.9 Business Add-Ins for Account Assignment Elements (BAdIs) 

36.2.3.1.9.1 BAdI: BAPI 0038 - Customer Enhancement for Funded Program 

Use 

This BAdI can be used to realize customer enhancements for the Funded Program BAPIs. 

The following methods can be implemented: 

- CREATE_IN 

- CREATE_OUT 

- CHANGE_IN 

- CHANGE_OUT 

- DELETE_IN 

- DELETE_OUT 

- GETDETAIL_IN 

- GETDETAIL_OUT 

- GETLIST_IN 

- GETLIST_OUT 

The <Function Name>_IN methods are called right after you enter the BAPI and the <Function 

Name>_OUT right before you leave the BAPI. 

Standard settings 

We do not deliver any standard settings. 

Activities 

To create an implementation for the BAdI, follow these steps: 

1. Open the IMG activity (BAdI: BAPI - Customer Enhancements for Funded Program) and create a 

new Enhancement Implementation: 

- Enhancement Implementation: 

- Enh. Impl: <Name of your enhancement implemenation> 

- ShText: <Short description> 

- Composite: <Name of your composite> (If none exists already,  you should create one.) 

2. Create the implementation <Implementation Name> for the BAdI definition BAPI_0038. 
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3. Open the BAdI - Tab and activate the Implementation. 

4. Expand the tree on the left side and dubble-click the 'Class' entry. 

5. Create a new class 

6. Implement all interface methods. (If there are methods you do not need, you can leave them empty 

but you must implement them.) 

7. Save and activate the class and go back. 

8. Save and activate the enhancement implementation. 

Now your BAdI-Implementation is active and ready. 

Keep in mind that several implementations can be used for this BAdI (Multi. Usability). So if you use 

several active implementations, all of them are called. 

36.2.3.2 Use of Account Assignment Elements 

36.2.3.2.1 Budget Structure (BCS) 

36.2.3.2.1.1 Define Derivation Strategy for Budget Addresses 

For an overview of using a budget structure, see the IMG under Create Budget Structure. 

Use 

In this IMG activity, you define the assignments of posting addresses to budget addresses using an 

account assignment derivation. In this process, you can define the n : 1 summarizations of several posting 

addresses to an assigned budget address. Actual/commitment postings can therefore be entered in exact 

account assignments, and the budget available for this is managed centrally for a number of posting 

addresses in an assigned budget address. 

You define the account assignment derivation as a derivation strategy. A strategy contains derivation 

steps that use one of the following derivation step types: 

- Derivation Rule 

In the 'derivation rule' step type, you create a table according to your choice of source and target 

fields. You can then maintain the table entries in which you make further assignments of postings 

addresses to budget addresses. 

- Table Lookup 

In the 'table lookup' step type, you can access individual records from database tables. 

- Move 

In the 'move' step type, you can define whether the values of individual FM account assignment 

elements of posting addresses are completely or only partially assigned to account assignment 

elements of budget addresses. You can also move a constant to the target field. 
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- Clear 

In the 'clear' step type, you can define whether you want to set a target field to initial. 

- Function Module 

In the step type function module, you can call function modules that allow you to search for account 

assignment elements in master data hierarchies or to determine master data attributes. 

All derivation steps defined may also have conditions that must be fulfilled so that they can be executed. 

Note on Grants Management 

If you use the account assignment element 'Grant', the values of this account assignment element are 

always copied from the posting address into the budget address. The 'Grant' account assignment element 

cannot be used as a target field in your derivation strategy. 

Standard settings 

SAP delivers strategy SAP00000 as a sample which illustrates how the different step types are used. 

If you do not define an account assignment derivation, a standard 1:1 assignment is supported. This 

means that every FM account assignment you use as a posting address is assigned as a budget address 

itself. 

Activities 

1. Create your own strategy by copying strategy SAP00000 delivered by SAP as a template. 

2. Edit your strategy by adding more derivation steps if necessary. 

3. Save your strategy. 

36.2.3.2.1.2 Create Budget Structure 

Use 

In this IMG activity, you create the key of a budget structure (BS). The key of a BS can be used for 

several fiscal years. You define a multi-level BS by setting the corresponding indicator in the FM area. 

However, this is only possible if you have activated the multi-level BS in Customizing by choosing 

Activate Multi-Level Budget Structure  in the FM area. 

If you work with several versions, SAP recommends that you work with different BS keys. 

Selecting Budget Addresses 

You need a budget structure if you want to restrict the number of budgetable FM account assignments 

from the selection of all FM account assignments of an FM area. You define these account assignments 

as budget postings. All Funds Management account assignments are at first budgetable by default. 

- You define budget addresses in the menu of Funds Management, under Master Data -> Use of 

Account Assignment Elements -> Budgeting -> Budget Structure -> Budget Address ->  

Mass Processing. 
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- You activate the check on budget addresses in the menu of Funds Management, under Budgeting -> 

Version -> Assign Status to a Version.  

Selecting Posting Addresses 

As well as defining budget addresses, you can also restrict the selection of postable FM account 

assignments in the FM area. You define these account assignments as posting addresses. At first all FM 

account assignments are postable by default. When you save budget addresses for each budget structure, 

the posting addresses are not saved in the budget structure but in the respective posting ledger of the FM 

area/fiscal year. 

- You define posting addresses in the menu of Funds Management, under Master Data -> Use of 

Account Assignment Elements -> Budget Structure -> Posting Address ->  Mass Processing. 

- You activate the check on posting addresses in the Customizing of Funds Management, under 

Master Data -> Use of Account Assignment Elements -> Budget Structure -> Define 

Settings for the Budget Structure. 

Copying Budget and Posting Addresses  

If you want to transfer the budget and posting addresses to the next fiscal year, you copy this master data 

in the menu of Funds Management, under Master Data -> Tools -> Use of Account Assignment 

Elements -> Budget Structure ->  Copy Budget and Posting Address. 

When you copy this master data, you can also assign a new budget structure key for the new fiscal year. 

Note on Grants Management 

If you work with the FM account assignment element "Grant", note that the definition of posting and 

budget addresses cannot be restricted to certain values of the grant, so irrespective of the selection of 

other account assignment elements, all values of the grant are included. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

Create the BS key(s) for your FM area and save your entries. 

36.2.3.2.1.3 Define Settings for the Budget Structure 

Use 

In this IMG activity, you assign a budget structure as well as derive account assignment budget addresses 

for an FM area/fiscal year. 

Cross-Version Settings 

On the Cross-Version Settings Screen, you define which settings should be valid for all budget versions 

in your FM area/fiscal year: 
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- By setting the Check posting address indicator, you specify that postings are only allowed on 

budget addresses defined for the FM area/fiscal year. 

- When you assign a budget structure, you specify which budget addresses can be used. 

Note that the check on defined budget addresses only takes place when the Check Budget 

Addresses indicator is set in the status maintenance. You define this setting in the menu of Funds 

Management, under Budgeting -> Budget Control System (BCS) -> Version ->  Assign Status 

of a Version. 

- By entering a derivation strategy, you define the valid assignment of posting addresses to budget 

addresses. 

Override Cross-Version Settings 

In the Version-Specific Settings section, you can override the cross-version settings for individual 

budget versions by defining different settings: 

- By entering a different budget structure, you can assign different budget addresses for a budget 

version. You activate the check on these budget addresses at the same time as the cross-version 

settings in the  Version Status Maintenance . 

- You activate or deactivate the derivation strategy defined in the cross-version setting with the Use 

Strategy indicator. 

Override Multi-Ledger Settings 

In section Ledger-Specific Settings, you can override the general settings for specific ledgers by 

defining different settings. 

Activities 

If you want to work with a budget structure in your FM area/fiscal year, define the required settings here. 

If you want to work without a budget structure, you do not need to define any settings here. 

Two separate ledgers are updated under specific update profiles (for example, 000359), whereas only one 

of them is used for the availability control. We recommend that you deactivate the check on the posting 

address at the level of level-dependent settings and, if there is no budget for the affected ledger, the 

automatic update of the index for the budget structure. 

Note 

- You can only assign the multi-level budget structure if you activated it for the FM area and fiscal 

year. This also applies to the settings at version level. 

- You can only assign the flat budget structure if the multi-level budget structure has not been 

activated for the FM area and fiscal year. This also applies to the settings at version level. 

- For a particular FM area and fiscal year, you cannot assign a multi-level budget structure to a 

version or a single-level budget structure to another version. 

36.2.3.2.1.4 Generate Budget Addresses from Budget Data 
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Use 

In this IMG activity, you start the program for generating budget addresses from existing budget values. 

You use the program if you first carried out budgeting in the budget control system (BCS) without using a 

budget structure and now want to convert to maintenance with budget structure. 

Requirements 

Budget postings have already been entered in the budget control system. 

The generation of budget addresses from budget postings that were entered using former budgeting is not 

supported. 

Activities 

You can find more information in the  program documentation. 

36.2.3.2.1.5 Generate Posting Addresses from Actual Data 

Use 

In this IMG activity, start the program for generating posting account assignments from existing 

actual/commitment postings. 

You use this program if have posted actual and commitment directly to all Funds Management account 

assignments existing in an FM area up until now, but want to convert to maintenance with budget 

structure. 

Requirements 

There are already actual/commitment postings in the FM area/fiscal year. 

Activities 

You can find more information in the program documentation. 

36.2.3.2.1.6 Delete Budget Addresses in the Budget Structure 

Use 

In this IMG activity, you can delete budget account assignments of a budget structure (BS) in the FM 

area/fiscal year. 
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Note: 

Only use this program if: 

- you are still in the test phase and you want to delete your test data before the live date. 

- until now you have entered budget on the budget account assignments of a BS, but want to work 

without the BS in the future so that you can post to all the FM account assignments that exist in FM 

area/fiscal year. 

When you delete, only the budget account assignments of a BS are deleted, not the respective BS key. 

You delete the BS key by deleting the corresponding entry in the IMG activity Create Budget Structure. 

Requirements 

You can only delete budget account assignments if there is no budget on the budget account assignments 

to be deleted. 

36.2.3.2.1.7 Delete Posting Addresses in the Budget Structure 

Use 

In this IMG activity, you can delete posting account assignments in the FM area/fiscal year. 

Note: 

Only use this program if: 

- You are still in the test phase and want to delete your test data before production startup. 

- You have entered actual/commitments postings in posting account assignments up until now, but 

want to post to all Funds Management account assignments existing in an FM area/fiscal year in the 

future. 

Requirements 

You can only delete posting account assignments if there are no actual/commitment postings in the 

posting account assignments to be deleted. 

36.2.3.2.1.8 Change Documents for Budget Structure 

36.2.3.2.1.8.1 Activate Change Log for Budget Structure 

Use 
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In this IMG activity, you activate the change log for the budget structure. 

The activation influences the following maintenance transactions of budget structure. Note that the 

activation of change log will also affect the performance of these transactions: 

- Manual maintenance of budget/posting addresses (transactions FMBSBO/FMBSPO) 

- Mass maintenance of budget/posting addresses (transactions 

FMBSBO_MULT/FMBSPO_MULT) 

- Generation of budget/posting addresses from existing data (transactions 

FMBSBO_GEN/FMBSPO_GEN) 

- Deletion of budget/posting addresses (transaction FMBSBO_DEL/FMBSPO_DEL) 

- Copy of budget structure (transaction FMBSCPY) 

- Reconstruction of budget structure index (transaction FMBSIDX_RECON) 

- For posting addresses: The change document will also be written when updating the budget structure 

index automatically during FM updating. 

Standard settings 

In the standard setup, the change log for budget structure is not active. 

Activities 

In order to activate the change log for budget structure, enter your FM area and checkmark the change log 

activation indicator. You can activate the change log separately for budget and posting addresses. 

36.2.3.2.1.8.2 Delete Change Log for Budget Addresses 

Use 

In this IMG activity you can delete a change log for budget addresses. See the documentation for further 

information. 

36.2.3.2.1.8.3 Delete Change Log for Posting Addresses 
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Use 

In this IMG activity you can delete a change log for posting addresses. See the documentation for further 

information. 

36.2.3.2.1.9 Business Add-Ins for Budget Structure 

36.2.3.2.1.9.1 Validate Budget and Posting Addresses in BS 

Title 

Business Add-In: Validation of FM Account Assignments in Budget Structure 

Use 

With this Business Add-In you can enhance the derivation of budget addresses (strategy ID 

BSAC). It can only be implemented for the Budget Control System (BCS) in Funds Management. You 

can also define validation rules for FM account assignements that are postable and can be budgeted. 

The methods of this BAdI are called in function module FMBS_CALL_DERI_BO, immediately before 

or after deriving a budget address. 

Furthermore, the methods of this BAdI are called when defining budget addresses and posting addresses 

if you have decided to work with a budget structure in your FM area. If you do not work with explicitly 

defined budget or posting addresses of a budget structure, then the methods are called during the check of 

valid budgeting and posting addresses. For further information, see SAP Library under Budget Structure 

of BCS. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

If you would like to use additional source fields within your derivation, first add these fields to the 

structure FMBS_S_BSAC_ADDRESS_SUPPL in the ABAP Dictionary. 

Now implement this BAdI applying the following steps: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 71 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Further notes 

Validation of Budget Address 

Validation of Posting Address 

Fill Supplementary Fields 

36.2.3.3 Allocations to Account Assignments from Other Components 

In the following steps, you define your derivation strategy. This strategy is used to derive the values for 

Funds Management account assignments (FM account assignments) from other account assignments. 

36.2.3.3.1 Select Derivation Steps 

In this IMG activity, you define your account assignment derivation as a derivation strategy. You do this 

by choosing the derivation steps relevant for your organization from those in the derivation strategy 

defined by SAP. 

You can use account assignment derivation to automatically determine Funds Management account 

assignments values from other account assignments as long as a logical dependency exists between them. 

Recommendation 

Customers implementing Funds Management for the first time 



 

WHATSAPP +255738656506 

 

SAP recommends that customers implementing Funds Management for the first time define their own 

derivation strategy by defining their own derivation steps in Define Account Assignment Derivation, as 

the derivation steps shipped as standard cannot be changed. In this way, you can tailor your account 

assignment derivation precisely to your individual requirements. It is possible to use the standard 

derivation steps as a reference when making your own definitions. 

Customers already using Funds Management 

Customers already using Funds Management (Release 4.6C or IS-PS 4.61) define their derivation 

strategy by choosing the derivation steps relevant for their organization from those steps shipped as 

standard. 

Note that defining your own derivation strategy can reduce the maintenance of the rules for account 

assignment derivation. 

Up until now, if, for example, the funds center and cost center had the same name, the funds center was 

derived from the cost center, each cost must be assigned to a funds center. If you define your own 

derivation strategy, you can map this relationship with a single derivation step. 

The derivation strategy delivered by SAP comprises the following nine steps that correspond to the 

account assignment logic in Funds Management that was in the standard system up until now: 

Cost element for commitment item 

The "Cost Element to Commitment Item" derivation step uses cost element as source field and 

commitment item as target field. The assignment is created as date-dependent and can be created 

using cost element ranges. The step is not dependent on company code, controlling area, or FM 

area. 

Cost center/cost element for commt item/funds ctr/fund/functional area 

The "Cost Center/CE to Commitment Item/Funds Ctr/Fund/Function" derivation  step uses 

controlling area, cost center and cost element as source fields and commitment item, funds center, 

fund, and functional area as target fields. The assignment is created as date-dependent. Any source 

field can be used via value ranges. 

Cost center for commitment item/funds center/fund/functional area 

The "Cost Center to Commitment Item/Funds Ctr/Fund/Function" derivation step uses controlling 

area and cost center as source fields and commitment item, funds center, fund, and functional area 

as target fields. The assignment is created as date-dependent. Any source field can be assigned via 

value ranges. 

Order/cost element for commt item/funds center/fund/functional area 

The "Order/CE to Commitment Item/Funds Ctr/Fund/Function" derivation step uses order number 

and cost element as source fields and commitment item, funds center, fund, and function as target 

fields. The assignment is created as date-dependent. Any source field can be used via value ranges. 

Order for commitment item/funds center/fund/functional area 

The "Order to Commitment Item/Funds Ctr/Fund/Function" derivation step uses order 

number as source field and commitment item, funds center, fund, and function as target fields. The 

assignment is created as date-dependent. Any source field can be used via value ranges. 

WBS element/cost element for commt item/funds ctr/fund/functional area 

The "WBS Element/CE to Commitment Item/Funds Ctr/Fund/Function" derivation step uses WBS 

element and cost element as source fields and commitment item, funds center, fund, and function as 

target fields. The assignment is created as date-dependent. Any source field can be used via value 

ranges. 
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WBS element for commitment item/funds center/fund/functional area 

The "WBS Element to Commitment Item/Funds Ctr/Fund/Function" derivation step uses WBS 

element as source field and commitment item, funds center, fund, and function as target fields. The 

assignment is created as date-dependent and the WBS element can be used via value ranges when 

creating the assignments. 

Profit center/cost element to commt item/funds ctr/fund/functional area 

The "Profit Center/CE to Commitment Item/Funds Ctr/Fund/Function" derivation step uses the 

- profit center and cost element as the 

source fields, and 

- commitment item, funds center, fund, 

and function as the target fields. 

The assignment is created as date-dependent. Any source field can be used via value ranges when 

maintaining the assignments. 

Profit center for commitment item/funds center/fund/functional area 

The "Profit Center to Commitment Item/Funds Ctr/Fund/Function" derivation step uses profit center 

as source field and commitment item, funds center, fund, and function as target fields. The 

assignment is created as date-dependent and the profit center can be used via value ranges when 

creating the assignment entries. 

Activities 

1. Check which derivation steps from the derivation strategy defined by SAP are relevant for the 

derivation of account assignments in your organization and whether you want to create your own 

derivation strategy. 

If you want to use the account assignment logic that applied up until now, you must select all 

derivation steps. 

2. Select the relevant derivation steps. 

The derivation steps you choose are stored in the system as the derivation strategy valid for your 

organization under the name SAP. 

3. You can edit your derivation strategy in the IMG activity Define Account Assignment Derivation. 

You do this by: 

a) Defining additional steps yourself 

b) Deleting standard steps 

c) Changing the sequence of steps 

Further notes 

For more information about account assignment derivation, see the SAP Library under SAP 

ERP Central Component -> Accounting -> Public Sector Management -> Funds Management -> 

Actual and Commitment Update -> Account Assignment Derivation. 
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36.2.3.3.2 Define Account Assignment Derivation 

In this IMG activity, you define your account assignment derivation. 

You can use account assignment derivation to automatically determine the values of FM account 

assignments from other account assignments, as long as there is a logical dependency between them. 

The account assignment derivation consists of a sequence of derivation steps - known as the derivation 

strategy. It is used to sequentially derive the values for FM account assignments from other account 

assignments. 

Each derivation step describes how a number of target fields can be filled from a number of source fields. 

There are a number of different derivation step types that can be used to represent different kinds of 

logical dependency between source and target fields: 

- Derivation Rule 

- Table Access 

- Assignment 

- Initialization 

- Enhancement 

- Function module 

You can use each function module as a derivation step. The prerequisite is that the function module 

has an import parameter with the name "INPUT" and an export parameter with the name 

"OUTPUT". Import and export parameters must be defined as a structure with at least one field. 

SAP delivers the following function modules which you can use for your account assignment 

derivation: 

- FMDT_CONVERSION_EXIT_ALPHA_OUT 

You can use this function module to convert alphanumeric fields to the output format. 

- FMDT_READ_MD_ACCOUNT_COMPANY 

You can use this function module to read data in the G/L account master record. 

- FMDT_READ_MD_ASSET 

You can use this function module to read asset master data 

- FMDT_READ_MD_CMMT_ITEM 

You can use this function module to read commitment item master data. 

- FMDT_READ_MD_COST_CENTER 

You can use this function module to read cost center master data. 

- FMDT_READ_MD_FUND 

You can use this function module to read fund master data. 

- FMDT_READ_MD_FUNDS_CTR 

You can use this function module to read funds center master data. 

- FMDT_READ_MD_ORDER 

You can use this function module to read order master data. 
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- FMDT_READ_MD_ORDER_OPERATION 

You can use this function module to read order master data using the sequence of activities 

- FMDT_READ_MD_ORDER_SD_HEADER 

You can use this function module to read information in the header data of the sales order. 

- FMDT_READ_MD_ORDER_SD_ITEM 

You can use this function module to read information in the sales order items. 

- FMDT_READ_MD_WBS_ELEMENT 

You can use this function module to read WBS element master data. 

- FMDT_READ_ORDER_NP_FROM_FMZUOB 

You can use this function module to read the assignments of FM account assignments to the 

network header. 

- FMDT_READ_ORDER_NV_FROM_FMZUOB 

You can use this function module to read the assignments of FM account assignments to the 

network activity. 

- FMDT_READ_ORDER_PM_FROM_FMZUOB 

You can use this function module to read the assignments of FM account assignments to the 

maintenance order. 

- FMDT_READ_ORDER_SD_FROM_FMZUOB 

You can use this function module to read the assignments of FM account assignments to the 

sales order. 

- Function Call 

You cannot define function calls yourself. However, you can include the derivation steps that have 

been predefined by SAP in your derivation strategy. You can find more information in the IMG 

activity "Select Derivation Steps". 

Note that the account assignment derivation only takes effect when you set the 

AcctAssgnDeriv.(account assignment derivation) in the IMG activity "Activate/Deactivate Funds 

Management". The activation ensures that the documents are supplied with an FM account assignment 

that corresponds with the assignments in the account assignment derivation when they are posted in the 

feeder components of Funds Management (FM). 

Standard settings 

SAP delivers a standard strategy with the name SAP: 

- The strategy is empty if you are using this tool for the first time. 

- If you migrate from an earlier release, the strategy contains the rules that you defined in this 

release. 

- You have to assign a company code to each strategy and each company code can only be 

assigned to one strategy. 

- If you do not specify a strategy on the selection screen, the standard SAP strategy is proposed 

by the system. 
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Activities 

You can create, change and delete steps and also change their order. 

Create Step 

1. Choose Create Step. 

If you want to add a new step to the derivation strategy, select the step before which you want to 

insert the new step and choose Create Step. 

2. Choose the derivation step type that you want from those offered to you. 

3. Enter a text and source and target field for the derivation step. For the source and target fields, you 

can determine field characteristics. 

a) Source Field 

You can determine that initial values are permitted. This means that a derivation is carried out 

if the source field is not filled. 

b) Target Field 

For the target field you can determine that: 

The new value is not copied if a value from a previous derivation step already exists. 

The new value is copied even if the new value is blank (space) 

The new value is copied when the new value is filled. 

Note: If you use this setting you can determine, for example, that the derived value cannot be 

overwritten manually. 

c) Source Fields and Target Fields 

In addition to the derivation step type "Derivation Rule", you can determine that either the 

entire field contents, or only a part of the field contents is included. 

4. If the derivation step should only be performed according to specific conditions, for example, only 

for specific account assignment values, enter this on the Condition tabpage. The derivation step is 

only executed when all conditions for the fields are fulfilled. 

5. Define step characteristics on the Characteristics tab page, for example, if an error message 

should be issued, if no target value can be determined. 

a) An error message should be issued if the derivation step is not successfully derived. 

Otherwise the strategy will not be continued. 

b) The execution of the strategy should be terminated if a suitable value is found in the derivation 

step. Otherwise the strategy is completed. 

Note: If you are using derivation step type "Derivation Rule", you can make the following additional 

entries: 

- You can use the Maintain Rule Entries function to specify which values should be entered in the 

target fields from which account assignment values in the source fields. You can make these 
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assignments in master data maintenance in Funds Management under Assignments -> Edit 

Account Assignment Derivation. 

- You can make additional specifications on the Characteristics tabpage; for example, you can 

allow the entry of a validity date for a step and therefore make it time-dependent. 6. When you 

have saved the new entry, go back to the complete list. 

7. To assign a company code to a strategy, select the strategy and choose company code assignment 

in the dialog window. 

8. Choose new entries in the overview that follows and enter the company code you want to assign to 

the strategy. 

Change/Delete Step 

- When making a change, you have all the options described under "Create Step". 

- To delete an entry, select the relevant step and choose Delete. 

Change Step Sequence 

1. Select the step you want to move. 

2. Position the cursor below the target position. 

3. Choose Move. 

Further notes 

Master Data Check 

Note that when you enter concrete values, no check is carried out for the existence of master data. This 

check does not take place until the posting is made. 

Test Derivation Strategy 

You can use the Test function to check your derivation strategy. In the test mode, the following functions 

are available: 

- To test which values are derived, enter the source fields that should be checked and choose Derive 

Assignment. 

- To determine which rules were used in the derivation, choose Display Log. 

- To delete the selection screen, choose  Delete Assignment. 

- To test the account assignment derivation when posting, choose TRACE. If this function is active, 

the check screen appears before the  update where you can check all values. In order to trigger the 

update, you must leave the check screen by choosing  Leave Assignment. 

Note that you can only activate this function if you have authorization. 

Transport 

You can use the Transport function to generate a transport request and transport your derivation strategy 

to other clients. 

Documentation 
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For more information on account assignment derivation, see the SAP Library under SAP ERP 

Central Component -> Accounting -> Public Sector Management -> Funds Management -> 
Actual and Commitment Update -> Account Assignment Derivation. 

36.2.3.3.3 Copy Commitment Items Defined in the G/L Account 

In this step, you can copy the commitment items, which you have defined for a particular company code 

in the G/L accounts, to the G/L accounts for another company code. 

Activities 

Enter a source company code and a target company code. 

36.2.3.3.4 Business Add-Ins (BAdIs) 

36.2.3.3.4.1 BAdI: Enhanced Functions for Account Assignment Derivation 

Use 

SAP provides methods that enable further validation of the FM objects assigned for each rule of the type 

"Derivation Rule". You must create an implementation using the following predefined methods: 

- CHECK_DRULE_BEFORE_SAVE 

- CHECK_DRULE_ENTRY 

- GET_STRATEGY 

- SET_ACTIVITY_ CHECK 

- STEP_CHECK_ON_ENTER 

- STEP_CHECK_ON_EXIT 

- SET_DISPLAY_MODE 

- SET_STRATEGY_BUTTONS 

- STEP_DRULE_ACTIVITY_CHECK 

- DERIVE 

- DISABLE_ENH_DRULE_MAINT 

- ACTIVATE_ENH_DRULE_TOGGLE 
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Standard settings 

We do not deliver any standard settings. 

Example 

(1) You use the method CHECK_DRULE_BEFORE_SAVE to prevent users from deleting assignments. 

<SE>*---- Check if table is initial</> 

<SE><EX>DESCRIBE TABLE  I_TAB_DELETED_ENTRIES lines sy-tfill.</></> 

<SE><EX>IF NOT sy-tfill is initial.</></> 

<SE><EX>* Raise MESSAGE  not allowed to delete entries</></> 

<SE><EX>  e_reject = 'X".</></> 

<SE><EX>ENDIF</></><EX>.</> 

(2) You use the method CHECK_DRULE_BEFORE_SAVE to check specific rule IDs. 

<EX>      CASE i_stepid</> 

<EX>           WHEN 'AAA'.</> 

<EX>*              Specific Check for Step ID 'AAA'</> <EX>           

WHEN OTHERS.</>       ENDCASE. 

36.2.3.4 Derivation Strategy for Reassignment 

36.2.3.4.1 Define Derivation Strategy for Reassignment 

Use 

In this IMG activity, you define the account assignment derivation for  reassigning Funds Management 

account assignments (FM account assignments) Closing Operations for fiscal year change and mid-year 

reassignments in Funds Management (FM). 

With the account assignment derivation, the values of the new FM account assignment are determined 

automatically from previous account assignments. Several target account assignments can be determined 

for some closing operations that allow amounts to be split over several target account assignments and 

partial amounts to be included. You can also use other objects as source fields for the derivation, provided 

that a logical dependency exists between them and the target account assignments. 

The account assignment derivation consists of a sequence of derivation steps - the derivation 

strategy - through that the values from FM account assignments are derived from other account 

assignments. 

Each derivation step describes how a number of target fields can be filled by a number of source fields. 

There are different derivation step types to map the different logical dependencies between source and 

target fields: 

- Derivation rule 
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- Table access 

- Move 

- Clear 

- Enhancement 

More information can be found in section "Prerequisites". 

- Function call 

You cannot define your own function calls. However, you can include the derivation steps (function 

calls) defined by SAP in your own derivation strategy. 

You can also use different derivation strategies for the different closing operations, by assigning a 

strategy to an FM area, fiscal year and a particular closing operation in IMG activity Assign Derivation 

Strategy for Reassignment to FM Area. 

The individual closing operations are represented by one or more programs or transactions. When they 

are executed, the derivation strategy assigned to the FM area is automatically included. 

The following is a list of all programs and transactions that include reassignments defined in the 

derivation strategy. Note that some programs can only be executed when the corresponding global 

functions have been activated in Customizing. The list contains the relevant programs for each closing 

operation and global function under the respective heading 

Global Function Heading 

Funds Management (PSM-FM) Funds Management 

Budget Control System (BCS) BCS 

German Government German Government 

- Commitment Carryforward 

Funds Management 

- Funds Management Closing Operations: Carryforward of Open Items  ( 

RFFMCCF1) 

- Closing Operations: Carryforward of Open Items (Chains) (RFFMCCF1_CHAIN) 

- Closing Operations: Carryforward by Entry DateRFFMCCFD) 

- Reassign Standing Request (RFFMSRCICHNG) German Government 

- Copy Commitment Items (RFFMMD_COM_ITEM_FYC) 

- Copy Assignment of Commitment Item to Revenue Type (RFFMFPCPY) 

- Down Payments/Carry Forward Down Payment Clearings (RFFMCCF_DP) 

- Carry Forward General Request (RFFMCCF0) 

- Copy PCO Assignment (RFFMBGCPY) 

- Reassign Commitment Documents 

Funds Management 

- Select Documents, Overall Reassignment (RFFMCHAG) 

- FM Closing Operations: Reassign Open Commitment  ( RFFMCCOVR) 
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- Carry Over Residual Budget 

Funds Management (former budgeting) 

- Prepare Budget Carryover (BPINDX05) 

- Determine Budget Carryover (RFFMCF25) 

- Carry Over Budget (RFFMCF30) BCS 

- Carry Over Residual Budget (RFFMMP_COVR) 

- Transfer Budget 

BCS 

- Transfer Budget Data (RFFMMP_TRANSFER) 

- Budget / Copy Budget Versions 

Funds Management (former budgeting, but not for German Government) 

- Copy Budget Version (BPCOPY00) 

- Transfer Budget Values of Previous Year into Stat. Budget Plan Year (BPFRES00) 

- Transfer Financial Result from Template Year (BPFRES01) 

- Transfer Budget Plan Version to Net Voting Version (RFFMBAL1) 

- Transfer Budget Values from Budget Plan of Previous Years (RFFMCPY1) BCS 

- Generate Plan Data (RFFMCY_PREP) 

- Load Budget Data (RFFMCY_LOAD) 

- Copy Eligible for Cover Relationships 

Funds Management (former budgeting) 

- Copy Rules for Revenues Increasing the Budget (RFFMKT12) 

- Copy Rules for Cover Eligibility (RFFMKT13) 

- Copy Rules for Revenues Increasing the Budget RFFMRB_COPY) 

- Copy Budget Structure 

Funds Management (former budgeting, but not for German Government) 

- Copy Budget Structure from Previous Year  ( BPCARRY01) 

- BS Copier for Converting to Year-Dependent Maintenance( BPCARRY02) BCS 

- Copy Budget and Posting Account Assignments (BCS) (RFFMBS_COPY) 

- Balance Carryforward 

Funds Management, but not German Government 

- Balance Carryforward (SAPFMVTR) 

For some closing operations - residual budget carryover, budget transfer ( BCS) and budget / copying 

budget versions (BCS), it is possible to distribute the amounts on an FM account assignment to several 

FM account assignments with reassignments or to include partial amounts only. 
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You can do this via a derivation step from the step type Derivation Rule: 

For more information on this, see the section "Dependencies" under Carry Over Residual Budget. 

It is advisable to create only one derivation strategy that you assign to all closing operations. Note that the 

availability of source and target fields are different for the individual closing operations. For more 

information on restrictions resulting from this, see section "Dependencies". 

Requirements 

If you want to use an enhancement in your strategy, you must implement and activate Business Add-Inn 

FM_FYC_DERIVE. To do this, execute IMG activity BAdI: FM Closing Operations: Enhanced Function 

for Derivation Strategy. Note that navigation from the strategy maintenance to the source code of the 

enhancement is not supported with this release. 

Standard settings 

If you do not define a derivation strategy for closing operations for the fiscal year change, the FM account 

assignments are transferred as they are with all permitted closing operations. 

You define which year-end closing operations are allowed to be executed in IMG activity Define Default 

Settings. 

Dependencies 

For the closing operations of former budgeting, the fund is not allowed to be derived dependent on other 

account assignment elements in Funds Management. So, if the fund (NEW_FUND, receiver fund)  is 

specified as the target field in a derivation step of step type derivation rule, no other account assignment 

element other than the fund (SOURCE_FUND, sender fund) can be used as the source field. 

In addition to this, the following dependencies apply to the closing operations in Funds Management: 

- Commitment Carryforward: 

Changes to the FM account assignment for documents of the following document type are 

supported: 

- Purchase requisitions 

- Purchase orders 

- Earmarked funds 

- Sales orders 

- Receipts 

Note the restrictions for the reassignment of receipts. 

You can use the following source fields to derive the target fields: 

- FM_AREA: FM area 

- OLD_FISCAL_YEAR: FM Closing operations: Sender fiscal year 

- NEW_FISCAL_YEAR: FM Closing operations: Receiver fiscal year 
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- CASH_YEAR: Year of cash effectivity 

- LEDGER: Ledger 

- SOURCE_COMMIT_ITEM: Sender commitment item 

- SOURCE_FUNDS_CENTER: Sender funds center 

- SOURCE_FUND: Sender fund 

- SOURCE_FUNCTION_AREA: Sender functional area 

- SOURCE_MEASURE: Sender funded program 

- SOURCE_GRANT_NBR: Sender grant 

- USER_DIMENSION: Customer dimension for FM actual and commitment data 

If required, you can add further fields using a customer enhancement. To do this, you must include 

the corresponding fields in the Customer Include CI_FMYC and implement and activate BAdI 

FM_FYC_DERIVE. 

If it is defined in the Define Basic Settings for Commitment Carryforward that the receiver account 

assignment should be selected in dialog by the user from several receiver account assignments with 

the commitment carryforward, you should use the source field NUMBER (sequence number) in 

your derivation strategy in order to number the receiver account assignments in the rule entries. 

Note that field FM_LAST_TARGET (last target object must be entered as the target field with field 

characteristic Overwrite with New Value as this field is prepopulated with X. If you do not specify 

this target field, the system always determines the first value as the sender account assignment, even 

if you have assigned several receivers to the sender account assignment. 

- Reassignment: 

Changes to the FM account assignment are supported for documents of the following document 

types: 

- Purchase requisitions 

- Purchase orders 

- Earmarked funds 

- Sales orders 

- Parked documents 

- Receipts 

Note the restrictions for the reassignment of receipts. 

With the exception of the target fiscal year, you can use the same source fields to derive the target 

account assignment as you use for the commitment carryforward. It is advisable to use the source 

field NUMBER and target field PERCENTAGE for this process. 

- Carryover of Residual Budget: 

You can use the following source fields to derive target fields in former budgeting: 

- FM_AREA: FM area 
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- OLD_FISCAL_YEAR: FM Closing operations: Sender fiscal year 

- NEW_FISCAL_YEAR: FM Closing operations: Receiver fiscal year 

- CASH_YEAR: Year of cash effectivity 

- LEDGER: Ledger 

- NUMBER: Sequence number 

- VERSION: Version planning / budgeting 

- SOURCE_COMMIT_ITEM: Sender commitment item (FM fiscal year change) 

- SOURCE_FUNDS_CENTER: Sender funds center (FM fiscal year change) 

- SOURCE_FUND: Sender fund (FM fiscal year change) 

- SOURCE_FUNCTION_AREA: Sender functional area (FM fiscal year change) 

The following target fields are available: 

- TARGET_COMMIT_ITEM: Receiver commitment item (FM fiscal year change) 

- TARGET_FUNDS_CENTER: Receiver funds center 

- TARGET_FUND: Receiver fund (FM fiscal year change) 

- TARGET_FUNCTION_AREA: Receiver functional area (FM fiscal year change) 

- PERCENTAGE: FI_FM distribution percentage 

- LAST_TARGET: Last target object 

If you want to distribute the budget of the sender FM account assignment as a percentage over 

several receiver account assignments, you must specify the field NUMBER (sequence number) as 

the source field and field PERCENTAGE (FI-FM distribution percentage) as the target field with 

the field characteristic Overwrite with New Value. (The field NUMBER is prepopulated with X, 

the field PERCENTAGE with the value 100). You can then enter several target account assignments 

for each source account assignment in the rule entries and number in field Sequence Number. 

You can assign a maximum of 99 target account assignments to a source account assignment. You 

define the corresponding percentage for each target account assignment in the field FI-FM 

Distribution Percentage. 

enter UP TP HERE111 If less than 100% of the residual budget should be carried forward, the field 

LAST_TARGET (last target object) should be specified as the target field with field characteristic 

Overwrite with New Value and select the last of the numbered target account assignments in the rules 

entry. 

- Budget / Copy Budget Version (former budgeting) The following source fields are available 

to derive the target fields: 

- FM_AREA: FM area 

- OLD_FISCAL_YEAR: FM closing operations: Sender fiscal year 
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- NEW_FISCAL_YEAR: FM closing operations: Receiver fiscal year 

- VERSION: Version planning / budgeting 

- SOURCE_COMMIT_ITEM: Sender commitment item 

- SOURCE_FUNDS_CENTER: Sender funds center 

- SOURCE_FUND: Sender fund 

- SOURCE_FUNCTION_AREA: Sender functional area 

All account assignment elements of the source fields can be used as target fields. 

- Budget /Copy Budget Version (German Government) The following source fields can be 

used to derive the target fields: 

- FM_AREA: FM area 

- OLD_FISCAL_YEAR: FM Closing operations: Sender fiscal year 

- NEW_FISCAL_YEAR: FM Closing operations: Receiver fiscal year 

- SOURCE_COMMIT_ITEM: Sender commitment item 

- SOURCE_FUNDS_CENTER: Sender funds center 

You can use all account assignment elements of the source fields as target fields. 

- Closing Operations for the Budget Control System (Carryover of residual budget, budget 

transfer, budget / copying budget versions) 

If you are using the Budget Control System (BCS), you can use all active account assignment 

elements as source and target fields. In addition to this, the following fields are available as source 

fields: 

- BCS_BUDGET_CATEGORY: Budget category 

- BCS_VALUE_TYPE_BUDGET: Value type 

- BCS_BUDGETING_APPLICATION: Original application 

- BCS_WORKFLOW_STATE: Workflow status of a data record in the budget totals table 

- BCS_BUDGET_PROCESS: Internal budgeting process 

- BCS_SOURCE_BUDGET_TYPE: Budget type 

In addition to the active account assignment elements, you can use the filed Budget Type 

(BCS_TARGET_BUDGET_TYPE) as a target field. You can use this field to transfer, carry over 

and copy budget to the new budget type entered in the BCS transactions. 

Activities 

You can create, change and delete steps and change their order. 

Note that all the target fields are prepopulated with the values of the source fields. The target value 

defined in a derivation strategy is only transferred when the target field is initialized through a previous 

step or if you define the field attributes so that the target value is transferred. 
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The procedure matches the procedure for defining the derivation strategy for account assignment 

derivation in Funds Management. For more information on this, see Define Account Assignment 

Derivation. 

36.2.3.4.2 Assign Strategy for Reassignment to FM Area 

Use 

In this IMG activity, you assign the derivation strategy(ies) for the reassignment of FM account 

assignments for closing operations in Funds Management (FM) of a combination of FM area, fiscal year 

and closing operation. 

The individual closing operations are represented by one or more programs or transactions. When these 

are then executed, the derivation assigned to the FM area is automatically taken into account. For more 

information on this, see IMG activity "Define Derivation Strategy for Reassignment". You can use 

different derivation strategies for the different closing operations. 

It is advisable to assign one strategy for all closing operations. To do this, enter "All Closing Operations". 

The value BLANK (initial) is allowed. If you use only one strategy for all closing operations, you can 

exclude a closing operation if necessary from the reassignment by creating an entry for it with the value 

BLANK. 

Note that the availability of source and target fields are different for the individual closing operations. For 

more information on the restrictions that result from this, see "Define Derivation Strategy for 

Reassignment". 

Requirements 

The strategy must be created in IMG activity  "Define Derivation Strategy for Reassignment". 

36.2.3.4.3 BAdI: Enhanced Functions for Derivation Strategy 

Use 

This Business Add-In (BAdI) is used in the following components: 

- Actual and Commitment Update (PSM-FM-BU) 

- Closing Operations (PSM-FM-CL) 

You can use this BAdI to supplement the derivation of FM account assignments for reassignments with 

the derivation tool as follows: 

- You can supplement derivation structure FMYC with your own fields by using enhancement 

structure CI_FMYC. You can then fill these fields and evaluate them. All components of structure 

FMIDATA can be included for the commitment carryforward or the mid-year reassignment. 

- You can create and program a derivation step of derivation type Enhancement in the derivation 

strategy. 
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- You can supplement the log of the program for fiscal year change operations with additional output 

parameters. This enables you to stop the execution of certai closing operations individually. 

Requirements 

A derivation strategy must be defined for the reassignment and assigned to your FM area, the respective 

start fiscal year and closing operations. 

For more information, see the implementation guide (IMG) of  Funds Management, under Define 

Derivation Strategy for Reassignment and Assign Derivation Strategy for Reassignment to FM Area. 

Standard settings 

The Business Add-In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. 

The system displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

You want to determine the target account assignment with the commitment carryforward (for example, 

depending on the document type of the earmarked funds). To do this, you must 
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- include the document key (such as the reference document number) in enhancement structure 

CI_FMYC, 

- populate the corresponding fields with method Fill Additional Fields for Derivation 

(COPY) 

- and, if necessary, program method Derivation Step as Enhancement (DERIVE) (for example, 

read document type and so on). 

See also: 

Methods 

Fill Additional Fields for Derivation 

Derivation Step as Enhancement 

Additional Return Parameters 

36.2.3.5 Status Management 

The following contains information on the settings which you must carry out for status management. 

36.2.3.5.1 Allocate Authorization Keys 

In this step, you define authorization keys which are used as the basis of status-dependent authorization 

checks. 

When you set or delete a user status, the system checks whether you are authorized to carry out this 

action. In addition to the status profile and the object type, the authorization key of the user status in 

question is also used for this authorization check. 

Example 

You want to make sure that certain user statuses may only be changed by a selected group of people. 

To do this, you create an authorization key and allocate it to the corresponding user statuses. 

In general authorization maintenance, you then assign authorizations for this key via the authorization 

object B_USERSTAT. 

Activities 

1. Check whether you want to assign authorizations for your user statuses. 

2. If necessary, create an authorization key as follows: 

a) Call up the function Authorization key and press New entries. 

b) Enter a key and an explanatory text into the corresponding fields and press "Save". 

This creates the authorization key. 
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3. Allocate the authorization key to one or more user statuses in the status profile. 

4. Define corresponding authorizations and include them in the relevant authorization profiles. 

36.2.3.5.2 Define Status Profiles 

This step tells you how to adapt SAP status management to your specific requirements by creating a 

Status profile. 

SAP status management gives you the option of adding your own user statuses to the system statuses 

supplied by SAP. You can then assign particular business transactions to the user statuses. 

Standard setup 

The standard system contains status profile FM000001 which includes the predefined user statuses BUSP 

(G/L account posting blocked) and MRSP (Funds reservation blocked). 

Activities 

Define status profiles to meet your requirements as follows: 

1. Create a status profile 

2. Assign the status profile to an object type 

3. Define your user statuses 

4. Assign business transactions to the user statuses 

5. If necessary, translate the status profile and user statuses (menu Go To -> Translation -> Status 

Translation). 

1 Create status profile 

To create a status profile, proceed as follows: 

1. Choose Edit -> New entry. 

2. Enter a name of your choice for the status profile. 

3. Enter an explanatory text. 

4. Specify a maintenance language for the status profile. 

Changes and additions to the status profile can only be made in the maintenance language and must 

then be translated into the other languages you use. This guarantees that the entries in the profile are 

complete and consistent. 

5. Press Enter to include the status profile in the list. 

6. Save your entries. 

2 Assign the status profile to an object type 
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To be able to use a status profile for objects of a particular object type , you must assign the profile to the 

relevant object type: 

7. Access the screen Change Status Profile: Overview and position the cursor on the status profile 

which you want to assign to an object type. 

8. Choose Goto -> Object Types. 

9. Select the object types for which you want to use the status profile in Funds Management. 

10. Save your entries. 

3 Define user statuses 

To define user statuses for a status profile, proceed as follows: 

11. Access the screen "Change Status Profile: Overview" and position the cursor on the status profile 

you want to maintain. 

12. Choose Goto -> User status. 

13. For each user status, you must enter a four character language-dependent key, which identifies the 

status. 

14. You can enter the following for each status. 

a) Enter a Status number in field ONr. 

The status number determines the sequence in which the statuses in a status profile can be set. 

b) In the columns "Low" and "High", enter the lowest and highest status numbers. 

c) Enter a short text. 

The short text contains a short description of the status. 

d) Enter a long text for the user status. Choose Goto -> Long text. 

e) If you wish, flag a status as the initial status. 

If you do this, the system automatically sets a newly created object at this status. You can only 

set one status with a status number as the initial status, but as many as you want with no status 

number. 

f) Use the "Pos" (="Position") field to the position in which the status is displayed in the string in 

the order header. 

g) Use the "Priority" field to determine the priority the user status has in a position if the same 

position is specified for more than one active status. 

15. Save your entries. 

The standard system includes a sequence of user statuses which you can use if you wish. 

4 Assign business transactions to a user status To do 

this, proceed as follows: 

1. Position the cursor on the relevant user status. 
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2. Choose Goto -> Transaction control. 

3. Choose Edit -> New entries to display a list of the existing business transactions. 

4. Assign the transactions you need to your user statuses. 

5. You can use the "Effect" options to activate the following fields for each transaction: 

a) No Effect 

The current user status will have no effect on this transaction. 

b) Permitted 

The current user status will permit the transaction. 

c) Warning 

The current user status will allow the transaction, but will generate a warning.  You choose 

whether or not to act on the warning. 

d) Forbidden 

The current user status forbids this transaction. 

If you want to use a particular business transaction, it must meet the following 

requirements: 

- At least one active status must permit the transaction 

- The transaction must not be forbidden by any active status 

6. You can use the "Next action" options to determine the effect which carrying out a particular 

transaction has on the current status: 

a) NoEffect 

The transaction neither sets nor deletes this status. 

b) Set 

The transaction sets the relevant status. 

c) Delete 

The transaction deletes this status. However, if the user status has a status number, you cannot 

delete it in this way, but must set a follow-up status selected from the other statuses which 

have a status number. 

7. Save your entries. 

5 Translate the status profile and user statuses 

You can translate the status profile and the  user statuses assigned to it into other languages. 

If you want to create a translation, bear the following points in mind: 

- User status can only be created, changed, and deleted in the original maintenance language. 

- If not all the user statuses in a status profile are fully translated, the system displays all the user 

statuses in the original language. 
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To translate a status profile, proceed as follows: 

8. Choose Go To -> Translation -> Profile Translation in the status profile overview. 

9. Use the "F4" button to obtain a list of the language abbreviations. 

10. Use the "F2" button to choose the one you want. 

11. Choose Continue 

12. Translate the name of your status profile into the desired language. 

13. Save your translation. 

To translate user statuses, proceed as follows: 

14. Position the cursor on the relevant status profile. 

15. Choose Goto -> User Status. 

The system displays a list of all the user statuses in the profile. 

16. Choose Goto -> Translation -> Status translation. 

17. Use the "F4" button to obtain a list of the language abbreviations. 

18. Use the "F2" button to choose the language you want. 

19. Choose Continue 

20. Translate the abbreviation, name, and long text (if any) into the desired language. 

21. Save your translation. Additional information 

To activate general SAP status management for Funds Management, assign the key for your status 

profile to the relevant FM area. For more information, see the documentation on the IMG activity Assign 

Status Profile to FM Area. 

36.2.3.5.3 Assign Status Profile to FM Area 

In this step, you assign the status profiles you have defined to your FM areas. 

Requirements 

You must first have defined status profiles.  You can also use status profile FM000001, delivered in the 

standard. 

Standard settings 

In the standard system, FM area 0001 is already assigned to status profile FM000001.  This profile 

includes the following, predefined user statuses: 

- BUSP G/L account posting locked 
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- MRSP Funds reservation locked 

Activities 

Make your assignments as necessary. 

36.2.3.5.4 Delete Status Management Entries 

In this step, you delete all entries of the status management of an FM area/fiscal year using program 

RFFMMDD5. 

Activities 

Execute the program 

36.2.3.6 Deleting Master Data 

In the following steps, you are able to delete different Funds Management master data as well 

as master data hierarchies (funds center, commitment item and funds). 

36.2.3.6.1 Delete Commitment Items in FM Area/Fiscal Year 

In the step you delete the commitment items in the FM area for a fiscal year using a report. You also 

delete both the master record information and all existing information about hierarchy relations on the 

level of the FM area. 

You should only use this program when you are still in the test phase and you want to delete your test 

data before the production startup. 

Requirements 

- You have carried out a data backup for security reasons. 

- You have not yet budgeted and you have not carried out any postings, or you have already deleted 

existing transaction data. On this subject see the Implementation guide (IMG) for Funds 

Management in sections: 

- "Delete FM line items" 

- "Delete budget data" 

- You have removed the stored commitment items from all G/L accounts. On this subject read the 

Implementation guide for Funds Managment paragraph  "Remove commitment item from G/L 

account". 
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Activities 

Delete the commitment items in the FM area for a fiscal year. 

36.2.3.6.2 Delete Funds Centers in FM Area 

In this step, you can delete all funds centers of an FM area with the help of a program You will 

delete: 

- Funds centers - key information 

- Classification assignments 

- Hierarchy references of funds center in hierarchy variants 

(but: the hierarchy variant key created in the IMG remains preserved) 

- Hierarchy variants - assignments for all fiscal years 

You should only use this program if you are still in the test phase and you want to delete your test data 

prior to your production startup. 

Requirements 

A data backup has been done for security reasons. You have not budgeted and have not carried out any 

postings, or you have already deleted existing transaction data. Read the following sections in the Funds 

Management Implementation Guide (IMG): 

"Delete commitment data and actual data" 

"Delete budget data" 

36.2.3.6.3 Delete Funds Centers of a Hierarchy Variant 

In this step you can delete all funds centers of a hierarchy variant using the RFFMMDD3 program. 

You will delete: 
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- Hierarchical structure of the funds center in the hierarchy variant 

(but: The hierarchy variants key created in the IMG remains intact) 

- All assignments of the hierarchy variant to fiscal years 

You should only use this program if you are still in the test phase and you want to delete your test data 

before your production start. 

Requirements 

You have done a data backup for security reasons. You have done no budgeting and no posting, or you 

have already deleted all existing transaction data. Read the following sections in the Funds Management 

implementation guide (IMG): 

Delete actual data 

Delet budget data 

36.2.3.6.4 Remove Commitment Item from G/L Account 

In this step, you can use program RFFMDL03 to delete all the commitment items stored in G/L accounts 

for one company code. 

You can use this program if you are still in the test phase and want to delete your test data before the 

production startup. 

Requirements 

- Make sure you back up your data first. 

- Deactivate your FM area by deactivating all the company codes to which you have assigned this FM 

area. For more information on activating/ deactivating Funds Managment, see the section 

"Activate/Deactivate Funds Management". 

Activities 

Start program RFFMDL03 to delete commitment items from the G/L account. 

36.2.3.6.5 Delete Objects 

In this step, you use a report program to delete objects (master data) from Funds Management. This 

involves deleting both the master data information and all existing assignments to customers and/or bank 

details. 

You should only use this program if you are in the test phase and want to delete your test data before the 

production startup. 

Requirements 

The following situations may affect whether an object can be deleted: 
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- The object is assigned to a customer. 

The program only deletes the object if the customer has already been deleted. 

You delete the customer master data in the Accounts Receivable and Accounts Payable IMG, 

step Delete customer master data. Refer to that IMG for more information. 

- The object has been used in the assignment of bank details to customers. The program only deletes 

the object if this assignment is no longer in place. You delete the assignment in the Funds 

Management for Germany IMG, step Delete bank details for revenue types and/or objects. 

Refer to that IMG for more information. 

Activities 

Delet the objects as required. 

Further notes 

For more information, read the program documentation. 

36.2.3.6.6 Delete Bank Details for Revenue Types and/or Objects 

In this step, you use a program to delete revenue type and/or object-specific assignments of bank details 

to a customer 

You should only use this program if you are still in the test phase and want to delete your test data before 

production startup. 

Requirements 

You must first delete the customer for whom revenue-type-specific or object-specific bank details have 

been maintained. 

You delete customer master data in the Customizing of accounts payable and accounts receivable 

accounting. See section "Delete Customer Master Data" in the Financial Accounting IMG for more 

information. 

Activities 

Delete the assignments for the selected company codes. 

36.2.3.6.7 Delete Bank Details for Revenue Types 

You delete the revenue type specific assignments of bank details to a customer with the aid of a program 

in this step. 

You should only use this program if you are still in the test phase and want to delete test data before 

production start. 

Requirements 
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The customer for whom a revenue type specific bank detail was maintained must be deleted. 

You delete customer master data in the Customizing of accounts payable and accounts receivable 

accounting. See section "Delete Customer Master Data" in the Financial Accounting IMG for more 

information. 

Activities 

Delete the assignments for the selected company codes. 

36.2.4 Budget Control System (BCS) 

In the following sections, you define the Customizing settings for the Budget Control System (BCS) of 

component Funds Management Government. 

36.2.4.1 Budgeting 

In this section, you define the budgeting settings for the Budget Control System (BCS). 

36.2.4.1.1 Basic Settings 

36.2.4.1.1.1 Use of Master Data 

36.2.4.1.1.1.1 Activate Account Assignment Elements in Budgeting 

Use 

In this IMG activity, you define which account assignment elements should be used in the budget control 

system (BCS). When you activate BCS, you define that the input field of an account assignment element 

is available in BCS budgeting transactions. 

You can define the following statuses for activating or deactivating the account assignment elements: 

- Not Used 

The account assignment element is not active for budgeting. The input field of the account 

assignment element is not displayed in the budgeting transactions. 

- Optional 

The account assignment element is activated for budgeting. The input field of the account 

assignment element is ready for input as an optional field entry in the budgeting transactions. Initial 

is also a possible entry value. 
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- Mandatory 

The account assignment element is activated for budgeting. The input field of the account 

assignment element is a Required Entry Field. 

The following account assignment elements are available: 

- Funds center 

- Commitment item 

- Fund 

- Functional area 

- Grant 

- Funded program 

Note: 

Although the settings that can be defined here are somewhat more flexible than the other Funds 

Management Customizing settings, the settings of the BCS budgeting defined here must take the other 

Funds Management settings into account. 

- Account assignment elements that are not activated in Funds Management cannot be activated 

in the BCS Budgeting. The status Not Used should be set for these account assignment 

elements. 

You can find more information on activating account assignment elements under "Activate Account 

Assignment Elements". 

- Account assignment elements that have the input value initial (blank) in Funds Management 

cannot be set with status Mandatory in BCS. 

Note the following settings for using the component Grants Management in the Budget Control 

System: 

- The account assignment element "fund" must have the same status as the account assignment 

element "grant". 

- Optional  or mandatory if the grant is optional 

- Mandatory if the grant is mandatory 

- The account assignment element "grant" must have the same settings in Funds Management 

and in BCS for budgeting and posting. The BCS status should be defined in the following way: 

- Optional: If no input values (value = initial) are allowed for the posting after BCS is activated. 

- Mandatory: If a value always has to be entered (because BSC was activated). 

Standard settings 

The account assignment elements "funds center" and "commitment item" are generally activated as 

mandatory entry fields in Funds Management and you cannot change them. 

Activities 
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Define the status of the account assignment elements for each FM area according to your requirements 

and save the entries. 

36.2.4.1.1.1.2 Deactivate Account Assignment Elements in Controlling 

Use 

In this IMG activity, you can deactivate the account assignment elements fund, functional area and grant 

in Controlling and Asset Accounting. 

If you want to use the fund, functional area or grant as the account assignment elements in Funds 

Management (FM), you must first activate these account assignment elements in IMG activity Activate 

Account Assignment Elements. 

If you want to use these account assignment elements in budgeting (BCS), then you have to activate them 

in IMG activity  Activate Account Assignment Elements in Budgeting. 

If you want to use Grants Management, you must activate the fund and the grant. 

When you activate an account assignment element, you must then assign it to an account in Controlling 

and in Asset Accounting. 

Deactivating an activated account assignment element for Controlling and Asset Accounting allows you 

to use this account assignment element within Funds Management or Grants Management without 

affecting business processes in Controlling or Asset Accounting. 

Requirements 

After activating the account assignment element, no postings were made on this account assignment 

element and no planning either. 

Activities 

Deactivate the account assignment elements that you have activated in order to use Funds Management or 

Grants Management in IMG activity Activate Account Assignment Elements. 

36.2.4.1.1.2 Definition of Budget Data 

36.2.4.1.1.2.1 Define Budget Category 

In this IMG activity, you determine the budget categories you want to use for an FM area in your 

organization. 

You can define the number of years or time horizon that should be used for budgeting for each budget 

category. You also define the year of cash effectivity and whether the time horizon should start from the 

following year or not. 
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Example 

You want to use the commitment budget with the following values: 

- Time horizon three years 

- Indicator set for the start of the time horizon from the next year 

Result: The commitment entitlement is valid for the cash effectivity years 2005, 2006 and 2007 in fiscal 

year 2004. 

Standard settings 

When using budget categories, the following ledgers are available: 

- 9F for the Payment Budget 

- 9G for the Commitment Budget - 9J for the Financial budget. 

Activities 

1. Define which budget category should be used for your FM area and which time horizon should be 

used for the year of cash effectivity. 

2. If you want to manage the year of cash effectivity as "valid from next year", set the indicator in the 

corresponding column. 

3. Save your entries. 

36.2.4.1.1.2.2 Budget Types 

In this section, you determine which combinations of processes and budget types can be used in your FM 

area for the Budget Control System (BCS). 

To do this, carry out the following IMG activities: 

- Define budget types 

- Assign one or more budgeting processes to each budget type 

- If you want to define a budget type for managing a statistical budget, do this in IMG activity Define 

Budget Type for Statistical Budget. 

36.2.4.1.1.2.2.1 Define Budget Types 

Use 

In this IMG activity, you define the BCS budget types that you want to use in your 
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organization. 

You can also define a budget type as eligible for cover or not eligible for cover. 

This setting can only be used with budget types of an FM area activated in IMG activity Activate Cover 

Eligibility. 

You use budget types to differentiate a characteristic of the budget values according to its use: 

- In BCS budgeting, you can define for which budget types a budgeting process is allowed. There are 

two options for this: 

- You can do it directly in this IMG activity for an individual budget type (individual maintenance of 

budget type). You can assign different budgeting processes to each budget type. You can assign all 

budgeting processes with * (asterisk). 

- or for all budget types for mass maintenance in IMG activity Assign Budget Types to Processes 

- In the BCS availability control, you can define which budget type is "released" as consumable 

budget and updated in the availability control. You do this in IMG activity Define AVC Filter 

Settings for Budget Values. 

Different budget types can be used for the budgeting process, amongst other things, for mass transactions 

in budgeting for example 

Standard settings 

SAP delivers the following budget types: 

Budget Type Purpose 

BT01 Normal budget entry 

SU01 Supplement 01   (normal budget supplement) 

SU02 Supplement 02   (unusual budget supplement) 

TR01 Transfer 01    (normal transfer posting) 

TR02 Transfer 02    (unusual transfer posting) 

You can change these budget types to suit your requirements. For example,BT01 which is set up with the 

activity "enter" for FM area 0001. You can adjust it to suit your requirements, for example, by assigning 

another activity. 

If you want to enter statistical budget that is to be used for the annual financial account, you do this in 

IMG activity Define Budget Type for Statistical Budget. 

Recommendation 

You cannot use special characters in the technical name of a budget type. Activities 

1. Define the budget types used in your organization for each FM area. 

2. If necessary, define the budget type as eligible for cover by setting the indicator in the corresponding 

column. 

3. Save your entries. 
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36.2.4.1.1.2.2.2 Assign Budget Types to Processes (Mass Maintenance) 

Use 

In this IMG activity, you determine which budget types are valid for each Budgeting Process in your FM 

area. 

When you assign processes to a budget type,  you can use the * symbol for both the process and the 

budget type. 

This means that all processes and budget types are considered. 

Requirements 

You have created budget types for your FM area in IMG activity Define Budget Types. 

Standard settings 

See section " Standard Settings" in the documentation on IMG activity Define Budget Types. 

As an example, SAP delivers budget type BT01 assigned with process Enter for FM area 0001, which you 

can change to suit your requirements. 

Activities 

1. Choose New Entries and assign budget types to the relevant activities for your FM area. 

2. Save your entries. 

36.2.4.1.1.2.2.3 Assign Budget Type Groups to Processes (Mass Maintenance) 

Use 

In this IMG activity, you determine which budget type groups are valid for each budgeting process in 

your FM area. 

When you assign processes to a budget type group, you can use the * symbol for both the process and the 

budget type group. This means that all process and budget type groups are considered, and all budget 

types in the budget type group will use the combination settings defined here. 

Requirements 

Budget type groups must have been created for your FM area in the MG activity Define Budget Type 

Groups. 

Standard settings 

SAP does not deliver any default settings. 
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Activities 

1. Choose New Entries and assign budget type groups to the relevant processes for your FM area. 

2. Save your entries. 

Example 

You have created a budget type group BG01, which has the combination payment budget category and 

budgeting process Enter. This means that all budget types in this budget type group will use this 

combination. 

36.2.4.1.1.2.2.4 Define Budget Type for Consumable Budget 

36.2.4.1.1.2.2.4.1 Define Budget Type Groups 

Use 

In this IMG activity you can bundle different budget types in a budget type group. Budget type groups 

enable you to define multiple budget types to be used for consumption. 

Requirements 

You must have defined several budget types in the IMG activity Define Budget Types. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. First create a budget type group to be used for consumption. 

2. Next, put the cursor on the budget type group you have defined and click on Edit Budget Type 

Group. 

3. Using the New Entries function, you now enter the budget types to be grouped. 

4. Save your entries. 

36.2.4.1.1.2.2.4.2 Define Budget Type for Consumption per Fund Type 

Use 
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In this IMG activity, you define general Customizing settings for budget types for each fund type. If you 

are using several budget types in your organization and are working with different fund types, in this 

activity you can define which budget types represent consumable budget for a fund type. 

In the columns Budget Type and Budget Type Group, you can specify either a budget type or a budget 

type group to be used for consumption, but not both. 

Budget types, or budget entered but not defined as consumable budget, are not updated in availability 

control and therefore cannot be "consumed" for actuals or commitment postings. 

Requirements 

You must have defined your budget type groups in the IMG activity Define Budget Type Groups. 

The settings defined in this IMG activity will only be included in availability control if the budget type is 

correctly defined. In the view "Define Budget Values as Consumed Amounts" of the IMG activity Define 

Filter Settings for Budget Values, you must select the value type "Posted budget and preposted budget 

documents" for this. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Define which of your budget types or budget type groups are intended as consumable budget and 

enter a "from" fiscal year. 

2. Save your entries. 

Further notes 

If you change the definition of consumable budget types, you should: 

- reconstruct availability control to obtain updated budget values -

 adjust the release amount (via mass release) if necessary. 

36.2.4.1.1.2.2.4.3 Define Budget Type for Consumption per Fund 

Use 

In this IMG activity, you define the general Customizing settings for budget types for each fund. 

If you are working with several budget types in your organization, in this activity you can define whether 

the budget values entered for budget types represent consumable budget or not. 

You can specify either one single budget type for consumption or several different budget types, using the 

budget type group. 

Budget types or budget entered which is not defined as consumable budget is not updated in availability 

control and can therefore not be "consumed" by actual and commitment postings. 
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Requirements 

The settings defined in the current IMG activity will only be included in availability control if the budget 

type is correctly defined. In the view "Define Budget Values as Consumed Amounts" of the IMG activity 

Define Filter Settings for Budget Values, you must select the value type "Budget or budget/release 

according to fund-dependent settings" for this. 

 In this IMG activity, you can also define which budget types are defined as consumable budget, 

irrespective of the general settings already made. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Define which of your budget types should be budgeted for each fund and enter a "from" fiscal year. 

2. In the column Budget Type Group, you can specify either one or several different budget type 

groups to be used for consumption. 

3. Save your entries. 

Further notes 

If you change the definition of consumable budget types, you must subsequently: 

- reconstruct the availability control ledgers, so that the correct budget values are used in 

AVC 

- if necessary, adjust the release amount (via mass release). 

36.2.4.1.1.2.3 Budget Releases 

36.2.4.1.1.2.3.1 Overview of Release Scenarios 

Use 

In order to define a release scenario, you have to follow a specific sequence of Customizing steps in the 

IMG. You first specify that you would like to activate the release functionality in your FM area. 

Next you can define exceptions to this rule for a specific fund or fund type. 

Then, in the budgeting workbench (BWB) or in the mass release transaction, you can carry out further 

manual releases of your budget if necessary. 

Requirements 

You have installed the Budget Control System. 

Standard settings 
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SAP does not deliver any default values. 

Activities 

Process the IMG activities in the order they appear. 

Example 

You want to use releases for your FM area, but do not need this function for a specific fund or fund type, 

for which the voted budget is immediately available and therefore does not need to be released. So you 

first activate the release for your FM area, then specify the exceptions per fund or fund type by choosing 

the scenario "no release" for this in the IMG activity Define Release Scenario for each Fund or Define 

Release Scenario for each Fund Type. 

Another option for a fund (or fund type) is to assign the scenario "automatic release" in the IMG activity 

Define Release Scenario for each Fund. In this case, every time the budget is updated, the release is 

adjusted accordingly. The full budget amount is then also immediately available. 

36.2.4.1.1.2.3.2 Define Release Scenario 

Use 

In this IMG activity, you activate the release functionality for your FM area. 

Standard settings 

SAP does not provide any default settings. Therefore, in the default, the release functionality is not 

activated. 

Activities 

In this IMG activity you specify whether you want to use a release scenario to release budget for an FM 

area of your organization. If you choose the release scenario, budget is released following a one-step 

procedure. The budget release is carried out for the same account assignment elements as the ones to 

which budget has been assigned. Only one release value is then checked by availability control (for 

standard ledgers defined according to BCS settings). 

You can also use the release function for releasing revenues in your organization. For this, checkmark the 

column called "Release on Revenues". 

Note 

It is necessary to distinguish between revenues that are related to a commitment item category and real 

revenues, that is, actual incoming amounts. The same is true for expenditures and real expenditures 

(outgoing amounts). 

In the default, the release functionality is applicable to real expenditures (outgoing amounts), regardless 

of the commitment item type. For more information see the information on ceiling types. 
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If you want to control your real revenues (incoming amounts), you can do this using the BCS Availability 

Control functionality. If the release function is active, and you want to carry out availability control for 

real revenues, you must also activate the release on real revenues. 

Further notes 

Please note that you can also customize the document type for your budget entry documents, in order  to 

have an automatic release for each budget amount entered. You do this in the IMG activity Define Entry 

Document Types. 

For further information, see the documentation on the available scenarios for value types. 

36.2.4.1.1.2.3.3 Define Release Scenario per Fund Type 

Use 

In this IMG activity, you define a release scenario for each fund type. In this way you can have separate 

release processing for a particular fund type if necessary. 

Requirements 

You have created a fund type in Funds Management master data in the IMG activity Create FM Fund 

Types. 

You have activated the release functionality for your FM area in the IMG activity Define Release 

Scenario. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. For each FM area and fund type, enter a from-fiscal year and a release scenario. 

2. Save your entries. 

Further notes 

If you want to specify that for a particular fund type, the release function should not be active, you can 

deactivate it here. 

For further information see the IMG documentation on release scenarios for documents. 

36.2.4.1.1.2.3.4 Define Release Scenario per Fund 
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Use 

In this IMG activity, you define a release scenario for the FM area, fund and fiscal year. 

Requirements 

You have created a fund or funds in Funds Management master data via the transaction Create Fund. 

You have activated the release functionality for your FM area in the IMG activity Define Release 

Scenario. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. For each FM area and fund, enter a from-fiscal year and a release scenario. 

2. Save your entries. 

36.2.4.1.1.2.3.5 Define Budget Types for Release 

Use 

In this IMG activity you define the budget type to use for carrying out budget releases in your 

organization. 

Requirements 

You must also have defined a release scenario for your organization in the IMG activity Define Release 

Scenario. 

Standard settings 

SAP does not provide any default settings. 

Activities 

1. For your FM area, enter the budget type to be used for budget releases.  You can enter a short, 

medium-length and long text for this combination. 

2. Save your entry. 

Further notes 

Please note that you can define only one budget type for releases for your FM area. 
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36.2.4.1.1.2.3.6 Assign Budget Types for Release to Processes 

Use 

In this IMG activity you determine the budgeting processes to be used in combination with the budget 

type defined for release. 

SAP only supports some processes for the release: Enter, Return, Supplement. You can decide which of 

these are relevant for your organization. 

Note that when  you are doing an automatic release,  a budget transfer will lead to a return (for the sender) 

and a supplement (for the receiver) on the release side. The same rule applies to budget carryovers. 

Requirements 

You have created a budget type to be used for releases in your FM area in IMG activity Define Budget 

Type for Release. 

Standard settings 

SAP does not provide any default settings. 

Activities 

Using the budget type you created for releases, you can now allocate any number of allowed processes to 

this budget type. 

If you need to delete budget types, access  the IMG activity Assign Budget Types to Processes to do so. 

36.2.4.1.1.2.4 Budget Type for Statistical Budget 

36.2.4.1.1.2.4.1 Define Budget Type for Statistical Budget 

Use 

In this IMG activity, you define the budget types you want to use for statistical purposes in your 

organization. 

See the IMG actvity on budget types for further information. 

Standard settings 

As an example, SAP delivers budget type FINR for FM area 0001. 

Activities 
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1. For your FM area, enter the budget type to be used for statistical purposes.  You can enter a short, 

medium and long text for this combination. 

2. Save your entry. 

Example 

You can use statistical budget types to store the financial result of a fiscal year for your organization. 

36.2.4.1.1.2.4.2 Define Budget Type Group for Statistical Budget 

Use 

In this IMG activity, you can bundle different statistical budget types in a budget type group. Statistical 

budget type groups enable you to define multiple statistical budget types to be used for statistical 

purposes. 

Requirements 

You must have defined several budget types in the IMG activity Define Budget Type for Statistical 

Budget. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Create a budget type group to be used for statistics. 

2. Put the cursor on the budget type group you have defined and click Assign Budget Type Group. 

3. Using the New Entries function, you now enter the budget types to be grouped. 

4. Save your entries. 

36.2.4.1.1.2.4.3 Assign Statistical Budget for Budgeting Process 

Use 

In this IMG activity you determine the budgeting processes to be used in combination with the statistical 

budget type you define. 

SAP only supports some of the existing budgeting processes to be used for statistical purposes: Enter, 

Return, Supplement. You can decide which of these are relevant for your organization. 
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Requirements 

You have created a statistical budget type in your FM area in IMG activity Define Statistical 

Budget Types 

Standard settings 

As an example, SAP delivers budget type FINR in combination with process ENTR for FM area 0001. 

You can adjust it to your requirements, for example, by assigning another activity. 

Activities 

Using the statistical budget type you created, you can now allocate any number of allowed processes to 

this budget type. 

Example 

You can use the combination of statistical budget type and budgeting process ENTR, in order to store the 

financial result for your organization. 

36.2.4.1.1.2.4.4 Assign Statistical Budget Type Group to Budgeting Processes 

Use 

In this IMG activity you determine the budgeting processes to be used in combination with the statistical 

budget type groups you define. 

SAP only supports some of the existing budgeting processes to be used for statistical purposes: Enter, 

Return, Supplement. You can decide which of these are relevant for your organization. 

All statistical budget types in the statistical budget type group will then use the combination settings 

defined here. 

Requirements 

You must create several statistical budget type groups in your FM area in IMG activity Define Budget 

Type Group for Statistical Budget Group. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Choose New Entries and assign statistical budget type groups to the relevant activities for your FM 

area. 

2. Save your entries. 

Example 
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36.2.4.1.1.2.5 Edit Versions 

Use 

In this IMG activity, you stipulate the versions you want to use for budgeting in your FM area. 

When managing different budget data, you can work with several operational versions at the same time 

when using the budget control system in Funds Management. 

Note: 

When performing this IMG activity, you use version management functions from the 

Controlling component. If you are already using the CO component in your organization, the CO 

versions already created will be displayed. You can, of course, also use an existing CO version when 

budgeting Funds Management. To do this, this CO version must meet the criteria defined under 

REQUIREMENTS. 

We strongly  advise that you do not change the attributes of existing CO versions to make them meet the 

requirements for budgeting (for example, by setting the Plan indicator for a version that is used in CO). 

Only use the General Version Definition section for editing versions in the dialog structure. All other 

sections in this IMG activity are special settings for Controlling and not relevant for budgeting in Funds 

Management. 

Frozen Version 

If you want to freeze the current budget data using program Freeze Budget Data, you must first create the 

frozen versions intended for this in this activity. 

For a frozen version, you must set the Plan indicator and have chosen the setting Budget Control 

System (BCS): Frozen Version in the Exclusive Use  field. The short text name of the version should 

be chosen in such a way that the timing of this budget data mapping can be recognized. The program run 

does not provide such a time memo. 

Requirements 

Versions you want to use for budgeting must have the following attributes: 

- Plan indicator is set 

- Value 0 is entered in the Exclusive Use field (the version is not used for any special applications) 

Standard settings 

As an example, SAP delivers status STAT02 which reflects Budget Preparation and Original Entry. You 

can change it to suit your requirements. 

Further notes 

For more information on version management in Controlling, see the Controlling IMG under Maintain 

Versions. 
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36.2.4.1.2 Budget Entry 

36.2.4.1.2.1 Planning 

In this section you define the planning settings for the Budget Control System (BCS). 

To do this, carry out the following IMG activities: 

- Define planning layouts 

- Define planner profiles and then assign the planning layouts to them. 

- Define the corresponding authorization groups and generate authorization profiles (roles) for them. 

36.2.4.1.2.1.1 Define Planning Layout 

Use 

Budget values that are posted in the planning transaction must be written in the database format. 

Postings created as expenditure budget to FM account assignments with the item category 3 

(expenditures) in planning must be written to the database with a minus sign before them. If you do not 

want this to be taken into consideration during plan data entry, you can use a formula definition for the 

plus/minus sign change in the planning layout. The procedure for using such a formula definition is 

described below. 

For posting as revenue budget to FM account assignments with the item category 2 (revenues), you do not 

need a specific layout, as these postings are stored in the database with a plus sign. 

36.2.4.1.2.1.2 Define Planner Profile 

Use 

In this IMG activity, you define planner profiles with which you can control planning. In a planner 

profile, you define which plan tasks are used with which default parameters for each table. You can 

define any number of plan tasks for each table. Using the profile item, which defines the sequence of the 

plan tasks for a table, you can assign the same plan task to a planner profile several times, but with 

different default parameters. 

The processing of planner profiles is structured in hierarchies in the following partial activities: 

General planner profile 

Planning tables (Only table FMBDT is available for BCS) 

Plan tasks for the table 
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Default parameters 

You have the following options when defining a planner profile: 

Navigation 

You can navigate in the hierarchy by selecting an entry in the list area and selecting the next hierarchy 

level under it by double clicking on it. You can go to the next highest hierarchy level using Back. 

General planning profile 

- You can assign an authorization group to each planner profile. 

You can assign authorizations for entering plan data using the combination of authorization groups 

and default parameters that cannot be overwritten. 

- Choose New Entries, to create a new planner profile. 

- To copy a planner profile, select any existing planner profile and choose Copy as..... 

Planning table 

- You can only assign the totals table FMBDT to each planner profile. This is used as the basis for 

your planning. 

- You can define distribution keys as default values for currency and quantity fields. 

Plan tasks for table 

- You can assign plan tasks to table FMBDT. To assign a new plan task, choose New Entries. Enter 

an item and a planning layout that is already defined. 

- You determine the order in which the plan tasks are offered using the item. 

- The indicator Default Parameters specifies whether a default parameter has been entered for your 

plan task. 

- You can activate the following functions: 

- Can be Overwritten specifies whether your default values can be overwritten when planning is 

carried out. If the indicator is activated, the preassignments apply as default values that can be 

overwritten. If the indicator is deactivated, the preassignments cannot be overwritten. 

- You specify whether it is possible to enter plan data via Excel with Excel-Integration. 

If you activate Excel-Integration, enter a file name in the field File Description. If you do not 

enter a name, the system automatically assigns one. 

Default parameters 

- You can assign default parameters for each plan task. Enter the value that you want. 

- The values entered appear as an initial screen during the execution of the planning. Plan data must 

exist for the layout of the Excel worksheet. 

Requirements 

You have already defined the planning layouts of the totals table FMBDT for the budget control system. 

Standard settings 
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SAP delivers the planner profile SAPFIFM with some sample layouts. 

Activities 

1. Create your planner profile again or use the SAP sample layouts as templates. The functions 

described above are available for this. 

2. Save your planner profile. 

Notes on Transport 

Planner profile maintenance is connected to the automatic recording of transport data. 

This also includes the settings for integrated Excel. The system includes file descriptions and Excel sheet 

templates in the transport request, provided you have created them in Customizing. 

The system also transports the settings for integrated Excel if you have manually included a planner 

profile in - or manually deleted a planner profile from - a transport request (you do both by choosing 

Table View -> Transport). 

Warning 

- When performing the transport, ensure that you have not manually created any integrated Excel 

settings in the target system. 

Only supply the target system by means of transports, otherwise inconsistencies could arise. When 

importing the Excel sheet templates from the source system, the system does not overwrite the 

settings already made in the target system. 

- If, however, planner profiles with corresponding Excel sheet templates already exist in the target 

system, you have to delete them before performing any imports. In planner profile maintenance, you 

can delete these Excel sheet templates for specific planner profiles or profile items. 

Further notes 

You can find more information in the SAP Library under Planning in the Budget Control System. 

36.2.4.1.2.1.3 Define Authorization Group 

Use 

In this IMG activity you define your authorization groups, with which you manage the authorizations for 

your planner profiles. 

The authorization management for planner profiles is carried out by using authorization object 

K_TKA50. You can define authorization groups for your planner profiles for this authorization object. 

To do this, choose New Entries. 

You must make the following assignments so that your authorization groups take effect: 

1. In step Define Planner Profile  you assign an authorization group to each planner profile. 

2. Assign the individual users to a user group. By doing so, you define which planner profile the user 

works with. To do this, choose the IMG activity Manage Authorizations in the Customizing of the 

budget control system. 
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Activities 

Define your authorization groups and save your entries. 

36.2.4.1.2.1.4 Manage Authorizations 

In this step, you can create roles and use the profile generator to generate authorization profiles. 

Activities 

To assign an authorization profile to a user, do the following: 

1. Create a role 

2. Enter a description 

3. Select transactions 

4. Create and edit authorizations 

5. Assigns users and compare the user master (in doing so, the profile is entered in the user's master 

record) 

6. Transport roles, if desired 

Detailed documentation 

For more information about the procedures, see transaction documentation 

See also the general documentation on the Profile Generator in the SAP Library. Choose: 

Basis Components -> Computing Center Management System -> Users and Roles or in the 

Implementation Guide (IMG), choose: Basis Components -> System Administration -> Users and 

Authorizations -> Maintain Authorizations and Profiles using Profile Generator. 

Note 

You can also use authorization profiles you created manually or were delivered by SAP, in roles. You can 

create a role without a menu and include the corresponding profile in the authorization data of the role. 

In the fourth step, choose "Edit -> Add authorization -> From profile" to add the authorization profile 

data to the role. 

Further notes 

Authorization objects 

The following lists shows the authorization objects that are checked by the individual functions of the 

Special Purpose Ledger. You can find these authorizations in the objects "Financial 

Accounting" and "Cross-Application Authorization Objects." 

Functions for... Authorization object 

Central administrative objects G_ADMI_CUS 
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Database G_GLTP 

Ledger G_881_GRLD 

Global company G_880_GRMP 

Activity G_022_GACT 

Field grouping code G_888_GFGC 

Planning parameters G_820_GPL 

Distribution key G_821S_GSP 

Rollup G_806H_GRJ 

Allocation G_ALLOCTN 

Report Writer G_800_GRP Report 

              G_803J_GJB Report group 

              G_801K_GLB Library 

              G_801H_GCL Parallel report 

              G_801U_GSY Standard layout 

              G_REPO_GLO Reporting (global) 

              G_REPO_LOC Reporting (local) 

Sets G_800S_GSE Set 

     G_802G_GSV Variable 

Validation G_GB93_  

Substitution G_GB92_  

 Boolean logical rules G_GB90_  

Profile 

The individual profiles of the Special Purpose Ledger are combined in the composite profile G_ALL. The 

following is a list of the individual profiles: 

- G_BASE_ALL 

All authorizations for the base functions (system settings, rollup, allocation, database) in FI-SL 

- G_PLAN_ALL 

All authorizations for maintaining and displaying planning parameters and distribution keys 

- G_REPO_ALL 

All authorizations for displaying summary records and line items in FI-SL reporting 

- G_RULES_ALL 

All authorizations for maintaining and displaying rules 
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- G_RW_ALL 

All authorizations for working with the Report Writer 

- G_SETS_ALL 

All authorizations for maintaining and displaying sets and variables 

- G_SUBST_ALL 

All authorizations for maintaining and displaying substitutions 

- G_VALID_ALL 

All authorizations for maintaining and displaying validations 

36.2.4.1.2.1.5 Technical Help 

36.2.4.1.2.1.5.1 Import Planning Layouts 

Use 

In this IMG activity, you can import planning layouts from a source client to your client. 

Activities 

To import a planning layout: 

1. Enter the source client from which you want to import a planning layout. Select Execute. 

2. Select the planning layout you want. 

3. Select Execute or Execute in Background Processing. 

The planning layout is imported. 

36.2.4.1.2.1.5.2 Transport Planning Layouts 

Use 

In this IMG activity you can transport planning layouts. For example, you can transport your planning 

layout from a test client to a production client. 
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Activities 

To transport a planning layout: 

1. Select the planning layout you want to transport. 

2. Select Execute or Execute in Background Processing. The 

planning layouts are transported. 

36.2.4.1.2.1.5.3 Delete Generated Planning Programs 

In this activity, you delete previously generated planning reports. 

During planning, a report with the abbrevation RK5* is generated. If you want to change the Customizing 

of a Special Purpose Ledger table, all generated planning reports are automatically deleted. You should 

complete this activity if you have syntax errors in a generated planning report. 

Activities 

Confirm the prompt, do you really want to delete the generated reports, by selecting Yes. Your planning 

reports are deleted. 

36.2.4.1.2.2 Plan Data Transfer to BCS 36.2.4.1.2.2.1 Define Field Assignments 

for Plan Data Transfer from SAP BW 

Use 

In this operation, you determine which fields in a SAP BW query are transferred to which fields in Funds 

Management when transferring plan data from the BW system. You can also set up a field assignment for 

all queries in the BW system. This reduces the maintenance load when the assignment is the same for all 

queries in the BW system. If a field assignment has been made at both system and query level, the more 

detailed assignment is made at query level. Note that key figures must always be assigned at query level. 

The following account assignment derivation options are available in the SAP system to implement 

additional functions, for example, to map customer fields to SAP fields or to postprocess query data. 
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- Commitment/Actual Derivation 

You determine commitment/actual derivation in Customizing for Funds Management 

Government, in the Customizing activity "Defining Account Assignment Derivation". 

Caution: The derivation strategy you set here is for account assignment in Funds Management for 

commitment/actual update. You are not allowed to change the derivation strategy for the plan data 

transfer. 

You can change this derivation type where, in the derivation strategy, the Funds Management 

account assignments are obtained from CO account assignments, and when you have performed 

planning for CO objects (cost centers, orders and projects). 

- Budget Planning Derivation 

You set budget planning derivation in the budget menu in the Funds Management Government. 

You can define several derivation strategies using this type of derivation. 

You can decide which derivation strategy to use when performing the plan data transfer. 

This derivation type can be used when you want to test different derivation scenarios. You 

must use this derivation if you have to change the derivation of commitment/actual values. If you 

want to use your own fields, add these in the CI_SBPBWRET include. 

When using the commitment/actual derivation, you also need to add the fields, under the same name, to 

the CI_FMDERIVE include in the FMDERIVE database structure. 

For more information about the fields that need to be filled in Funds Management and about valid fixed 

values, see the documentation for the "Creating a Budget Entry Document" function module. 

Requirements 

- The query must be RFC-enabled; The Release for OLE DB for OLAP indicator must be set. 

- The query must not contain more than one structure. 

Activities 

1. From the available RFC systems, select the BW system from which the data is to be transferred. 

Note that a dialog user must be used for the RFC connection. 

Note 

If you are using several BW systems, you must make these Customizing settings for each BW 

system with an RFC connection. If you are for example using one system for the implementation, 

one for quality control and one for operational purposes, you must make these settings three times. 

2. Select a query from which the data is to be transferred. 

3. On the detail screen, you can assign the BW objects to the fields in Funds Management. BW objects 

include: 

- All query InfoObjects 

- Formulas defined in the query 

- All InfoObject attributes 

- InfoObjects that define a restriction to a key figure. 

The prerequisite is that the restriction contains a single value. 
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Not included are filter values defined in the query. These values cannot be assigned. 

All fields in the structure SBPBWRET and, if applicable, the customer-defined fields in the include 

CI_SBPBWRET_BCS are available in Funds Management. 

4. If a value cannot or is not to be transferred from the BW system, you can specify a fixed value for 

the FM field. This may apply to the FM area field if this field does not exist in the query and cannot 

be obtained using a derivation. 

5. When selecting the option of setting up a field assignment for the entire BW system, all BW system 

InfoObjects are made available as are all fields for the SBPBWRET_BCS structure. An assignment 

in this case is overridden by the assignment of the corresponding Info Objects at query level. 

Note 

Note that all the data required for posting in FM must be specified by a fixed value or a BW object. 

Further notes 

Fixed values for the modeling of a budget category in BW and in the ERP system 

 Budget Cat.in the BW (0FM_BUCAT) Budget Cat. in the ERP system (BUDCAT) 

 0 Payment Budget 9F Payment Budget 

 1 Commitment Budget 9G Commitment Budget 

36.2.4.1.2.2.2 Define Budgeting Data for Transfer from Position Budgeting and 

Control 

Use 

In this IMG activity, you define how the budget data that was created using budget creation of 

Personnel Budget Planning (based on Personnel Cost Planning) should be stored in Funds 

Management. The subtypes of the infotype financing status that you created in Position Budgeting 

Control are available for storing this budget data. You can also link these subtypes with different budget 

versions and use different planning scenarios of Personnel Cost Planning for creating budget versions in 

Funds Management. 

Requirements 

If you want to create budget in Funds Management, you must have installed at least SAP ECC 

5.0, Human Resources Extension (EA-HR 500) Public Services (EA-PS 500) with the component Budget 

Control System. These two components either have to run in one system or be connected by ALE. 

In addition, you must have edited the following IMG activities in Customizing of Position 

Budgeting and Control: 

- Define Subtypes for Budget Creation 

- Determine Period for Budget Creation 
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- Define Run Variant for Budget Creation 

36.2.4.1.2.2.3 Customer-Specific Field Assignment for Position Budgeting and 

Control 

Use 

In Position Budgeting and Control in SAP BW, you must assign characteristics in BW to account 

assignment elements in Public Sector Management. This is necessary when the derivation of the funds 

center should be carried out from the cost center. 

Remote Function Call from the BW system. 

If you use customer-specific fields in Position Budgeting and Control, you must define the assignment to 

objects in the structure COBL. 

Standard settings 

The assignments necessary for Position Budgeting and Control are delivered in the standard and do not 

exist in this table. 

Activities 

Maintain the assignment for any additional fields or fields used differently. 

Example 

In the standard settings, company code 0CO_AREA is assigned from BW to field BUKRS of structure 

COBL. If you use, for example,  customer-specific characteristic ZCO_AREA instead of 0CO_AREA in 

your planning application, maintain the assignment ZC0_AREA to field BUKRS. 

36.2.4.1.2.3 Budget Entry Documents 

In this section, you define the necessary settings for budget entry documents for the Budget Control 

System (BCS). 

Entry documents log the generation of budget data. 

36.2.4.1.2.3.1 Document Definition 

36.2.4.1.2.3.1.1 Define Document Types 

Use 
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In this IMG activity, you define the document types you want to use for budget postings in Funds 

Management. 

You can use different document types to classify your budget entry documents. By using different 

document types, you can classify budget entry documents according to your user-specific criteria, by 

assigning meaningful names to the individual document types used within your organization. 

Workflow 

Using the entry document type, you also control whether the budget posted provisionally in a budget 

entry document is to be used in a workflow-controlled approval procedure or not. If you want to use a 

workflow for provisionally posted budget, set the Workflow indicator for this document type in this IMG 

activity. 

For more information on activating the workflow in BCS, see Role Definition: Preposted Budget in 

Budget Control System. 

Using the document type, you also control the scenario to be supported within an entry document. You 

can choose between the following scenarios: 

- Budget only - only budgeted amounts are contained in the entry document 

- Release only - only released amounts are contained in the entry document 

- Budget with automatic release - you can restrict the entry document to specific budgeting processes: 

enter, return, supplement, transfer. In the specific case of  a transfer process (send / receive), the 

following applies: 

- If the sender side is chosen, only released budget can be transferred. Budget will be updated on the 

receiver side. 

- If the receiver side is chosen, only unreleased budget can be transferred. Budget will be released on 

the receiver side. 

- Statistical only - only statistical values are contained in the entry document. 

Requirements 

You must assign each entry document type that you define here to a number range. It is also possible to 

assign the same number range for different document types. To do this, you must first create a number 

range and a number range interval for budget entry documents. 

Standard settings 

SAP does not provide any predefined settings. 

Activities 

1. Choose New Entries and define the document types and their number range assignments. 

2. Save your entries. 

36.2.4.1.2.3.1.2 Maintain Number Range Interval for Entry Documents 
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In this IMG activity, you define the number range interval for budget entry documents of an FM area for 

each fiscal year for the industry-specific component Funds Management. 

When you post budget values directly or temporarily in the budgeting workbench, the system generates 

automatically numbered entry documents according to the number range interval you define here. 

Requirements 

Only internal number allocations are permitted. You must not set the Ext (external number allocation) 

indicator. 

Activities 

1. Define a Number range and number range interval for an FM area for each fiscal year. 

2. Save your entry. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.4.1.2.3.1.3 Maintain Number Range Interval for Budget Change Documents 

Use 

In this IMG activity, you define the number range interval of budget change documents in an FM area for 

each fiscal year in the component Funds Management. 

Change documents are always generated, when changes are made to the totals records for existing budget 

values. Change documents provide a complete history of the changes made to budget values. 

Requirements 

- Use Number range  01 for Funds Management budget change documents. Enter 01 

and not 1 as the number range. 

- Only internal number allocations are valid. You must not set the Ext (external number 

allocation) indicator. 

Activities 

1. Define number range 01 and the number interval for an FM area for each fiscal year. 
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2. Save your entry. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.4.1.2.3.1.4 Define Number Range Interval for Document Family 

Use 

In this IMG activity, you define the number range interval to assign document family numbers. Several 

budget entry documents are grouped together under one document family which were created at the same 

time in a mass activity. 

For example, for mass activities whereby a document family number is automatically assigned to an entry 

document: 

- With the fiscal year change, all residual budgets carried forward to the following year get the same 

document family number. 

- Grants Management (GM): When generating a GM document, the budget entry documents 

generated in the BCS are grouped together under the same document family number. 

- When generating entry documents with BAPI_0050_CREATE, you can define which documents 

can be assigned to the same document family. 

The document family number references all the budget entry documents generated at the same time in a 

mass run and makes drilldown reporting and further processing easier (such as a mass reversal with the 

program Reverse documents). In this way, an entry document also gets a document family number as 

well as the individual budget entry-document number. The respective document family is displayed in the 

budgeting workbench in the header data of a budget entry document. For entry documents without a 

family document, the Document Family field in the budgeting workbench is hidden. 

Customer enhancement 

By using Business Add-In FMKU_BUDGET_EVNT, you can use the document family for your 

customer enhancement. 

Requirements 

- If you use the  Number range  0 1 for the budget change documents of Funds Management. 

Enter 01 for the number range and not 1. 
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- Only internal number assignment is allowed. You are not allowed to set the Ext  indicator (external 

number assignment). 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Define number range 01 and the number range interval for an FM area and for each fiscal year. 

2. Save your entries. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.4.1.2.3.1.5 Define Layout for Budgeting Workbench 

Use 

In the budgeting workbench, you can define whether a specific input field appears in the header area of 

the budgeting workbench or in the BWB table area of the screen. The table area contains the document 

lines of a budget entry document. Whether an input field is placed in the header area or as a column of the 

table affects how the user makes entries: 

Input Field in Header 

If you define an input field for the header, the value entered is valid for all rows of the table. If you are 

making a budget transfer, entry fields will be shown for both the sender and the receiver. 

If you are sure that certain document fields of the sender are always the same as the receiver, you can 

choose the option Header: same for sender and receiver for these fields. In this case, the receiver can 

be copied from the sender automatically. 

Input Field in Table Area 

If you define an input value as a column in the table area, these input values can be entered in lines and 

are therefore different. 

The following fields are available for defining the layout: 
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- Funds center 

- Commitment item and, if desired, with the item category 

If you chose the commitment item for the table area, you can display the item category as an extra 

column. 

- Budget Type 

- Year of Cash Effectivity 

The following additional fields are available if you have activated the respective FM account assignment 

elements for Funds Management (FM): 

- Fund 

- Functional area 

- Grant 

- Funded program 

When defining a layout variant, you can choose between the two fixed values header or column. You 

can also define the fixed value no display for the FM account assignment elements that can be activated 

(fund, functional area, grant, funded program). 

You can define the sequence for column data in which the data in the table area of the budgeting 

workbench should be displayed. 

Display/Hide Automatically Generated Lines 

In the layout you can determine the standard value that determines whether automatically generated line 

items are displayed or not in the Budgeting Workbench. 

To display or hide the automatically generated line items in the Budgeting Workbench, choose Hide 

Automatic Lines or Display Automatic Lines. 

Distribution key 

When you enter a distribution key, you define the default value that is set as standard in the budgeting 

workbench when new budget documents are created. You can change the default value in the budgeting 

workbench. 

Note: 

The distribution keys 3, 4, 5 and 6 cannot be used for automatic document creation. SAP recommends 

that you use the keys 1, 2 or 7 as default values. You can also use your own distribution keys. 

Layout selection 

You can find the layout variants in the budgeting workbench under Extras -> Change Layout. The 

layout variant used is saved in the user data when you leave the budgeting workbench. 

If you have selected a layout variant in the budgeting workbench that does not match your organization's 

requirements, the system adjusts the BWB entry screen automatically. 

Example 

The account assignment element Fund is selected in the layout variant as an input field even 

though the fund is not activated in your organization. In this instance, the input field Fund 

remains automatically hidden in the BWB. 
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Layout with the SAP List Viewer 

The SAP List Viewer (ALV) is the standard tool for displaying and formatting lists in the SAP system. 

You can use this layout to display your BWB data by clicking on Document -> Preview. 

Standard settings 

SAP provides the following predefined layout variants: 

SAP001 SAP BWB Minimum Standard 

Header: Budget Type 

Column: Funds Center, Commitment Item 

No display: 

Program 

Fund, Functional Area, Grant, Funded 

SAP002 SAP BWB Minimum Standard - Flexible 

Header: - 

Column: 

Type 

Funds Center, Commitment Item, Budget 

No display: 

Program 

Fund, Functional Area, Grant, Funded 

SAP003 SAP BWB Minimum - Operative 

Header: Fund, Budget Type 

Column: Funds Center, Commitment Item 

No display: Functional Area, Grant, Funded Program 

SAP004 SAP BWB Standard - Operative 

Header: Budget Type 

Column: Funds Center, Commitment Item, Fund, 

Functional Area, Funded Program 

No display: Grant 

SAP005 SAP BWB Decentral 

Header: 

Program 

Funds Center, Budget Type, Grant, Funded 

Column: Commitment Item, Fund, Functional Area 

No display: - 

SAP007 SAP BWB with two budget categories 

Budget Category Payment budget and commitment budget 

Header: 

Period 

Budget Type, Grant, Fund, Budget Period, 

Column: Year of Cash Effectivity, Funds Center, 

Commitment Item, Functional Area, Funded Program  

 No display: - 
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The following is also preset for all layout variants: 

- Distribution key 1 (even distribution) 

- Commitment Item Category is not displayed 

Activities 

If you want to use a layout variant different from those delivered by SAP, define your own layout variant. 

You can use a layout variant delivered by SAP as a template by selecting one and saving it with a user-

defined description via Copy as.... 

36.2.4.1.2.3.1.6 Define Layout for Multiple Budget Entry 

Use 

In this IMG activity, you can define one or several layouts for the multiple budget entry transaction 

FMPEP. This transaction enables you to maintain budget for several budget categories on one screen, as 

well as select between different types of database update (additive/non-additive modes) for budgeting. 

Standard settings 

The following standard layouts beginning with SAP* are predelivered: 

- SAP001 Posted Payment Budget 

- SAP002  Payment and Commitment Budgets 

This layout can be used to enter the payment budget for the current fiscal year and the commitment 

budget for the four following years of cash effectivity. 

- SAP005 Payment Budget Preposted 

This layout can be used to create preposted entry documents. The documents can be posted in the 

Budgeting Workbench. 

- SAP006 RECHNUNGSERG 

This layout  can be used in the context of the financial result scenario. See Release Note Financial 

Result for further information. 

Activities 

You can define as many layouts as you want: 

1. In order to define a new layout, click on New Entries and enter a name starting with Y or Z. 

2. Select the line you created and click on Header. 

3. Assign values to the parameters belonging to the header section of transaction FMPEP. 
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4. Save the header data. 

5. Next, double click on Tabstrips to define one or several tabstrips, and activate them. At present, 

only one tabstrip can be used. The tabstrips allow you to group individual columns into different 

categories. If you do not want to split your set of columns, create only one tabstrip. 

6. Save the tabstrip data. 

7. Then define the contents of individual columns for each created tabstrip: select the desired tabstrip 

and double-click on Entry Columns or Display Columns. Entry columns are columns for which a 

parameter has to be entered by the user, while display columns are columns used to display the value 

of a predefined key figure, for example. Display columns are greyed out in Tr. FMPEP. 

8. Create as many entry columns and display columns as you want. Note that you must number your 

columns sequentially, that is, you cannot use "1" as the column header more than once. You must 

start numbering with the number '"01" and create numbers sequentially without any gap. 

9. By scrolling to the right, you can enter up to four predefined text variables, containing, for example, 

the budget categories and/or fiscal years that you will be using (available for Entry Columns only) 

10. Save your entries individually for the entry columns and for the display columns. 

11. Repeat the last three operations for each tabstrip you have created. 

Consistency checks on columns 

Some checks are performed on the entry and display columns each time you save your data. 

These checks are intended to prevent you from creating inconsistent columns, such as duplicate columns. 

When creating your columns, follow these rules: 

- Do not create exact duplicate columns (columns whose values in all fields are identical) 

- When using the # metavalue in a field (user input required) of an entry column, be careful not to 

define another column with a standard value in the same field and with all other fields identical.  See 

the example below. 

If you do not observe these rules, you will receive error or warning messages. 

Example 

Example of redundant columns which trigger a warning message: 

 Column Budget Category Fiscal Year YCE Value Type Budget Type 

1 Payment # 2006 Budget BT01 

2 Payment 2005 2006 Budget BT01 

3 Payment 2006 2006 # #  

All three columns are potentially redundant, because an inappropriate entry in place of the # metavalue 

can lead to duplicate columns. 
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36.2.4.1.2.3.1.7 Define Mask for Easy Multiple Budget Entry 

Use 

In this Customizing activity, you define a mask for the Easy Multiple Budget Entry (FMPEPE) 

transaction. You use this mask to hide some of the options on the FMPEPE transaction screen when using 

the transaction. 

Note: 

The mask you define in this activity needs to be consistent with the session variant that you will define 

later in the Create Template for Easy Multiple Budget Entry (FMPEP_ADMIN) transaction. 

Standard settings 

The following standard masks beginning with SAP* are predelivered: 

- SAP01 - Enter only budget amounts 

- SAP02 - Add/delete commitment items 

Activities 

You can define as many masks as you want. 

To define a new mask, proceed as follows: 

1. Click on New Entries and enter a name for the mask in the the Mask ID field. 

2. Select the checkbox of the options you want to hide. 

3. Enter a description for the mask in the Descritpion field. 

4. Save your entries. 

36.2.4.1.2.3.1.8 Assignment of Forms for Printing Budget Documents 

Use 

In this IMG activity, you define the forms to be used when you print budget entry documents in the 

budgeting workbench (transaction FMBB) or in the entry document display transaction (FMEDD). 

This form is defined for a specific document type and process. 

Requirements 

If you want to define your own forms,  enter the name of the form that you have previously created in 

transaction Form Builder with the SAP form interface "FM_ENTRY_DOCUMENT". If you do not 

define your form with this interface, you cannot print any budget entry documents. 
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Activities 

1. Select a form for your document type and process. As a template, SAP proposes the delivered form 

interface "FM_ENTRY_DOCUMENT". 

2. Save your entry. 

36.2.4.1.2.3.2 Field Control for Budget Entry Documents 

36.2.4.1.2.3.2.1 Field Status 

36.2.4.1.2.3.2.1.1 Define Field Status Variant 

Use 

In this step, you can create and delete field status variants for Budget Control System (BCS). A field 

status variant enables you to control whether the fields your users see when they create budget entry 

documents are hidden, displayed, optional, or mandatory. 

You assign a field status variant to each FM area. You can enter a field status variant for as many FM 

areas as you want. 

By assigning a field status variant and field status group to a field status definition, you can control the 

document entry parameters for the various business transactions differently for each of your FM areas. 

Standard settings 

We do not deliver any standard settings. 

Activities 

In order to work with field status variants, proceed as follows. 

1. Use the New entries option to create a field status variant. 

2. Save your entries. 

Further notes 

If there are any field status variants you do not need any more, you can delete them by choosing Edit-> 

Delete 

36.2.4.1.2.3.2.1.2 Assign Field Status Variant 

Use 
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In this step, you assign a field status variant to your FM areas. You can assign a different field status 

variant to each FM area. However, please note that you can only assign one field status variant per FM 

area. 

 Requirements 

You have defined one or more field status variants in the previous IMG activity. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Using the field status variants you defined in the previous activity, you now assign this variant or these 

variants to your FM area(s). 

36.2.4.1.2.3.2.1.3 Define Field Status Group 

Use 

In this step, you define field status groups. Together with the field status variant, the field status group is 

used for the field status definition. You carry out this assignment in the subsequent IMG activity. 

Requirements 

You have already defined a field status variant and assigned it to your FM area in the previous IMG 

activities. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. Choose Edit -> New entries to create new field status groups. There is a copy function available. 

To use it, select an entry in the standard list and choose Edit -> Copy as. 

2. Save your entries. 

36.2.4.1.2.3.2.1.4 Assign Field Status Group 
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Use 

In this step, you assign a field status group to a document type and process. You can assign a field status 

group to as many document types/processes as necessary. 

The document types and the processes, which are optional entries, subdivide the business transactions in 

budgeting. 

You can define separate field status groups for the various budgeting transactions and control 

the document entry by defining the assignment to document type and process accordingly. 

If you do not specify the process for your assignment, the field status group will be valid for all budgeting 

processes. 

Requirements 

You have already defined a field status group in the previous IMG activity. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. Allocate your field status group or groups to a document type and budgeting process. You can create 

several entries. 

2. Save your entries. 

36.2.4.1.2.3.2.1.5 Maintain Field Status Definition 

Use 

In this step, you create field status definitions. For this, you specify which fields are: 

- hidden 

- for display only 

- optional, or - mandatory. 

Requirements 

You have already defined field status variants and field status groups in the previous IMG activities. 

Standard settings 

SAP does not deliver any standard settings. 
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Activities 

1. Create a new field status definition. 

2. Save your entry. 

3. Put your cursor on the new entry and open the view which enables you to select whether fields are 

hidden, etc. and select or deselect the assignments. 

4. Save your entry. 

36.2.4.1.2.3.2.1.6 Assign Field Status Definition 

Use 

In this step, you assign a field status variant and field status group to a field selection definition you want 

to use. 

By assigning a field status variant and field status group to a field status definition, you can control the 

document entry parameters for the various business transactions differently for each of your FM areas. 

Requirements 

You must have maintained field status variants and field status groups, as well as created a field status 

definition, in the previous IMG activities. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. Assign the field status variants and the field status groups you created in the previous activity to the 

field status definitions you have created. 

2. Save your entries. 

36.2.4.1.2.3.2.2 Changeable Fields in Budget Docs 

36.2.4.1.2.3.2.2.1 Define Profile of Changeable Fields in Budget Docs 

Use 



 

WHATSAPP +255738656506 

 

Use this step to define a profile of changeable fields for your preposted and posted budget documents. 

Standard settings 

SAP delivers default settings for each profile. The default settings are that the text fields in the header and 

line of the document can be changed in preposted or posted budget documents. 

Activities 

1. In the first maintenance view, choose New Entries and enter a definition and description for your 

profile of changeable fields. 

2. Save the new profile, then select it and choose Edit Profile for Preposted Documents or Edit Profile 

for Posted Documents in the Dialog Structure. 

3. Choose the changeable fields to be included in your profile. 

The header text, text and text name are selected to be changeable by default, but you can 

deselect them. 

36.2.4.1.2.3.2.2.2 Assign Profile of Chngble Flds to Doc. Types 

Use 

Use this step to assign your profiles of changeable fields in preposted or posted budget documents. 

Requirements 

You must define the profile first in the IMG activity Define Profile of Changeable Fields in Budget 

Documents 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

In the maintenance view, choose New Entries and enter the FM area(s), document type(s), and profile(s) 

that suit your requirements. 

Note 

If you do not enter any settings here, only the text fields will be changeable in later processing of 

preposted or posted budget documents. 

You can enter "*" as the value for the document type. If you do, all the document types in this FM area 

use this profile except for any document types for which specific entries are made (see example below). 
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Example 

You enter the following settings: 

FM Area   Document Type   Profile 

0001   DT01   PF01 

0001   *   PF02 

The effect of these settings is that document type DT01 in FM area 0001 uses profile PF01. All the other 

document types in FM area 0001 use profile PF02. 

36.2.4.1.2.3.2.2.3 Change Log for Preposted Budget Documents 

36.2.4.1.2.3.2.2.3.1 Activate Change Log for Preposted Budget Documents 

Use 

Use this step to activate the change log relating to preposted budget documents in the Budget 

Control System (BCS). Funds Management (FM) 

Activities 

1. In the maintenance view, choose New Entries. 

2. Enter the FM area(s) whose change log activation status you want to process and choose whichever 

of the following options suits your requirements for each FM area: 

- Change log not active 

- Change history active for document headers only -

 Change history active for document headers and lines 

3. Save your entries. Example 

36.2.4.1.2.3.2.2.3.2 Display Change Log for Preposted Budget Documents 

Use 

Use this step to display the change log relating to preposted budget documents in the Budget Control 

System (BCS). 

Requirements 
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Changes in the preposted documents are only recorded if the change log has been activated, so you may 

encounter cases where only part of the changes have been traced. 

36.2.4.1.2.3.2.2.3.3 Delete Change Log for Preposted Budget Documents 

Use 

Use this step to delete the change log relating to preposted budget documents in the Budget Control 

System (BCS). 

This frees up memory in your system. 

Standard settings 

The deletion cannot be done document by document. It is a mass tool for which you have to enter the 

following: 

- FM area 

- Budget category 

- Date up to which you want to delete the changes. Everything up to and including this date will be 

deleted from the log. 

- You can test the future result of this transaction setting using the "Test Run" option. Then the 

number of records to be deleted is displayed in the detailed list. 

36.2.4.1.2.3.3 Additional Budget Line Items 36.2.4.1.2.3.3.1 Define Derivation 

Strategy for Additional Budget Line Items 

Use 

In this IMG activity, you can generate additional lines in budget entry documents via a derivation 

strategy. The derivation strategy is called for each original line of the entry document. You can choose 

the relevant fields from the document header and original document line as source fields to define the 

derivation steps. When you assign the target fields, you define which fields are displayed in the additional 

document lines of an entry document. The additional document lines are displayed in the budgeting 

workbench (BWB) directly under the respective original document line. The values of an additional 

document line generated cannot be changed manually in the BWB and are also saved in the database 

when an entry document in posted. 
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For example, if you are a US client working with the budgetary ledger, you can display offsetting 

postings of a budget posting in the additional line items of the entry document. 

You define the display of additional line items using a derivation strategy. You define the individual 

derivation steps of the strategy in this IMG. The same steps are  available for this strategy as are available 

for the IMG activity Define Substitution for Entry Documents  namely Clear - Move - Derivation Rule - 

Table Lookup). You activate the strategy for displaying additional line items in another assignment step 

delivered by SAP. 

Note: 

If you want to work with additional document lines, you must activate these in your derivation strategy in 

a 'move' step. 

Requirements 

1. In IMG activity Activate Additional Budget Document Lines , you have define in which Original 

Applications you should work with additional document lines. 

2. You activate the derivation strategy for additional line items by setting the activation indicator for 

a target field FLG_ADD_LINE in an assignment step in the strategy. SAP recommends that you 

assign all defined derivation steps to these activating derivation steps. 

Standard settings 

The strategy for additional line items is inactive when delivered. 

When you activate the strategy, it is supported in the budgeting workbench and for the business method 

Create Entry Document . If you want to use this strategy for other applications, you can define this in 

the IMG activity Activate Additional Line Items. 

The standard implementation is delivered by SAP for additional line items. 

Notes 

You can add additional line items either by using only the standard implementation delivered by 

SAP and/or the Business Add In (BAdI) Enhance Budget Line Items (FMKU_BUDGET_LINES). 

Additional line items are supported by the method Create Additional Line Items (ADD_LINES) in the 

BAdI. 

36.2.4.1.2.3.3.2 Activate Additional Budget Line Items 

Use 

In this IMG activity, you define in which applications you want to work with additional line items during 

budget document entry. 

Note that the settings defined here affect all clients. 

Standard settings 
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In the standard system, SAP delivers the applications BAPI-ED (business object: budget entry document) 

and BWB (budgeting workbench) as activated. 

It is recommended that you do not deactivate the areas activated by SAP. 

Activities 

If you want to use additional line items in other applications, activate them by setting the indicator 

Additional Line Items. 

36.2.4.1.2.3.4 Define Editing Options for Budget Amounts 

Use 

In this activity you define the number of decimal places to be used in the budgeting workbench and for 

document display, as well as in key figure evaluation, for your FM area. 

You also define whether the revenues and expenditures have to be entered as positive or negative values 

in the budgeting workbench. 

These editing options are not considered within budget planning (however, similar features can be defined 

separately within the planning transaction). 

Standard settings 

The number of decimals corresponds to the FM area currency you have set in Customizing. Please note 

that expenditures and revenues are both positive. 

Activities 

Enter the number of decimal places, the necessary signs and save your data. 

36.2.4.1.2.3.5 Define Substitution for Entry Documents 

Use 

In this IMG activity, you define settings so that you can work with substitutions when entering budget 

documents. It is then possible to influence the input values in the entry document, for example, if you 

want to work with standard values. Substitution is only supported for document entry in the budgeting 

workbench at the moment. 

The substitution of input values is supported by a derivation strategy. In this activity, you define the 

individual derivation steps. 

Note: 

If you want to use the substitution, you must activate this in the derivation strategy in a 'move' step. 
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A derivation strategy contains sequences of derivation steps in which you can define the influence of 

input values in the system. You define a reference between the input values of source fields and the 

values of target fields that result from it in a derivation step. 

The following derivation step types are supported in this: 

- Clear 

In the 'clear' derivation step type, you can set a target field to Initial. 

- Move 

In the 'move' derivation step type, you can define that the value of a source field or a constant value 

is transferred into the target field. 

- Derivation rule 

In the 'derivation rule' step type, you create a table according to your choice of source and target 

fields. You can then maintain the table entries in which you make more assignments. 

- Table lookup 

In the 'table lookup' step type, you can access individual records from database tables. 

All derivation steps defined here can be linked to conditions which must be fulfilled before they can be 

executed. 

Requirements 

You activate your derivation strategy for substituting input values by setting the activation flag for the 

target field FLG_SUBSTITUTE in a 'move' step. 

SAP recommends that you always activate this step at the end when you are defining derivation steps. 

Standard settings 

Substitution is inactive in the standard system. 

SAP delivers a standard implementation for substitution. 

Example 

You want to define in a derivation step that the fund Fund1 is automatically filled by the system when the 

funds center FC1 is entered in entry documents: 

1. You create a new derivation step Assignment. 

2. On the tab page Definition, choose the option Constant and enter Fund1 as a fixed value. 

3. Select the value FUND as the target field using F4 help. 

4. Select the push button (blue arrow) beside the target field to define the field control in the dialog 

box Substitution of Field Values in Budget Documents: Change Field Attributes. Select the 

option Copy new value even if value is zero or blank. 

5. Switch to the tab page Conditions and select the value FUNDSCTR (funds center) as the source 

field using F4 help. 

6. Define the following condition: funds center = FC1. 
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Notes 

Alternatively, you can carry out the substitution using the Business Add-In (BAdI) Enhance Budget 

Document Lines (FMKU_BUDGET_LINES) in combination with the standard implementation 

delivered by SAP.  The substitution derivation strategy is supported by the method Replace Fields in Line 

Items (SUBSTITUTE_DATA) in the BAdI. 

36.2.4.1.3 Control Budgeting Flow 

36.2.4.1.3.1 Activate Period Control 

Use 

In this IMG activity, you activate period control for budgeting per FM area and budget version. You can 

also specify all versions by entering an asterisk (*) in the corresponding column. 

Note 

If period control is not activated (no entry), all periods are open for budgeting by default. 

You can open and close periods by specifying a period range in the menu of Funds Management -> 

Additional Functions -> Closing Operations -> Open and Close Posting Periods -> Budget 
(BCS) -> Individual Processing (Transaction  FMOPER). 

You can only use Transaction FMOPER to open and close budgeting periods if period control has been 

activated in this IMG activity. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

Activate period control for each FM area and version according to your requirements and save the entries. 

If you want to implement fund-based period control, call up transaction FMOPER and select a budgeting 

period line. Then double-click on the left node Open Budgeting Periods per Fund in order to make the 

corresponding entries. 

36.2.4.1.3.2 Edit Status 

Use 

In this IMG activity, you define which phases the budgeting contains during the course of a fiscal year. 

You define a budget status here for each phase. 
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The budgeting typically runs through a sequence of different phases such as: 

- Budget planning 

- Budget entry 

- Budget consumption 

- Changes to the approved budget 

- Budget block 

Each phase of budgeting is thereby distinguished by the fact that only certain processes should be 

performed. To define these different phases, proceed as follows: 

1. You define a budget status for each phase. 

2. You define which combination of budget category, process, and budget type are allowed for each 

phase. 

3. You define an authorization group for each phase. 

The statuses defined here are available in the menu of Funds Management for defining the individual 

budgeting phases, under  Budgeting -> Budget Control System (BCS) -> Version -> Assign Status to 

Version. 

If you maintain a status for budgeting, you can assign all of the budgeting processes to the relevant budget 

types using the placeholder *. Depending on the budget type or budget type group, it is possible that * 

does not correspond to the same processes. For example, if you use the budget type financial budget, * 

means all statistical processes (in other words, processes such as carryover, revenues increasing the 

budget and cover eligibility) are not supported. 

If the status is assigned to a combination of budget type, process, and budget type group, all the budget 

types in the group will have the same combination for the status. 

Example: 

The budget type group BG01 is defined as follows: 

- It contains the budget types BT01 and BT02 

- It uses a combination of payment budget type and process ENTR 

- It is assigned to status STAT01 

This means that the following two combinations are relevant for STAT01: 

- Payment budget/Process ENTR/Budget type BT01 - Payment budget/Process ENTR/Budget 

type BT02 

Requirements 

You can only select those budget types for a process whose combination was defined beforehand in IMG 

activity Assign Budget Types to Processes. 

You can only select those budget types for the release for a process whose combinations were defined 

beforehand in IMG activity  Assign Budget Type for Release to Processes . 
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You can only select those budget types for a process whose combinations were defined beforehand in 

IMG activity  Assign Statistical Budget for Budgeting Process. 

You can only select those budget type groups for a process whose combinations were defined beforehand 

in IMG activity  Assign Budget Type Groups to Processes (Mass Maintenance) 

You can only select those statistical budget type groups for a process whose combinations have been 

defined in IMG activity Assign Statistical Budget Type Group to Budgeting Processes. 

Standard settings 

As an example, SAP provides status STAT02 for the phases budget planning (process PREP) and entry 

(process ENTR). You can change this status to suit your requirements. 

36.2.4.1.3.3 Define Key Figures 

Use 

You define key figures in this IMG activity. You use these key figures for the following functions in 

BCS: 

- Consistency check of budgeting 

- Activities for the end of the year 

For example, to carry forward your residual budget. 

- As additional information in the budgeting workbench 

You can display up to 5 columns with key figures in the budgeting workbench as additional 

information at the document line level. 

- For reporting purposes with report FMKF_REPORT01 

You execute the report in the Funds Management menu under  Infosystem -> Budget Control 

System (BCS) -> Budget -> Evaluation Using Key Figures. - If you use an individual budget 

type for the consumable budget for each fund or fund type - Execute transfers in a Transfer Budget 

Data. 

Key Figure Category 

When you define a key figure, you define a Category on the tab page specifying for which of the above 

functions a key figure should be used. If the indicator for a category is not set, the key figure in the 

respective function is not displayed in F4 help. 

In this IMG activity, you can restrict the selection of existing key figures according to their category on 

the initial screen. The key figures of all categories are displayed by default. 

Customer Name Space 

Note the specifications for the customer name space when creating your user-specific key figures. The 

key of user-specific key figures must start with YY... or with ZZ.... 
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Defining Key Figures 

The data of particular data sources is read in a key figure. If you select a data source, all the fields for 

defining key figures contained in it are available. If you have selected a number of data sources, they are 

displayed on different tab pages. 

- Key Figure Term 

A key figure combines one or several terms for each selected data source. You define the filtering 

and totaling of the data in the term by defining attributes or fixed values for the data fields. You can 

set a differentiated data aggregation by assigning (plus/minus sign) a number of terms to each other. 

- Meta Values 

When you select attributes that you can define for a data field, the interpretation of meta values is 

supported in addition to the direct entry of original data of the data source. This means that the 

original data can be totaled or modified, or the fields can be set to entrydependent. 

The following meta values are supported for key figures: 

 Attribute  Meta value interpretation 

 # the input value is adopted as a 

value 

 * all existing values for the 

attribute are totaled up 

 -1,-2...+1,+2... the meta value entered is 

added/subtracted for the input value. 

 & Only valid for the fields 

Budget Type and Fiscal Year 

Note 

Depending on the fund in question, some budgets are considered as consumable and others as "not 

available for consumption". This means that when you choose the meta-value &, the key figure will only 

evaluate the amount of all consumable budget types for the fund currently being processed. Other budget 

values which are assigned with non-consumable budget types are not totaled up. 

Please find further information on the budget type under IMG activity Define Budget Type for Consumed 

Amount for Each Fund . 

Depending on the fund in question, some budgets are based on annual values and others on overall values. 

This is defined in the IMG activity for fund types. 

- If the fund you are processing is defined as annual, the input value for the Fiscal Year is adopted as 

a value. In this case,  the meta-value &   is dynamically replaced by # . 

- If the fund you are processing is defined as overall, all existing values for the Fiscal Year are totaled 

up. In this case,  the meta-value &   is dynamically replaced by *. 

Please find more information on the fund type under the IMG activity Create FM Fund Types. 

Standard settings 

SAP delivers a group of key figures that you can use in your FM area. You can also define your own key 

figures and use the key figures delivered by SAP as templates. 
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Note: 

Key figures of the Year End category are subject to certain restrictions. You can only create customer-

defined key figures of the year end category by using the key figures delivered by SAP as a template. 

Furthermore, changes can only be made in the budget data term. It is not possible to make changes in the 

actual data term. 

Example 

You want to display the budget values of the budget category 9F (payment budget) entered in the 

previous year in the budgeting workbench as additional data. As you work with several budget versions, 

define that the budget of the previous year for the version entered is displayed using the attribute "#". 

You define a key figure with the following term: 

Plus/minus sign version category value type activity budget type WF status fiscal year 

 + # 9F B1 ENTR* P -1 

Activities 

1. Select Create. 

2. Define the key of a key figure, the description and the heading. 

The heading is displayed in the budgeting workbench as the column description of this key figure. 

3. Select the pushbutton Select Data Source and select one or more data sources. Hold down the 

CTRL key to select more than one data source. The data fields of the selected data sources are 

displayed in a tab page. 

4. Create a line that is ready for input for a key figure term by selecting the pushbutton Add Line. 

5. Define the key figure term by selecting an entry via F4 for each input field, or define the appropriate 

attribute using meta values. 

6. Repeat steps 4 and 5 if the key figure is made up of several terms. In such a case, define the 

reference of the terms to each other using the plus/minus sign control (field Plus/Minus Sign+/-). 

7. Save your entries. 

Further notes 

When you are on the entry screen, you can transport several key figures between systems by selecting the 

pushbutton Transport of Key Figure and defining the assignment made to a transport request. 

You can find more information in the SAP Library under Budget Control System (BCS). 

36.2.4.1.3.4 Define Distribution Keys 

In this activity, you can define a distribution key. 

Using a distribution key, you can distribute plan totals over individual plan periods. 
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The following options are available for defining distribution keys: 

- You can define a distribution key that references an existing standard distribution key (1, 2, 3, 4, 5, 

6, 7). 

- You can define an independent distribution key without using a reference. 

Standard settings 

The SAP Standard System includes multiple distribution keys. You can copy these standard distribution 

keys and then change them. 

To copy a standard distribution key, position the cursor on the desired distribution key in the tree 

structure, and use the right mouse key to copy it. 

Note 

If you use one of the standard distribution keys as a reference, you cannot change the number of 

periods and the relative factor of the distribution key. 

Activities 

To define a distribution key, proceed as follows: 

1. Position the cursor in the tree on 

- referenced, if you want to reference a standard distribution key 

- Independent, if you want to define a new distribution key 

2. Using the right mouse button, choose Create. 

3. Enter a key up to four characters long and a name for your distribution key. 

4. Enter the posting periods to which the plan values are to be distributed. 

- You can enter the numbers of the posting periods in any order: the system automatically sorts 

the period numbers entered and the numbers assigned to these values in ascending order. You 

can enter any number of periods. 

Example 

If you want to distribute the totals to the first period of each quarter, enter 1, 4, 7 and 10  in 

the posting period column. 

- The relative distribution factor determines the share of the total plan amount that the period in 

question receives. Each period receives a specific share of the plan total based on the following 

formula. 

Example 

(Distribution factor * Total plan amount) / Total of the relative factors If a distribution factor 

of 40 is assigned to period 1, the total of all relative factors for the distribution key is 320, and 

the entire plan amount is 5000, period 1 receives: 

(40 * 5000) / 320 = 625 

5. The following functions are also available: 
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- To suppress the display of all periods with a distribution factor of 0, choose Hide zero values. 

To redisplay these posting periods, choose Display zero values. 

- If you set the distribution factor of a period at a later date to 0, you can recalculate the factors 

of the remaining periods. To do so, choose Calculation. 

- To compare your new distribution key with your original distribution key, choose Compare. 

- To view the change history of a distribution key, choose History. 

6. Save your distribution key. 

36.2.4.1.3.5 Consistency Check 

In this section, you define the settings for the consistency checks of the Budget Control System 

(BCS). The consistency checks are called in the background as soon as you try to save a 

budget entry document and to save it in the database. Consistency checks also take place when planning 

data is entered. This means: if you enter plan data in the BCS with the planning tool. 

In a consistency check, the budget values to be posted are checked against the rules you set. Consistency 

checks are supported for: 

- budget entry documents. In other words, only the budget amounts in an entry document are checked 

- budget addresses and the budget amounts in the entry document are compared (account assignment-

related) with the current budget data in the database. 

In order to set up consistency checks in the BCS, do the following: 

1. Use user-specific key figures in the consistency checks as well as system messages. Both must have 

already been created. 

2. You define check libraries, in which the rules of the respective consistency checks should be 

defined. 

3. You assign the check libraries to the version of an FM area/ fiscal year in which you want to use 

them. 

For more information, see the IMG activity and the SAP library on the Budget Control System (BCS). 

36.2.4.1.3.5.1 Define Check Libraries for Budget Entry Documents 

Use 

In this IMG activity, you define check libraries for budget entry documents. The check libraries for 

budget entry documents contain check rules. The consistency of the budget amounts in documents is 

checked in accordance with these rules. The consistency checks are always carried out when you try to 

save an entry document. 
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Aggregation of FM Account Assignments 

You define which FM account assignment elements should undergo a consistency check for each check 

rule. For this purpose, you exclude all FM account assignments that are not relevant for the check using 

aggregation. You define this setting in the header data of a check rule in the screen area Aggregation. 

For example, in budget transfers, you can check whether the amount transfer postings from sender to 

receiver are carried out for each fund. In this case you set the aggregation indicator for all FM account 

assignments that are not to be checked except for the fund. 

A check library contains consistency checks that you can define as check rules for budget values. If a 

check rule is not complied with, a message is issued. You can also set which system message is issued if 

errors occur for a check rule. If the message class Error is set, a budget posting can be prevented. 

Once check libraries are defined, they can be used for all FM areas. You can define the FM 

area currency required in the header data of a check library. 

Rule Definition 

You can define a sequence of individual rules for each check library, that are carried out one after the 

other during the consistency check. Rules are subdivided into three parts: 

- Prerequisite 

You define which budget documents should be checked according to this rule. You define a formula 

using the formula editor for the budget documents that should be included in the consistency check. 

If you do not define a formula, the consistency check takes place for each budget posting. For more 

information, see Formula Builder. 

- Check Rule 

In this step, you define the rule to be checked. You define a formula between the amounts of two 

operands using an operator ( > ; = ; <...). Two key figures or one key figure can be checked against a 

fixed value. If you select the operator "=" you can also define a tolerance value. 

- Messages 

An error message is issued if the check of a rule is not complied with. You can define which error 

message is issued in this section. For this purpose, you must already have created a customer-

defined message class containing the corresponding messages. 

Message Variables: 

The message control youdefine here also supports the use of message variables. You can transfer the 

specific data on inconsistencies (e.g. which FM account assignment is affected) to the respective 

error message to be issued via the message variable. Up to four message variables can be transferred 

for each message, provided that the selected message also contains the same number of variables. In 

the case of an error, the selected messages are filled dynamically with the corresponding values and 

facilitate the reproduction of the error. Error messages are forwarded to the Application log. 

Requirements 

- Key Figure for Consistency Check 

You have defined the key figures that you want to use for the check rules in Customizing of Funds 

Management under Define Key Figures. 
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Note that you must have checkmarked the key figures for the category consistency check. If a key 

figure is not assigned to the category consistency check, the definition of the check rule is not 

displayed in the F4 selection. 

- Messages for Consistency Check 

You have selected the system messages you want to issue if errors occur. You define a message 

class and the system messages contained in it in the SAP Easy Access Menu under Tools -> ABAP 

Workbench -> Development -> Programming Environment -> Messages. 

Standard settings 

SAP delivers a sample check library with a predefined check rule for the consistency check on budget 

entry documents and for budget account assignments. You can use these as a template for your own 

check libraries. 

SAP delivers a selection of message variables that you can call in the Message Variables field via F4 

input help. 

Activities 

1. Create a library by selecting Create and entering the key of the library in the dialog box Create 

New Library. Define a suitable description for the check library and a currency that applies to all 

other numeric values and save your entries. The new library is displayed in the selection frame on 

the left. 

2. Create a rule in the library by selecting the library, choosing Create and entering the library key in 

the dialog box Create New Check Rule. Define a suitable description for the check rule. You can 

also define an aggregation of an account assignment in the screen area Aggregation. Save your 

entries. The new check rule is displayed in the selection frame on the left under the library. 

3. Expand the structure of the library in the selection frame on the left and the rule assigned under it, 

then double click on Prerequisite. Create a formula using the formula editor. The budget 

documents to be checked are selected using this formula. Save your entries. 

4. Double click on Check in the selection frame on the left. Select a suitable key figure for the left 

operand using F4, then define the check to be carried out for the right operand using an operator (< ; 

= ; > ...). You can also select a key figure as a right operand, or enter a constant. 

5. Double click on Message in the left selection frame. Enter the message class and the message 

number, then create a message type. Save your entries. 

If you want to use the check library defined for the consistency check, define the appropriate settings in 

the IMG activity 

Assign Budget Address Check Libraries. 

Example 

You want to ensure that the budget transfers are cleared in a fund. You define this in a check rule as 

follows: 

a) Define the aggregation of all account assignment elements, except for funds to be evaluated. 
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b) Formula for prerequisite: ' ' 

(If you do not enter a formula, this check rule takes place for all budget postings) 

c) Formula for check rule: Key Figure Balance from Transfer (Total)= 0 

d) If the check rule is not adhered to, the posting is prevented with an error message. The example 

is available as a sample (check rule 0000001 of check library 0000001) for budget entry 

documents. 

36.2.4.1.3.5.2 Define Check Libraries for Budget Addresses 

Use 

In this IMG activity, you define check libraries for budget addresses. 

During consistency checks of budget addresses, budget amounts entered in budget entry documents are 

evaluated with the budget already posted. Note that this form of consistency check affects system 

performance because the database entries are accessed each time an entry document is saved for each 

budget address. 

A check library contains consistency checks that you can define as check rules for budget values. If a 

check rule is not complied with, a message is issued. You can also set which system message is issued if 

errors occur for a check rule. If the message class Error is set, a budget posting can be prevented. 

Once check libraries are defined, they can be used for all FM areas. You can define the FM area currency 

required in the header data of a check library. 

Rule Definition 

You can define a sequence of individual rules for each check library, that are carried out one after the 

other during the consistency check. Rules are subdivided into three parts: 

- Prerequisite 

You define which budget documents should be checked according to this rule. You define a formula 

using the formula editor for the budget documents that should be included in the consistency check. 

If you do not define a formula, the consistency check takes place for each budget posting. For more 

information, see Formula Builder. 

- Check Rule 

In this step, you define the rule to be checked. You define a formula between the amounts of two 

operands using an operator ( > ; = ; <...). Two key figures or one key figure can be checked against a 

fixed value. If you select the operator "=" you can also define a tolerance value. 

- Messages 

An error message is issued if the check of a rule is not complied with. You can define which error 

message is issued in this section. For this purpose, you must already have created a customer-

defined message class containing the corresponding messages. 

Message Variables: 

The message control youdefine here also supports the use of message variables. You can transfer the 

specific data on inconsistencies (e.g. which FM account assignment is affected) to the respective 

error message to be issued via the message variable. Up to four message variables can be transferred 

for each message, provided that the selected message also contains the same number of variables. In 
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the case of an error, the selected messages are filled dynamically with the corresponding values and 

facilitate the reproduction of the error. Error messages are forwarded to the Application log. 

Requirements 

- Key Figure for Consistency Check 

You have defined the key figures that you want to use for the check rules in Customizing of Funds 

Management under Define Key Figures. 

Note that you must have checkmarked the key figures for the category consistency check. If a key 

figure is not assigned to the category consistency check, the definition of the check rule is not 

displayed in the F4 selection. 

- Messages for Consistency Check 

You have selected the system messages you want to issue if errors occur. You define a message 

class and the system messages contained in it in the SAP Easy Access Menu under Tools -> ABAP 

Workbench -> Development -> Programming Environment -> Messages. 

Standard settings 

SAP delivers a sample check library with a predefined check rule for the consistency check on budget 

entry documents and for budget account assignments. You can use these as a template for your own 

check libraries. 

SAP delivers a selection of message variables that you can call in the Message Variables field via F4 

input help. 

Activities 

1. Create a library by selecting Create and entering the key of the library in the dialog box Create 

New Library. Define a suitable description for the check library and a currency that applies to all 

other numeric values and save your entries. The new library is displayed in the selection frame on 

the left. 

2. Create a rule in the library by selecting the library, choosing Create and entering the library key in 

the dialog box Create New Check Rule. Define a suitable description for the check rule, then save 

your entries. 

The new check rule is displayed in the selection frame on the left under the library. 

3. Expand the structure of the library in the selection frame on the left and the rule assigned under it, 

then double click on Prerequisite. Create a formula using the formula editor. The budget 

documents to be checked are selected using this formula. Save your entries. 

4. Double click on Check in the selection frame on the left. Select a suitable key figure for the left 

operand using F4, then define the check to be carried out for the right operand using an operator (< ; 

= ; > ...). You can also select a key figure as a right operand, or enter a constant value. 

5. Double click on Message in the left selection frame. Enter the message class and the message 

number, then create a message type. Save your entries. 

If you want to use the check library defined for the consistency check, define the appropriate settings in 

the IMG activity Assign Budget Address Check Libraries. 
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Example 

In the Budget Control System, by default you are allowed to post negative budget. The indicator 

Negative Budget in the master record of commitment items is not relevant in BCS. If you want to 

prevent negative budget occurring on a budget account assignment when budget is entered or updated 

(returns, transfers, carryforwards), define a corresponding consistency check. In the following check 

rule, the posting of negative budget values is checked for each budget type. 

a) Formula for prerequisite: Workflow Status of a Data Record in Budget Totals Table = 'P'  

b) Formula for check rule: Key Figure Current Budget for each Budget Type >= 0 

c) Example of an error message:  Current Budget must be greater than or equal to 0. 

This example is available as a sample (check rule 0000002 in check library 0000002). 

36.2.4.1.3.5.3 Assign Budget Entry Document Check Libraries 

Use 

In this IMG activity you define which consistency checks are carried out during posting of budget entry 

documents. You assign the appropriate check libraries to the versions of the FM area/fiscal year for this. 

Requirements 

The check libraries required were created in IMG activity Define Check Libraries for Budget Entry 

Documents first. 

If you use an existing check library (across all FM areas) that is therefore linked to another currency, the 

currency entered in the header data of the check library must be brought into line with your FM area 

currency. 

Standard settings 

Standard settings 

Activities 

Assign the check libraries to an appropriate version in the FM area/fiscal year. 

36.2.4.1.3.5.4 Assign Budget Address Check Libraries 

Use 

In this IMG activity, you define which consistency checks should be carried out per budget address 

during posting of budget entry documents. You assign these check libraries for the relevant version of the 

FM area/fiscal year. 

Requirements 
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The check libraries defined were created in IMG activity Define Check Libraries for Budget Addresses. 

If you use an existing check library (across all FM areas) that is therefore linked to another currency, the 

currency entered in the header data of the check library must be brought into line with your FM area 

currency. 

Activities 

Assign the check libraries to an appropriate version in the FM area/fiscal year. 

36.2.4.1.3.5.5 Check Consistency Rules 

Use 

With this report, you can verify active or inactive rules that have been defined in the Consistency Check 

tool. 

Standard settings 

SAP does not deliver any standard settings. 

Further notes 

For more information, please see the documentation for Consistency Check Report. 

36.2.4.1.3.6 Budget Texts 

36.2.4.1.3.6.1 Define Templates for Budget Texts/Budget Memos 

Use 

In this IMG activity, you create templates for budget memos to be used in the Budget Control System for 

the following: 

- Cover groups in BCS cover eligibility 

- Revenues Increasing the Budget (RIB) 
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These budget memos provide details to better describe the planned budget, or to explain the reasons for 

specific decisions relating to cover eligibility or RIB. You can use variables containing, for example, 

account assignment elements, in order to create the budget memo long texts. 

Note 

You cannot create any variables yourself. In the standard system, a large number of variables are 

predelivered. 

Standard settings 

SAP provides predefined variables for your use. 

Activities 

In order to create text templates for budget memos, proceed as follows: 

1. Click on New Entries and select a budget text category to work with. 

2. Enter the name of your new text template and a short text for it. 

3. Save your entry. 

4. Select a line and click on Enter Long Text. 

5. Enter a long text using the variables on the left side.  For this,  you use the Drag&Drop function to 

pull the variable from the left to the right side, and write your text before and after the variables. 

Note that the variables do not contain any text, so you must include the name of the objects, for 

example, the funds center &BA_FUNDSCTR&.. 

6. Save your entry. 

Example 

You want to display the budget memo linked to a cover group. After carrying out the necessary 

Customizing activities as described above,  you proceed as follows: 

- You have assigned a budget memo template in one of the three fields (receiver and sender, or only 

receiver, only sender) in the detail screen of Transaction FMCERULE. 

- You next mark a budget address line in the lower screen section, and access menu Goto -> Display 

Budget Memo. 

- The budget memo text is displayed in a separate window. The search function within this text is 

active, if you want to look for a specific term or phrase in a longer budget memo text. 

36.2.4.1.3.6.2 Define Key Fields for Budget Texts 

Use 
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In this IMG activity, you define the key fields to be used when you create budget texts in your FM area.  

In this way you can define the structure of texts to be displayed in the budgeting workbench or in your 

budget structure. 

These texts can be maintained during budget planning or with the text maintenance transaction FMTEXT. 

They can be copied via program Copy Budget Text. 

If you have checkmarked a column in this IMG activity, this field will be used as a key field in budget 

texts: 

- Used   -  The field is active for the budget text transaction and the input field is a required entry for 

text maintenance. 

- Not Used - The field is not active for defining the budget text key. The input field is not displayed in 

the budget text transactions. 

Together, these key fields form the default name of budget texts that you create. 

Standard settings 

SAP does not provide any standard settings for this activity. 

Activities 

1. Create a new entry for your FM area. 

2. Checkmark the objects that are relevant keys for defining budget texts. 

3. Save your data. 

36.2.4.1.3.6.3 Activate Processing Mode for Budget Texts 

Use 

In this IMG activity, you can activate an editing mode for budget text in BCS transactions. 

Activities 

1. Enter the FM area in the first column and specify whether you want your budget texts to be edited 

only in the Budget Text Organizer (transaction FMTEXT), or also in other transactions. 

2. Save your data. 

36.2.4.1.3.6.4 Assign Forms for FM Budget Texts 
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Use 

In this IMG activity, you can define the forms to be used when you create budget texts for the account 

assignment elements of your FM area. This form will be then defined for all  FM account assignment 

texts ("budget texts") used in the planning transaction, the budgeting workbench, the budget structure 

maintenance transaction, the key figures report and the RIB rule maintenance transaction. 

Requirements 

If you want to define your own forms, enter the name of the form that you previously created in 

transaction Smartforms.  If you want to use PDF-based forms, you can define your own form with 

transaction Form Builder. 

Activities 

1. For your FM area, select a form. As a template, SAP proposes the delivered Smartform 

"FMBUDGET_TEXT". If you do not select a template, this one will be selected by default. In case 

you want to use a PDF-based form, SAP proposes the delivered form 

"FM_BUDGET_TEXT". 

2. Save your entries. 

36.2.4.1.3.7 Revenues Increasing the Budget 

36.2.4.1.3.7.1 Activate Budget Memos for RIB 

Use 

In this IMG activity, you activate budget memos to be used for Revenues Increasing the Budget (RIB). 

You can specify whether budget memos are not used, are optional, or are mandatory. If you activate the 

use of budget memos for RIB, you can assign a text template for budget memos to each RIB rule. In 

reporting these templates are then used to generate budget memos, based on the actual data of the 

corresponding RIB rule. 

Standard settings 

In the standard setup, the functionality of budget memos is not active for RIB. 

Activities 

In order to activate budget memos, enter your FM area, choose between "optional'"and "mandatory'", and 

then save your entries. 

Note 
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You define text templates for budget memos in the IMG activity Define Text Templates. 

36.2.4.1.3.7.2 Define Derivation Strategy for RIB Objects 

Use 

In this IMG activity, you define the account assignment derivation for RIB objects used for revenues 

increasing the budget. 

Each account assignment to which you post revenues (such as customer invoices or expected revenues) is 

assigned to a budget address through the account assignment derivation of the budget structure. If you do 

not define a derivation strategy for your RIB objects, they will always be identical to the budget addresses 

assigned to the posting addresses used for collecting your revenues. 

RIB objects serve two basic functions: 

- Aggregation of revenues and, if applicable, of revenue budget 

Posted revenues are assigned to a RIB object in two steps: first using the derivation strategy for 

budget addresses of the budget structure and then using the derivation strategy defined in this IMG 

activity. This allows for an independent definition of your budget structure and the creation of so-

called "RIB rules". If you define RIB rules using relative limits (or thresholds), you have to enter 

revenue budget values for the budget addresses assigned to a RIB object, aggregating the revenue 

budget from several budget addresses. 

- Assignment of RIB rules 

Each rule for revenues increasing the budget must be assigned to a RIB object (= a particular 

revenues budget address). In this a rule, you specify the amount available for a budget increase, the 

relevant type of revenues and the receiving expenditures budget addresses. 

Requirements 

You have set up and assigned your derivation strategy for budget addresses of the budget structure in the 

IMG activity Define Derivation Strategy for Budget Addresses. 

Notes 

The derivation strategy for RIB objects consists of a sequence of derivation steps that are executed in the 

given order and which use one of the following step types: 

- Initialization 

In derivation steps of step type Initialization you can set the value of any target field to its initial 

value (usually = SPACE). 

- Assignment 

In steps of step type Assignment, you can assign the value of any source field or a constant value to 

some target field. 
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- Derivation rule 

In derivation steps of step type Derivation rule, you can set up database tables, where you can enter 

combinations of values of source fields corresponding to certain combinations of target fields. 

- Table lookup 

In steps of step type Table lookup, you can access single individual records of database tables. 

- Function module 

In steps of type Function module, you can call a specific function module, for instance, for reading 

master data attributes of account assignment elements, or for searching for account assignment 

elements in master data hierarchies. 

All derivation steps defined here can be linked to conditions which must be met in order for the derivation 

step to be executed. 

Standard settings 

SAP does not deliver any standard implementation for the derivation strategy for RIB objects. 

Recommendation 

If you want to assign RIB rules on the level of revenue budget addresses assigned to your posting 

addresses (or even at the level of the posting addresses),  you should not implement a derivation strategy 

for RIB objects: In this case, RIB objects will automatically be identical to the revenues budget addresses. 

Activities 

1. If required, edit the derivation strategy by adding appropriate derivation steps. 

2. Save your strategy. 

3. Test or transport your strategy using the appropriate buttons or menu functions. 

Further notes 

- The value of the account assignment element Grant is always identical in the budget address and the 

assigned RIB object. 

- The value of each account assignment element of the RIB object is identical with the value of the 

budget address, provided there is no step in the derivation strategy that changes the value of this 

target field. 

36.2.4.1.3.7.3 Maintain Calculation Formulas for RIB 

Use 

In this IMG activity, you maintain the calculation formulas to be used for defining rules for revenues 

increasing the budget. 

With a calculation formula, you can define: 
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- The percentage of collected revenues that will be relevant for a budget increase (usually = 100%) 

- A lower limit for revenues with budget-increasing effect 

- An upper limit for revenues with budget-increasing effect 

You have the option to work without lower or upper limits. If you decide to set up a lower or upper limit, 

then you have to choose the type limit (for instance, absolute value of relative percentage) and enter a 

value for it. 

If you do not work with limits or if you only set up limits using absolute values, it is not necessary to 

enter revenue budget. Revenue budget values are only needed to calculate limits which are defined by 

relative percentages. 

Standard settings 

SAP only delivers the standard formula 1000 as template. 

Activities 

1. Create your own calculation formulas using the currency of the your FM area. 

2. Save your calculation formulas. 

Example 

You set up the following calculation formula: 

- Relevant percentage of revenues: 50% -

 Lower limit: absolute value = 

$1,000 

- Upper limit: relative percentage = 200% 

The current revenue budget amount may be $1,500, which means that the upper limit will be equal to 

$3,000. 

If you have collected revenues of $1,800, then this will not be sufficient for a budget increase, because 

only 50% of the revenues, i.e. $900, enter the calculation. 

If the collected amount of revenues is $4,000, then $2,000 will become relevant. Since this amount 

exceeds the lower limit of $1,000, the amount of $1,000 (out of $2,000) has a budget increasing effect 

and may be distributed to some expenditure budget address. 

If no surplus budget address is used, then revenues up to $6,000 may have budget increasing effect, 

because of the upper limit given by the current revenue budget of $1,500, multiplied by a factor of 2, as 

defined by the upper limit. Therefore the maximum budget increase will be $2,000 (= upper limit - lower 

limit), which is reached with collected revenues of $6,000. 

Further notes 

- Each calculation formula must be assigned to a currency. This currency must be identical to the 

local currency of the FM area, which this calculation formula is to be used for. 
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- Usually only the revenues between the lower and upper limit will have a budget-increasing effect. 

You may, however, set up rules for revenues increasing the budget which use surplus budget 

addresses. In this case, you must set the indicator Use Surplus Amount?. This indicator refers to 

revenues that exceed the upper limit as defined in the calculation formula, and will then increase the 

budget of the assigned surplus budget address. 

- Revenues below the lower limit or residual revenues from calculation formulas with percentages < 

100% have no budget-increasing effect. 

36.2.4.1.3.7.4 Maintain Derivation Strategy for Rule Generation 

Use 

In this Customizing activity, you can maintain the derivation strategy for proposing values for the 

automatic generation of rules for Revenues Increasing the Budget ("RIB rules"). 

Using this derivation strategy, you can assign values for the definition of RIB rules. You define the source 

fields by assigning the following values to a given RIB object or revenue cover group: 

- Activation status 

- Filter profile - Calculation formula 

- Indicator Use surplus amount? 

- RIB procedure 

- Receiving expenditure budget address (fixed percentage = 100%) 

- Surplus budget address (fixed percentage  = 100%), if the indicator Use surplus amount? is set 

- Automatic cover group (RIB rule is to be assigned to), if the RIB procedure is selected as 

Call Procedure (value C) 

- A budget memo template for revenue addresses and a budget memo template for expenditure 

addresses, if you work with budget memos for RIB rules. 

Notes 

The derivation strategy for the generation of RIB rules consists of a sequence of derivation steps. These 

are executed in a given order and use one of the following step types: 

- Initialization 

In derivation steps of step type Initialization, you can set the value of any target field to its initial 

value (usually = SPACE). 

- Assignment 

In derivation steps of step type Assignment, you can assign the value of any source field or assign a 

constant value to a target field. 

- Derivation rule 
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In derivation steps of step type Derivation rule, you can set up database tables in which you can 

enter combinations of values of source fields that should correspond to certain combinations of 

target fields. 

- Table lookup 

In derivation steps of step type Table lookup, you can access single individual records of database 

tables. 

- Function module 

In derivation steps of step type Function module, you can call a function module to determine the 

values of target fields. 

All derivation steps defined here can be linked to conditions which must be met in order that the 

derivation step can be executed. 

Requirements 

You have made settings in all previous Customizing activities in this section. 

Standard settings 

SAP does not deliver any standard implementation of the derivation strategy. 

Recommendation 

If you want to generate rules for Revenues Increasing the Budget using the program Generate RIB Rules 

(transaction FMRBGENMD), then you must implement this derivation strategy. 

Activities 

1. Edit the derivation strategy by adding appropriate derivation steps. 

2. Save your strategy. 

3. Test or transport your strategy using the appropriate buttons or menu functions. 

Further notes 

- For further details on the automatic generation of RIB rules, refer to the documentation of program   

Generate RIB Rules. 

- If you create an RIB rule for an RIB object, then the values of the source fields for the RIB rule (FM 

account assignment element values) are determined by the RIB object. 

However, if you create an RIB rule for a revenue cover group, then these source fields (example: 

funds center and commitment item of the RIB rule) are determined by the RIB source address of the 

revenue cover group. 

- Only a single receiving expenditure budget address (with fixed percentage = 100%) can be assigned 

with this derivation strategy. If you want to maintain multiple receivers, you can add them manually 

in the transaction Process Single RIB Rule (transaction code FMRBRULE). 

- If you do not specify derivation steps for the account assignment elements of the receiving 

expenditures budget address, all the values of these account assignment elements will be identical to 
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the values of the RIB object or of the RIB source address (if you base the new RIB rule on a revenue 

cover group). Since the RIB object or the RIB source address, is a revenues budget address, this will 

cause an error message. Therefore, you must in any case specify the value of the account assignment 

element commitment item. 

- A surplus budget address can only be assigned if the indicator Use Surplus Amount is set. If not set, 

any assigned surplus budget address value will be automatically cleared by the system without any 

message. In addition, the surplus budget address must be different from the receiving expenditure 

budget address. Furthermore, you cannot set this indicator for RIB rules with call procedure. 

- An automatic cover group can be assigned if Call Procedure (valueC) is selected for the field RIB 

procedure. For RIB rules with distribution procedure, however, any value entered for the automatic 

cover group field will be automatically cleared by the system without any message. 

36.2.4.1.3.7.5 Activate Change Log for RIB Rules 

Use 

In this IMG activity, you activate the change log for RIB rules in Funds Management (FM) budgeting. 

The activation influences the following maintenance transactions for RIB rules: 

- Manual maintenance of RIB rules (transaction FMRBRULE) 

- Mass generation of RIB rules (transaction FMRBGENMD) 

- Mass deletion of RIB rules (transaction FMRBDEL) 

- Copy of RIB rules (transaction FMRBCPY) 

- Reconstruction of index for RIB rules (transaction FMRBIDXREC) 

If the change log is activated, document change records are updated in the history tables when RIB rules 

are created, deleted, or changed in any of the above transactions. 

Standard settings 

In the standard setup, the change log for RIB rules is not active. 

Activities 

1. In order to activate the change log for RIB rules, enter your FM area and checkmark the change log 

activation. 

2. Save your data. 

36.2.4.1.3.7.6 Delete Change Log for RIB Rules 
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Use 

In this IMG activity, you can delete a change log for RIB rules. If the change log was active for a period 

in the past, you may want to delete it for performance reasons. 

Standard settings 

SAP does not provide any default settings. 

Activities 

1. Enter the FM area, budget category for RIB and the date up to which you want to delete the change 

records. 

2. Set the test run indicator if you want to simulate the deletion before actually deleting. 

3. Run the transaction. 

For more information, see the documentation of the transaction. 

36.2.4.1.3.7.7 Activate Period Control for Distribution Procedure 

Use 

In this IMG activity, you activate period control for RIB rules with distribution procedure. 

You have the choice between the following values: 

- Annual Totals: This is the default value. The RIB process cumulates all periods of the fiscal year to 

calculate the amounts for increasing the budget through the RIB process. 

- Single Period: The RIB process is separated for each single period. To increase the budget of a given 

period only the revenues and the previous budget increases from this single period are taken into 

account. 

- Cumulative Periods (To-Period): To calculate the process amounts for budget increase the RIB 

process takes into account the amounts of a selected period, plus the amounts from all preceding 

periods, starting with period 1. 

The activation influences the following transactions: 

- Increase Budget from Revenues (transaction FMMPRBB) 

If you activate period control, you can only increase the budget on a single period. The use of a 

distribution key is forbidden. Furthermore, the selected periods for the source and target part of new 

RIB documents must be identical. 

- Overview of RIB Rules Values (transaction FMRBMON01) 
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If you activate period control, an option for period selection is shown to restrict the calculated and 

displayed RIB values to the selected periods. 

Requirements 

You have defined RIB rules with distribution procedure. 

Standard settings 

In the system standard, period control is not active. The default value is "Annual Totals". 

Activities 

1. Enter the FM Area, for which you want to activate period control for RIB. 

2. Select the desired option for period control. 

3. Save your entries. 

Example 

You have activated period control with the option "Cumulative Period". 

You use a RIB rule without any lower and upper limits and have posted the following revenues in the first 

5 periods of your fiscal year: 

 Period 1 Period 2 Period 3 Period 4 Period 5 

500.00600.00300.00200.00500.00 

Suppose that you have not increased the budget of this year via RIB and you now select period 3 in 

transaction FMMPRBB. 

This transaction selects all revenues from period 1 until the selected period 3 to calculate the budget 

amount for increase: 

500.00 + 600.00 + 300.00 = 1,400.00 

You will increase the budget of period 3 by the cumulative revenues of the 2 previous periods and of the 

selected period, that is by 1,400.00. 

36.2.4.1.3.8 Cover Eligibility 

36.2.4.1.3.8.1 Activate Cover Eligibility 

Use 

In this Customizing activity, you can activate the cover eligibility functions in the Budget Control System 

(BCS). 

The activation of cover eligibility influences the following areas: 
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- Maintenance of cover groups: you can create and maintain rules for cover eligibility or more general  

cover groups. 

- Manual budget transfers using cover eligibility: you can enter manual transfers with process 

Transfer Cover Eligibility (TRCE) in the Budgeting Workbench, which makes use of the definition 

of manual cover eligibility rules (or manual cover groups). 

- Cover groups in availability control: you can define automatic cover groups, which automatically 

share the budget and budget consumption of assigned budget addresses for purposes of availability 

control. 

Note that each budget address that does not belong to an automatic cover group is 

automatically assigned to a standard control object using the derivation strategy for control objects. 

- Use of budget memos: in this Customizing activity you can also decide whether you want to use 

budget memos for expenditure budget addresses in cover eligibility rules (manual or automatic 

cover groups). If you activate the use of budget memos here, you can assign text templates for 

budget memos to each manual or automatic cover group. For reporting purposes, these templates can 

then be used to generate your budget memos, based on the current definition of the corresponding 

cover eligibility rule. 

If you want to use budget memos for revenue budget addresses or for expenditure budget addresses 

receiving budget from RIB rules, you must activate budget memos for RIB rules in Customizing 

activity Activate Budget Memos for RIB. 

- Use of RIB rules based on revenue cover groups: you can define revenue cover groups, which 

bundle different revenue budget addresses, and then create rules for Revenue Increasing the Budget 

(RIB) based on these revenue cover groups. This means that all budget addresses from the revenue 

cover group will then contribute their resources (revenues or revenue budget values) to the RIB rule. 

Note that you can still use RIB rules based on "RIB objects" in parallel. However, a specific revenue 

budget address for use in the RIB process must then be assigned to either a revenue cover group or 

an RIB object - it cannot be used simultaneously in both types of RIB rules. 

- Activation of RIB call procedure ("pseudo cover eligibility"): if you set the indicator  Activation of 

RIB Call Procedure, you can create RIB rules with call procedure. Such a rule makes additional 

revenues available for use in an automatic cover group - that is, other members of this automatic 

cover group can automatically consume these additional resources from RIB in availability control 

checks. 

Note that after activation of the RIB call procedure, the system no longer allows you to use 

availability control objects which join expenditure budget addresses and revenue budget addresses 

in a single control object or where the commitment item is set to the initial value ('SPACE'). 

- Sequence of budget processes to balance automatic cover groups: with this indicator you can define 

the sequence of budget  processes for the creation of budget documents in the transaction  

FMMPCEPCLO. 

Standard settings 

In the standard setup, the cover eligibility function is not active. 

Activities 
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To activate the cover eligibility functions, enter the FM area and fiscal year for which these functions are 

to be used, decide on additional definitions such as the use of budget memos, then save your entries. 

Notes 

- If you want to use Revenues Increasing the Budget (RIB) functions, for example RIB rules with call 

procedure ("pseudo cover eligibility"), you must carry out the steps in Customizing activity 

Revenues Increasing the Budget. 

- You can distinguish between budget types that are eligible for cover from budget types that are non-

eligible for cover (only relevant for automatic cover groups and for availability control) by making 

the corresponding setting in Customizing activity Define Budget Types. 

- You define text templates for budget memos in Customizing activity Define Text Templates. 

36.2.4.1.3.8.2 Maintain Number Range for Cover Groups 

Use 

In this Customizing activity, you can define number range intervals for cover groups to be used in BCS 

cover eligibility. 

Requirements 

If you want to generate cover eligibility rules (or more general, cover groups) using transaction Generate 

Cover Eligibility Rule (FMCEGENCG), you must maintain at least the number range interval  01 with 

an internal number allocation. You should therefore not set the Ext (external number allocation) indicator 

for number range interval  01. 

Standard settings 

In the standard system, no number range interval is defined. 

Activities 

1. Define the internal number range interval 01 for your FM area for each fiscal year if you want to 

automatically allocate numbers when creating cover eligibility rules using transaction Edit Cover 

Eligibility Rule (FMCERULE) or Generate Cover Eligibility Rule (FMCEGENCG). Do not set 

the Ext (external number allocation) indicator for this particular number range interval. 

2. If you want to use external number assignment, choose another number range interval (not 01) and 

set the Ext indicator. Note that number range interval 01 must always be internal. 

3. Save your entries. 

Further notes 

Transport number range objects as follows: 
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- After you have defined your number ranges, select Interval -> Transport in the number range 

screen. 

- All intervals for the selected number range object (that is, for the cover groups you are defining 

number ranges for) are first deleted in the target system. 

- After the import, only the intervals you have exported exist in the target system. The number 

statuses are imported with their values at the time of export. 

Dependent tables are not transported or converted. 

36.2.4.1.3.8.3 Define Derivation Strategy for Generating CE Rules 

Use 

In this Customizing activity, you can define a derivation strategy for generating cover groups. 

Using a derivation strategy, you can assign budget addresses to new cover groups or to existing cover 

groups. required for defining cover eligibility rules. 

You must assign the following values to a given budget address: 

- Role of the selected budget address. This is the role assumed in the cover group. 

- Cover group, if the budget address is to be assigned to an existing cover group. or 

- Another budget address, which should belong to the same cover group as the selected budget 

address. 

- Check the indicator "Do Not Assign Budget Address" if the selected budget address is not to be 

assigned to a cover group. 

- A cover group text, if you want to assign a text to the cover group description. 

- If you work with budget memos for cover eligibility rules, you must also assign a budget memo 

template for each possible role of the budget address, for instance, a  template for receiver addresses. 

Notes 

The derivation strategy for the generation of cover groups consists of a sequence of derivation steps. 

These are executed in a given order and use one of the following step types: 

- Initialization 

In derivation steps of step type Initialization you can set the value of any target field to its initial 

value (usually = BLANK). 

- Assignment 

In derivation steps of step type Assignment, you can assign a value to any source field or a constant 

value to a target field. 

- Derivation rule 
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In derivation steps of step type Derivation rule, you set up database tables in which you can enter 

combinations of values of source fields that should correspond to certain combinations of target 

fields. 

Note that you can maintain table entries for derivation steps of type Derivation rule from the menu 

using transaction FMCERGR. 

- Table lookup 

In derivation steps of step type Table lookup, you can access individual records of database tables. 

All derivation steps defined here can be linked to conditions which must be met before the derivation step 

can be executed. 

For further information, see the documentation on derivation strategies used in FM. 

Requirements 

Before starting the mass generation of cover groups using transaction Generate Cover Eligibility Rule 

(FMCEGENCG), you must have carried out all previous Customizing activities in this section, as well 

as implemented the derivation strategy for generating cover groups 

Standard settings 

SAP does not deliver any standard implementation of the derivation strategy. 

Activities 

1. Edit the derivation strategy by adding the appropriate derivation steps. 

2. Save your strategy. 

3. Test or transport your strategy using the appropriate buttons or menu functions. 

Further notes 

For further details on the automatic generation of cover groups, refer to the documentation of the program  

Generate Cover Groups. 

36.2.4.1.3.8.4 Activate Change Log for Cover Eligibility 

Use 

In this IMG activity, you activate a change log for cover groups in the Budget Control System (BCS). 

The activation affects the following cover group maintenance transactions: 

- Mass generation of cover groups (transaction FMCEGENCG) 

- Mass deletion of cover groups (transaction FMCEDELCG) 

- Mass copy of cover groups (transaction FMCECPYCG) 
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- Manual maintenance of cover groups (transaction FMCERULE) 

- Migrate cover pools and unilateral cover eligibility rules from Former Budgeting 

(transaction FMMIGCE) 

If the change log is activated, document change records are updated in the history tables whenever 

cover groups are created, deleted or changed by any of the above transactions. 

Standard settings 

In the standard setup, the change log for cover groups is not active. 

Activities 

Activate the change log for cover groups by entering your FM area(s) and checking the Change Log 

Activation indicator. 

36.2.4.1.3.8.5 Delete Change Log for Cover Eligibility 

Use 

In this IMG activity, you can delete the change log for cover groups. 

If the change log was active for a period in the past, you may want to delete it for performance reasons. 

Requirements 

The cover eligibility feature must be activated. 

Standard settings 

SAP does not provide any default settings. 

Activities 

1. Enter the FM area, budget category and the date up to which you want to delete the change records. 

2. Set the test run indicator if you want to simulate the deletion before actually carrying it out. 

3. Run the transaction. 

For further information, read the SAP Library and program documentation. 

36.2.4.1.4 Migration of Former Budgeting to BCS 

36.2.4.1.4.1 Overview of Migration Activities 
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Use 

The following IMG activities enable you to migrate budget data that you have been using in Former 

Budgeting to the Budget Control System. 

Standard settings 

The following IMG display settings are predefined by SAP: 

- Rules that enable you to assign or map the existing budgeting processes to the BCS processes, in the 

IMG activity Display Assignment Rules for Budgeting Process 

- Assignment rules for mapping BCS value types in Display  Assignment Rules for Value Type 

Activities 

In order to migrate your budgeting data to BCS, proceed as follows: 

- Define a derivation strategy to migrate budget document header data in the IMG activity 

Define Derivation Strategy for Migration of Header Data 

Note 

This activity is optional, and is only relevant if you want to carry out document-based 

migration. 

- Define a derivation strategy to migrate line items in the IMG activity Define Derivation Strategy for 

Line Items 

- If you want to migrate the carryover documents of the last year before BCS activation via document 

migration, you must activate the Full Migration for Carryover Documents 

- Carry out the migration of your previous budgeting totals in Migrate Budget Totals 

- Migrate your budget documents for the BCS years in Migrate Budget Documents 

- If you are working with cover pools and/or unilateral cover eligibility rules in Former Budgeting, 

you can migrate them to BCS in the IMG activity Migrate Cover Pools and Unilateral CE Rules. 

36.2.4.1.4.2 Display Assignment Rules for Budgeting Process 

Use 

In this IMG activity you display  the budgeting process and value type to be used in the Budget Control 

System. 

The data source for the budgeting process is the Former Budgeting budget type in the first column. 

For each budget type listed, you can see the combination of value type and BCS internal budgeting 

process assigned for migration to BCS, and whether (column "Ignore") the budget tables in Former 

Budgeting contain data that should not be migrated to Budget Control System. For example, all entries 

related to availability control should be ignored during migration. 

Standard settings 
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Assignment rules are predefined by SAP and cannot be changed. 

Activities 

No activity required. This is informational data. 

Further notes 

Some budget types from Former Budgeting should not be migrated to BCS (for example, for availability 

control data). These budget types are flagged to be ignored during the migration run. 

36.2.4.1.4.3 Display Assignment Rules for Value Type 

Use 

In this IMG activity you can display the assignments of the value type, the budget category and the 

workflow status  to be used for migration of budget data to the Budget Control System. 

The data source is the value type in the Former Budgeting system. 

Standard settings 

Assignment rules are predefined by SAP and cannot be changed. 

Activities 

No activity required. This is informational data only. 

Further notes 

Some value types from Former Budgeting should not be migrated to BCS (for example, for availability 

control data). These value types are flagged to be ignored during the migration run. 

36.2.4.1.4.4 Define Derivation Strategy for Header Data 

Use 

In this IMG activity you create a derivation strategy to derive the necessary fields for your budget 

document header from different source fields. You do this by creating the corresponding derivation steps 

in the derivation strategy. 

Standard settings 
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SAP does not deliver any standard settings. 

Activities 

Create a derivation strategy for the migration of your budgeting documents and save it. 

36.2.4.1.4.5 Define Derivation Strategy for Line Items 

Use 

In this IMG activity,  you can define the derivation strategy to be called for each budget line during the 

migration run. The relevant fields from Former Budgeting are displayed as source fields in the definition 

of the derivation steps. 

Standard settings 

SAP does not deliver a standard derivation strategy. 

Activities 

Enter a derivation strategy for the migration of budget lines and save your data. 

36.2.4.1.4.6 Activate Full Migration for Carryover Documents 

Use 

Note 

This IMG activity is only relevant if you have carried out  fiscal year-end closing for the last fiscal year 

that you are using the Former Budgeting (FB) system. 

In this IMG activity, you determine whether to apply a specific handling procedure for migrating the 

corresponding data. Document migration normally deals with data used since BCS activation. Therefore, 

the sender part of the carryover document (referring to the last fiscal year before BCS activation) is not 

taken into account by the document migration program. 

Only the receiver part is migrated. As this leads to an unbalanced carryover, the FB process is mapped 

to represent a budget supplement in BCS. 

To also migrate the sender part of the carryover, you need to carry out a migration of your budget totals 

including totals from the last year before BCS activation. Since no budgeting document is involved here, 

the budgeting process is not changed. 

By checkmarking the full migration of carryover documents in this IMG activity, you to migrate the 

entire carryover document from FB via document-based migration. The corresponding data will then not 

be taken into account by the totals migration. The advantages are: 

- the original process (carryover) is kept 
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- delta migration is sufficient if the year-end closing process is performed after the migration. 

Note 

This specific handling procedure cannot be used for budget release data. If you are using the release 

functionality, the system will not be able to determine which part of the released amount concerns 

carryover data. The specific handling of carryover documents will then lead to inconsistencies between 

released amounts and budgeted amounts in BCS. 

Furthermore, for "carryback documents",  the same logic also applies: the sender year is the first BCS 

year and receiver year is the last FB year. Unfortunately, such documents cannot be migrated, as BCS 

does not permit a carryback procedure. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. If necessary, set the indicator for full migration of carryover documents in your FM area by 

checkmarking the last column Carryover.  Note that only FM areas for which BCS has been 

activated are available for selection. 

2. Save your entry. 

36.2.4.1.4.7 Migrate Budget Totals 

Use 

In this IMG activity, you migrate your budgeting totals from the former budgeting system to the Budget 

Control System. 

Read the documentation on Migration of Totals from Former Budgeting to BCS and then carry out the 

activities as specified there. 

Standard settings 

SAP does not deliver any standard settings. 

36.2.4.1.4.8 Migrate Budget Documents 

Use 

In this IMG activity, you carry out a document-based migration of budgeting data from Former Budgeting 

the Budget Control System. 
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Read the documentation on the Migration of Budget Documents and then carry out the activities as 

specified there. 

Standard settings 

SAP does not deliver any standard settings. 

36.2.4.1.4.9 Migrate Cover Pools and Unilateral CE Rules 

Use 

In this IMG activity, you migrate the cover pools created in Former Budgeting and/or unilateral cover 

eligibility rules to the Budget Control System. 

Requirements 

BCS must be installed. Cover eligibility should be activated in the IMG activity Activate Cover 

Eligibility. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Please read the program documentation Migrate Cover Pools and Unilateral CE Rules and then carry out 

the activities as specified there. 

36.2.4.1.5 Tools 

36.2.4.1.5.1 Delete Budget Data 

Use 

In this step, you start the program for deleting budget data in BCS Funds Management. 

You can use this program in the following situations: 

- If you are still in the test phase and want to delete your test data before the production startup. 

- If you have transferred budget for a future year to the production system using batch input and you 

want to delete the existing budget data for the current year. 

Standard settings 



 

WHATSAPP +255738656506 

 

SAP does not deliver any standard settings. 

Activities 

1. Specify the scope of data you want to delete. 

2. Specify whether you first want to create a test run in order to get an overview of the data that will be 

deleted in the current selection. 

3. Run the report. 

For further information, please refer to the program documentation. 

36.2.4.1.5.2 ALE Distribution of Budget Data 

36.2.4.1.5.2.1 Create Standard ALE Customizing Settings 

Use 

This IMG activity is a link to the standard Customizing settings of Application Link Enabling (ALE), 

where you make all the settings necessary to communicate between different systems. 

Note the following with respect to the distribution of BCS data: 

- The message type to use is FMEDMSGTYPE. 

- The IDoc that you must use is called FMEDIDOC. 

For further information see the Application Help of the Budget Control System under BCS Budgeting, 

"Distribution of Data using Application Link Enabling". 

Activities 

Carry out the standard Customizing settings for Application Link Enabling. 

36.2.4.1.5.2.2 Define Derivation Strategy for Distributed Budget Data 

Use 

In this IMG activity you create a derivation strategy which enables the distribution of budget entry 

documents to ALE-linked systems for the following source fields: 

- FM area 

- Fiscal year 

- Budget category 

- Version 
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- Funds center 

The system derives the following target fields: 

- a distribution model created from the ALE standard, which at minimum determines the sender and 

the receiver systems (mandatory in order to set the distribution) 

- the name of the funds center in the receiver system, if different from the sender system (optional) 

- the name of the FM area in the receiver system, if different from the sender system (optional) 

Requirements 

In order to use this derivation strategy, you must first make the ALE customizing settings in the IMG 

activity Create Standard ALE Customizing Settings. You must define at least one distribution model. 

Activities 

Create a derivation strategy by first selecting a derivation step type and then entering a step description, 

conditions and attributes. 

Example 

See the documentation of the IMG activity Select Derivation Steps for further information on how to 

maintain a derivation strategy. 

36.2.4.1.5.3 Business Add-Ins for Budgeting (BAdIs) 

36.2.4.1.5.3.1 BAdI: Create User-Defined Fields in Budget Entry Document 

Title 

Business Add-In: Customer-Specific Fields in Budgeting Workbench (entry document) 

Use 

With this Business Add-In you can define a su-screen for the input/output of your specific fields 

associated with an entry document. 

It can only be implemented for Funds Management, component Budget Control System (BCS). 

The methods of this BAdI are called in the PBO (Process Before Output) and PAI (Process After Input) 

of the screen that contains additional data. 

Additionally, the method PRINT is called when the entry document is printed. 

Standard settings 
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SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

If you would like to have customer-specific fields for entry documents, you should first define the 

corresponding customer include (CI_FMBH). Now implement this BAdI applying the following steps: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

Define a subscreen that contains customer-specific fields. 

10. The method GET_DATA_FROM_SCREEN should be called in the PBO of your subscreen. 

- The method PUT_DATA_TO_SCREEN should be called in the PAI of your subscreen. 

- The method PRINT is called when the entry document is printed. 

11. Assign the subscreen to the BAdI implementation. 

12. Activate your BAdI implementation. 
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Requirements 

The structure CI_FMBH (customer include for entry document) should be defined. 

Recommendation 

Only use character-like fields in the structure. 

Further notes 

Documentation for the BAdI method PUT_DATA_TO_SCREEN 

Documentation for the BAdI method GET_DATA_FROM_SCREEN 

Documentation for the BAdI method PRINT 

36.2.4.1.5.3.2 BAdI: Control Budgeting Periods 

Use 

With this Business Add-In you specify the time periods that are open for budgeting in the following areas: 

- Budget entry using the budget planning transaction or the budgeting workbench 

- Budget mass transactions (copy, carryforward of residual budget, ...) 

This Business Add-In provides various features enabling you to control periods. For instance: 

- You can distinguish whether you want to open specific periods when creating entry documents 

and/or change documents. 

- You can also distinguish per original application during budget planning or execution (using the 

budgeting workbench) 

- You can also open periods only for certain users. 

Requirements 

You have carried out the IMG activity to activate period control. 

Standard settings 

SAP does not provide any default settings. 

Activities 

This is a single-use BAdI, meaning that only one implementation can be activated. 
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Please note that if you open budgeting periods using transaction FMOPER (Open Budgeting Periods), the 

open periods are then changed according to the implementation. 

After you have made the period control settings, you can implement the BAdI applying the following 

steps: 

Notes 

See method Get Open Periods 

36.2.4.1.5.3.3 BAdI: Enhance Budget Entry Documents 

Title 

Business Add-In: Customer enhancement for entry document. 

Use 

With this Business Add-In you can define customer enhancements related to the business object 

BudgetEntryDocFM (BUS0050) . 

It can only be implemented for Funds Management, component Budget Control System (BCS). 

The methods of this BAdI are called during the processing of the business object methods. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

If you would like to handle customer specific fields for entry documents, you should first define the 

corresponding customer include (CI_FMBH). 

Now implement this BAdI applying the following steps: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 
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The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

Activate your BAdI implementation. 

Recommendation 

Only use character-like fields in the structure. 

Further notes 

Documentation for method CREATE_IN 

Documentation for method CREATE_OUT 

Documentation for method GETDETAIL_IN 

Documentation for method GETDETAIL_OUT 

Documentation for method GETLIST_IN 

Documentation for method GETLIST_OUT 

Documentation for method REVERSE_IN 

Documentation for method REVERSE_OUT 

36.2.4.1.5.3.4 BAdI: Enhance Checks and Document Postings 

Title 

Budgeting Interface: Enhance Checks and Post Data 
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Use 

With this Business Add-In (BAdI) you can: 

- Improve checks on budget entry documents 

- Improve checks on line items 

- Post data for purposes other than BCS 

The corresponding methods are called by the check and posting events of the Budget Control System. 

Standard settings 

SAP delivers the following default implementations: 

FMKU_BUDGET_EVNT_AVC Update and post data for availability control 

FMKU_BUDGET_EVNT_BL 

ledger 

Add checks and post data for the budgetary 

FMKU_BUDGET_EVNT_CC For document consistency checks 

FMKU_BUDGET_EVNT_GM Specific checks for Grants Management 

FM_CHECK_EXP_DATE  Check against the expiration date of the master 

records on FM objects 

Activities 

This is a multiple-use BAdI, meaning that all active implementations will be triggered for each event 

called. You implement the BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Further information 

For further information on each method, see: 

- Enhance Checks on Entry Documents 
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- Enhance Checks on Line Items 

- Post Budgeting Data 

36.2.4.1.5.3.5 BAdI: Enhance Budget Line Items 

Title 

Budgeting Interface : Add Lines / Substitute Data 

Use 

With this Business Add-In you can : 

- Create additional lines in budget entry documents 

- Substitute fields contained in the original lines 

The corresponding methods are called in the kernel of the Budget Control System (BCS). 

Standard settings 

SAP offers a default implementation using the CO-PA derivation tool: 

For both implementations use the CO-PA derivation tool. Source fields are derived to create target fields. 

Source fields and target fields are part of the fields contained in a line. For each methode you have to 

define your derivation strategy in the IMG activities: 

Define Derivation Strategy for Additional Budget Line Items 

Define Substitution for Entry Documents 

Implementation of the method ADD_LINES: 

The target fields are initialized with the values of the source fields. After this, processing depends on the 

derivation strategy involved.  If the commitment item category has changed (for example, from 

expenditures to revenues),  the signs of the values are reversed. If a target field is ultimately empty, but 

the corresponding source field is not "blank", a message is generated in the application log to warn the 

user. 

Implementation of the method SUBSTITUTE_DATA: 

The target fields are initialized with the values of the source fields. After this, processing depends on the 

derivation strategy involved. If a target field is ultimately empty, but the corresponding source field is not 

"blank", a message is generated in the application log to warn the user. 

Activities 

This is a single-use BAdI, meaning that only one implementation can be activated. 

Now implement the BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 
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1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Further information 

For further information on each method, see: 

- Creates Additional Lines 

- Substitutes Fields in Line Items 

36.2.4.1.5.3.6 BAdI: Define Grouping Key 

Use 

Using this Business Add-In (BAdI), you can assign any FM account assignment to a group of FM account 

assignments, which can be identified by a grouping key. If an active implementation exists, the system 

ensures that: 

- posting and budget addresses belong to the same group 

- in AVC the grouping keys of budget addresses and the corresponding control objects are identical 

- in the case of residual carryforward, the grouping key of the sender FM account assignment is the 

same as that of the receiver FM account assignment 

- the mass transfer of residual budget supports only one grouping key for all referenced sender FM 

account assignments and one for the receiver FM account assignments. 

Example 

In your FM area, the multi-year budget execution has been activated. The budget ID has been coded into 

the fund data, so that each fund is uniquely assigned to  a budget ID. You need to ensure the following: 

- Every posting object and the corresponding budget object must be assigned to the same budget ID. 
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- In availability control, the control object and the corresponding budget objects must have the same 

budget ID. 

You do this by creating an implementation of this BAdI, which returns the budget ID as the grouping key 

for each FM account assignment. 

Requirements 

In order to use the grouping key for multi-year budget execution, you must first activate period-based 

encumbrance tracking (PBET) in the IMG activity Override Update Profile. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.2.4.1.5.3.7 BAdI: Enhance Reassignment Rules 

Use 
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With this Business Add-In you can enhance FM account reassignment rules in BCS transactions when 

you are: 

- Copying planned / budget data 

- Transferring budget data 

- Carrying over budget data to another year 

- Transferring CO planning data to BCS 

On the target/ receiver side, you can use this Business Add-In to: 

- Split budget among different FM account assignments 

- Split budget using a specific distribution key, shift budget according to a period shift or aggregate 

budget using a specific period 

- Revaluate budget using a percentage value 

- Change budget amounts in the transaction and FM area currency 

Standard settings 

SAP does not provide any default settings. 

Activities 

This is a single-use BAdI, meaning that only one implementation can be activated. This BAdI is filtered 

by applications. Please note that reassignment rules can only be integrated in the following applications: 

- Copy planning data (COPY) 

- Carry over residual budget data (COVR) 

- Freeze budget data (FREEZE) 

- Generate budget data (LOAD) 

- Generate budget data from CO planning data (LOAD-CO) 

- Transfer budget data (MASS-TRANS) 

After you have defined your reassignment rules, you should implement the BAdI applying the following 

steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and 

Composite Enhancement Implementation. If no Composite exists, create a new one by 

choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 
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4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Further notes 

For further information on the method, see: 

Enhance Reassignment Rules 

36.2.4.1.5.3.8 BAdI: Enhance Plan Data Transfer from CO 

Use 

With this Business Add-In you can overwrite the target budget type using CO planning data when you 

transfer the CO planning data to BCS  with transaction FMCYCOPI_CO. 

Standard settings 

SAP does not provide any default settings. 

Activities 

After you have defined your reassignment rules, you should implement the BAdI applying the following 

steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 
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8. Save and activate all the objects. 

Example 

Here is an example: 

*Primary cost planning 

IF I_S_COSP-VRGNG EQ 'RKP1'. 

MOVE 'CAT1' TO  C_TBUDTYPE 

*Revenue element planning 

ELSEIF I_S_COSP-VRGNG EQ 'RKP5'. 

MOVE 'CAT2' TO  C_TBUDTYPE ENDIF. 

36.2.4.1.5.3.9 BAdI: Enhance Report Writer Implementation 

Use 

This BAdI is used to enhance the Report Writer implementation of table FMRBCS. 

Method GET_TEXT is used to supply texts for field values that are not provided by the system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 
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6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.2.4.1.5.3.10 BAdI: Enhance Cover Groups/Cover Rules 

Title 

Business Add-In: Enhancements for Cover Groups (Cover Eligibility Rules) 

Use 

With this Business Add-In you can implement specific checks for new or modified cover groups. 

Requirements 

You have activated cover eligibility functions in Customizing. 

Standard settings 

SAP delivers a default BAdI implementation, which is implemented by the class 

CL_FMCE_COVER_GROUP_DEFAULT, and which performs the following checks in method 

CHECK_COVER_GROUP: 

- All budget addresses of a cover group are assigned to the same value of the account assignment 

element   Fund. 

- The commitment items of all budget addresses have the same value of the master data attribute  

commitment item type. However, if you do not use this attribute in the commitment item master 

data, then this check will not have any effect. 

If you do not want to carry out these default checks or if you want to implement other checks, you can 

overwrite this default implementation with your own BAdI implementation. 

If you are copying cover groups, you can change the number or short text of the target cover group by 

implementing the method COPY_COVER_GROUP. 

If you are balancing automatic cover groups, you can change the sequence of budget senders and budget 

receivers by implementing methods:  

SORT_BUD_SENDER  
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SORT_BUD_RECEIVER 

Activities 

Create your BAdI implementation by applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Further notes 

For further information see: 

- Documentation for the BAdI method CHECK_COVER_GROUP 

- Documentation for the BAdI method COPY_COVER_GROUP 

- Documentation for the BAdI method SORT_BUD_SENDER 

- Documentation for the BAdI method SORT_BUD_RECEIVER 

36.2.4.1.5.3.11 BAdI: Check for New or Changed RIB Rules 

Title 

Business Add-In: Enhancements for Rules for Revenues Increasing the Budget (RIB) 

Use 

With this Business Add-In, you can implement specific checks for new or modified rules for Revenues 

Increasing the Budget (RIB). 
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Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

Implement this BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

You want to check that all budget addresses receiving budget from a single RIB rule are assigned the 

same value from the account assignment element Fund. 

See the example implementation of this BAdI, which is implemented by the class 

CL_FMRB_RIB_SAMPLE. 

Further notes 

For further information see: 

- Documentation for the BAdI method CHECK_RULE 

36.2.4.1.5.3.12 BAdI: Enhance Key Figures 

Title 

Enhance Key Figures 
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Use 

With this Business Add-In you can: 

- Check before evaluation whether a key figure has to be evaluated or not 

- The corresponding methods are called from the key figure evaluation of the Budget Control System 

(BCS). 

Requirements 

SAP offers a default implementation for GLA customers. For further information, see Default 

implementation for Total Cost. 

Activities 

This is a single-use BAdI, meaning that only one implementation can be activated using a filter which is a 

key figure name. 

You implement the BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.2.4.1.5.3.13 BAdI: Activate CO-PA Enhancements 

Use 

This BAdI enables you to activate enhancements of the CO-PA derivation tool for all the derivation 

strategies used in BCS Budgeting and Availability Control (AVC), starting with Rel. ECC 5.0, Public 

Services EA_PS 500. 
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Standard settings 

No standard implementation is delivered by SAP. You must create your own implementation to activate 

the CO-PA  enhancements that you want to use. 

Activities 

Method ACTIVATE_CHANGE_DOC: if you set the flag as active, any changes in a given derivation 

strategy, including the sequence of the rules and their attributes, will be recorded in the change 

document. Example 

36.2.4.1.5.3.14 BAdI: Enhance Copy Process for Budget Entry Documents 

Use 

With this Business Add-In you can manage budget documents lists for the Budget Entry Document 

Copying process. 

You can add or delete budget entry documents from this list. 

The corresponding methods are called in the Copy Budget Documents program. 

Requirements 

Standard settings 

SAP delivers an active implementation which will exclude some kind of documents like carry over / 

Revenues Increasing Budget /  Balance CE document. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 
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7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. Example 

36.2.4.2 Availability Control 

In this step you define the availability control settings for the Budget Control System (BCS). 

You can find more information on activating the availability control under Prepare Activation of 

Availability Control. 

36.2.4.2.1 Prepare Activation of Availability Control 

Availability Control of  Budget Control System (BCS) 

Active availability control works with ledgers on the summarization and saving of the overall 

consumable budget and amounts already assigned as consumed amounts. 

Each Availability Control Ledger requires entries of two Data Sources in order to match the summarized 

values. 

In IMG activity  Check Standard Customizing of Availability Control , you ensure that all necessary 

standard Customizing settings that SAP delivers and those you require for the IMG activities of this 

section are available. 

In the IMG activity  Activate/Deactivate Some AVC Messages for Applications, you define which 

posting activities trigger AVC error messages and for which activities messages are suppressed. 

In the IMG activity Edit Tolerance Profiles, you define a tolerance profile which allows you group 

together tolerance limits of availability control for different activity groups. You maintain these in the 

IMG activity Edit Activity Groups. 

In IMG activity  Define AVC Filter Settings for Budget Values, you determine which budget values of 

BCS budgeting are relevant for availability control. 

In the IMG activity  Define Derivation Strategy for Control Objects, you define strategies which you can 

use to define on which account assignment of the ledger (Control Object) a posting activity is 

summarized. 

In the IMG activity   Assign Tolerance Profiles and Strategy for Control Objects, you have to assign a 

tolerance profile to the AVC ledgers and to your FM area. You can also assign a derivation strategy for 

overriding this tolerance profile and for AVC objects. 

You have to activate a ledger before you can update the AVC values and carry out availability control 

checks. Different Activation Levels are available for the Activation of the Availability Control. 

Recommendation 

Execute the availability control Customizing settings in the same order as the individual IMG activities 

appear in the structure. 
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36.2.4.2.2 Check Standard Customizing of Availability Control 

Use 

In this IMG activity check whether the standard Customizing delivered by SAP required for activating 

availability control exists in the current client. 

The missing setting can be transferred from client 000 if required. 

Note 

Missing Customizing Settings are not automatically transferred to a transport request. Therefore, it is 

recommended that you also execute this IMG activity in your target system or in your target client. 

36.2.4.2.3 Activate/Deactivate Some AVC Messages for Applications 

Use 

In this IMG activity, you can selectively deactivate availability control (AVC) messages for certain 

Applications of BCS Budgeting. 

Note: 

- Even if you deactivate the AVC messages for the applications of BCS budgeting, the Funds 

Management update of posting data for this area still takes place using the control objects of the 

AVC. You cannot deactivate the AVC here. 

- With the deactivation, you suppress only the messages that are triggered by AVC because of a 

budget overrun, which are issued by the system during posting. Messages that are not suppressed 

are those related to incorrect functions (for example, incorrect Customizing settings). You cannot 

deactivate these messages - they will still be issued. 

Standard settings 

By default, the AVC messages are already activated for a number applications of BCS budgeting. 

You should not deactivate the applications activated by SAP. 

Activities 

If necessary, activate or deactivate the AVC messages selectively for individual applications by setting 

or deleting the AVC active indicator. Example 

36.2.4.2.4 Activity Groups 
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In this section you define the activity group settings for availability control for the Budget Control System 

(BCS). 

In the following IMG activities you can define your own activity groups in addition to the 

activity groups delivered by SAP and enhance or change the derivation rules delivered by SAP. You can 

define a tolerance limit for each activity group in IMG activity Edit Tolerance Profiles. 

Example 

You want to divide all posting activities of the Funds Managment update into two new activity groups: 

To do this, define an activity group for commitment postings and one for actual postings in IMG activity 

Edit Activity Group. 

Then assign all the relevant posting activities to the two activity groups in IMG activity Edit Derivation 

Strategy for Activity Groups. 

36.2.4.2.4.1 Edit Activity Groups 

In this IMG activity you can display the activity groups delivered by SAP and create your own activity 

groups. 

Recommendation 

Avoid changing or deleting the activity groups delivered by SAP. 

Activities 

1. Select New Entries and define the key and name of the activity groups. 

2. Save your entries. 

36.2.4.2.4.2 Edit Derivation Strategy for Activity Groups 

Use 

In this IMG activity you can adjust the strategy for the activity groups derivation delivered by SAP. 

The activity groups are derived from different parameters; these parameters depend on the application 

you are working with, whether it is CO Activity or Value Types for example. 

The derivation strategy comprises steps that uses one of the following derivation methods: 

- Move 

In a "move" derivation step the activity group is assigned a certain value. 
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- Derivation rule 

In a derivation rule step you assign certain values as input parameters (source field) to an activity 

group as target field. 

All derivation steps can be linked to requirements which must be met so that the derivation step can be 

executed. 

Example 

You wish to derive certain activity groups directly from the CO activity. To do this you create a 

derivation rule step with source field CO Activity and target field Activity Group. Then maintain 

derivation rules for all relevant CO activities. 

Standard settings 

At the moment only the strategy maintenance on the derivation of activity groups is supported for the FM 

update. 

The new FM budgeting activities are not available for strategy maintenance. They are assigned to activity 

groups 90 (posted budget) or 95 (preposted budget). 

36.2.4.2.5 Edit Tolerance Profiles 

Use 

In this IMG activity, you define the tolerance profile for the active availability control in the budgeting of 

Funds Management (FM). 

For each tolerance profile, you define whether you only want to work with percentage usage rates or also 

with maximum permissable absolute differences. If you allow absolute variances as tolerance limits, you 

must assign a currency to the tolerance profile - this currency must match your FM area currency. 

In a tolerance profile you group together the tolerance limits for the different activity groups. You can 

define one or more tolerance limits for each activity group by specifying different usage rates or also 

absolute variances. You also define the check sequence of the different tolerance limits. Assign a message 

type to each of these defined check events. As message type, an error message, a warning, or an 

information can be issued. 

Ceiling Type 

You can use the ceiling type to control whether the availability control should limit expenditures 

(outgoing amounts and/or revenues (incoming amounts) from bottom to top. 

Normally the availability control checks only expenditures (for example, outgoing payments). Under the 

revenues ceiling type, you can also maintain tolerance limits to check revenues (for example, incoming 

payments). 

Usage Type for Tolerance Limits 

If you allow both percentage usage rates and absolute variances in your tolerance profile, you can use 

indicator Usage Type for Tolerance Limits to control whether the tolerance limit is derived only from the 

usage rate or whether the tolerance rate is determined as minimum or maximum value from both values. 
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Event Control 

You can assign an availability control check to each check event. This event is triggered if you post your 

document despite the tolerance limit being overrun. At the moment, you can only send mails from SAP 

office for this. You can define whether the system only sends a mail the first time, the specified tolerance 

limit is exceeded, or whether a mail should be sent  each time the tolerance limit is exceeded when a 

document is checked. 

Deactivating Individual Check Events 

You can exclude individual check events from the active availability control by setting the Inactive 

indicator. 

Procedure for Searching for Matching Entries 

The active availability control proceeds as follows when searching for matching entries: 

a) Determines the tolerance profile to be used 

b) Determines all matching entries (check events with their tolerance limits) of the tolerance 

profile, which fit the activity group 

c) Checks the tolerance limit in inverted sequence of the check events, starting with the highest 

percentage tolerance limit 

d) Determines the action (=message type and if necessary event) when the first of these tolerance 

limits is exceeded. 

e) Suppresses the action found, if the Inactive indicator is set for the entry. 

Note 

Note that all tolerance limits for each activity group must be entered in order of the check events (with 

increasing values). 

Example 

The tolerance limits of the availability control for actual postings (activity group 40) could, for example, 

be defined in a tolerance profile such as this for example: 

Activity Group Sequence Message Type Usage rate 

40 01 Information 70% 

40 02 Warning 85% 

40 03 Error Message 100% 

Standard settings 

If no matching entry is found for a tolerance profile, the checks are carried out according to the following 

standard setting: 

- Ceiling type: expenditures (outgoing amounts) 

- Message type: error message 

- Usage rate: 0% 

- Usage type for tolerance limits: only usage rate 

- Check: active 
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36.2.4.2.6 Settings for Availability Control Ledger 

36.2.4.2.6.1 Maintain Customer-Specific Ledger for Availability Check 

This IMG activity is optional. As far as possible, you should use the AVC ledgers 9H and 9I delivered by 

SAP for AVC checks, and only create new AVC ledgers if they are required for additional checks. 

Use 

In this IMG activity, you maintain the list of availability control ledgers (AVC ledgers). You can define 

new (customer-defined) availability control ledgers, modify some of their attributes, or delete ledgers, 

providing some conditions are fulfilled. 

When creating a new AVC ledger, you can have most of its attributes copied from a reference ledger 

taken as template. The following settings and assignments are copied from the reference ledger: 

- Filter settings for budget values 

- Assignment of tolerance profiles and derivation strategy for control objects 

- Assignment of checking horizon for availability control 

The new ledger and the settings are automatically copied to the IMG activities Define Filter Settings for 

Budget Values, Assign Tolerance Profiles and Derivation Strategy for Control Objects and Select 

Checking Horizon for Availability Control. 

You can change the settings of the new ledger in these IMG activities. You can also modify the 

following ledger settings: 

- For the predefined ledgers 9H and 9I, you can only modify the name (short text) of the ledger. 

- For customer-defined ledgers you can also modify the AVC data sources assigned to the ledger. By 

default,  availability control for BCS is set in such a way that it checks the budget for 

actuals/commitments that have already been posted (Data Source for Consumed Amount) against 

the budget entered in Funds Management (FM) for assigned funds (Data Source for Consumable 

Budget). 

In this IMG activity, you can define a different user-specific AVC ledger by checking one set of 

budget values against another set of budget values. For this, select two budget data sources (one as 

Data Source for Consumed Amount and one as the Data Source for Consumable Budget), instead of 

a single budget data source together with an actuals data source. 

This means that you select another budget category as the Data Source for Consumed Amount, 

instead of a posting ledger. The Data Source for Consumable Budget of each ledger can also be 

modified, but the choice is restricted to budget data sources. For further information, see the 

documentation of the IMG activity Define Filter Settings for Budget Values. 

When deleting a ledger, some checks are performed before deletion to prevent any inconsistency: 

- the deletion of the predefined ledgers 9H and 9I is forbidden. 

- the ledger to be deleted should be empty, that is, no data should be recorded in table FMAVCT for 

this record. 

- the ledger should not be active (see IMG activity Define Activation of Availability Control) 



 

WHATSAPP +255738656506 

 

Note 

The copying of AVC ledgers is only supported within an FM area. The keys of your new ledger are 

entered with the copy process and cannot be changed. 

By default, the activation status of a newly created AVC ledger is set at "not active" . 

Standard settings 

SAP delivers the following AVC ledgers for Funds Management budget categories: 

AVC ledger Budget category 

9H payment budget 

9I commitment budget 

Use these AVC ledgers to carry out the standard checks of the budget in the corresponding budget 

category. 

Activities 

If you want to use a new customer-defined AVC ledger for your FM area, carry out the activities in the 

following order: 

1. Create a new AVC ledger in this IMG activity. 

2. Activate the new AVC ledger by setting the appropriate activation status in the IMG activity Define 

Activation of Availability Control. 

3. Reconstruct availability control in the new AVC ledger using transaction Re-Initialize AVC 

Ledgers. 

36.2.4.2.6.2 Define Filter Settings for Budget Values 

Use 

In this IMG activity, you define which budget values should be included in active availability control. 

You generally define the total consumable budget against which consumable budget (commitment or 

actual values) is checked using the AVC filter settings. You define this in the activity Define the 

Consumable Budget . 

You also have the option of creating your own availability control ledger in which you check budget 

values against the consumable budget instead of consumed amounts. In cases like this, you have to 

maintain the filter settings of the activity Define Budget Values as Consumed Amounts in addition to 

the activity Define Consumable Budget. 

You can set filter values for the following budget attributes: 

- Version: 

If you do not enter a version, the system automatically uses the active budget version, which is 

usually version 000. 

- Selection of Value Type: 
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If you select the value " " (or Budget or Release in Accordance with Fund-Specific Settings), you 

cannot define any filter settings for selecting the value type and the relevant budget types. The 

general Customizing settings apply to the budget type in this case. 

- WF STATUS Combination: 

With the WF-STATUS combination, you define whether only posted budget or also preposted 

budget is included in availability control. If you want to permit preposted budget documents for 

availability control, the security principle applies: preposted budget is only included if it decreases 

the budget. 

Standard settings 

If you do not define any filter settings for a control ledger, the system automatically uses the following 

standard settings: 

- Version = active version 

- Selection of value type = " " 

- WF-STATUS Combination = " " (or posted and preposted budget documents) 

Recommendation 

SAP recommends the following filter settings for the standard control ledgers 9H and 9I: 

- Version = active version 

- Selection of value type = " " 

Further notes 

- If you change the filter settings of an AVC ledger that is already active, you have to Reconstruct 

Availability Control for this ledger. 

You start the reconstruction of availability control from the Funds Management menu under 

Budgeting -> Tools -> Availability Control -> Reconstruct. 

- If you want to define AVC filter settings for budget values in the role of consumed amounts, you 

have to defined your own ledger first in which budget values are checked against consumable 

budget. 

You define your own ledgers in the IMG activity Maintain Customer-Specific Ledger for 

Availability Check. 

- Selecting Budget Types 

You can only select relevant budget types in the AVC filter settings if you have selected the value B 

or budget) for the field Selection of Value Types. If you do not define any settings for selecting 

budget types, all budget types are automatically taken into account by availability control. If you 

only want certain individual budget types to be checked by availability control, you have to 

determine them individually in this IMG activity. The selection applies to all AVC checks in the 

control ledger entered. 

Example 
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You want to flag the budget of version 002and budget types BT01 and BT02 as consumable budget. 

Enter the value 001 for the version and the value B for the Selection of Value Types for the ledger you 

want and for a fiscal year (from fiscal year) (from fiscal year) in the activity Define Consumable 

Budget. 

Then enter the values BT01 and BT02 as permitted budget types in the view Select Budget Types. 

Note that the setting defined applies to all fiscal years after this "from fiscal year" if you do not make any 

other entries for future from years. 

Activities 

1. Enter your FM area, the availability control ledger and "from fiscal year" of the fiscal year. 

2. Define the budget version and choose whether availability control should include preposted budget 

or not. 

3. Determine the selection of the value types and budget types. If you enter the value B, you can 

control the selection of the budget types using AVC settings: 

4. If only individual budget types are relevant for availability control, enter these individually in the 

IMG activity Define Budget Types. 

If you do not enter any individual budget types, all budget types are included automatically. 

5. Save your entries. 

36.2.4.2.6.3 Define Filter Settings for Commitment/Actual Values 

Use 

In this IMG activity, you define the actual and commitment values that should be excluded from active 

availability control. Usually all posting records containing such actual and commitment values that are 

updated to Funds Management in a non-statistical manner define the consumed amount, which AVC 

checks against the consumable budget, as defined in the previous IMG activity Define Filter Settings for 

Budget Values. For particular purposes or for checks in special customer-defined control ledgers, you 

may, however, want to exclude certain FM value types from availability control. 

Example 

You want to check "soft" commitments, such as purchase requisitions and funds reservations, by using 

tolerance limits or budget values defining the consumable budget, which differ from the values used for 

checking actuals or other "hard" commitments. In this case, you must set up two control ledgers: 

- Standard ledger (for example, 9H): Define posting filter settings that exclude all "soft" commitments 

according to your definition. Then assign normal tolerance profiles (for example, with error at usage 

rate 100%) and define filter settings for budget values as usual. 

- Customer-defined ledger for "soft" checks: Do not define any posting filter settings, but assign 

tolerance profiles with "soft" limits (for example, warning at usage rate 100%) or define filter 

settings for budget values that result in higher amounts available in the consumable budget. 

Requirements 
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- As far as possible, exclude only the value types that are at the start of a commitment chain (for 

example,  purchase requisitions, funds reservations, purchase orders and so on), but not cash-

relevant value types, such as invoices or payments. 

- When excluding a given value type, you must also exclude all other value types of earlier steps in 

the commitment chain. Example: If you exclude funds precommitments, then you must at least 

exclude funds reservations, too. 

- Note that you must set the GR/IR update indicator for the value MM invoice receipt in the 

Customizing settings of your FM update profile (transaction OFUP), if you exclude value type 60 

(parked documents), but not value type 54 (invoices). 

Standard settings 

If you do not define any settings here, then availability control considers all non-statistical posting records 

as relevant for budget consumption. 

Further notes 

If you change the filter settings of an AVC ledger that is already active, then you have to "reinitialize" or 

Reconstruct Availability Control for this ledger (transaction FMAVCREINIT). 

You start the reconstruction of availability control from the Funds Management menu under Budgeting -

> Budget Control System (BCS) -> Tools -> Availability Control -> Reconstruct. 

Activities 

1. Enter filter settings for your FM area and for all relevant availability control ledgers. 

2. Specify from which fiscal year onwards the filter settings apply. 

3. For each new entry, enter all the FM value types to be excluded from availability control. 

4. Save your entries. 

36.2.4.2.6.4 Define Derivation Strategy for Control Objects 

Use 

In this IMG activity, you can define your own strategies for deriving Funds Management account 

assignments (FM account assignments) for availability control. 

Each FM account assignment in which you create budget or to which you post budget consumption is 

assigned an account assignment in the availability control ledger. In this IMG activity, you define the 

logic on how the account assignments of the availability control ledger (availability control object) should 

derive the budget addresses and posting addresses. 

One and two-step derivation of control object 

The derivation strategy that you define in this IMG activity controls the assignment of the control object 

to one or more budget addresses. For a budget posting, the corresponding control object is determined on 

the basis of this derivation strategy. Budget postings are updated in the AVC in a single step. In 
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comparison, actual/commitment postings are updated in two steps in the AVC, using two consecutive 

derivation strategies. First the corresponding budget address is determined from the posting address - this 

occurs with the derivation strategy of the budget structure (IMG activity Define Derivation Strategy for 

Budget Addresses). The control object is then derived from the respective budget address in the same way 

as the budget posting. 

The derivation strategy for availability control objects consists of a sequence of steps that uses one of the 

following derivation step types: 

- Clear 

In the "clear" derivation step type, you can define whether you want to exclude individual FM 

account assignment elements from the availability control ledger. 

- Move 

In the "move" derivation step type, you can determine whether the values for the individual FM 

account assignment elements of your postings should be carried forward partially or in full to the 

account assignment elements of the ledger. 

- Derivation rule 

In the "derivation rule" step, you can directly enter the assignment of the FM account assignments 

of your postings to the ledger account assignments. 

- Table Lookup 

In the step "table access", you can access individual records from database tables. 

- Function Module 

In the step "function module", you can call function modules that allow you to search for account 

assignment elements in master data hierarchies or to determine master data attributes, for example. 

All derivation steps defined here can be linked to requirements which must be met before the derivation 

step can be executed. 

Example 

You want to aggregate the budget for consumed amounts in the AVC ledger in the following way when 

entering budget values: 

Posting to account assignments Acct assgmts in AVC ledger 

Fund/Funds center/Commitment item item 

Move 

Fund/Funds center/Commitment 

FND1/FC1/CI1 -> FND1/FC1/CI 

FND1/FC1/CI2 -> FND1/FC1/CI 

FND1/FC1/CI3 -> FND1/FC1/CI 

A possible derivation strategy in this case consists of three derivation steps which carry forward the 

values of the account assignment elements one after the other to the relevant account assignment elements 

in the ledger, the fund and funds center being carried forward in full, whereas only the first five 

characters of the commitment item are carried forward. 

Requirements 
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The example makes clear  that a suitable technical name is required for the FM account assignments when 

you use "move" steps for this type of summarization. 

If you use descriptive names for your FM account assignments, there are function module steps available 

that carry out an evaluation during the derivation of master data hierarchies. 

Standard settings 

SAP provides standard strategy 9HSAP000, which contains examples of how to use different step types. 

Note 

If you do not need a summarization of budget values in one of your availability control ledgers, that is, if 

all control objects in this ledger match the Funds Management budget objects, then it is not necessary to 

to define your own strategy. In this case, leave the field Strategy for Derivation of Control Objects blank 

in the IMG activity Assign Tolerance Profiles and Strategy for Control Objects. 

Recommendation 

1. Create your own strategy by copying the strategy 9HSAP000 delivered by SAP. 

2. Edit your strategy by adding more derivation steps. 

3. Save your strategy. 

Further notes 

If you change a strategy that is used by already active AVC ledgers, you must execute Re-Initialize 

Availability Control Ledgers (FM)  for all these ledgers. 

You start the reconstruction of availability control from the Funds Management menu under Budgeting -

> Tools -> Availability Control -> Reconstruction. 

36.2.4.2.6.5 Define Derivation Strategy for Tolerance Profiles 

Use 

In this IMG activity you define the derivation rules with which you can replace the standard tolerance 

profile by an alternative tolerance profile. 

You normally assign a standard tolerance profile to the availability control ledger for each fiscal year and 

FM area. This defines the tolerance limits for all postings. 

If you want to make the tolerance limits valid for postings to certain FM account assignments or users, 

you can define a derivation rule which derives an overriding tolerance profile with different tolerance 

limits for the relevant FM account assignments. 

A strategy includes successive steps that uses one of the following derivation step types: 

- Clear 

In the "clear" derivation step type, you can reset the value of the tolerance profile or of other 

available target fields to blank or zero. 
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- Move 

In the "move" derivation step type, you can assign particular values to the overriding tolerance 

profile or other available target fields. 

- Derivation Rule 

In the "derivation rule" derivation step type, you can, for example, assign your tolerance profile to 

certain values of FM account assignment elements of the availability control ledger or the name of 

the user. 

- Table Lookup 

In the "table lookup" derivation step type, you can access individual records from the database table. 

- Function Module 

In the "function module" step type, a function module is called when the derivation step is executed. 

In this way, the target fields you specified will be filled with values. 

You can assign additional conditions to all derivation steps which must be fulfilled before the 

derivation step can be carried out. 

Further notes 

If you work with cover eligibility rules, the system usually calls the derivation strategy twice: 

1. Once for AVC at the budget address level which is assigned to an automatic Cover Group 

(= control object first level) and 

2. Again during the check at the cover group level (=control object second level). 

You can differentiate between the two check levels using source field TYPE_CONTROL_OBJECT in 

the derivation strategy: 

- The value TYPE_CONTROL_OBJECT is "X": The derivation strategy is called for a budget 

address with automatic cover eligibility. In this case, you have the budget address in source fields 

CG_FUND, CG_FUNDSCTR, CG_CMMTITEM, ... and the automatically assigned cover 

group in source field RCVRGRP_9. 

- The value TYPE_CONTROL_OBJECT is " ": The derivation strategy is called either for a 

normal control object (in other words, for an FM account assignment with no reference to a rule for 

automatic cover eligibility) or for an automatic cover group (control object second level). In this 

case, the control object is either in the usual source fields RFUND, RFUNDSCTR, 

RCMMTITEM, or, if a rule exists for automatic cover eligibility, in the source field 

RCVRGRP_9. Source fields CG_FUND, CG_FUNDSCTR, CG_CMMTITEM, remain empty. 

Example 

You want to use tolerance limits that are different from the standard tolerance profiles for postings that 

are summarized to a certain account assignment of availability control ledger 9H. You use tolerance 

profile 1000 as the standard tolerance profile for ledger 9H 

You define different tolerance limits for certain ledger account assignments of the AVC tolerance profile 

by using other tolerance profiles. You define a strategy for this, which executes the following 

assignment steps: 
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Fund/Funds center/Commitment item Tolerance profile 

Assignment 

FND1/FC1/CI   -> 1001 

FND1/FC2/CI   -> 1002 

FND1/FC3/CI   -> 1003 

According to the strategy defined, for postings that are summarized on the FM account assignment 

FND1/FC1/CI of the ledger 9H, the tolerance limits of the tolerance profile 1001 are valid. The tolerance 

limits of standard tolerance profile  1000  are overridden. 

Requirements 

You have defined tolerance profiles with different tolerance limits in IMG activity Edit Tolerance 

Profiles. 

Standard settings 

Availability control will work with the standard tolerance profile of the ledger, in case the derivation rule 

does not find an alternative tolerance profile. 

Activities 

1. Create a strategy for your tolerance profile by copying the strategy delivered by SAP. 

2. Maintain your strategy by including further derivation steps in your strategy if necessary. 

3. Save your strategy. 

36.2.4.2.6.6 Assign Tolerance Profiles and Strategy for Control Objects 

Use 

In this IMG activity you define the derivation of availability control objects and the assignment of the 

tolerance profile for each availability control ledger. 

You define these attributes for each FM area, ledger and fiscal year (from fiscal year). Derivation and 

summarization of FM postings to availability control objects 

If you want to define your own derivation strategy for deriving FM account assignments to the 

availability control ledgers, you assign this in the field Strategy for Deriving Control Objects. 

If you do not enter a strategy, the account assignment of the availability control object is always identical 

to the posting or budget address that is either assigned as the FM account assignment of a budget 

transaction or that is derived from the posting address of a posting transaction (possibly with the 

exception of the value of the account assignment element "grant"). 

Note on deriving the FM account assignment element "grant" 

If you use the FM account assignment element "grant" in your organization, note that the value of this 

account assignment element  is not defined by the strategy for account assignment derivation. You define 
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the value of the grant in the field Defining the grant in control objects. You can select one of the 

following settings: 

a) The value of the grant is always taken from the budget address 

b) All grants are summarized; that is, the grant is always set to zero or blank in control objects. 

Assigning and overriding the standard tolerance profile 

You must assign a standard profile to the availability control ledger by entering a profile in the field 

Tolerance Profile. If you do not make an entry in the field Strategy for deriving a tolerance profile 

the tolerance limits of this profile are used for all postings. 

However, if you want to use different tolerance limits for particular posting activities, you can override 

the tolerance limits defined in the standard tolerance profile by assigning one of the strategies you defined 

for determining a tolerance profile to be overridden in the field Strategy for deriving a tolerance 

profile. 

Example 

You want to maintain attributes for the ledger 9H and for the fiscal year 2005 and define the following 

entry: 

Ledger fiscal year 

9H 2005 

If you do not make any other entries for the ledger 9H, these attributes apply to all other fiscal years 

from the fiscal year 2005. 

Requirements 

You have already created tolerance profiles and strategies in the following IMG activities: 

- Edit Tolerance Profiles 

- Define Derivation Strategy for Control Objects 

- Define Derivation Strategy for Tolerance Profile 

Recommendation 

Maintain entries for all availability control ledgers that you want to activate. 

Further notes 

If you want to change the account assignment derivation of an AVC ledger that is already active, you 

have to Reconstruct Availability Control for this ledger. 

You start the reconstruction of availability control in the Funds Management menu under Budgeting -> 

Tools -> Availability Control ->  Reconstruct. 

36.2.4.2.6.7 Specify Checking Horizon 
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36.2.4.2.6.7.1 Select Checking Horizon for Availability Control 

In this IMG activity you define how the checking horizon is selected for availability checks in a specified 

control ledger. For this, you can select one of the following values for the field Selection of Checking 

Horizon: 

- " ": The checking horizon is entirely determined by the fund-specific settings in the FM master data 

and cannot be overwritten. 

- "A": The default value Annual Period is used for checks in this control ledger, which means that 

availability control will normally aggregate data over all periods of a fiscal year and thus perform 

checks on annual values. You can overwrite this default value, if you maintain a derivation strategy 

in the IMG activity Define Derivation Strategy for Checking Horizon. 

- "O": The default value Overall Period is used for checks in the selected control ledger, which 

means that availability control will normally aggregate data over all periods of all fiscal years and 

therefore perform checks on overall values. You can overwrite this default value, if you maintain a 

derivation strategy in the IMG activity Define Derivation Strategy for Checking Horizon. 

Standard settings 

If you do not enter a value for a control ledger in your FM area, the system will automatically take the 

value " " as the default value for the field Selection of Checking Horizon. 

Recommendation 

SAP recommends that you assign the value " " to the standard control ledgers 9H and 9I shipped by SAP. 

However, you can also select another value for a customer-defined control ledger that has been created in 

the step Maintain Customer-Specific Ledger for Availability Check. 

Activities 

1. Select your FM area. 

2. Enter values for all relevant control ledgers. 

3. Save your entries. 

36.2.4.2.6.7.2 Define Specific Assignments for Checking Horizon 

In this IMG activity you can define specific assignments for the checking horizon by implementing a 

derivation strategy. This specific assignment overwrites the default value of the checking horizon selected 

in the activity Select Checking Horizon for Availability Control. 

Requirements 

The derivation strategy defined here is not used, if no entry exists for a given control ledger in the activity 

Select Checking Horizon for Availability Control or if you have chosen the value " " for the field 
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Selection of Checking Horizon. In this case the checking horizon is entirely determined by FM master 

data settings. 

Notes 

Each derivation strategy consists of a sequence of steps that uses one of the following step types: 

- Initialization 

In derivation steps of this type, you can set the value of any target field to initial 

BLANK. 

- Assignment 

In steps of step type assignment, you can assign specific values to any target field. You can also 

transfer only part of the field contents of source fields to a target field. 

- Derivation rule 

In derivation rule steps, you can directly enter specific assignments of the checking horizon (for 

instance) to any combination of source fields. 

- Table lookup 

In a step of this step type, you can access individual records from database tables. 

All derivation steps defined here can be linked to conditions, which must be met in order for the 

derivation step to be executed. 

Example 

You have selected checking horizon Overall Period as the default value for control ledger 9H in the 

activity Select Checking Horizon for Availability Control. But for availability checks on control objects 

with certain values of the account assignment element Fund, you can overwrite this default value and use 

the checking horizon Annual period for checks with control ledger 9H. 

Create a derivation step of step type Derivation rule, select Definition and choose as source field the 

field RFUND and as target field the field CHECKHORIZON. Then select Condition and enter the 

following as condition for this derivation rule: 

Name of column Value 

Field ALDNR 

 Op. = 

 Value 9H 

After saving this new derivation step, you maintain rule entries for all desired fund values. 

Standard settings 

SAP does not provide any implementation of the derivation strategy. 

Recommendation 

Since SAP recommends that you choose the value " " of the field Selection of Checking Horizon in the 

activity Select Checking Horizon for Availability Control for the standard control ledgers 9H and 9I, the 

derivation strategy is usually only relevant for customer-defined control ledgers that have been created in 

the step  Maintain Customer-Specific Ledger for Availability Check. 
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Activities 

1. Implement your derivation strategy. 

2. Save your strategy. 

36.2.4.2.7 Define Activation of Availability Control 

Use 

In this IMG activity, you activate availability control by assigning an activity status for each ledger and 

fiscal year (from year). You can choose between five activation statuses for each availability control 

ledger: 

- Ledger not active 

Posting values (including budget values) are not updated in the availability control ledger and no 

availability control takes place. 

- Active without availability checks 

Posting values are updated in the availability control ledger. No availability control takes place. 

- Active with usual check logic 

Posting values are updated in the availability control ledger. The usual availability control takes 

place. In the usual availability control, the error messages of AVC checks are always issued as 

warning messages if the available amount (= difference between the consumable budget and 

consumed amounts) is not reduced by the posting activity for each availability control object. 

- Active with soft check logic 

Posting values are updated in the availability control ledger and an availability control check is 

carried out. During this check, the system stops all AVC messages if the available amount for the 

availability control object is not reduced by the posting. 

- Active with strict check logic for document chains 

Posting values are updated in the availability control ledger. The usual availability control takes 

place, except for document chains. Strict availability control applies to document chains. This 

means that each document of a document chain is checked again and can be rejected by an error 

message of the availability control, even if the new document does not contain any additional 

budget consumption. 

This means, for example, that the posting of an invoice must always undergo this strict check again 

even though availability control has already taken place for the commitment of the corresponding 

purchase order. 

- Active with strict check logic 

Posting values are updated in the availability ledger. All postings undergo the strict check logic. 

This strict check logic can also stop postings if the available amount of a control object is increased. 

This activation is only used in special situations. 

SAP recommends that you use the normal check logic or the check logic with strict check for document 

chains. 
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Note 

In this activity you can also define whether you want to exclude revenue items from the availability 

control in the chosen Availability Control Ledger. Set indicator Ignore Revenue Items for this. In this 

case, budget values and commitment/actual values of revenue account assignments are neither checked 

nor updated in the availability control ledger. 

Example 

You want to use the ledger 9H from the year 2002 without checks and only update values first. You want 

to use the ledger with availability checks from the fiscal year 2003. 

You define the following settings for this: 

Ledger FYear Status of AVC 

9H 

control 

2002 Active without availability 

9H 

logic 

2003 Active with normal check 

Example of check logic for document chains 

You selected the setting Active with strict check logic for document chains. The following tolerance 

limits are set in the tolerance profile for postings of the document chain purchase requisition -> purchase 

order -> invoice: 

Activity group Tolerance limit Message type 

20 (purchase requisition) 120 % warning 

30 (purchase order) 110 % warning 

40 (invoice) 100 % errors 

You create a purchase order of 230 that follows a corresponding purchase order and invoice with the 

same amount. The current consumable budget of the control object remains constant at 200 for all 3 

postings. If the strict check logic for document chains is active, the system acts in the following way 

(example): 

- The purchase order can be posted without a message ( the tolerance limit set is only exceeded by 

amounts >240) 

- The purchase order can also be posted, but the system issues a warning (the tolerance limit is 

exceeded by amounts >220) 

- The invoice posting cannot be posted, the system issues an error message (the tolerance limit is 

exceeded by amounts  >200) 

In the usual check logic, the availability control would not reject the invoice posting in the last step 

because the invoice does not contain any additional budget consumption against the purchase order 

(the consumable amount on the affected control object stays the same) and because of this only a 

warning is issued instead of an error message. 

Requirements 

You can only assign an activation status to an availability control ledger (and activate it) if you have 

defined all the settings required in the availability control IMG activities. 
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Activities 

1. Select an availability control ledger you want to use and a "from fiscal year" as well as an 

activation status for it. 

2. Save your entries. 

Further notes 

Note that activating several AVC ledgers when using parallel availability controls influences 

performance. You should therefore not activate more than 3-4 AVC ledgers. 

Carry out the Reconstruction of Availability Control after you have activated your AVC ledger. 

You start the reconstruction of availability control in the Funds Management menu under Budgeting -> 

Tools -> Availability Control -> Reconstruct. 

36.2.4.2.8 Other Settings for Availability Control 

36.2.4.2.8.1 Define Multi-Annual Budgeting 

Use 

This IMG activity is relevant for Spanish customers but may be of interest for other customers who want 

to automatically run availability control for commitments taking effect only in the future. 

In this IMG activity, you customize the budget option and the time horizon for percentages per FM area 

and budget category, in order to be able to carry out multi-annual budgeting, that is, budgeting for several 

years. 

Furthermore per availability control ledger, you assign standard percentages to be used for the years of 

cash effectivity within the time horizon defined. 

Note 

If you are using BCS Cover Eligibility, note that the percentages defined at the beginning of a fiscal year 

are independent of cover groups. The percentages defined here are valid for all cover groups.  If - during 

the course of a fiscal year - the percentages defined must be changed for a particular cover group, you 

can change them by making entries in the view "Assign Percentages for YCE to Cover Groups". You do 

this in transaction FMMACGPERC. 

Using transaction FMAVCREINIT,  you must subsequently reconstruct the Availability Control Ledger 

for the cover group for which you changed the percentages, if this cover group already contains budget or 

posting data. 

Requirements 

The folllowing prerequisites apply: 

- The fields customized by this IMG activity are only used by the sample coding of the 

following Business Add-Ins: 

- FMAVC_ADD_LINES 
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- FMAVC_ENTRY_FILTER 

- FMKU_BUDGET_EVNT 

This means that you must create your implementation for these Business Add Ins by copying the 

sample coding. 

- The year of cash effectivity has been customized in the IMG activity Choose Budget Category 

for the FM area and budget category in question. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

In order to customize multi-annual budgeting in BCS, proceed as follows: 

1. Enter the FM area. 

2. Enter the budget category and assign the budget option and the time horizon for percentages. 

3. Select the line and assign the percentages for the years of cash effectivity to be used within the time 

horizon. 

4. Save your entries. 

Note 

The maximum value for the time horizon for percentages is 20. 

36.2.4.2.8.2 Commitment/Actual Values: Define Filter for Revenue-Based 

Expenditures 

Use 

This IMG activity is relevant for Spanish customers but may be of interest for other customers who want 

to perform a further availability control check, in which FM commitment/actual documents consuming 

expenditure budget are checked against  FM commitment/actual documents consuming revenue budget. 

This process is known as "revenue-based expenditure control (RBE)". In this way,  FM execution 

documents consuming expenditure budget can be posted only if FM execution documents consuming 

revenue budget were previously posted with a sufficient amount. 

Note 

The commitment item category, which is maintained in the commitment item master record, is used in 

order to distinguish FM documents consuming revenue budget from those consuming expenditure budget. 

In this IMG activity, you define the AVC filters for commitment/actual values for revenue-based 

expenditures. AVC filters combine value types with the corresponding filter types. You must specify 

whether the filter should be used for revenue operations or for expenditure operations. 
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You must also maintain the second IMG activity where you define the settings for revenue-based 

expenditure control and assign them to an availability control ledger. An example of an RBE control 

scenario is provided in the documentation of this second IMG activity. 

Requirements 

The fields customized by this IMG activity are only used by the sample coding of the Business Add-In 

FMAVC_ENTRY_FILTER, Enhance Filter Settings for Availability Control, and from the IMG activity 

"Assign settings for RBE to control ledger". 

This means that you must create your implementation for these Business Add-Ins by copying the sample 

coding. 

Furthermore, you must: 

- Define a customer availability control ledger to be used for revenue-based expenditure 

control. 

- Define a derivation strategy for availability control objects, where you aggregate all budget 

addresses at the fund level.  In this way, RBE is performed at the fund level of the control objects. 

- Define a tolerance profile, where the tolerance limits are inactive. 

- Define a derivation strategy for the tolerance profiles, where you assign the previous tolerance 

profile to all fund types which are not RBE-relevant. Assign the standard tolerance profile to the 

fund type used in RBE. 

- Assign the derivation strategies for control objects and tolerance profile to the RBE customer-

specific availability control objects. 

- Activate the AVC for your control ledger. 

Standard settings 

SAP delivers the following six standard filters: 

- 01 "Funds Reservation" is a filter for expenditure operations and filters all FM earmarked funds, 

invoices and payments consuming expenditure budget for the AVC ledger for RBE. 

- 02 "Funds Precommitment" is a filter for expenditure operations and filters all FM earmarked funds 

starting from the precommitment level, invoices and payments consuming expenditure budget for 

the AVC ledger for RBE. Note: If you use this filter in your settings, funds reservations will not be 

checked. 

- 03 "Funds Commitment" is a filter for expenditure operations and filters all FM earmarked funds 

starting from the commitment level, invoices and payments consuming expenditure budget for the 

AVC ledger for RBE. Funds reservations and precommitments are not checked using this filter. 

- 04 "Forecast of Revenue" is a filter for revenue operations and  filters all forecasts of revenues,  

invoices and payments consuming revenue budget for the AVC ledger for RBE. 
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- 05 "Invoice" is a filter which can be used for revenue or expenditure operations and filters all  

invoices and payments for the AVC ledger for RBE. Earmarked funds are not checked using this 

filter. 

- 06 "Payment" is a filter which can be used for revenue or expenditure operations and filters all  

payments for the AVC ledger for RBE. Earmarked funds and invoices are not checked using this 

filter. 

Note 

You cannot use this filter if payments are updated in Funds Management via program RFFMS200, 

because this program does not access the BCS availability control functions. 

Activities 

You can use the standard filters. If not, proceed as follows: 

1. Enter your filter choosing the key from the permitted namespace. 

2. Assign the filter type, which can be "Revenue", "Expenditure" or "Revenue and Expenditure". 

3. Select the corresponding line and assign the value types involved. 

4. Save your entries. 

36.2.4.2.8.3 Assign Revenue-Based Expenditure Settings to Availability Control 

Ledger 

Use 

This IMG activity is relevant for Spanish customers but may be of interest for other customers who want 

to perform a further availability control check, in which FM commitment/actual documents consuming 

expenditure budget are checked against FM commitment/actual documents consuming revenue budget. 

This process is known as revenue-based expenditure control (RBE). 

In this way,  FM execution documents consuming expenditure budget can be posted only if FM execution 

documents consuming revenue budget were previously posted. 

Note 

The commitment item category, which is maintained in the commitment item master record, is used in 

order to distinguish FM documents consuming revenue budget from those consuming expenditure budget. 

In this IMG activity you make specific settings for revenue-based expenditures and assign them to an 

availability control ledger. 

Requirements 

See the prerequisites for the IMG activity: Commitment/Actual Values: Define Filter for Revenue-Based 

Expenditures 

Standard settings 
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SAP does not deliver any standard settings. 

Activities 

In order to maintain the settings for RBE,  proceed as follows: 

1. Enter an FM area and the availability control ledger. 

2. Enter a combination of "From Fiscal Year" and "Fund Type". 

3. Assign the filters for your revenue and expenditure operations to a combination of "From Fiscal 

Year" and "Fund Type".  Here, you can only use the filters you defined in the IMG activity 

Commitment/Actual Values: Define Filter for Revenue-Based Expenditures. 

4. Save your entries. 

Example 

You want to use the filter "02 - Funds-Precommitments" as a filter for expenditure operations and "05 - 

Invoices" as a filter for revenue operations. These settings are valid for a given fund type and fiscal year. 

This means that all earmarked funds (with the exception of funds reservations), invoices and payments 

(however, note that in this case you cannot carry out the update of payments via RFFMS200) consuming 

expenditure budget are checked against invoices and payments consuming revenue budget. The following 

will result from this: 

- The check is now carried out at the fund level, for the funds whose fund type is used by RBE. This 

means that the postings can have different posting addresses, but however have the same fund. 

- If you post a forecast of revenue, this will not be checked and filtered in the AVC ledger for RBE. 

You now post an invoice consuming revenue budget of 100 Euro. This means that you can post funds 

precommitments, commitments, invoices and payment (see above exception) up to 100 Euros. A funds 

reservation can be posted because it will not be checked and will not consume the 100 Euros. 

36.2.4.2.8.4 Enhance Availability Control for Changes in HR 

Use 

Organizational changes in HR (Position Budgeting and Control (PBC)) frequently demand additional 

budget during a certain period of time - for example, until the HR changes are settled by retroactive 

payroll calculations. However, such HR changes may be rejected by availability control if insufficient 

budget is available to cover both them and the corresponding changes in earmarked funds documents. In 

such situations, you are forced to increase the budget temporarily before you can perform the 

organizational changes. 

To avoid such unnecessary budget changes, you can now implement a Business Add-In (BAdI) (method 

POSTING_FILTER of the BAdI FMAVC_ENTRY_FILTER) to filter out additional budget requests 

arising from HR changes. Such additional budget requests are characterized by the FM amount type 0500 

and the new CO business transaction values HRM1 and HRM2. 
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You can use the sample BAdI implementation FMAVC_ENTRY_FILTER_SMPL_HRPBC as a template 

for your own implementation. 

Note 

You may also need to adjust your reporting to filter out actual data correspondingly - for example, by 

adjusting the definition of your Key Figures in BCS. 

36.2.4.2.9 Business Add-Ins for Availability Control (BAdIs) 

36.2.4.2.9.1 BAdI: Add Additional Lines for Availability Control Checks 

Use 

Using this Business Add-In (BAdI), you can add further lines to the availability control ledger. 

Requirements 

Availability Control has been activated in the Budget Control System 

Standard settings 

SAP does not deliver any default settings. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> 
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~ <Name of method> and endmethod. Note that sample implementation is copied 

automatically. 

8. Save and activate all the objects. 

Further notes 

For further information see: 

- Documentation for the BAdI method ADD_BUDGET_LINES 

- Documentation for the BAdI method ADD_POSTING_LINES 

36.2.4.2.9.2 BAdI: Enhance Filter Settings for Availability Control 

Title 

Business Add-In: Enhance Filter Settings for Availability Control 

Use 

With this Business Add-In you can selectively exclude budget records or commitment/actual records from 

availability control checking. You can also modify individual amounts of budget or commitment/actual 

records by creating an availability control ledger. 

Requirements 

The methods of this BAdI are only executed for budget and commitment/actual records that correspond to 

the filter settings made for the availability control ledger in question, as defined in the Customizing 

activities: 

- Define Filter Settings for Budget Values or 

- Define Filter Settings for Commitment/Actual Values. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

Implement this BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 
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1. In the dialog box, enter a name for the enhancement implementation, Short Text and 

Composite Enhancement Implementation. If no Composite exists, create a new one by 

choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

You want to multiply all budget amounts entering a specific availability control ledger by a fixed factor 

(such as 0.90). 

- Implement the method BUDGET_FILTER of the BAdI. For budget records of the selected 

availability control ledger, multiply all fields (LVAL01 etc.) of the changing parameter 

C_S_AVC_VALUES by the fixed factor. 

- Save the method and activate your BAdI implementation. 

Further notes 

For further information see: 

- Documentation for the BAdI method BUDGET_FILTER 

- Documentation for the BAdI method POSTING_FILTER 

36.2.4.2.9.3 BAdI: Enhance Account Assignment Derivation for AVC Control 

Objects 

Title 

Business Add-In: Account Assignment Derivation of AVC Ledger 

Use 

With this Business Add-In you can enhance the derivation of availability control objects (strategy 

ID AFMA). It can only be implemented for the Budget Control System (BCS) in Funds 
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Management. The methods of this BAdI are called in function module 

FMAVC_CALL_DERIVATION_ACO, immediately before or after deriving an availability 

control object. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

If you would like to use additional source fields within your derivation strategy, first add these fields to 

the structure FMAVC_S_AFMA_ADDRESS_SUPPL in the ABAP Dictionary. 

Next, implement this BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

You wish to use the field AUGRP (authorization group) of the commitment item master data records as 

an additional source field in your derivation strategy: 

- Add the field AUGRP (data element FM_AUTHGRP) to the include 

CI_FMAVC_S_AFMA_ADDRESS_SUPPL of the structure 

FMAVC_S_AFMA_ADDRESS_SUPPL in the ABAP Dictionary. 

- Activate the structure FMAVC_S_AFMA_ADDRESS_SUPPL. 

- Implement the method FILL_ADDRESS_SUPPL of the BAdI (see also the sample code for this 

method): 

- Read the commitment item master data records, for instance by using the function module 

FM_COM_ITEM_READ_SINGLE_DATA. 
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- Fill the field AUGRP of structure FMAVC_S_AFMA_ADDRESS_SUPPL. 

- Activate your BAdI implementation. 

Further notes 

- Documentation for the BAdI method FILL_ADDRESS_SUPPL 

- Documentation for the BAdI method CHECK_ACO_ADDRESS 

36.2.4.2.9.4 BAdI: Enhance Derivation Strategy for Tolerance Profile of AVC 

Ledger 

Title 

Business Add-In: Derivation of Tolerance Profile for AVC Ledger 

Use 

With this Business Add-In you can enhance the derivation of tolerance profiles (strategy ID 

AFMT). It can only be implemented for Funds Management, component Budget Control System 

(BCS). The methods of this BAdI are called in function module 

FMAVC_CALL_DERIVATION_TOLPROF, immediately before or after a tolerance profile is 

derived. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore, in the standard release, the BAdI is 

not active. 

Activities 

If you wish to use additional source fields within your derivation strategy, add these fields to the structure 

FMAVC_S_AFMT_ACO_ADDRESS_SUPPL in the ABAP Dictionary first. 

Now implement this BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 
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4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

You wish to use the field AUGRP (authorization group) of the commitment item master data records as 

an additional source field in your derivation strategy: 

- Add the field AUGRP (data element FM_AUTHGRP) to the include 

CI_FMAVC_S_AFMT_ACO_ADDR_SUPPL of the structure 

FMAVC_S_AFMT_ACO_ADDRESS_SUPPL in the ABAP Dictionary. 

- Activate the structure FMAVC_S_AFMT_ACO_ADDRESS_SUPPL. 

- Implement the method FILL_ACO_ADDRESS_SUPPL of the BAdI (see also the sample code for 

this method): 

- Read the commitment item master data records, for instance by using the function module 

FM_COM_ITEM_READ_SINGLE_DATA. 

- Fill the field AUGRP of structure FMAVC_S_AFMT_ACO_ADDRESS_SUPPL. 

- Activate your BAdI implementation. 

Further notes 

 Documentation for the BAdI method FILL_ACO_ADDRESS_SUPPL 

36.2.4.2.9.5 BAdI: Define Mail Recipient for Availability Control Check 

Title 

Business Add-In: Define Mail Recipients for AVC Checks 

Use 

This Business Add-In enables you to create an individual list of email recipients, if this type of 

list is to be sent for the "With internal mail" events. 
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Requirements 

The method of this BAdI is only executed if you have maintained availability control (AVC) tolerance 

profiles for which tolerance limits are defined with event "With internal mail (only once)" or "With 

internal mail (repeatedly)". You set these tolerance limits in the IMG activity Edit Tolerance Profiles. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

Implement this BAdI applying the following steps: 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

You want to send an additional internal email to the person responsible for a particular fund. For this, you 

carry out the following steps: 

- Implement the method MODIFY_MAIL_RECIPIENTS of the BAdI. 

- Create a new entry in the table C_T_RECEIVERS,  using the first line as template. This line already 

contains the person responsible for the funds center as the receiver, as well as all other required 

information. 

- Using the fund, the system then derives the receiver field for the new entry. 

- Finally, you save the method and activate the BAdI implementation. 

Further notes 
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For further information see: 

- Method MODIFY_MAIL_RECIPIENTS documentation 

- Method MODIFY_MAIL_HEADER documentation 

- Method MODIFY_AVC_MESSAGE documentation 

36.2.4.2.9.6 BAdI: Assign Standard AVC Ledger 

Use 

With this Business Add-In (BAdI), you can define which availability control ledger (AVC ledger) is used 

to determine the control object. 

Requirements 

You use Funds Management with the Budget Control System (BCS) and you want to display availability 

control data for selected FM account assignments. 

Standard settings 

SAP does not ship any implementation. The following AVC ledgers are used per default: 

- Ledger 9H for payment budget (posting ledger 9A) 

- Ledger 9I for commitment budget (posting ledger 9B) 

Activities 

Implement the method of this BAdI if you use other AVC ledgers in your organization: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name 

was automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 
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6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

In reporting you want to display the available budget for selected posting addresses, using the AVC data 

of your customer ledger ZH instead of the SAP standard ledger 9H. 

36.2.4.2.9.7 BAdI: Modify Check Result of Availability Control 

Use 

With this Business Add-In (BAdI), you can modify the check result from availability control. 

Requirements 

You use the availability control tool of one of the application components of BCS availability control . 

Standard settings 

In the standard delivery, no implementation is provided. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 
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7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

Example 

Implement the method VALUES_CHECK_MODIFY to avoid error messages from the availability 

control check, if you use "strict checks for document chains" and if the budget situation improves: 

IF IM_PARAMS-LDGRSTAT = 'D' AND 

  IM_PARAMS-DOC_CHAIN = 'X' AND 

  IM_PARAMS-NEW_CONSUMABLE > IM_PARAMS-NEW_CONSUMED AND   CH_PARAMS-

MSGTY = 'E'. 

  CH_PARAMS-MSGTY = 'W'. ENDIF. 

36.2.5 Funds Management-Specific Postings 

In the following steps you enter the settings which are a prerequisite for processing business transactions 

in Funds Management. 

36.2.5.1 Earmarked Funds and Funds Transfers 

In the following steps, you will learn how to control document entry for the business transactions in 

Funds Management. 

By defining the field selection strings, you determine the field selection, that is, which fields are 

optional, required or hidden when you enter documents. 

You define field status variants and field status groups and assign these to your field selection strings. 

In assigning the field status variant to an FM area, you determine the field selection for this FM area. In 

assigning the field status group to a document type, you determine the business transactions (such as 

funds reservations or funds transfers) for which the field selection is valid. 

36.2.5.1.1 Maintain Global Settings 

In this step you can activate or deactivate specific functions for Earmarked funds. 

- Check in Local Currency 

If this function is active, a check in Local currency takes place when reducing earmarked funds with 

other documents. 

- Value adjustment required 
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If this function is active, no amount changes may be performed on an earmarked funds document. 

An additional document, a value adjustment document, must be entered in order to change the 

amount of earmarked funds. 

Standard settings 

In the standard delivery the functions Check in local currency are active. 

Activities 

Deactivate or activate the function(s) required. 

36.2.5.1.2 Field Control for Earmarked Funds and Funds Transfers 

In the following steps you define the field control for the earmarked funds and the funds transfer. 

36.2.5.1.2.1 Define Field Status Variant 

You can create and delete field status variants in this step. 

You must then assign a field status variant to each FM area. You can enter a field status variant to as 

many FM areas as you want. 

By assigning a field status variant and field status group to a field selection string, you can control the 

document entry for the various business transactions very differently in your FM areas. The field 

selection string determines which fields are optional, required or hidden when you enter documents. 

Activities 

1. Use the New entries option to create at least one field status variant. 

2. Then use the step "Assign field status variants to FM area" to assign the field status 

variants to your FM areas. 

3. Then use the step  "Assign field selection string" 

4. to assign field status variants and field status groups to the field selection strings. 

5. If there are any field status variants you do not need any more, you can delete them by choosing 

Edit-> Delete . 

36.2.5.1.2.2 Assign Field Status Variant to Company Code 
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In this workstep you assign a field status variant to your company codes. You can assign a field status 

variant to as many company codes as you want. 

Activities 

Make the assignments. 

36.2.5.1.2.3 Define Field Status Groups 

In this step, you define field status groups. You must assign the field status groups, along with a field 

status variant, to a field selection string, and enter them when defining document types. 

By defining the field selection string, you determine which fields are optional, required or hidden when 

you enter documents. The document types classify the business transactions (such as funds blocking and 

funds commitments) in Funds Management. 

You can define separate field status groups for the various business transactions and control document 

entry by defining the field selection and document type accordingly. 

Standard settings 

There are field status groups defined in the standard. 

Activities 

1. Check the field status groups delivered in the standard system. 

2. Choose Edit -> New entries  to create new field status groups. There is a copy function available. 

To use it, select an entry in the standard list and choose Edit -> Copy as. 

3. In the step Define field selection string, assign the field status group and the field status variant to a 

field selection string. 

4. Remember to specify the field status group you need in the step Define document types. 

36.2.5.1.2.4 Define Field Selection String 

In this step, you can define the field selection strings - that is, you can specify which fields are ready for 

entry, required or hidden during Earmarked funds and transfers. In another step, you must assign a field 

status variant and field status group to the field selection string. 

Activities 

1. Determine which fields on the doucment entry screen are 

- ready for input 

- required 

- to be hidden 

- displayed only 
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2. Use the New entries option to create a field selection string, then choose Maintain field status for 

field selection string. 

3. Choose a desired field status for each field. 

If you mark the following fields as required entry, the fields are preassigned when entering an FM 

document and cannot be changed by the user: 

a) FM account assignment changeable in the follow-on document 

b) Use may exceed reserved amount without limit 

c) Reduction only in local currency 

d) Statistics indicators Funds Management 

4. Subsequently, assign a field status variant and a field status group to the field selection string in the 

step "Define Field Selection String". 

36.2.5.1.2.5 Assign Field Selection String 

In this step, you assign a field status variant and field status group to a field selection string you want to 

use. 

Activities 

Enter the assignments you need. 

36.2.5.1.3 Reference Types 

In the following steps you define reference types and define the field selection for the reference types. 

36.2.5.1.3.1 Maintain Template Types 

In this step you define reference types. The reference type specifies for which fields the values from the 

reference document should be copied into the new document. 

You need reference types if you want to use an existing document as a reference when creating earmarked 

funds and funds transfers. 

Standard settings 

Reference types are defined in the standard. 

Activities 

1. Check whether you want to use the reference types distributed with the standard. 

2. If necessary, create your own reference documents and, for each document type, select the fields that 

should be copied from the reference document into the new document. 
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3. Specify your preferred reference type in IMG activity Define Document Types. 

36.2.5.1.4 Tolerance Limits 

In the following steps you define the tolerance limits for exceeding the amount earmarked funds. 

36.2.5.1.4.1 Define Tolerance Keys 

In this step, you define tolerance keys. 

In an additional step, you can set up percentage-based or value-based (absolute) tolerance limits for 

individual tolerance keys that permit the Earmarked Funds to be reduced and the document reducing it to 

have different amounts as long as the difference does not exceed this limit. 

Once you have defined a tolerance key in a document type for an earmarked fund, the tolerance limit 

applies for all documents posted with this document type. 

Activities Define your 

tolerance keys. 

36.2.5.1.4.2 Define Tolerance Limits for Differing Amounts 

In this step you can define percentage and value-dependent (absolute) tolerance limits for amount 

differences when reducing earmarked funds. The variance types are represented in the SAP system by 

tolerance keys. 

You define the tolerance limits for each tolerance key and local currency,and then assign your tolerance 

key to the document types for earmarked funds. The tolerance limit is then valid for all documents of this 

document type and this local currency. 

When reducing earmarked funds, the SAP system checks whether the amount of the reduced document is 

different to the amount of the earmarked fund to be reduced. If you have set, activated, and defined the 

tolerance limits in the document types, differences within the tolerance limits are allowed. If the 

difference exceeds the tolerance limit, the system issues a message. If you have defined both a percentage 

as well as an absolute tolerance limit, the smallest difference takes precedence for the check. 

Notes: 

- System message 

You can define whether the system messages (no. 023, no. 164 und no.165) appear as warning or 

error messages in step Change Message Control. 

To do this, select Funds Management Government  in the IMG, then  Funds Management-

Specific Postings -> Earmarked Funds and Funds Transfer -> Change Message Control. 

- Overdraft tolerance in earmarked funds 
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You can also enter a tolerance limit yourself (indicator % Overrun Tolerance) in the earmarked fund 

document. If tolerance limits are defined in Customizing and in the document, the smallest 

difference has priority during the check. 

If a percentage tolerance limit is defined in Customizing, you can override the Customizing setting 

by setting the indicator Global (Percentage-Based) Tolerance. Note that you cannot override 

absolute tolerance limits with this indicator. 

However, if the indicator Unlimited Overdraft is set in the earmarked funds, the earmarked funds 

may then be overdrawn. 

You can find more information on this in the SAP library under 

Funds Management Government -> Funds Management-Specific Postings -> 

Earmarked Fund and Funds Transfer -> Earmarked Fund Document -> 
Tolerance Limits for Amount Overrun. 

Requirements 

The tolerance key must be created in step Define Tolerance Key 

Activities 

1. Define the tolerance limits for each tolerance key. 

2. Define the tolerance key in step Define Document Types. 

36.2.5.1.5 Define Integration Scenarios 

36.2.5.1.5.1 Define Company Code Group 

Use 

In this step, you create a company code group for your company codes. In a extra step, you must assign 

the company code groups to your company codes. 

The same settings are valid for these company codes. 

Activities 

1. Create the company code groups using New Entries. You can also copy existing entries via Edit -> 

Copy as . 

2. Save your entries. 
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36.2.5.1.5.2 Assign Company Code to a Company Code Group 

Use 

In this step, you assign your company codes to a company code group. 

Requirements 

You have created at least one company code group in the previous step. 

Activities Make 

your assignments. 

36.2.5.1.5.3 Maintain Data for Integration Scenario 

Use 

In this step you maintain the document category, company code group, document type, and block for 

different integration scenarios. 

Requirements 

You must have maintained a company code group. 

Standard settings 

1. On the first screen you define the category of the earmarked funds document. 

2. On the second screen you maintain the company code group, document type, and block. The only 

values proposed as document type are those that, depending on on the category, are allowed. 

Activities 

Define the necessary settings. 

36.2.5.1.5.4 Create Year-Dependent Earmarked Funds 

Use 

With this IMG activity you can create year-dependent earmarked funds documents in integration 

scenarios. 
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Requirements 

You use Grantor Management. 

Standard settings 

Year-independent earmarked funds documents are created. The value annual budget - single EF is 

selected. 

Activities 

If you want to create year-dependent earmarked funds documents in integration scenarios, select Annual 

Budget - Multi EF. 

If you want to create year-independent earmarked funds documents in integration scenarios, 

select Annual Budget - Single EF. 

If you want to create year-independent earmarked funds documents with a line for each year in 

integration scenarios, choose Overall Budget - Single EF. 

If you create the whole budget in the first year and want to then transfer the residual budget to the next 

fiscal year, choose Overall Budget - Single EF. 

36.2.5.1.6 Define Document Number Ranges 

In this work step you create number ranges for the documents. For every Number range you state among 

other things the following: 

- a number interval, from which document numbers are chosen 

- the type of Number assignment (internal or external). You assign every number range in a further 

work step to one or several document categories. The number range takes effect via the document 

type when entering and posting a document. 

Standard settings 

In the standard the following number range intervals are supplied for individual document categories: 

- 09  Funds transfer 

- 02  Funds block 

- 03  Funds reservation 

- 04  Funds pre-commitment 

- 05  Funds commitment 

- 06  Estimated revenue 
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These number ranges are assigned to the document types supplied in the standard. 

Recommendation 

Check in the work step "Define document types" if you want to use the document types supplied in the 

standard with the corresponding number ranges. 

Activities 

1. Specify how the document folder is meant to take place. 

2. Define your number ranges accordingly. 

3. Assign the number ranges to the corresponding document types. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.5.1.7 Define Number Ranges for Groupings 

Use 

In this step you create the number range for the grouping number. The grouping numbers are only taken 

from number range interval 01 (grouping numbers). 

Only an internal number assignment is offered. 

Notes 

If you want to transport number range objects, choose Transport on the screen Number Range Interval for 

Groupings (earmarked funds) for the grouping number Interval. 

Note that in the target system first all intervals of the selected number range object are deleted so that 

after the import only the exported intervals exist. The current number levels are imported with the value 

that they have at the time of export. 

Dependent tables are not transported or converted. 

Activities 
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You must maintain number range interval 01. 

36.2.5.1.8 Define Document Types 

In this IMG activity, you create the document types for the documents in Funds Management. Document 

types are used to classify the documents. You can define characteristics for each document type which 

control how the document is entered or they may be recorded in the document itself. For each document 

type, you must specify: 

- A number range interval 

- A field status group. 

The field status group, together with the field status variant, determines, by way of its assignment to 

a field selection string, which fields are optional, required or hidden when you post documents in 

your FM area. 

You can also control: 

- which field contents are copied from the reference document 

- which style sheet the system should use when printing a document type 

- which tolerance limits are checked when earmarked funds are reduced 

- whether the document is to be included in Workflow 

- whether the G/L account should automatically be derived from the FM account assignment The G/L 

account can only be derived automatically when you are using requests. 

Requirements 

The number range interval must be defined in the IMG activity "Define document number ranges". 

If you do not want to print a specific document using the SAP standard style sheet, you must define your 

own form for it. 

If you want to define tolerance limits, you must first make the following settings: 

- Define Tolerance Key 

- Define Tolerance Limits for Amount Differences 

Standard settings 

The document types defined in the standard cover the types of document used (document category) for 

the individual business transactions in Funds Management: 

- AA Document type with Workflow 

- 11 Document type without Workflow 
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There are two forms in the standard system: 

- FMFUNDSRES based on SAP smart forms 

- FMFUNDS_RESERVATION based on Adobe 

The system used the form FMFUNDRES as a printing template if you do not enter a form. 

If you want to change a standard form, SAP recommends that you copy the form and change the copy. 

Note that the name of the form must be in the customer namespace so that it is not overwritten if the 

release is upgraded. The descriptions for your own forms should therefore start with Y or Z. 

To copy the FMFUNDRES form, choose Tools -> Form Printout -> Smart Forms from the SAP 

Easy Access screen. 

Use transaction SFP to copy the form FMFUNDS_RESERVATION. 

You can find more information on SAP smart forms and PDF-based forms in the SAP Library under 

SAP-NetWeaver -> Application Platform SAP Web Application Server) -> Business Services -> 
Smart Forms and PDF-Based Forms. 

Recommendation 

If you want to change the style sheet, SAP recommends copying the delivered form and then changing the 

copy. Please note that the form name must be within the customer name area so that it will not be 

overwritten in a change of releases. The names of your own forms should therefore begin with a Y or Z. 

This is how you copy a form: 

1. Choose Tools ->Word processing ->Form from the SAP menu. You reach the initial screen of the 

Form Painter. 

2. Choose Utilities -> Copy from client. 

3. Enter the necessary data and choose Execute. 

4. Change the copied form. 

5. Save the copied form. 

You can find detailed information concerning the maintenance of forms in the SAP Library under BC - 

SAPscript style and form maintenance. 

Activities 

1. First, check whether you can use the standard settings for the individual document categories (such 

as funds blocks and funds commitments). 

2. Change or add to the standard settings as necessary. 

Further notes 

When posting the forecast of revenues, you should use the document types shipped in the standard 

system. 

The field status groups in the standard contain all fields in the field selection string that you need if you 

want to make full use of all the different options for posting a forecast of revenue. 
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36.2.5.1.9 Account Assignment Transfer 

In the following steps you define which account assignments are to be transferred when posting a 

document with reference to a Earmarked funds, from the earmarked funds into the follow-on document. 

36.2.5.1.9.1 Define Rules for Account Assignment Transfer 

In this step you define which account assignments are to be transferred from the earmarked fund to the 

follow-on document when posting a document with reference to an Earmarked fund. 

You can define different rules for particular activities (e.g. G/L account posting, purchase orders, funds 

commitments). 

You can group together several account assignments in a group. This has the effect that all account 

assignments of a group are transferred into the follow-on document. 

However, if the indicator Account assignment changeable is set in the earmarked fund, the group 

assignment of the account assignments has the following effect: 

- If no account assignment is entered in addition to the earmarked funds all account assignments are 

transferred from the earmarked funds. 

- If an account assignment is entered manually, all other account assignments belonging to the group 

must be entered manually. Or assignments must exist for these account assignments, from which a 

derivation can take place (e.g. funds center is defined in the commitment item). 

Example 

FM account assignments 

The fields Commitment item, Funds center and Fund are grouped together. A funds commitment 

contains the following account assignments: 

- Commitment item: Materials expenditures 

- Funds center: Department 1 

- Fund: Fund 1 

The indicator Account assignment changeable is set for the funds commitment. 

You want to reduce a funds commitment with an invoice. The invoice must however have different FM 

account assignments than the funds commitment. Assignments are maintained for the automatic 

derivation from funds center and fund. 

In the invoice, you enter both the funds commitment and that commitment item only that is at variance 

with the earmarked funds. The grouping has the effect that the funds center 'department 1' and the fund 

'fund 1' are not transferred from the funds commitment. The funds center and the fund are derived 

from the assignments. 

CO account assignments 

The fields G/L account, order and cost center are grouped together. 

A funds reservation is assigned to an account in a cost center, the indicator Account assignment 

changeable is set. You would like to refer to an order in an invoice, but still reduce the funds 
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reservation. You enter the funds reservation and an order in the invoice. The grouping has the effect that 

the order entered is assigned to an account and not the cost center from the funds reservation. 

Standard settings 

SAP delivers a rule in the standard that groups together the FM account assignments, the CO account 

assignments and the assignments to sub-ledger accounts. 

If you do not change the standard setting, these account assignments are automatically transferred 

together into the follow-on document. Manual entries in the follow-on document are autommatically 

overwritten by the automatic derivation. 

Activities 

1. Check if you want to use the rule delivered in the standard. 

2. Create additional rules if required. 

36.2.5.1.9.2 Assign Rules 

In this IMG activity, you assign the rules for the account assignment transfer from the earmarked funds to 

individual activities (such as purchase order, G/L account posting). 

Standard settings 

SAP delivers a rule in the standard that is assigned to all activities. 

Activities 

1. Check if you want to transfer the rule delivered in the standard for all activities. 

2. If desired, create additional rules and assign them to the activities. 

If you have defined a rule for "All activities", but another rule is to apply for a particular activity, 

then make another entry. This entry overwrites the rule for "All activities". 

36.2.5.1.10 Define Blocking Reasons 

In this step you define the blocking reasons for the earmarked funds and value adjustment documents. 

With these blocking reasons you can block a document or document item for manual processing. 

Currently, you cannot block or unblock the documents or items manually. The blocks are set manually, 

either in Workflow, after approving the document or when generating documents automatically. 

Note: It is currently only possible to reverse the block for the documents or items which were blocked in 

the Workflow, but not for the documents generated automatically. 

Blocked earmarked funds and blocked earmarked funds items can no longer be processed but 
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they can still be reduced. 

Activities 

Define blocking reasons according to your requirements. 

36.2.5.1.11 Delete Earmarked Funds and Funds Transfers 

In the following steps, you can delete the earmarked funds and funds transfers. 

36.2.5.1.11.1 Delete Earmarked Funds and Funds Transfers per Client 

In this step you use a program to delete the earmarked funds and funds transfers of a client. 

You should only use this program if you are in the test phase and want to delete your test data before the 

production startup. 

Requirements 

The following applications may not be in use because their data is only partially deleted and 

inconsistencies arise: 

- Funds reservations in Controlling (cost center, order..) 

- Fixed price agreement 

- Fixed price clearing 

Activities 

Delete the earmarked funds and funds transfers for the client required. 

Further notes 

For additional information, see the Program documentation. 

36.2.5.1.11.2 Delete Some Earmarked Funds and Funds Transfers 

In this step you can delete Earmarked funds and funds transfers according to the following selection 

criteria: 

- FM area 

- Company code 

- Document category 
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- Document number 

- Posting date 

Dependent entries such as change document, development records and long texts are deleted as well. 

Note ,however, that this program does not delete the corresponding line items and totals records in Funds 

Management that were created due to earmarked funds and fund transfers. You have to delete this data 

using the program .Deleting Commitment Data and Actual Data in Funds Management (RFFMDLOI) 

You should only use this program if you are still in the test phase and want to delete your test data before 

the production start up. 

Activities 

Delete the documents according the selection chosen. 

Further notes 

The following documents are not deleted by the program: 

- Funds reservations in Controlling 

- Fixed price agreements 

- Fixed price clearings 

36.2.5.1.12 Enhancement Wizard for Customer and Partner-Specific Fields 

In this step, SAP clients or SAP partners can integrate their own fields in document entry in a simple 

manner using an enhancement wizard. At the same time, it is also possible to control the fields using the 

earmarked funds field control. 

Requirements 

You can only integrate document entry fields which you have previously defined. The procedure is 

different for SAP partners and SAP clients. 

- SAP Partners 

You define new fields by defining append structures for the corresponding tables and include the 

fields there. See the SAP Partner IMG for more information. 

- SAP Clients 

You define new fields by filling in the client include structures specified. See the SAP Client IMG 

for more information. 

Activities 

Make the necessary settings for the fields in accordance with the enhancement wizard documentation. 
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36.2.5.1.13 Change Message Control 

In this activity you can set system messages to appear as you require them. You can 

- determine whether a message is issued as a note in the dialog box or in the footer 

- change warnings into error messages 

- switch off warnings and error messages 

Different specifications are possible for the online mode and for the batch input sessions processed in the 

background. 

You can make the corresponding specifications for a client or, if required, also for the individual user. 

Standard settings 

Messages 166, 168, 172, 173 appear as warnings if, for earmarked funds having indicators  % Overrun 

Tolerance or Unlimited Overrun, the overrun of the amount still open is allowed and the earmarked funds 

amount still open was exceeded by a reduction by other documents. 

Messages 023, 164 and 165 appear as warnings when the tolerance limits defined in Customizing for the 

amount variance are exceeded when reducing earmarked funds. 

Message 603 appears as a warning if the Account Assignment Changeable indicator was set for an 

earmarked fund and a deviating FM account assignment was entered in the reduction document of one of 

these earmarked funds. 

Activities 

1. Enter the following data: 

- Message number 

Use F4 for field MsgN to find out which messages are available. 

- Name of user 

If you enter a name here, the definitions are only valid for this certain user. If "Blank" is 

entered, the settings are valid for all users in the client. 

- Message type 

Use F4 for the fields Dialog or BatchI to find out the message type valid. 

2. Save your entries. 

The accompanying message text will automatically be used by the system. 

36.2.5.1.14 Business Add-Ins (BAdIs) 

36.2.5.1.14.1 BAdI: Change GUI Status for Funds Precommitments 

Use 
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Using this Business Add-In (BAdI), you can change the GUI status of earmarked funds and of their value 

adjustment documents. 

You can use the BADI in the components Controlling (CO) and Funds Management Public Sector 

(IS-PS-FM). 

Standard settings 

The BAdI is not active in the standard system 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

- Documentation for BADI Method SET_PFSTATUS_DETAIL -

 Documentation for BADI Method SET_PFSTATUS_LIST 

- Documentation for BADI Method SET_PFSTATUS_PMDOC 
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36.2.5.1.14.2 BAdI: Additional Form Data for Funds Precommitments 

Use 

You can provide additional data for the form printout of earmarked funds using this Business-Add-In 

(BAdI). 

You can use the BAdI in the components Controlling (CO) and Funds Management Government (IS-

PS-FM). 

Requirements 

Before you can provide additional information, you have to add an append structure to the structure 

KBLD_PRINT which contains the desired data fields. The fields can then be filled in the method 

FORM_ADDATA. 

Standard settings 

The BAdI is not active in the standard system. 

The BAdI can be used in many ways. All active implementations are called and carried out. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 
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The code you stored in the method will be run when the application program is executed. 

Notes 

Documentation on BAdI Method FORM_ADDATA 

36.2.5.1.14.3 BAdI: Define Document Categories for Reduction by Other 

Documents 

Use 

This Business Add In (BAdI) is used in Funds Management in the component Earmarked Funds and 

Funds Transfer (PSM-FM-PO-EF). 

You can use this BAdI to determine which document categories of earmarked funds (such as funds 

reservation, funds precommitment) can be reduced by FI documents and documents of the MM invoice 

check. 

Standard settings 

The Business Add In is active in the standard system. The default coding is executed automatically. 

In the standard system, FI documents and documents of the MM invoice check can only reduce funds 

reservations, funds commitments and forecast of revenues. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them 

in a dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 
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6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Also see: 

Methods 

Determination of Document Categories Allowed 

Example 

To display sample coding, select Goto -> Sample Coding -> Display. 

The reduction of funds precommitments is allowed in the sample. 

36.2.5.1.14.4 BAdI: Activate Grouping Function in Earmarked Funds 

Use 

This Business Add-In (BAdI) is used in Fund Management in the component Earmarked Funds and 

Funds Transfer (PSM-FM-PO-EF). 

You can use this BAdI to activate the grouping function for earmarked funds. Any number of document 

items of an earmarked funds documents can be grouped together logically with this. 

SAP delivers two implementations that you can activate as you wish: 

- FM_EF_GROUP_SPAIN 

This implementation covers the grouping scenario for Spanish customer requirements. 

- FMSPLIT_EF_GROUP 

This implementation is intended for customers who want to use the multi-funding scenario. You can 

also create your own implementations. 

With active implementation, different methods of this BAdI are called with different events. For more 

information on the exact call events and the corresponding functions of the implementations, see the 

documentation on the implementations. 

Standard settings 
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No BAdI implementation is active in the standard system. No methods are called and there are also no 

screen-relevant changes. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

36.2.5.1.14.5 BAdI: Earmarked Funds Journal 

Use 

With this Business Add-In you can filter or maintain the output data of the earmarked funds 

journal. The entire output table is transferred as a changing parameter for this in method 

FILTER_AND_COMPLETE. 

Example 
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You can use the Business Add-In, for example to make only certain information visible to the user based 

on rules (such as, authorization check). To do this, do not delete the desired lines from the table. 

36.2.5.1.14.6 BAdI: Scenario-Specific Customizing Checks 

Use 

You can use this Business Add-In (BAdI) to carry out scenario-specific Customizing checks. The 

earmarked funds data can be checked with certain events. The following methods are used for this: 

- Method CHECK_ITEM: 

If you add a new entry, this method is called to check the individual Customizing entries. 

- Method CHECK_ALL_ITEMS: 

If you want to save the data to the database, this method is first called to check all entries in the 

table. 

Example 

You can use the Business Add-In for example to check that only funds precommitments can be used for 

application variants in the grantor scenario. 

36.2.5.1.14.7 Country-Specific Settings 

36.2.5.2 Requests 

In the following sections you find out which system settings are required if you want to use request in the 

Funds Management Government. 

These settings are only relevant for organizations for which the Financial Accounting has to cover fiscal  

requirements. 

The requests make it possible to generate FI accounting documents in an easy way, via the interface 

which refers to Funds Management. 

36.2.5.2.1 Maintain Global Settings 

If you use the request functions in Funds Management Government, you can make the following 

settings in this set, which extend the scope of requests. 

Subsequent Bundling 
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When you enter requests manually or post requests by using the Direct Input Procedure, the system 

assigns a request ID. You can suppress the automatic allocation of request numbers and subsequently 

bundle the documents under one request number by using transaction F899 (manual bundling), or 

program RFFMBUND. 

Note: If you want to define that no request number be assigned only for requests posted by using the 

direct input procedure, you must not activate "Subsequent Bundling". If this is the case, set the Without 

request number indicator in the Define Company Code Variant step. 

Use Posting Day 

The posting day is the prerequisite for day-end closing: Incoming and outgoing payments are displayed 

under the date of the posting day, for example. 

The posting day does not depend on the documents and posting date in the SAP system. It is defined for 

each company code in Customizing when the system is used for the first time and is then updated 

automatically at day-end closing. For more information about this, see Closing Posting Day. 

The system sets the posting day in the document header for each Accounting document. 

Unless this setting is active, the posting date is filled with the current system date. 

Revenue Types 

Using revenue types allows you to classify revenues and to implement different dunning procedures 

depending on the revenue type. 

You can also use the revenue types as an entry aid when processing requests. If the revenue type is 

assigned to a commitment item, the commitment item can be derived from the revenue type. 

Enhancement of customer and vendor master data 

You can use the following enhancements: 

- Address screen 

Enhancement of existing fields 

The fields Title, First Name, and 3 name fields are added to the address. This data is copied to the 

existing fields Name1 to Name4 in the standard system (saved twice, see SAP Note 511906). This 

ensures that the programs working with this data (such as the payment program) can be used without 

changes being made. 

New Fields 

The Subledger Preprocedure field was added to store the relationship between customer and vendor. 

The Processor Group field was added to define the responsibilities for a processor. You can assign a 

processor group to a customer or vendor. 

- Validity period for bank details 

Only bank details for which no validity period was defined or with a payment run posting date within the 

validity interval of the bank details are valid for payment. 

You can activate additional checks by using User Exits. 

- For address data, 

Enhancement SAPMF02D, component EXIT_SAPMF02D_800, development class FBD or 

enhancement SAPMF02K, component EXIT_SAPMF02K_800, development class FBK 

- For bank details, enhancement SAPMF02D, component EXIT_SAPMF02D_801, development class 

FBD or enhancement SAPMF02K, component EXIT_SAPMF02K_801, development class FBK 
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Activities 

1. Check whether you want to use the functions described above in your organization. 

2. Activate the functions you require. 

Note: Unless you have made settings in this step, the selectable function only appears on the screen 

if you choose New Entries 

3. You have to carry out some additional steps to use the functions. For more information, see the 

sections that describe the settings for the revenue types. 

Further notes 

For more information about requests, see the Customizing documentation for Funds Management 

Government under Requests. 

36.2.5.2.2 Activate Customer/Vendor Check Digits 

In this step, you stipulate that a check digit is allocated when customer or vendor master records are 

created. The system then assumes that the last digit in the customer/vendor number is the check digit. 

In internal number assignment, the system allocates the check digit automatically; in external number 

assignment, the system automatically interprets the last digit as the check digit. 

Requirements 

If you want to work with check digits in internal number assignment, the number range interval for 

customer/vendor master records may only have nine characters. The system automatically inserts the 

check digit as the last character. 

Activities 

1. If you want to work with internal number assignment, first verify that the number range interval for 

the customer/vendor master record has been defined with only nine digits. 

2. Enter the number range object CUSTOMER for customer master records. 

3. Enter the number range object VENDOR for vendor master records. 

4. The following function is only available for the client German Local Authorities: Enter the number 

range object PSOOB for the object master records. 

Further notes 

You can also activate the check digit procedure using the enhancement Master Data Subledger 

Accounts (SAPLF0KB) (Component Active Check Digit Procedure: Return code equals zero 

(EXIT_SAPLF0KB_001) package FMKW). If check digits are being used, the MODULO11 procedure is 

used. If you want to use another procedure, use the appropriate component Return Number Including 

Check Digit (EXIT_SAPLF0KB_002) of enhancement  SAPLF0KB. 
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36.2.5.2.3 Variants 

In the following work steps you undertake the required settings for using company code group and fiscal 

year identification. 

36.2.5.2.3.1 Define Company Code Group 

In this step, you create a company code group for your company codes. In an additional step, you must 

assign the company code group to your company codes. 

Different assignments take place uniformly for these company codes: 

- G/L account to FM account assignment 

Note: the FM account assignment must exist in each company code that belongs to the company 

code group. If this is not the case the program cannot save the assignment. 

- Revenue type for the dunning area 

- Revenue type for the commitment item 

In addition to this, you can define control information for requests for each company code group. For 

more information on this, see: 

Copy customer master data into the document 

Copy vendor master data into the document 

Check revenue type against account group (customers) 

Only enter complete requests 

No request number issued 

Interest calculation block for additional receivables 

Suppress summary during request printing 

This function is only available for customers of German Government: Check revenue type against object 

class 

Activities 

1. Create the company code group using New entries. You can also copy already existing entries 

using Edit ->Copy as. 

2. Save your entries. 

36.2.5.2.3.2 Assign Company Code to a Company Code Group 

In this step you assign your company codes to a company code group. 
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Requirements 

You have already created at least one company code group. 

Activities 

Make your assignments. 

36.2.5.2.3.3 Define Fiscal Year Identification 

In this step you define a fiscal year identification for several fiscal years. In a further step, you have to 

assign the fiscal year identification to the individual fiscal years. 

A fiscal year identification groups together several fiscal years under one identification. The assignment 

of G/L account to FM account assignment then takes place for these fiscal years, in a uniform way. 

Note: The FM account assignment must be present in EVERY fiscal year belonging to the 

fiscal year identification. If this is not the case, then the program cannot store the assignment. 

Activities 

1. Create the fiscal year identification via New entries. You can copy already existing entries via Edit 

->Copy as. 

2. Save your entries. 

36.2.5.2.3.4 Assign Fiscal Year to a Fiscal Year Identification 

In this step you assign individual fiscal years to a fiscal year identification. 

Requirements 

You have already created at least one fiscal year identification. 

Activities 

Make your assignments. 

36.2.5.2.4 Revenue Types 

Revenue types classify revenues. Among other things they are used in: 

- derivation of account assignments 

- controlling of dunning activities 
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- flexible assignment of bank details to customers 

In the customer master record you can assign revenue types and the appropriate bank details to the 

customers per company code. 

These bank details are processed preferentially from the payment program. 

If you would like to assing non-permitted revenue types to accounts in acceptance requests, you have to 

make a setting in Customizing so that the program executes a consistency check when entering a request. 

For this you must assign the revenue type to a customer account group and activate the check in the 

company code group. 

36.2.5.2.4.1 Define Revenue Types 

In this step, you create a revenue type and specify if it is a revenue type for a main claim or a 

supplementary claim. 

Activities 

1. Create the revenue type via New entry. You can also copy already existing entries via Edit ->Copy 

as 

2. Select the supplementary revenue type (SRT), if it is a supplementary claim. If it is a main claim, 

leave the field empty. 

3. Save your entries. 

36.2.5.2.4.2 Assign Sub-Revenue Type to Main Revenue Type 

In this step you assign an additional revenue type to a main revenue type. You can also assign several 

additional revenue types to a main revenue type. 

Requirements 

Before you can execute this section, you must have created the required main and additional revenue 

types in the step Define revenue types. 

Activities 

1. Make the desired assignment via New entries. You can also copy already existing entries via Edit -

>Copy as. 

2. Save your entries. 

36.2.5.2.4.3 Assign Revenue Type to Account Group 
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In this step you assign the account group of the customer to a revenue type. 

You require this assignment if you would like to define in the company code group, that the revenue type 

should be checked against the account group. 

For further information on this, see Check Revenue Type Against Account Group. 

Requirements 

- The account group of the customer must have been created in the Financial Accounting 

Customizing. 

- The revenue type must have been created in the Funds Management Customizing in the step Define 

Revenue Types. 

Activities 

Make your assignments. 

36.2.5.2.4.4 Assign Revenue Type to Object Class 

In this section you can assign one or more revenue types to an object class. 

You need this assignment if you want to define in the company code group that the revenue type should 

be checked against the object class. In this case, the program checks whether the assigned combination of 

object and revenue type is allowed when entering a request. The check takes place at object class level. 

Requirements 

Object class and revenue type must have been created in the implementation guide (IMG) of Funds 

Management Government . 

Activities 

Make the defined assignments. 

36.2.5.2.4.5 Define Dunning Areas 

In this step, you can define your dunning areas. Dunning areas are used if several organizational units are 

responsible for carrying out dunning within one company code. These organizational units are referred to 

as dunning areas. The dunning area can correspond, for example, to a profit center, a distribution channel, 

a sales organization or a business area. 

The individual dunning areas can use different procedures or the same dunning procedure. 
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- The dunning areas with the required dunning procedures are to be entered into the customer or 

vendor master record if you use different dunning procedures. 

- Otherwise, the system uses the standard dunning procedure. The dunning area is then entered in the 

line item. The system enters the dunning area into the master record automatically with the 

corresponding data. 

Note 

The use of dunning areas is optional. 

Requirements 

If the field for the dunning area in the line item is to be ready for input, specify in the company code-

specific specifications for dunning that you want to dun separately according to dunning areas. Also read  

"Setting up dunning program". 

Activities 

1. Define your dunning areas if you want to use them. 

2. Make sure that you specify for the required company codes that you want to dun according to 

dunning areas . 

3. Make sure that the required dunning areas are entered into the master records of the business 

partners with the dunning procedures, if you use different dunning procedures for the individual 

dunning areas. 

36.2.5.2.4.6 Assign Revenue Type to Dunning Area 

In this step, you assign a dunning area to the revenue type. This assignment is dependent on the company 

code. To make the same assignment for several company codes, enter a company code group. 

Requirements 

You must have executed the following steps: 

1. Define revenue types 

2. Define dunning areas 

3. Define company code group 

Activities 
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1. Make the desired assignment via New entries. You can also copy existing entries using Edit -> 

Copy as. 

2. Save your entries. 

Dependencies 

If a request is to be assigned with a revenue type, the program derives the dunning area from the revenue 

type of the dunning area of the processed documents. 

36.2.5.2.4.7 Assign Revenue Type to Commitment Item 

In this step you assign a commitment item to the revenue type. This assignment is company code and 

fiscal year-dependent. If you want to make the same assignment for several company codes and fiscal 

years, you can reduce maintenance time by entering a company code group and fiscal year variant. 

Note that within closing operations, it may be necessary to update the assignments made here for the new 

fiscal year. The program RFFMFPCPY is available for this purpose. You can find it in the Funds 

Management menu, under Other Functions -> Additional Functions for German Government -> 

Closing Operations -> Preparations -> Copy Assignment from Commitment Item to Revenue 

Type. 

You can find more information in the Program Documentation. 

Requirements 

The commitment items must have been previously created within the master data maintenance and you 

must have executed the following steps in Customizing: 

1. Define Revenue Types 

2. Define Fiscal Year Variant Identification 

3. Define Company Code Group 

Activities 

1. Make the desired assignment via New entries. You can also copy already existing entries via Edit -

> Copy as 

2. Save your entries. 

36.2.5.2.5 Number Ranges for Object Classes 

In the following work steps you define number ranges for object classes and subsequently assign these 

number ranges to the desired object classes. 

36.2.5.2.5.1 Create Number Ranges for Object Class 
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This hypertext is only relevant for German local authorities. 

36.2.5.2.5.2 Assign Object Class to Number Range Interval 

This hypertext is only relevant for German local authorities. 

36.2.5.2.6 Account Determination 

In the following work steps you make the required settings for the G/L account definition. 

36.2.5.2.6.1 Define Characteristics for Account Determination 

In this step, you create characteristics for account determination. You can use these characteristics to 

assign various identical combinations of fiscal year variant, company code group, FM account assignment 

and request type to various G/L accounts. 

You find further information on the functionality of the characteristic for account determination here. 

Activities 

Using New Entries create the characteristic for account determination. You can also use Edit ->Copy as 

to copy entries which already exist. 

Save your entries. 

36.2.5.2.6.2 Define G/L Account Determination 

In this IMG activity, you specify the assignment between the Funds Management account assignment 

commitment Item and a corresponding G/L account. Note that making entries in the fields Funds 

Center and Fund is not supported in the standard system. You can find more information on this in the 

section Standard Settings. 

The system provides you with some ways to save labor: 

- You can define a Fiscal Year ID which you can use to specify the G/L derivation from the 

Funds Management account assignment for several years, in a uniform way. 

Similarly you can use the Company Code Group to make the same assignments for several company 

codes. 

If you want to assign a combination of fiscal year variant, company code group, FM account assignment 

and request type to 2 different G/L accounts, assign a characteristic for account determination to one of 

the combinations. 

You assign a fixed value for a commitment item to a G/L account or mask the value if you want to assign 

according to a particular template. For information on masking, see the documentation on Commitment 

Item. 
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If you assign the G/L account '*' to the entry, you can choose any G/L account in the document entry for 

the corresponding commitment item. 

- You enter a value for commitment item/fund/funds center and assign a G/L account to 

this triple. The blank character also counts as an entry. 

If you assign the G/L account '*' to a triple, then you have a free choice in the document entry 

of the G/L account in the document entry for the corresponding FM account assignment. 

- You mask a commitment item and assign a G/L account to it. For information on masking, see 

the documentation on Commitment Item. 

- Furthermore, you can differentiate the G/L account determination per request category: 

- If you do not enter a request category then the specified G/L account applies to all request 

categories. 

- If you enter a request category, then the program derives the G/L account according to the 

assignment made here. 

- By entering a priority, you can control which G/L account entry has priority if the program 

finds several G/L accounts for a request. 

Using the entries in the G/L account determination table, the system determines the assignment between 

the FM account assignment and the G/L account. 

Note: the FM account assignment must exist in each company code belonging to the company code 

group, or in every fiscal year of the fiscal year identification. If this is not the case, the program cannot 

save the assignment. 

Requirements 

Before you can link a Funds Management account assignment with a G/L account, the appropriate master 

data (commitment item and G/L account) must have been created. 

Standard settings 

Only assignments between commitment items and G/L account are supported in the standard system since 

Release 1.10. 

You can only use the additional account assignment specification by making entries in the fields 

Funds Center or Fund if you have implemented the Business Add-In  Enhance Derivation of G/L 

Account (FM_REQUEST_GL_ACC). You must also deactivate the error message FICUSTOM 072 in 

IMG activity Change Message Control for this. 

Activities 

1. Create the information for the account determination using New Entries. You can copy already 

existing entries using Edit ->Copy as. 

2. Save your entries. 

36.2.5.2.6.3 Define Account Determination for Deferrals 
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In this step you define the G/L account per fiscal year identification and company code group to which 

the deferral is to be posted. 

As soon as the G/L account has been defined, this G/L account will be used in the deferral request as well 

as in the corresponding inverse posting instead of the one defined in the account determination table. 

The special account for the deferral allows for a better overview of the postings that are generated during 

a deferral. In doing so, these postings must therefore not be followed up on in the the integrated 

components (such as controlling or earmarked funds). 

Requirements 

To ensure data consistency, you must make the settings for the FI field status for this G/L account so that 

the user can only enter one Funds Management account assignment (FM account assignment). All other 

account assignments must be hidden. You make these settings in the Customizing of  Financial 

Accounting in the "Maintain field status variant" step. 

Activities 

Define one G/L account per fiscal year variant and company code. 

36.2.5.2.7 Number Ranges 

In the following work steps you define the number ranges for the request documents. 

36.2.5.2.7.1 Create Number Range Intervals for Requests 

In this step, you create number ranges per company code for the request documents in funds management. 

You specify for each number range the following: 

- Number range key 

You must assign a number range key to the request type for which it should be valid. You carry this 

out in the next step "Assign request type to number range interval". 

- Number range interval from which the document number is to be chosen 

- The type of number assignment (internal or external) The numbers are always assigned interally for 

funds management. 

You can define as many intervals per company code as you like. Each request type should have its own 

number range interval created. If you define several intervals per company code, you must be careful that 

the number intervals do not overlap. 

Activities 

1. Enter a company code for which you want to create the intervals. 

2. Choose Interval -> Change. 
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3. Choose Edit -> Insert interval. 

4. Store all the necessary information about the number range in the dialog box. 

5. Subsequently save your entries. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.5.2.7.2 Assign Request Type to Number Range Interval 

In this step, you define for each request type a number range interval for the actual data documents. 

Requirements 

You have already defined at least one number range interval in the previous step. 

Standard settings 

There are no number range intervals assigned to request types in the standard system. Therefore, you 

must define and assign at least one number range interval. 

Recommendation 

In order to be able to differentiate the documents based on their document number, you should define a 

different number range interval for each request type. 

Activities 

Make your assignments. 

36.2.5.2.8 Request Types 

In the following step you enter the setting for request categories. 

36.2.5.2.8.1 Assign Request Category to FI Document Type 

In this section, you assign a request type to an FI document type. In section Propose document type for 

request type, you can choose those combinations that are to be displayed as default values during entry. 
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You can assign only one request type per document type. However, several document types may exist for 

one request type. 

Requirements 

The document type must have been created in component Financial Accounting (FI). See 

"Define document types" for more information about document types in FI. 

Standard settings 

No table entries are supplied in the standard. 

36.2.5.2.8.2 Propose FI Document Type for Request Category 

In this section you define FI document types for request categories. These document types appear as a 

default value, when entering a request, which you can overwrite if so required. 

Requirements 

When assigning - and later when entering a request - you can only select combinations which you have 

defined in the section Propose FI document type for request category. 

Standard settings 

No table entries are delivered in the standard. 

36.2.5.2.8.3 Control Processing of Request Categories 

In this step, you can define the approval procedure for requests in accordance with the company code 

group, processor, request type and document type, so that: 

- Completed requests are automatically saved with the status approved 

- Approved requests are automatically posted 

This way, you can create a processing profile for various request types and company code groups 

specifically for one processor. 

If you do not define settings for each document type, the settings for each request type are used. 

If a processor, for whom no settings are maintained in Customizing, processes a request, the program 

checks whether the entry "empty" exists for the processor of the company code being processed. If so, 

these settings are copied. If there is no entry, the program transfers these fields empty to automatic 

approving and automatic posting. These fields are also transferred empty if no entries were maintained in 

the company code group being processed. 

Example 
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This function can, for example, be used to variably control the processing of acceptance requests and 

payment requests: Completed acceptance requests should automatically be saved with the status 

approved. However, payment requests should not be approved automatically; they should be approved 

by the responsible cost center. 

Requirements 

- The company code group must exist in the system. 

- A user master record must have been created in the system for the processor. 

- The document type must be created in the system. 

Standard settings 

No table entries are supplied in the standard. 

Activities 

1. Using New entries create the assignment. 

2. Save your entries. 

36.2.5.2.9 Field Control for Requests 

In the following steps, you define the field control for the requests. 

36.2.5.2.9.1 Define Field Selection String 

In this step, you define the field selection for the requests. To do so, you define field selection strings. By 

defining different field selection strings you can individually control the document entry for individual FI 

document types and in doing so also control individual request types (for example, payment request, 

clearing request). 

Requirements 

If you want to format the field selection differently for individual request type, you must observe the 

following: 

- Which FI document type is assigned to the individual request types in step Assign Request Category 

to FI Document Type? 

If the FI document type, for example, does not allow an asset posting in the payment request, the 

field Asset may not be indicated as a an optional entry or required entry. 

- Which fields must appear because of the request type and which don´t? 

The fields Customer and Vendor, for example, must be hidden in the clearing request. 
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- Which settings have you maintained in section Maintain Global Settings? If you do not use the 

revenue type function, for example, field Revenue type must be hidden in all requests. 

Standard settings 

SAP does not provide any field selection strings in the standard. 

If you do not define any field selection strings, all fields in the request entry screens will be ready for 

input. 

Fields for the proposed values (such as customer, earmarked fund) are always ready for input in the intial 

screens of the request. The settings in the field selection string are not considered there. 

The required entry field check is only performed directly in the individual request screen. In all other 

cases, the required entry field check is not performed until the request check is performed. 

Activities 

1. Determine which fields in the entry screens during the entry of a request 

- are to be ready for input 

- must be filled 

- should be hidden 

- are to be displayed 

2. Using New entries create a field selection string and choose Maintain field status for field 

selection string. 

The field status for all fields is in green. The text fields are preassigned with field status "Proposed", 

all other fields have status "Optional entry". 

3. Choose the desired field tatus for each field. 

By specifying a request type in field Proposed, you can display which field status is required for the 

individual fields for the individual request types. 

4. In the following step  Assign field selection string, assign the field selection string to a company 

code variant and FI document type. 

Further notes 

To avoid inconsistencies with FI field control, you should indicate that all fields that are used in the field 

control of requests as optional entries in the FI field control. 

If, for example, the field Item text is indicated as a required entry in FI field control, but was hidden in 

the field control for the requests, the posting or "complete" setting of a request is not possible. 

See Define Field Status Variants for more information about field control in FI. 

The tax commitment item is an exception in field control: If the tax update does not require a tax 

commitment item, (VAT separately), possible setting concerning tax items in the request will be ignored. 

See section Make Other Settings for more information on tax display. 
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36.2.5.2.9.2 Assign Field Selection String 

In this step, you assign a field selection string to a company code group and document type. You can 

assign a field selection string to as many company code groups and document types as you wish. 

Requirements 

Before doing so, you must have carried out the following steps: 

- Define Field Selection Screen 

- Define Company Code Group 

- Assign Request Category to FI Document Type 

Standard settings 

SAP does not provide any assignments in the standard. 

If you do not assign a field selection string, all fields in the entry screens will be ready for entry in the 

requests. 

Activities 

Make the desired assignments. 

36.2.5.2.10 Additional Details 

In the following work steps you undertake different additional settings for requests. 

36.2.5.2.10.1 Define Deduction Reasons 

In this step you define deduction reasons. 

According to the gross principle too many incoming amounts must be estimated and posted as 

expenditures. Under conditions - stipulated by law - it is possible to have a variance from this. 

These exceptions are named as deductions. 

Deduction reasons are specified at document postings and are therefore available for evaluations. 

Example 

The repayment of too many incoming amounts can be deducted from the revenues if the repayment takes 

place in the same year. 

Activities 
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Create the deduction reason via New entries. You can also copy already existing entries via Edit -

>Copy as. 

36.2.5.2.10.2 Define Regions 

In this step you define regions. 

If you specify the regions defined here at document posting, you can evaluate the postings which have 

taken place per defined region. 

Activities 

Create the region via New entries. You can also copy already existing entries via Edit ->Copy as. 

36.2.5.2.10.3 Define Funds Usage 

In this step you define the funds use. 

If you enter the funds use defined here at document posting, you can evaluate the postings after the funds 

use. 

Activities 

Create the funds use via New entries. You can also copy already eintries via Edit ->Copy as. 

36.2.5.2.10.4 Set Up Amount-Based Payment Block 

In this step you define a payment block per company code, amount and currency. 

The Amount for payment block document describes how this amount affects the payment program. 

Requirements 

Payments block reasons must be set up in the system. For this, see the documentation on the step Define 

Payment Block Reasons in the Financial Accounting component. 

For detailed information on configuring the payment program, see the SAP Library under: FI Automatic 

procedures. 

Activities 

Make the desired entries in the table. 
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36.2.5.2.10.5 Define Rounding Unit for Due Dates 

You require this setting if you want to divide a request into different due dates. If the partial amounts are 

not to be divided in the actual currency unit, but rather in a multiple of it, then specify the rounding unit 

in this section. The residual amount which arises from the rounding is added to the last installment. 

Example 

For an example of using the rounding unit, see Example. 

36.2.5.2.10.6 Create Earmarked Funds for Standing Request 

In this step, you stipulate whether the program should automatically create earmarked funds for all 

standing requests entered in a company code. 

The program creates a earmarked funds for the current fiscal year from the data of a standing request 

source document and from the information that you have defined in this step. The amount of earmarked 

funds comes from the amount of an execution date and the number of executions in the fiscal year. 

If you have stipulated in this step that earmarked funds should be created for standing request source 

documents, then you cannot manually enter the earmarked funds in the standing request source document. 

When you make an entry using a template or using a default funds commitment, data derived from the 

funds commitment is also transferred the request. However the actual earmarked funds are not 

transferred, instead the program creates new earmarked funds when you save. 

To prevent the manual processing of earmarked funds, you must define a block for earmarked funds in 

this step. 

The category of the earmarked funds depends on the assignment document type - request categories. The 

following earmarked funds categories are generated: 

- Funds commitment: if the document type is assigned to request category '01' (payment request) 

- Forecast of revenues: if the document type is assigned to request category '02' (acceptance request) 

If the assignment document type- request category is to be changed, the entries for the affected document 

types in "Create Earmarked Funds for Standing Request" must be deleted and recreated. 

Activities 

Specify which document types for the funds commitment and which block flags you wish to use for your 

company code and the request document types being used. 

Further notes 

For further information about features of standing requests, refer to the SAP library under Funds 

Management Government  in area Requests. 

36.2.5.2.10.7 Request Printout: Assign Own Forms 
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SAP delivers several print format templates (forms) for the printing of requests. Each form is assigned to 

a form type that groups the different types of requests from a printing perspective. This grouping is done 

internally in the program and is not identical with the request category. 

If the form that is assigned to a form type does not meet the requirements of your organization, you must 

define your own form. You can use the forms delivered as a reference to do this. 

In order for the program to access the form you have defined when printing the request of this request 

type, you must assign the form to the request type. The assignment is defined in this step. 

If you do not assign a form to a request type, the printing of the request type will be done using the style 

sheet as defined by SAP in the program. The relevant SAPscript form for the corresponding form type is 

used. 

Standard settings 

The standard system contains a number of different form types. The different collective request types 

differ from one another by the account assignment information they contain: 

Collective Request Account Assignment Information 

Type 1 or 

vendors 

 an FM account assignment but various customers 

Type 2 

customer or vendor 

 various FM account assignments but one 

Type 3  various FM account assignments and various 

customers or vendors 

Type 4  an FM account assignment and a customer or vendor 

The request type and the form type differ from each other in the following cases: Deferral request, 

temporary waiver and remission are assigned to form type acceptance or payment request. 

Standard forms are delivered by SAP in two different technologies: 

- SAPscript Forms 

- PDF-based Forms 

SAP delivers the following templates for PDF-based forms: 

- FM_ACCEPTANCEREQUEST Acceptance request 

- FM_ACCEPTANCEREQUEST_TYP1 Acceptance request type1 -

 FM_ACCEPTANCEREQUEST_TYP2 Acceptance request type2 -

 FM_ACCEPTANCEREQUEST_TYP3 Acceptance request type3 

- FM_ACCEPTANCEREQUEST_TYP4 Acceptance request type4 

- FM_CLEARINGREQUEST Clearing request 

- FM_PAYMENTREQUEST Payment request 

- FM_PAYMENTREQUEST_TYP1  Payment request Type1 
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- FM_PAYMENTREQUEST_TYP2 Payment request Type2 -

 FM_PAYMENTREQUEST_TYP3 Payment request Type3 -

 FM_PAYMENTREQUEST_TYP4 Payment request Type4 

Recommendation 

If you want to change the standard system form, SAP recommends copying the delivered form and then 

changing the copy. 

You maintain SAPscript forms in transaction Form Painter and PDF-based forms in the transaction Form 

Builder. 

To change or recreate a PDF-based form, you must use the form interface FM_REQUEST. Only these are 

used to print the requests. 

Activities 

Make the required assignments. 

Further notes 

Form types collective request type 1, type 2 and type 3 reduce the printing volume. The option of 

suppressing the grouping of data is available in the Customizing of Funds Management Government 

because under certain circumstances some interesting data may not be printed. You make this setting for a 

company code group in the IMG activity Define Company Code Group. 

36.2.5.2.10.8 Define Interest Calculation 

Use 

You create an interest formula in this IMG activity. The interest formula combines the following factors: 

- Whether one or a number of interest items should be generated 

- An interest calculation indicator that is defined in Customizing of Financial Accounting. 

Interest that is calculated using the interest calculation indicator is always on a year basis. 

- An interest rate that you enter manually if you do not want to work with an interest calculation 

indicator. 

- The interest base defines whether the interest rate is an annual, monthly or daily interest rate. 

- Using the interest basis, you define whether the interest should be calculated for started or 

completed months or for days. 

In addition, you can define the following currency-dependent entries: 

- The so-called petty amount. The program only generates an interest item if the interest amount 

calculated is above this amount. 
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- Rounding units for the base amount and for the interest calculated. 

- You can also define whether the interest amount should be rounded up or down. 

If you want to generate interest items for a request, the program displays the interest formula that you 

created as input help. The program saves the interest formula in the interest document generated. In this 

way, the type of interest calculation can be traced for each interest document. When you print the interest 

document, the interest formula and the interest calculation date are not printed. However, they are in the 

structure used for transferring the data to the printing program, so you can print them in customer-defined 

forms. 

If you want to change an interest formula, you must check whether interest documents with this interest 

formula are already saved in the system. If this is the case, SAP recommends that you create a new 

interest formula in Customizing, otherwise the interest calculation of the old interest documents can no 

longer be traced. 

Requirements 

You define the interest calculation indicator in Customizing of Financial Accounting in the IMG activity 

Define Interest Calculation Types. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Define the settings required. 

36.2.5.2.10.9 Permit Negative Postings 

Use 

In this activity you allow negative postings. You define whether negative postings are allowed for each 

company code group, fiscal year variant, and document type. 

Requirements 

You must have defined the required settings for negative postings in FI Customizing. 

In Funds Management, no check is carried out on the FI Customizing for negative postings in this 

activity. If the negative postings are not allowed in FI, you cannot enter any negative postings in requests. 

Example 
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In the following example, a negative posting is carried out for the entry for company code group 1000 

with fiscal year ID if a deduction with document type DZ (customer payment) or a request with a set 

inverse posting indicator and the document type DZ (customer payment) is entered. 

CCG FYID Type Allow negative postings 

1000 2006 DZ Yes 

36.2.5.2.10.10 Define Additional Lines for Advance Payment (Spain) 

Use 

This IMG activity is for the use of Spanish customers. Here you can define: 

- A G/L account to be derived from the document type when a payment request is created 

- New documents to be automatically posted when a payment request is posted See the example 

below for further details. 

Requirements 

The following prerequisites apply: 

- The Business Add-In implementation BAdI: Activate Posting of Subsequent Documents must be 

active. 

- The Spanish Budgetary Ledger must have been maintained. 

Example 

For the two functions involved, there are two examples: 

- G/L account to be derived from the document type Under the node Payment Request you 

enter the following data: 

 CoCode Doc. Type First Year G/L Account 

 001 AA 2005 999999 

Note 

This line is entered only once. Then, every time you create a payment request for company code 

001, document type AA, in fiscal year 2005 or the following, G/L account 999999 is automatically 

derived for the payment request. 

- New documents to be automatically posted 

Under the node Payment Request, you enter the same data as in the above example. Under the 

node Lines for New Postings, you enter the following: 

Counter Doc.Type Vendor PK SpGLAc Acct Off.PK Off. Acct 

1 A1 X 29 Z - 50 111111   
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2 A1 X 29 H - 50 111111   

3 A1 X 21 - 50 111111   

4 A1 40 111111  50 444111   

5 A2 40 111555  50 555000   

In this case, when you post a payment request as specified in the first example, two new documents 

are generated and posted. Both of them contain the same amount as the payment request: 

- The first document has document type A1 and contains four line items: 

- One line item is to be posted for the vendor. In this example, there are three lines 

for vendor posting (for different special GL indicators). When the payment request is posted, 

only the line with the same GL indicator as the one used in the payment request is used for the 

new document. 

If the payment request has special GL indicator Z, Customizing lines 2 and 3 will be ignored. 

If the request has special GL indicator H, Customizing lines 1 and 3 will be ignored. And if the 

request has no special GL indicator at all, Customizing lines 1 and 2 will be ignored. 

- The second line uses posting key 50 to post to account 111111. 

- The third line uses posting key 40 to post to account 111111. 

- The fourth line uses posting key 50 to post to account 444111. 

- A second document is posted with document type A2 using posting key 40 to post to account 

111555. As the counterpart, posting key 50 is used to post to account 555000. 

36.2.5.2.11 Business Add-Ins (BAdIs) 

36.2.5.2.11.1 BAdI: Change GUI Status of Requests 

Use 

This Business Add-In (BAdI) is used in component Funds Management (PSM-FM). You can use this 

Business Add-In (BADI) to change the  GUI Status of Requests. 

Standard settings 

The BAdI is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 
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1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

See also: 

Methods 

Change of GUI status on the request screen 

Ok Code Processing 

Interfaces 

Interface Docu 

36.2.5.2.11.2 BAdI: Enhance Derivation of G/L Account 

Use 

You use this Business Add-In (BAdI) to implement your own derivation of G/L account from 

commitment item, funds center and fund. 

The BAdI is mainly called when entering requests. However, the BAdI is also run for programs that use 

the G/L account determination for requests, for example, when the derivation is configured for earmarked 

funds. 

Starting from Release 1.10, the derivation of the G/L account is supported only in accordance with the 

commitment item. The funds center or fund are no longer considered with the G/L account determination 

as this can cause an error to occur in the account assignment when using component CO at the same time. 

This is due to the flow of account assignment derivations: 

Overview of flow of account assignment derivation for requests 
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1. Manual entry of account assignments such as commitment item, CO account assignment and so on. 

2. Derivation of G/L account from the commitment item and calling the BAdI 

3. Derivation of more account assignments using the account assignment block and simultaneous 

calling of the Define Account Assignment Derivation for deriving FM account assignments (for 

example, funds center from cost center or funds center as default funds center of the respective 

commitment item). 

In accordance with this flow logic (steps 1 - 3), the following problems may occur when using the BAdIs: 

- If you do not enter the funds center in step 1 manually, but it is first derived in step 3, you 

cannot use the funds center to derive the G/L account in step 2. 

- If you enter the funds center in step one instead, then the G/L account is derived through the 

activated BAdI depending on step 2. If a different funds center is derived in step 3, the derived 

G/L account may not match the derived funds center. 

If you want to enter a funds center and fund (in spite of the mentioned problems) for the G/L account 

derivation, you can create a customer- specific implementation using this BAdIs. You can use the coding 

example of the BAdI delivered by SAP for this. With this coding example the G/L account is derived in 

accordance with the commitment item, funds center and fund entered in the request. 

In this case, you must ensure that: 

a) the funds center or fund of the user necessary for the derivation (step 1) has been entered 

b) the funds center and fund entered are not overwritten by derived values with the account 

assignment derivation (step 3) 

Standard settings 

The BAdI is not active in the standard delivery. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 
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5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such 

a case, end the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

In order to copy the sample coding example to your customer method, on the initial screen of your 

implementation, choose  Go To -> Coding Example -> Copy. 

Notes 

Documentation on BAdI method DERIVE_GL_ACCOUNT 

36.2.5.2.11.3 BAdI: Activate Authorizations on FI Accounts 

Use 

Using this Business Add-In (BAdI), you can enhance the authorization check for the reports document 

journal and request journal with the following authorization objects: 

- F_BKPF_BES   Accounting document: account authorization for subledger accounts 

- F_BKPF_BED   Accounting document: account authorization for customers 

- F_BKPF_BEK   Accounting document: account authorization for vendors 

Standard settings 

The checks are delivered using the implementation FMRP_ACCOUNT_AUTH. The activity '03' 

(Display) is used for calling them from the reports. 

The BAdI is not active in the standard system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 
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If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Also see: 

Method: FI-Check Account Authorization 

36.2.5.2.11.4 BAdI: Check and Post Documents Subsequently 

Use 

You can use this Business Add-In (BAdI) to post more documents with requests. 

Requirements 

Note that documents that are posted with this BAdI are saved in all request transactions. Because of this, 

a COMMIT WORK in the implementation is not allowed. This can cause errors in all request 

transactions. 

Standard settings 
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For Spanish processes, the active implementation FM_REQUEST_FLLW_DOC_SPAIN is delivered. 

The implementation is filter-dependent and will only run if you have activated it in the Customizing of 

the Spanish budgetary ledger. 

For more information on Spanish processes, see the documentation on class interface 

CL_FM_REQUEST_FLLW_DOC. 

Activities 

The BAdI is filter-dependent. Possible filter values are: 

 20 Spain Active Implementation for Spanish processes are run 

 99 Customer implementation Active customer implementation 

Active customer implementations can be run even when the filter value is 20. If this is the case, the 

customer implementation must be checked for filter value 20. 

The BAdI: Check and Post Documents Subsequently (FM_REQUEST_FLLW_DOC) is 

called with each request transaction. The key for the individual transactions is delivered in the BAdI 

method. Possible values are: 

01 Enter 

02 Change 

03

 Dis

play 

 43 Approve 

 10 Post 

36.2.5.2.11.5 BAdI: Activate Posting of Subsequent Documents 

Use 

In this IMG activity, you activate the BAdI implementation to create additional documents for a payment 

request. 

Standard settings 

If the implementation is inactive, click on this activity and you will see a pop-up to confirm the 

activation of the implementation. 

Activities 
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To customize the documents that will be posted after you post a payment request, make the necessary 

settings in the IMG activity Additional Lines for Advance Cash Payment. 

For further information read the documentation of the IMG activity. 

36.2.5.3 Payment Directives 

Use 

In this IMG activity, you customize payment directives for a company code. 

Requirements 

You must have set up a special G/L reconciliation account in SAP Financial Accounting (FI), which must 

contain at least one commitment item processed with financial transaction 80. 

Furthermore, you must make an entry in the special G/L account configuration transaction 

OBXT. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. Choose New Entries. Then use the dropdown box to choose the settings. 

2. In the company code field, enter the company code for which these settings are valid. 

3. Select a document type. The document type must be the one for which the payment directive is 

posted. Note that this document is not the one used in the payment directive itself. The payment 

directive references a document of this type. 

You can use payment directives for an invoice document type, if you want a payment directive to be 

mandatory for the invoice. 

4. Select the posting key for the payment directive line item that matches the original (referenced) 

document. 

5. Select the posting key and the special G/L indicator for the offsetting line item of the payment 

directive. 

6. Finally, select the payment blocking key to be used to block the payment of the original document 

(for example, the invoice). 

7. Save your entry. 

Example 

You want to customize payment directives for document type KR (invoices) in company code 0000. 
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First you specify the company code and document type as described above. Then enter a payment block, 

for example "B". This is the payment block with which the invoices in that company code are blocked for 

payment. The only way to pay these invoices is by creating a payment directive. 

Next , you enter the posting characteristics of the payment directive, which means entering the posting 

keys (PK) and the special G/L indicator for the payment directives. For example, here the posting keys 

would be 22 and 39Z, as follows. 

1) For the invoice, blocked for payment with payment blocking key "B": 

 Itm PK  Account Account short text Assignment Tx Amount 

1 31 AAAA Vendor AAAA V0 - 10 

2 40 400000 Purch. raw material V0   10 

2) For the resulting payment directive: 

Itm PK  Account Account short text Assignment Tx Amount 

1 22 AAAA Vendor AAAA V0   10  

2 39Z AAAA Vendor AAAA V0 - 10  

36.2.5.4 Cash Desk 

In the following steps, you make the settings required for the cash desk, more specifically, the settings for 

day-end closing and the dunning procedure. 

36.2.5.4.1 Payment at Cash Desk 

In this section you maintain the settings required for cash desk processing. 

36.2.5.4.1.1 Create Number Range Intervals for Cash Desk Documents 

In this step you create the number range for the cash desk documents in Funds Management for each 

company code and each fiscal year. 

Standard settings 

The number range 01 is delivered with the Standard system for Funds Management. 

The number assignment for cash desk documents always takes place internally in Funds Management. 

Activities 

1. Specify the company code for which you want to create the interval. 
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2. You should only use number range interval 01, which is delivered with the standard. You cannot 

create a new number range interval, as, by default, the system only assigns numbers from number 

range interval 01. You can extend this number range interval if necessary. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.5.4.1.2 Define Payment Transactions 

In this step you define payment transactions. Payment transactions differentiate the payment transactions 

in the cash desk, for example dividing them into incoming and outgoing payments. You can also 

differentiate between cash and check payments. 

When entering a cash desk document, a payment transaction must always be specified. This identifies the 

type of payment and controls the further processing of the document. 

Incoming and outgoing payments 

You differentiate incoming payments from outgoing payments by setting the appropriate D/C ind. for the 

payment transaction. 

Checks 

Checks are usually entered with the manual check deposit transaction and posted in component Financial 

Accounting. Checks accepted at the cash desk must be entered with a payment transaction, for which the 

indicator "Statistical transaction" has been set. 

Outgoing payments - such as special social welfare payments - that are related to a financial accounting 

document must have a payment transaction, for which the indicator FI outgoing payments is set. Indicator 

"PB (payment block)" should also be set for this payment transaction. 

Down payments 

Down payments that are to be posted from a customer or a vendor with a special G/L indicator in 

Financial Accounting must have a payment transaction, for which the relevant G/L indicator is set. 

Reversal Documents 

You can assign a reversal document type to a payment transaction. If you have maintained a user-defined 

form printout for this reversal document type in step Maintain Receipt Printout, differents forms are 

used for the cash document and the corresponding reversal document. If you have not defined a reversal 

document type for a payment transaction, the form assigned to the payment transaction is used for the 

printout of the reversal document. 

You define reversal document types in the Customizing of Financial Accounting under Define Document 

Types. 
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Requirements 

Any payment blocks you want to define for a payment transaction must be defined in the Financial 

Accounting Customizing. For more information about payment blocks, see the Financial Accounting 

IMG in section "Check payment block reason". 

Activities 

Define your payment transactions. 

36.2.5.4.1.3 Assign General Ledger Account to Cashier 

In this step you can define an individual account for each company code and each payment transaction for 

every cashier. 

Activities 

Make the assignments. 

If you only enter a company code and a G/L account, all of the payment transactions processed by the 

cashiers are posted to this account. 

If you only enter a company code, a cashier and a G/L account, all of the transactions processed by that 

cashier are posted to the specified account. 

36.2.5.4.1.4 Define Printed Receipt 

In this IMG activity, you assign the receipt forms of a document type. You also determine how many 

receipts should automatically be printed when the cash desk document is saved. 

Requirements 

In step Determine Payment Transactions, you define payment transactions for document types. 

Standard settings 

SAP delivers a SAPscript form (RECEIPT) as an example with the standard system and a PDF-based 

form (FM_RECEIPT) as an example. 

Recommendation 

If you want to change the form of the standard system, we recommend copying the form delivered and 

then changing it. 

You maintain SAPscript forms in the transaction Form Painter and PDF-based forms in transaction Form 

Builder. 
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To change or recreate a PDF-based form, you must use the form interface FM_RECEIPT. Only 

this is used for printing the receipt. 

Activities 

1. Check whether you want to use the form included in the standard delivery. To display or change 

forms, from the menu, choose Tools -> Text Processing -> Form. 

2. If necessary, change the form or create a new form. 

3. Assign the forms to document types and determine the number of receipts that should be printed. 

36.2.5.4.2 Close Posting Day 

In the following steps, you make the settings required for executing a day-end closing. 

36.2.5.4.2.1 Assign Posting Day to Company Code/FM Area 

In this activity, you stipulate the closing groups for day-end closing. You must assign each group to at 

least one FM area/company code combination. This ensures that all FM areas and company codes in a 

closing group are working with the same posting date. 

The posting date is required for the day-end closing. To be able to carry out day-end closing, you must 

also maintain a summary key in the next step. 

You only need to enter the posting date the first time you use the system. 

When you carry out day-end closing for the current posting date, the system sets the posting date to the 

next posting date, based on the factory calendar you have defined. It also deletes all the posting dates 

earlier than the next one, because postings for these dates are either not permitted or simply superfluous. 

The system enteres the posting date in the document header for each posting document. 

Activities 

1. Make the assignments for the FM area and company codes used. 

2. Use the next step to maintain the summary keys. 

36.2.5.4.2.2 Maintain Summarization Key (FI Accounts) for Day-End Closing 

This hypertext is only relevant for German Local Authorities customers. 

36.2.5.4.2.3 BAdI: Definition of Print Layout for Day-End Closing 

Use 
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With this Business Add-In (BADI) you can print the totals list of day-end closing to suit your own 

requirements, for example in a SAPScript form. 

Standard settings 

The Business Add-In is not active in the standard system. The list printed is based on the SAP List 

Viewer. The functions of the SAP List Viewer can be found in the documentation on this tool. This 

documentation is in the SAP Library under CA - Cross-Application Components -> General 

Application Functions -> SAP List Viewer. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

- Documentation on BADI Method PRINT_TABS 

- Documentation on BADI Method PRINT_ACTIVE 
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36.2.5.4.3 Dunning Procedure 

In this step, you make the settings that you require for the IS-PS enhancement of the dunning program. 

36.2.5.4.3.1 Extend Dunning Procedure 

In this section you extend the dunning procedure of component FI to include funds management specific 

settings. 

You can stipulate the following for all dunning procedures: 

- If dunning charge and/or dunning interest are posted 

- Due date for dunning interest 

- Whether it is a private law or a public law dunning procedure. 

- For Public law dunning procedures, the calculation of the dunning charge and dunning interest 

will deviate from the calculation in the dunning procedure in component Financial Accounting. 

Using the additional data for public law dunning procedures you can adjust the calculation of 

dunning charges and interest according to the needs of your organization. For information about the 

individual control options see the field help while entering additional data for public law dunning 

procedures. 

Requirements 

You can only use dunning procedures which you have previously defined in component Financial 

Accounting. 

If you are a German Government customer, a dunning procedure can only lead to execution if the Use 

Execution indicator was set in the "Maintain Global Settings" step. 

Standard settings 

No table entries are delivered in the standard. 

Activities 

Select the desired Funds Management specific function for the dunning procedure. 

36.2.5.4.3.2 Define Grace Period for Public Law Dunning Procedure 

Use 

In this IMG activity, you define grace periods for a combination of dunning procedure and document 

type. 

Grace periods can only be defined for public law dunning procedures. Entering document types means 

that you can control the grace period per payment type. For example, if you want to define that the 

program considers a grace period of 5 days for a bank transfer, but not for cash payments, then you must 
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have created a document type for both payments (bank transfer and cash payment) in the system. Define 

a grace period of 5 days for the bank transfer and you do not have to enter anything for the cash 

payment. 

When public law dunning interest is calculated (penalty surcharges), grace period is added in days or 

months at the end of the due date of the invoice. If the day calculated is a weekend or a public holiday, 

the end of the grace period is moved to the next weekday. All payments for this invoice for which this 

grace period is set and were made within this grace period are treated as if they were already made by the 

due date when the penalty surcharges are calculated. 

Note that the grace period only changes the due date of particular documents at the time of the calculation 

of the dunning interest. It has no effect on whether, for example, the invoice is dunned within the grace 

period. If you want to prevent an item being dunned within the grace period, you have to define the 

relevant days in arrears for each dunning level when you define the dunning procedure. 

Note: 

The program also evaluates the settings that you define here during the calculation of dunning interest 

according to receivables clearing. 

Requirements 

You have flagged at least one dunning procedure as public law in the IMG activity Enhance Dunning 

Procedure. 

Standard settings 

SAP does not deliver any standard settings. 

Example 

The following example is based on German law: 

If you want to follow § 240 of the general tax code, enter a grace period of 5 days for the document type 

bank transfer and for the relevant public law dunning procedure. 

36.2.5.4.3.3 Assign Dunning Procedure to a Dunning Area 

In this step, you assign a dunning area to a dunning procedure. This assignment is the basis for the 

program RFFMKWD0 and RFFMKWD1 which you can enter or update the assignment of dunning areas 

to dunning procedures in customer and vendor master records. 

Requirements 

You can only use dunning procedures and areas which have been defined in Financial Accounting. 

Standard settings 

The tables in the system we deliver are empty. 

Activities 

Make the assignments. 
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36.2.5.4.4 Petty Amount Rule 

You enter the settings for the petty amounts rule in the following steps. This rule applies if customers or 

vendors do not pay the exact amount due, but pay too much (overpayment) or too little (underpayment). 

See the Process petty amounts documentation for more information about how the petty amounts rule 

works. 

36.2.5.4.4.1 Define Petty Amount Limits 

You define the amounts for the petty amounts rule in this step - one for underpayment and one for 

overpayment. The petty amounts rule applies if the overpaid or underpaid amount is less than the defined 

amount. 

You enter the respective amounts naming a revenue type. When determining the overpayment or 

underpayment, the program first processes all postings it finds with a revenue type entry (the entry 

"empty" is also considered). 

In addition, you can define a dunning level at which the petty amounts rule should apply. 

Recommendation 

We recommend entering amounts for underpayment and overpayment for generic revenue type 

"*". In doing so, the program can also process postings in which revenue items assigned to 

account that were not explicitly assigned in this step. 

Further notes 

See the Process petty amounts documentation for more information about the petty amounts rule. 

36.2.5.4.4.2 Define Posting Information for Petty Amounts 

You define the posting information for the petty amounts rule in this step. This rule applies if customers 

or venders do not pay the amount due exactly, but pay too much (overpayment) or too little 

(underpayment). 

If you have stipulated, in the Customizing of Funds Management Government in step Maintain 

global settings, that you are working with revenues types, you must enter a revenues type here for 

account assignment information. In this case, the program does not evaluate any funds center or 

commitment item entries. 

Activities 

Define the account assignment information separately for overpayment and underpayment. 

Further notes 
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See the Process Petty Amounts documentation for more information about the petty amount rule. 

36.2.5.4.5 Derive Processor from Customer Master 

In the following steps you make the system settings which are required for automatically deriving the 

responsible accounting clerk in each case, from the name of the customer. 

Note: 

The name enhancement must be activated so that the program can derive the assignment of the 

responsibilities from the last names of the customers. The first and last names are stored separately in this 

case. You activate the name enhancement in the implementation guide of Funds Management 

Government in IMG activity Maintain Global Settings. 

36.2.5.4.5.1 Define User Role 

This hypertext is only relevant for German Local Authorities customers. 

36.2.5.4.5.2 Assign Name Interval to Processors 

In this step, you assign the customers to the accounting clerks that are responsible for them for each 

company code. 

You define a name interval and a validity period from which the assignment is valid. 

The accounting clerk responsible can be derived from the last name of the customer and does not have to 

be entered manually when you create or change a customer master record. 

Requirements 

- A user role must be assigned to the company code used. 

You can find more information in the section "Define User Role". 

- The accounting clerks must be created in Customizing of Financial Accounting. You can find more 

information in the implementation guide (IMG) of Financial Accounting in section  "Enter 

Accounting Clerk Identification Code for Customer". 

- If automatic derivation is always necessary and if it should not be possible to overwrite it with a 

manual entry, you have to define that messages 032 and 033 appear as error messages in message 

control. 

You can find more information on message control in the IMG of Funds Management Government 

in the section "Change Message Control". 

Activities 

Assign the name interval to the accounting clerk responsible. 

You can adapt existing customer master data using program RFFMSETB. This program includes all 

assignments of name intervals to accounting clerks maintained in Customizing. 
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36.2.5.4.6 Payment Transfer 

In the next steps, you make the definitions that are required for the processing of payment transfers using 

transaction FMITPO. 

Using this transaction, you can transfer automatically generated payment items without a reference to 

invoice (receivable) of sub-ledger accounts wrongly posted to, or interim accounts created especially for 

this purpose to a sub-ledger account in which an invoice can be assigned or is expected. In every posting 

transaction, a received down payment or partial payment to a target account (customer or vendor) is 

posted as a target item. 

In addition, the payment transfer transaction contains other functions as well. These functions differ in 

their business relevance, but are realized by one transfer each. The following functions are available: 
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Transfer 

You can use this function to transfer an incoming payment, a partial payment, a credit memo or 

down payment received. 

- Distribute and transfer 

You can distribute and transfer an incoming payment, a partial payment, a customer credit memo or 

a down payment received to several account assignments using this function. 

- Statement for reimbursement 

The function represents an interim for the reimbursement of a credit item in a customer account. In 

doing so, an optional partial amount is transferred to a special general ledger activity to be set up for 

this. This special general ledger activity can take part in the automatic payment run via the payment 

program. In addition, the reimbursement document can be paid in cash. 

- Assign invoice 

You can assign an incoming payment, partial payment, a customer credit memo or a down payment 

received to an invoice using this function. In doing so, a transfer with a partial payment as a target 

item is created. 

36.2.5.4.6.1 Enter Settings for Functions Distribute/Transfer Posting 

In this step, you make the settings for a company code, that are required for functions Transfer and 

Distribute and transfer  in the payment transfer function (FMITPO). You can also define default values 

for the entry of these payment transfers. 

You must maintain the following settings: 

- Define a baseline date for payment, that is suggested when entering a document. For this type of 

payment transfer, SAP recommends the Baseline date of the initial item. 

- Define special G/L indicator, which determines the reconciliation account in which the line items in 

the general ledger are updated. 

To do this, you can use the special G/L indicator A which is delivered with the standard. 

- Define interim account 

For technical reasons, the Interim account is necessary for updating payments in Funds 

Management Government. 

This account can only be used for these automatic postings. 

You can maintain the following settings: 

- Define the document type that is suggested when entering a document. 

- Set indicator for the initial item comment in the document header text of the payment transfer. 

- Set indicator for automatic document print on saving. 

- Define correspondence type for print. 

Requirements 
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- Special G/L indicator 

If you want to use your own special G/L indicator for this type of payment transfer, you must have 

created it in the Customizing of Financial Accounting. To do this, select the following in the 

Customizing of Financial Accounting 

- for customer down payments 

Accounts receivable accounting and accounts payable accounting -> Business 

transactions -> Down payments received -> Define reconciliation accounts for 
customer down payments. 

- for vendor payments 

Accounts receivable accounting and accounts payable accounting -> Business 

transactions -> Down payments made -> Define different reconciliation account for 
down payments. 

- Document type 

The document type must be created in the Customizing of Financial Accounting under Basic 

settings Financial Accounting -> Document -> Document header -> Overview . 

- Interim account 

The interim account must be created as a bank clearing account. A commitment item must be 

created in this account using Financial transaction Post cash holdings (90). 

Correspondence 

The correspondence type must be created in the Customizing of Financial Accounting along the path 

Basic settings Financial Accounting -> Correspondence -> Define correspondence types. You 

should use the correspondence type Internal document (SAP09), which is delivered with the standard, 

as a template. You must also have executed all the other IMG activities that are required for the 

correspondence, if you want to print out payment transfer documents. These activities include the 

creation of your own form, for example. 

Activities 

Make your definitions for the functions Transfer and Distribute and transfer. 

36.2.5.4.6.2 Enter Settings for the Statement for Reimbursement Function 

In this step, you make the settings for a company code, that are required for the function Statement of 

reimbursements using transaction payment transfer (FMITPO). You can also define default values for 

the entry of these payment transfers. 

You must maintain the following settings: 

- Define a baseline date for payment that is suggested when entering a document. SAP recommends 

the Current date  for statements for reimbursement. 
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Define special G/L indicator that determines the reconciliation account in which the line items in the 

general ledger are updated. 

SAP recommends that you define your own special G/L indicator for statements for reimbursement. 

You should have already created this special G/L indicator in the Customizing of Financial 

Accounting. 

- Define payment method 

- Define interim account 

For technical reasons, the Interim account is necessary for updating payments in Funds 

Management Government. 

This account can only be used for these automatic postings. 

You can maintain the following settings: 

- Define the document type that is suggested when entering a document. 

- Set indicator for the initial item comment in the document header text of the statements for 

reimbursement. 

- Set indicator for automatic document print on saving. 

- Define correspondence type for print. 

Requirements 

- Special G/L indicator 

The special G/L indicator that you want to use for the statements for reimbursement must be created 

in Customizing of Financial Accounting. This G/L indicator must be assigned to class "Payments". 

You must create the special G/L indicator for account types D and K, even if negative payments are 

reimbursed to a vendor account. The description that you define for the posting keys is printed out 

in the reimbursement document. To create a special G/L indicator select the following in 

Customizing of 

Financial Accounting for customer down payments 

Accounts receivable accounting and accounts payable accounting -> Business 

transactions -> Down payments received -> Define reconciliation accounts for customer 
down payments. 

- for vendor down payments 

Accounts receivable accounting and accounts payable accounting -> Business 

transactions -> Down payments made -> Define different reconciliation account for 
down payments. 

- Document type 

The document type must be created in the Customizing of Financial Accounting under Basic 

settings Financial Accounting -> Document ->Document header -> Overview. 

- Interim account 

The interim account must be created as a bank clearing account. A commitment item must be 

created in this account using Financial Transaction Post cash holdings (90). 

Correspondence 
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The correspondence type must be created in the Customizing of Financial Accounting along the path 

Basic settings Financial Accounting -> Correspondence -> Define correspondence types. You 

should use the correspondence type Internal document (SAP09), which is delivered with the standard, 

as a template. You must also have executed all the other IMG activities that are required for the 

correspondence, if you want to print out payment transfer documents. These activities include the 

creation of your own form, for example. 

Activities 

Make your definitions for statements for reimbursement. 

36.2.5.4.6.3 Enter Settings for the Assignment of Invoices Function 

In this step you make the settings for a company code, that are required for Assign invoices function 

using the payment transfer transaction (FMITPO). You can also define default values for the assignment 

of invoices. During the assignment of invoices, a transfer posting with a partial payment is generated as a 

target item. 

You must maintain the following settings: 

- Define a baseline date for payment that is suggested when entering a document. 

SAP recommends the Baseline date of the initial item for the assignment of invoices. 

- Define interim account 

For technical reasons, the Interim account is necessary for the updating of payments in Funds 

Management Government. 

You must only use this account for automatic postings. 

You can maintain the following settings: 

- Define the document type that is suggested during document entry (entry of partial payment). 

- Set indicator for the initial item comment in the document header text of the partial payment. 

- Set indicator for automatic document print on saving. 

- Define correspondence type for document print. 

Requirements 

- Document type 

The document type must be created in the Customizing of Financial Accounting along the path 

Basic settings Financial Accounting -> Document -> Document header -> Overview 

- Interim account 

The interim account must be created as a bank clearing account. A commitment item must be 

defined in this account using the Financial transaction Post cash holdings (90). 
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Correspondence 

The correspondence type must be created in the Customizing of Financial Accounting along the 

path Basic settings Financial Accounting -> Correspondence -> Define correspondence 

types. You should use the correspondence type Internal document (SAP09), which is delivered 

with the standard, as a template. You must also have executed all the other IMG activities that are 

required for the correspondence, if you want to print out payment transfer documents. These 

activities include the creation of your own form, for example. 

Activities 

Make your definitions for the assignment of invoices. 

36.2.5.4.7 Payment Distribution 

You should use the payment distribution if you want to enter received payments and distribute a bank 

item over several customers or vendor accounts. The posted payment in the budget is only traceable if 

you use this function. 

In the following IMG activities you make all the settings that you need to use the payment distribution. 

36.2.5.4.7.1 Define Number Ranges for Payment Distribution 

In this step, you create number range intervals for a company code for payment distribution. 

For each number range interval, you must enter: 

- Number range key 

- Number interval from which the program chooses the number for the payment document generated 

- Number range status 

- Type of number allocation (internal or external) 

You can define any number of intervals. However, a single interval is sufficient. If you define more than 

one interval, you must ensure that the number intervals do not overlap. 

Activities 

1. Choose Interval -> Change. 

2. Choose Edit -> Add Interval. 

3. Define all the necessary information for the number range in the dialog box. 

4. Save your entries. 

Further notes 

You transport number range objects as follows: 



______________________________________________________________

SAP System 

- 

______________________________________________________________ 

SAP AG 293 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.5.4.7.2 Define Settings for Payment Distribution 

In this IMG activity, you make the settings that allow you to use payment distribution. The distribution 

logic for payment distribution is comparable to the distribution logic for manual account statements. 

This activity determines how the document generated is posted. 

The folder name corresponds to the batch input session to which the program writes the documents 

generated. 

Once payments have been divided among several customer or vendor accounts, the postings are displayed 

in an account statement. 

If you want to process payment distribution data with the clearing control of Funds Management 

(PSM-FM), you must define an activity category so that you can make the required settings in the 

Customizing of Clearing Control. 

If you do not set the clearing control, you can leave this field empty. 

Requirements 

The activities offered when you make your entry (F4) must first be defined in the Customizing of 

Financial Accounting under Bank Accounting -> Business Transactions -> Payment Transactions 

-> Manual Bank Statement. 

During this process, you should take ensure that all payment distribution transactions are defined for 

posting area 2 (Subledger Accounting) (the actual incoming payment must however be posted at the 

bank  for posting area 1 (General ledger)). 

 - Your heuristics is set up so that it can process entries for payment distribution. 

Standard settings 

SAP does not provide any standard settings. 
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Activities 

1. Call the IMG activity. 

2. Create new entries for all relevant company codes. 

3. Save your entries. 

Further notes 

For documentation on the settings for the manual account statement in component Financial 

Accounting, see: 

- Create and Assign Business Transactions 

- Define Posting Keys and Posting Rules for Manual Bank Statement 

36.2.5.4.8 Clearing Control 

36.2.5.4.8.1 Prerequisites and Functional Clearing Control 

Use 

With clearing control you can map the automatic assigning and clearing  logic of your organization's 

payments from an electronic account statement for open customer/vendor items. 

You can use clearing control for the electronic account statement instead of the interpretation algorithms 

available in Financial Accounting. 

Clearing control carries out the following functions: 

- Interpretation of individual turnover of an account statement 

- Account and item determination according to this interpretation 

- Posting of processed turnover 

Clearing control can therefore interpret the note to payee and assign different sort keys (customer, 

reference, etc.). Based on the sort key, the clearing control looks for open items and can include different 

sequences in which the open items are cleared (for example, according to the German Civil Code public 

law). As well as simple processes such as a partial payment and the full clearing, you can use it to control 

complex processes such as residual item mapping, and complex partial payments with clearing and 

payments in all company codes. 

Clearing control can process the following business transactions: 

- Customer down payment (received payment) 

- Vendor down payment (down payment made) 

- Debit G/L account posting (outgoing payment) 
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- Credit G/L posting (incoming payment) 

- Vendor down payment with general request (down payment made with account assignment of a 

funds commitment) 

- Customer down payment with general request (down payment received with account assignment of 

an estimated revenue) 

- Customer bank credit memo (post with clearing on customer account) 

The following process interfaces (events) are available to adjust the clearing control to suit your 

requirements: 

- Clearing control turnover interpretation(00102021) 

With this event, SAP provides a sample function module called Interpretation of note to payee 

(FU.FM_LGD_VWEZW_ANALYSE_MUSTER) which you usually have to adjust to suit your 

requirements. 

- Clearing control, change clearing order (00102022) 

- Clearing control indicator for clarification case (00102024) 

- Change clearing control posting/account assignment (00102025) 

- Clearing control, predefine clearing sequence (00102026) 

Requirements 

Customizing for electronic account statement 

You must carry out Customizing for the electronic account statement. Note the following for the 

electronic bank statement: 

Clearing control is only called if no interpretation algorithm is defined in the < 

DS:SIMG.FIBLEBS_VC_T028_DC>Basic Settings for Electronic Account Statement for the respective 

external process. Therefore, the interpretation algorithm 000 No Interpretation must be defined for all 

relevant external processes. 

Customer Bank Credit Memo (Posting Type 07) 

So that residual items are displayed correctly in the reference of Financial Accounting documents, you 

must set up a substitution for residual items. 

During posting in Financial Accounting, the field BSEG-REBZT (type of follow-on document) cannot be 

specified. .The consequence of this is that the indicator Zis automtically entered in all postings. In the FI 

document, the document is displayed as a reference Payment for ... , in other words, always as a partial 

payment. In payment selection only (program RFFMS200), these postings  are represented as partial 

payments. 

So that these postings are displayed correctly, the indicator V must be entered in field BSEG-REBZT. In 

the FI document, the reference Residual Item to ... can be displayed. 

In order to ensure that what is displayed is correct, you must make a substitution at the document segment 

level. 

You do this as follows: 
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1. You must make field BSEG-REBZT available for substitutions 

(For more information on this, see SAP note 0042615.) You must 

change table GB01 as follows for this: 

*/ program  

tables: gb01. 

 select single * from gb01 where BOOLCLASS  = '009' and 

     CLASSTYPE = 'S' and 

     BCLTAB    = 'BSEG' and      

BCLFIELD  = 'REBZT'.  if gb01-

bexclude= 'X'.    gb01-bexclude= ' '    

modify gb01.  endif. 

2. You must make the substitutions at the document item level 

You make substitutions in the Customizing of Financial Accounting, under Financial Accounting 

Global Settings-> Document -> Line Item -> Define Substitution in Accounting Documents. 

36.2.5.4.8.2 Account Assignment Profile 36.2.5.4.8.2.1 Set Account Assignment 

Profile for Customer-View Down 

Payments 

Use 

In this step, you configure the account assignment profile for customer down payments (posting type 01). 

By assigning an account assignment profile in the  of clearing control together with the posting type and 

account assignment method 01 to a sort key, you define the processing of an interpreted sort key (for 

example, of an interpreted cash reference number) as a customer down payment through clearing control. 

Customer down payments are assigned to a customer account. The account assignment is also required on 

a funds centers and commitment item. You can define the funds center and commitment item directly in 

the account assignment profile or derive these account assignment elements from other account 

assignment elements by defining a revenue type (for deriving the commitment item) or an estimated 

revenue in the account assignment profile. If you do not make any specifications, the funds center and 

commitment item may be derived from the differentreconciliation account of the customer. 

Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 
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In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.2.2 Set Account Assignment Profile for Vendor-View Down 

Payments 

Use 

In this step, you configure the account assignment profile for vendor down payments (posting type 02). 

By assigning an account assignment profile to a sort key in the Note to Payee Control of clearing control, 

together with the company code and account assignment method 01, you define the processing of an 

interpreted sort key (for example, of an interpreted cash reference number) as vendor down payment . 

You do this using clearing control. 

Vendor down payments are assigned to a vendor account. In addition to this, an account assignment to a 

funds center and a commitment item is required. You can define the funds center and commitment item 

directly in the account assignment profile or derive these account assignment elements from a funds 

commitment by defining a funds commitment in the account assignment profile. If you do not specify a 

funds center/commitment item, they can be derived from the different reconciliation account of the 

vendor. 

Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 

In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.2.3 Set Account Assignment Profile for Debit G/L Account Postings 

Use 

In this step, you configure the account assignment profile for debit G/L account postings (posting type 

03). 

By assigning an account assignment profile to a sort key in the Note to Payee Control of clearing control, 

together with the posting type and account assignment method 01, you define the processing of an 
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interpreted sort key (for example, of an interpreted cash reference number) as the G/L account debit 

posting. You do this through clearing control. 

G/L account postings are assigned directly - without a subledger account (actual = target) - to a G/L 

account. Additional account assignment information is required for this such as a CO account assignment 

or the account assignment of a funds center and commitment item in accordance with the selection 

outsorting of the G/L account. 

If you define a G/L account and a commitment item, the G/L account and the commitment item are 

assigned to an account. If you only define a G/L account, the commitment item is derived from the G/L 

account. If you only specify one commitment item, the G/L account is derived from the commitment 

item. 

Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 

In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.2.4 Set Account Assignment Profile for Credit G/L Account Postings 

Use 

In this step, you configure the account assignment profile for credit  G/L account postings 

(posting type 04). 

By assigning an account assignment profile to a sort key in the Note to Payee Control of clearing control, 

together with the posting type and account assignment method 01, you define the processing of an 

interpreted sort key (for example, of an interpreted cash reference number) as the G/L account credit 

posting. You do this using clearing control. 

G/L account postings are assigned directly - without a subledger account (actual = target) - to a G/L 

account. Additional account assignment information is required for this, such as a CO account assignment 

or the account assignment of a funds center and commitment item, in accordance with the selection 

outsorting of the G/L account. 

If you define a G/L account and a commitment item, the G/L account and the commitment item are 

assigned to an account. If you only define a G/L account, the commitment item is derived from the G/L 
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account. If you only specify one commitment item, the G/L account is derived from the commitment 

item. 

Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 

In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.2.5 Set Acct Assignment Profile for Vendor-View Down Pymnt with 

General Request 

Use 

In this step, you configure the account assignment profile for the vendor direct debit (posting type 05). 

The vendor direct debit is updated as a vendor down payment with an account assignment on a funds 

commitment. 

By assigning an account assignment profile to a sort key in the Note to Payee Control of clearing control, 

together with the posting type and account assignment method 01 or 02,  you define the processing of an 

interpreted sort key  (for example, of an interpreted cash reference number) as vendor down payment with 

a general request . You do this using clearing control. 

Vendor down payments are assigned to a vendor account. In addition to this, an account assignment to a 

funds center and commitment item is required. 

- Account Assignment Method 01 

By defining a funds commitment in the account assignment profile, the company code, vendor, 

funds center and commitment item are derived from the funds commitment. 

- Account assignment method 02 

By defining the bank details of the business partner (bank key and account) and a funds 

commitment, you can derive the company code, vendor, funds center and commitment. This means 

that the correct account assignment is determined by comparing the texts of the note to payee and 

the text of the funds commitment items. (The text of the note to payee must match the text of the 

fund commitment items). 

Therefore, it is prerequisite that a corresponding funds commitment item is created for each account 

assignment. 

Requirements 
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Fund commitments that you want to define in the account assignment profile must be created in the menu 

of Funds Management with amount 0. The indictor Unlimited Overpayment must be set. 

Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 

In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.2.6 Set Acct Assgnmnt Profile for Customer-View Down Pymnt with 

General Request 

Use 

In this step, you set the account assignment profile for customer down payments with account assignment 

on a general request (posting type 06). 

By assigning an account assignment profile in the DS:SIMG._ISPSFM_FMLGD_H_CUST> Note to 

Payee Control of the clearing control together with the posting type and account assignment method 01, 

you define the processing of an interpreted sort key (e.g. of an interpreted cash reference number) as 

customer down payment with general request through clearing control. 

Customer down payments are assigned to a customer account. The account assignment is also 

required on a funds center and commitment item. By specifying an estimated revenue, the company code, 

customer, funds center and commitment item is derived from the estimated revenue. 

You require an account assignment profile for customer down payments with general request if you want 

to post similar revenues without the amount, the payer or the due date being known (for example, with 

donations). 

Requirements 

Estimated revenues that you want to define in the account assignment profile must be created in the menu 

of Funds Management with the amount 0. Apart from this, the indicator Unlimited Overpayment 
must be set. 
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Further notes 

Alternatively, you can determine the necessary account assignments from your own note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)). 

If the derivation should take place from your function module, you do not need to define any settings for 

the account assignment profile. 

In the note to payee for clearing control, you must define account assignment method 00 for the sort keys 

that should be processed on the basis of their function module. 

36.2.5.4.8.3 Create Session Variants for Grouping of Postings 

Use 

In this step you define folder variants. You only need folder variants if the posting of the turnover 

processed fromthe clearing control should take place with the Batch Input Procedure. 

Folder variants enable you to group turnover by deriving a two-figure folder prefix from the folder variant 

when the folder is created and is added to the beginning of the folder name. 

For each folder variant you define the prefix of the first and last folder that you want to use and the 

number of postings a folder should include. 

When processing an electronic account statement, the defined number of postings, starting from the 

lowest interval level to the highest interval limit, are put in a Batch  Input Session. The last batch input 

session  (highest interval limit ) contains more than the defined number of postings if the number of 

postings exceeds the number of postings specified. 

If you do not define any settings in this step, all postings are put in one session. 

Activities 

Define the settings you want. 

Further notes 

Note that when processing the electronic account statement, a maximum of two sessions per bank 

turnover are generated. A session for the general ledger and a session for the subsidiary ledger. The 

subsidiary ledger receives / (slash) before the prefix. 

36.2.5.4.8.4 Define Error Handling 

Use 
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In this step, you can determine how non-assignable payments can be processed further and updated  

correctly based on errors that occur. 

The error handling enables you to generate  batch input sessions that are processed automatically in the 

Background. 

If you do not use error handling, batch input sessions are generated for the corresponding bank turnover 

that you must process manually in order to carry out the necessary adjustments or supplements for an 

update. 

Certain problems may arise with the update, such as incomplete Customizing settings, unclear entries in 

the note to payee or an unclear account situation which can cause errors. Each error that occurs is 

represented by an error message in message class FMLGD. 

In this step, you can define how the bank turnover should be processed further for these error messages. 

In addition to this, you can also outsort your own messages. 

The error messages delivered in message class FMLGD are divided into the following areas: 

- 0XX Technical error messages 

- 1XX Customer down payments 

- 2XX Vendor down payments 

- 3XX G/L account debit posting 

- 4XX G/L account credit posting 

- 5XX Vendor down payment with general request 

- 6XX Customer down payment with general request 

- 7XX Customer bank credit memo 

- 80X Clearing Sequence of Open Items 

- 85X Turnover interpretation (credit memo) 

- 87X Turnover interpretation (debit memo) 

- 9XX Customer-specific errors 

You must define at least one error message for each company code and transaction type for the processing 

of credit memos 001 and one error message for the processing of debit memos 002. Otherwise the 

turnover cannot be processed if errors occur. 

In addition to this, you can use a general error message for each posting type (X00 basic setting) that you 

can define if you want to use error handling. It is advisable to define this basic setting, otherwise the 

system cannot carry out the posting automatically. 

You can also trigger a specific error handling, depending on the request by defining further error 

messages for this posting type accordingly. 

If an error is triggered for a posting type and no setting exists for this in the Customizing of error 

occurrences, the system checks whether a basic setting exists for the error handling of the posting type. If 

a basic setting does not exist either, the program carries out the posting in accordance with the settings for 

message 001 or 002. 

Requirements 
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The account assignment profile for the corresponding posting types must be created as well as folder 

variants. 

Activities 

1. You create an error message for processing credit memos 001 and one for processing debit memos 

002 for each company code and transaction type. 

Note that you are not allowed to make any entries for the posting rule, business transaction code, 

+/- sign and amount for these error messages. 

2. Check which problems you want to define automatic error handling for and define the error 

messages accordingly. 

Further notes 

For more information on the error messages delivered, see the long text on messages in message class 

FMLGD. You can also create your own messages here if you wish, in area 9XX. 

Special handling is possible for error message 712. The message is issued if no open items exist for a 

payment, but the customer and company code can be determined from items already cleared. You can use 

this message to control that the payment occurs as a down payment on the company code and customer 

determined beforehand from the first cleared item. 

The following setting is necessary for this: 

- Posting type 01 (customer down payment) 

This allows payments to be updated automatically without open items having been cleared. 

- An account assignment profile for posting type 01 for which neither a customer or company code 

has been specified. 

Note that an account assignment profile in which neither a customer or company code is specified 

can only be used for errors  712 and 713. 

36.2.5.4.8.5 Define Clearing Sequence for Additional Receivables 

Use 

In this step, you define the clearing sequence for additional receivables. 

This involves defining the relative position (rank) in the clearing sequence at which the additional 

receivable item should be cleared if several items with additional receivables are determined by the 

clearing control. 

Requirements 
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The clearing control must be able to determine all related receivables. 

If you are using a cash reference number as a sort key, the additional receivables that occur from dunning 

open items must contain the corresponding cash reference number for the correct open items to be 

selected. 

You can use BTE process Requests: Field Substitution for dunning interest with sample function module 

SAMPLE_PROCESS_00102026 as a template for your own function module; or BTE process Post 

Dunning Interest (00103020). 

For dunning charges you can use BTE process Post Dunning Charges (00103025). Prerequisite for this is 

that only the items of a cash reference number are included in dunning. You can ensure this by defining a 

corresponding dunning grouping (reference in document header) in the Customizing of the dunning 

program (IMG activity Define Dunning Groupings. 

Activities 

Define the relative position in the clearing sequence for additional receivables for each revenue type. 

Further notes 

Note that the clearing sequence for main/additional receivables could also affect other system areas. 

When processing customer credit memos, the clearing control executes an account analysis. With 

an account analysis, the clearing sequence of the selected open items (receivables, payables, partial 

payments) is determined. Note that down payments are not included in the clearing. 

The clearing control supports two kinds of clearing sequence: 

- Public-law clearing sequence 

The main receivables are cleared before additional receivables. 

- Private law clearing sequence 

The additional receivables are cleared before the main receivables. 

For the clearing, both the main and additional receivables are sorted according to their due date and the 

oldest receivable is cleared first. 

Which of the two sequences is used by the clearing control is determined by the runtime and depends on 

which dunning procedure is defined in the master record of the customer and therefore also by the 

settings for the dunning procedure in step Enhance Dunning Procedure. 

If a dunning procedure is defined in the customer, that is flagged as a public-law dunning procedure  

(Indicator Public-Law in step Enhance Dunning Procedure, then the open items are in accordance with 

the public-law clearing sequence. If a dunning procedure  defined in the customer is not flagged as a 

public-law dunning procedure, the clearing is carried out according to the private-law clearing sequence. 

You can influence the standard setting as follows: 

You can define that only the public-law clearing sequence should be used or only the private law; or you 

can d efine the sequence to suit your own requirements. 
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To do this, you can use BTE process  Clearing Control. Convert Clearing Sequence with the sample 

function module SAMPLE_PROCESS_00102026 as a template for your own function module. 

IF you want to define your own clearing sequence, you should first convert the clearing sequence (BTE 

Process Clearing Control. Convert Clearing Sequence (00102022). 

36.2.5.4.8.6 Define Processing Variants 

Use 

In this step, you can create your own processing variants for clearing control. 

You need your own processing variants when you want to process an interpreted sort key or you want to 

work with different sort keys (for example, cash reference number and customer). 

You can process differently by making an additional entry with your different processing variant for these 

sort keys in the note to payee control of clearing control. 

In number range 9000 to 9999, you can create your own variants if you wish. Number range 0000 to 8999 

is reserved in the standard system for predefined processing variants. 

Requirements 

If you want to use your own processing variants, you must define this criteria in your note to payee 

interpretation (BTE process Clearing Control Turnover Interpretation (00102021)) which stipulates how 

the different processing should occur. 

Standard settings 

SAP delivers standard variant 0001 which you can use for all entries in the note to payee control. 

If you want to assign payments with the clearing control using the function Payment Distribution, you 

do not need your own processing variants, you can use variants 1001, 1002 or 1003. 

With variant 1001, the clearing control processes data from the payment distribution which includes a 

posting reference (XBLNR). 

With variant 1002,  the clearing control processes data from the payment distribution which includes a 

customer (KUNNR). 

With variant 1003,the clearing control processes data from the payment distribution which includes an FI 

document number (BELNR). 

36.2.5.4.8.7 Define Note to Payee Control 

Use 
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In this step, you define the settings for the note to payee control. 

The clearing control can only process the turnover if a valid sort key (for example, cash reference 

number) can be determined. The clearing control interprets the data of an individual turnover from SAP 

bank data storage in order to determine a valid sort key. Relevant data is, for example external 

transactions, internal transactions, +/- sign, note to payee, payer (name and bank details of the payer) and 

the amount. 

The turnover interpretation matches your own note to payee interpretation (BTE process clearing control 

turnover interpretation (00102021)). The target of the interpretation is to return a sort key and processing 

variant. The sort key returned in addition to the processing variant is compared with the settings that you 

define here. This then controls the subsequent processing. 

Note the following if you define settings for customer credit memos (posting type 07): 

For customer credit memos an open item or several open items should be cleared when a payment is 

successful. The items to be cleared contain the necessary account assignment information. It is therefore 

not necessary for you to specify an account assignment profile. 

In the first step, the clearing control selects the open items, whilst the account assignment method 

controls which criteria the selection should follow: 

- Account assignment method 00 

All the necessary information for the posting is transferred by the system from your note to payee 

interpretation. 

- Account assignment method 01  (reference in document - for example, cash reference number 

) 

The sort key defined is interpreted as the reference in the document  (field XBLNR). The clearing 

control selects all open items for this posting reference. If you specified a company code in your 

note to payee interpretation, only the open items for this company code will be selected; otherwise 

all company codes are included. 

If no open items exist for this posting reference, the system determines the corresponding customer 

based on the items already cleared for this reference (customer of the first cleared item). You can 

then update the payment as a down payment for this customer through error handling (error 

message 712)  (see Define Error Handling) . 

- Account assignment method 02 (customer) 

The define sort key is interpreted as the customer (field KUNNR). Clearing control selects all open 

items for this customer. If you specified a company code in your note to payee interpretation, only 

the open items for this company code will be selected; otherwise all company codes will be 

included. 

- Account assignment method 03 (document number) 

The defined sort key is interpreted as the document number (field BELNR). Clearing control selects 

all open items for this document number. If a company code was specified in your note to payee 

interpretation, only the open items for this compnay code will be selected; otherwise all company 

codes are included. 

Once the open items have been selected, the account analysis takes place through clearing control. This 

determines the clearing sequence of the open items. (For more information on this, see Define Clearing 

Sequence for Additional Receivables). 

The clearing control then tries to clear the open items in accordance with the clearing sequence. 
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The following postings can occur with this: 

- Full clearing 

Note that small differences are not considered. 

- Residual item creation 

The open items are cleared in accordance with the clearing sequence. As the payment amount is 

more than the total of open items, the residual amount is posted as a payment with residual items for 

the last cleared item. 

- Partial payment 

For a partial payment, not all open items can be cleared in accordance with the clearing sequence 

as the payment is smaller than the total of open items. Note the following different cases: 

- The clearing control cannot clear any open items. 

In this case, a partial payment occurs for the first open item in accordance with the clearing 

sequence. When updated, the system generates a line with posting key 15 for the customer. 

- The clearing control can clear several but not all open items. 

In this case, the partial payment occurs in accordance with the clearing sequence on the last 

open item which cannot be cleared. The system adds an additional line with posting key 15 for 

the customer. 

Note 

If the FI document numbers are assigned fiscal year-dependently, problems may arise when a clearing is 

posted  (transaction FB05) if the transferred document number is not clear. These postings cannot be 

processed automatically. See SAP note (105985). 

Activities 

Define the note to payee control for posting types. 

36.2.5.4.8.8 Check Customizing Settings 

Use 

In this step you check whether the settings in the Customizing of clearing control are consistent. 

For more information on this program, see the  Program documentation 

(RFFM_CHECK_VERRECHNUNG). 

Activities 
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You can only use applications that use clearing control when a check is run without any errors occurring. 

In order to ensure that your Customizing settings are consistent, you must carry out the check each time 

you make changes in Customizing for the clearing control. 

If errors are displayed in the Application Log, you must correct the fields in the corresponding IMG 

activities. 

36.2.5.4.8.9 Activate Clearing Control 

Use 

In this step, you activate the clearing control. 

Requirements 

- The Customizing settings for clearing control must be consistent. For more information on this, see 

Check Customizing Settings. 

- You must have provided a user-specific function module with the BTE event Clearing Control 

Turnover Interpretation (00102021). 

SAP provides sample module Interpretation of Note to Payee  

(FM_LGD_VWEZW_ANALYSE_MUSTER) for this event which you must adjust to suit your own 

requirements. 

- For more general prerequisites, see Prerequisites and Functions of Clearing control. 

Activities 

Check whether all prerequisites are fulfilled and activate the clearing control. 

36.2.5.4.9 Clarification Worklist 

36.2.5.4.9.1 Define Processing Status 

Use 

In this IMG activity, you can create your own user-defined processing statuses for processing clarification 

cases in addition to those delivered by SAP. 

You use a processing status to select clarification cases for processing. You can find the statuses in F4 

help (field Processing Status) under Process Clarification Worklist. 

The following statuses are set automatically: 

- Clarification cases included in the clarification worklist receive the status 000 (new) 
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- If a resubmission date is set for a clarification case, it receives the status 130 (put back) 

- If a clarification case is completed and posted without errors, the status is set to 200 (completed) and 

the assigned processor is removed. 

You can set all other statuses manually when processing a clarification case. 

Standard settings 

The following statuses are in the standard system 

Symbol Key Description/Meaning 

- 000 new 

@5W@ 100 allocated 

@AJ@ 110 in processing 

@A0@ 120 customer response 

@FR@ 130 put back (for resubmission) 

@8Y@ 190 not to be clarified 

@0V@ 200 completed (clarified) 

Activities 

If you want to create more user-defined statuses, use the key interval 900 - 999. 

36.2.5.4.10 Data Transfer 

You can use the following IMG activities when transferring the data you require for cash desk operations. 

36.2.5.4.10.1 Assign Preprocessing Procedure Subledger Account to a SAP 

Subledger Account 

You can use this IMG activity to assign subledger accounts from the preprocessing procedure to 

customer/vendor accounts in the SAP system. 

For more detailed documentation on the functions of this program, see the Program documentation. 

Activities 

1. Call the IMG activity. 

2. Enter the file path. 

3. Execute the program. 
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36.2.5.4.10.2 Delete "Preprocess. Proc. Subldgr Acct to SAP Subldgr Account" 

Assignment 

You use this IMG activity to delete assignments of subledger accounts from the preprocessing procedure 

to vendor/customer accounts in the SAP system. 

For more information, see the Program Documentation. 

Activities 

1. Call the IMG activity. 

2. Choose the required selection criteria. 

3. Execute the program. 

36.2.5.4.10.3 Delete Help Data for Execution 

You can use this IMG activity to delete help files for execution. 

For detailed information, see the Program documentation. 

Activities 

1. Call the IMG activity. 

2. Choose the required selection criteria. 

3. Execute the program. 

36.2.5.5 Public-Owned Commercial Operations 

You enter the settings for public-owned commercial operations in the following steps. 

36.2.5.5.1 Enter Settings for the Taxation Procedure in FI 

This hypertext is only relevant for German Local Authorities customers. 

36.2.5.5.2 Maintain Global Settings 

In this step you define the document type for the documents for input tax adjustment. 

Requirements 
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The document type must be created in Financial Accounting Customizing under Financial Accounting 

Global Settings -> Document -> Document Header -> Overview . The document type must have the 

following characteristics: 

- Reversal document type 

The reversal document type should retain the document type of the original document. Therefore do 

not enter a reversal document type or, otherwise, define the document type for public-owned 

commercial operations as reversal document. 

- Permitted account types 

Only G/L account postings are allowed. 

Activities 

Enter the document type for correction documents. 

36.2.5.5.3 Create Public-Owned Commercial Operations 

You create the public-owned commercial operations (PCO) per FM area in this step. 

In addition, you can define a cost center and an order for each PCO. These account assignments then 

appear when entering input tax corrections as default values and, if required, can be overwritten. 

Activities 

Enter the public-owned commercial operations per FM area. 

36.2.5.5.4 Define Tax Code for Budget 

This hypertext is only relevant for German Local Authorities customers. 

36.2.5.5.5 Define Document Type for Transfer Postings 

Use 

In this IMG activity, you define the document types you want to use for transfer postings in public-owned 

commercial operations (PCO). You also have to enter the reversal document types for consistency. 

Transfer postings such as clearing requests between PCOs can only be executed if you have defined the 

corresponding document types in these settings. You can only define document types that are allowed for 

fixed asset or G/L account postings for transfer postings. 
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If you use the document type for transfer postings in PCO to transfer one commitment item to another, the 

corresponding tax share is determined from the tax code and displayed. This is necessary because G/L or 

fixed asset transfer postings are made net with the same tax code in Financial Accounting provided that 

the posting stays in the same company code. 

Requirements 

You have selected or created the appropriate document types in Customizing of Financial Accounting 

under Define Document Type. 

Activities 

Select the appropriate document types for transfer postings in your PCOs and save your entries. 

36.2.5.5.6 Assign FM Account Assignments to Public-Owned Commercial 

Operations 

In this step, you assign the FM account assignment to your public-owned commercial operation (PCO) a 

combination of FM area and fiscal year. 

FM account assignments without assignments belong to the budget. 

Note: 

Do not assign the FM account assignments you have already assigned in the budget or which have already 

had postings made to them for your PCOs. Re-create the appropriate master data this applies to 

commitment items in this case. 

Requirements 

- The FM account assignments must be created in master data maintenance. 

- The PCOs must be created in the step Create Public-Owned Commerical Operations. 

Activities 

Assign the FM account assignments to your public-owned commercial operation. 

36.2.5.5.7 Activate Processes for Public-Owned Commercial Operations 

This hypertext is only relevant for German Local Authorities customers. 

36.2.5.5.8 Business Add-Ins (BAdIs) 36.2.5.5.8.1 BAdI: Derive CO Account 

Assignment for Correction Documents 
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You can use this Business Add-In (BAdI) to determine which CO account assignments should have a tax 

adjustment posted. This is especially easy if a 1:1 relationship exists between Funds Management and 

CO. 

The BAdI is used in Funds Management for public-owned commercial operations (PCOs). 

The following parameters are specified: 

 I_FIPEX: Commitment item 

 I_FISTL: Funds center 

I_FONDS: Fund 

C_SAKNR: G/L account 

C_KOSTL: Cost center 

C_AUFNR: Order number 

Example 

Assuming, each subsection has its own cost center that has the same name as the subsection. The 

following derivation rule would then be possible: 

C_KOSTL = I_FIPEX + OFS_UA(4). 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 
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8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.2.6 Actual and Commitment Update/Integration 

In the following sections you find out: 

- which system settings are required for updating commitment and actual data. 

- how you can set the Funds Management integration to other SAP components according to your 

requirements. 

36.2.6.1 General Settings 

In the following steps, you process the settings you must enter so that actual and commitment data from 

the Funds Management feeder systems are recorded. 

The essential control parameters for updating in Funds Management are summarized in update profiles 

pre-defined by SAP. You must select the update profile relevant to you and assign it to your FM area. 

You can override settings supplied in the standard per update profile. 

36.2.6.1.1 Assign Update Profile to FM Area 

In this step you define your update profile per FM area. 

You make the following specifications in the existing update profiles: 

- With which budget categories you want to work 

- Payment budget 

- Payment budget and commitment budget 

- Which document date (such as purchase order, invoice, payment) is to be used when assigning 

commitment/actual data to a period in Funds Management, that is in which period the actual data is 

displayed in the information system for the payment budget and/or the commitment budtget 

- Update period from posting date/document date. 

- Update period from due date 
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- Whether the commitments and budget are allowed to be carried forward at the fiscal year change 

and for which value types. 

You can find more information on the specifications in the individual profiles in the "Funds Management 

Government" document in the "Update Profiles" section of the "Integration" chapter. 

Activities 

1. Check to see which update profile you want to work with in the "Funds Management Government" 

document. 

2. Assign an update profile per FM area. 

Further notes 

- Line items in Funds Management are only recorded online if you specified a commitment item with 

financial transaction 30 as the additional account assignment when posting. Bank postings and check 

postings are, for example, not recorded online. 

- Only when an invoice has been completely cleared in Financial Accounting can you use program 

RFFMS200 in Funds Management to convert the invoice from the status invoice to the status 

payment. Depending on the update profile you have chosen, the cleared invoice is then displayed in 

the information system in the Payments column with either the invoice or the payment date. 

- Due date 

The period in Funds Management is determined for updates with a due date for the following 

business transactions as follows: 

- Purchase order: Delivery date and terms of payment 

- Invoice: Payment baseline date and terms of payment 

- Vendor credit memos: Payment baseline date without terms of payment 

- Payment: Invoice clearing date 

The clearing date of the invoice is generally the posting date. 

36.2.6.1.2 Override Update Profile 

In this IMG activity, you can override the valid settings of an update profile in the standard system. 

Override for a value type 

You can individually specify for each update profile and value type, which document date should be 

called for the period assignment of commitment and actual data in Funds Management. This refers to the 

period in which the actual data in the Information system should be displayed for the payment budget 

and/or the commitment budget. 

The update periods are determined by one of the following: 

- Posting/Document date 
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- Due date 

- Delivery date 

In addition, you can specify for each value type that the update in Funds Management should only be 

statistical. This means that the posting is not subject to availability control and does not use any budget. 

Note: A document statistically updated cannot refer to a document that was "really" updated. Ensure that 

the start of a document chain is flagged as statistical - for example, the purchase requisition or the funds 

reservation and fund precommitment. 

Override for an FM area 

You can stipulate for an update profile and FM area whether the updating of commitment data should 

take place on an annual basis or a periodic basis. 

- Commitment update on annual basis 

For the commitment update on a yearly basis, there is only one data record representing 

commitments in table FMIOI for each fiscal year and amount type (Original, Reduction, Previous 

year carryforward commitments, Following year carryforward commitments, Change). 

Changes to amounts or account assignments in the original document are not logged under amount 

type Change, but instead they overwrite the record for amount type Original. An existing reduction 

record is overwritten the same way as the commitments are reduced by a follow-on document. 

The commitments are updated according to the chosen update profile or, if necessary, according to 

the chosen update date for the value types with the posting/document date, due date, or delivery 

date. Commitments that were carried forward into the new fiscal year using the commitment 

carryforward are displayed in the new fiscal year in period 0 under amount type Following year 

carryforward commitments. A data record under amount type Change is only generated for 

changes to a document that already exists, the amount type is overwritten again for further changes. 

Restrictions: If you select the update of commitment on an annual basis, you cannot track 

document changes and as a result you are also unable to analyze the precise budget situation as it 

was previously. You are also unable to close posting periods, as they are still being posted to when 

changes are made to the original document, because changes are updated in Funds Management 

under the original update date. 

Advantage: This type of update offers the advantage that the volume of documents is kept small. 

 - Commitments update on a periodic basis 

Updating commitments on a periodic basis allows you to log all changes to documents and account 

assignments. For each change, an appropriate data record with the amount type Change is 

generated in table FMIOI. The changes, including those made to documents that have executed a 

year change, are updated under a configurable update date. Therefore you have a "historical" view 

in the Information system, which gives the precise point in time at which the budget was used. 

Warning: If you want to set up the commitment update on a periodic basis, you need to be aware 

that it results in approximately three times the volume of data, as compared to the commitment 

update on an annual basis. Frequent changes to the amounts and the account assignments also 

increase this volume of data. 
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Requirements 

If you want to set up commitments update on a periodic basis, you must use an update profile that updates 

the commitment value types under the posting date (for example, 101 or 102). 

Standard settings 

The commitment update is set up on an annual basis in all the update profiles in the standard delivery. 

Exceptions to this rule are profiles 000300 and 000600, which SAP only releases for specific customer 

groups. 

Note that you can change the commitment update from an annual basis to a periodic basis at any time. 

However, the opposite is not true. Once commitment data has been posted, a change from period-based to 

annual-based commitment update is no longer possible. 

Activities 

1. Make the desired settings for an update profile and value type. 

When you save, the system displays a message if your entries are different from the configuration 

delivered as standard. 

Note: You should not make any changes to the settings after production startup, as this may 

adversely affect the reliability of the data in the Information system. 

2. Activate commitment update on a periodic basis for your FM area, if you need this type of update. 

Note: Make sure all posting periods/fiscal years are closed. Postings to closed periods are not 

possible. You must therefore open the required posting periods/fiscal years for posting for your FM 

areas. You can use either transaction Individual processing of open intervals (FMIR) or 

transaction Mass processing of open intervals (FMMI) to do so. 

Further notes 

Posting Integration with Cost and Project Controlling 

If you have used the step Choose Business Transactions for Integration to activate posting integration for 

CO business transactions, the following settings must be active for the individual documents: 

- Purchase order: Delivery date 

- Invoice: Posting date 

- Payment: Invoice posting date 

Documentation 

For further information on updating commitments, refer to the SAP library under SAP ERP 

Central Component -> Accounting -> Public Sector Management -> Funds Management -> 
Actual and Commitment Update -> Period-Based Encumbrance Tracking. 

36.2.6.1.3 Make Other Settings 
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When you post business transactions to other components, such as Materials Management and Financial 

Accounting components, the system passes on the data to Funds Management (FM). The actual data is 

updated there and displayed in the information system. 

In this IMG activity, you can define: 

- When the goods receipt should be included in Funds Management 

- The process by which tax should be displayed 

- Whether the derivation of FM Account Assignments only occurs for real Controlling Objects or also 

for statistical Controlling objects. 

- Which documents should be used for determining the Carryforward Level 

- Which Currency Type is used for currency integration (see section "Define Currency Type for 

Currency Integration") 

- Whether sales orders should be updated in FM Note the following: 

- GR/IR Updating 

- If you choose  Goods Receipt, the actual data is displayed in Invoice  column in the information 

system, per the goods receipt date. 

If you work on payment basis (RFFMS200) and have chosen a corresponding update profile, 

you cannot set this indicator, you must choose either MM Invoice Receipt or GR and IR for 

the GR/IR update. 

- If you choose Invoice Receipt, the actual data is displayed in the Invoice column in the information 

system, per the invoice receipt date. 

- If you choose GR and IR, both the goods receipt and the invoice receipt are displayed in the Invoice 

column according to the period, however with the corresponding activity Goods Receipt 

Purchase Order (RMWE) and Invoice Receipt (RMRP). 

Additional postings to expense accounts, such as price differences, are also included in the 

GR/IR updating. 

- Tax Display 

- If you choose Net, the information system on the commitment item shows no value added tax but 

only the net tax. 

- If you choose Gross, the information system on the same commitment item shows, in addition to 

the line with the net amount, a further line with the corresponding tax amount. 

- If you choose Separate, all the VAT amounts are updated in their own commitment item. 

Precondition: Create a commitment item for the input tax and another for the output tax (financial 

transaction 30 for both and item category 2 (revenues) or 3 (expenditures)) in the Funds 

Management menu  and store them in the input/output tax account. 

- Define Currency Type for Currency Integration 

The local currency is not recalculated in the FM area currency when amounts are transferred from 

Financial Accounting to Funds Management. The currency of each company code assigned to the 

FM area must therefore match the FM area currency. If the first local currency (currency type 10 = 
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company code currency) of all company codes assigned to a FM area does not match the FM area 

currency, you have to use an additional local currency in these company codes. The additional local 

currencies must each have the same currency type and the same currency as the FM area currency. 

You create additional local currencies in the Customizing of Financial Accounting in IMG activity 

"Define Additional Local Currencies". Then you define the currency type in this IMG activity. 

Examples 

- Company code 1: 1. local currency (currency type 10); currency EUR Company code 2: 1. local 

currency (currency type 10); currency EUR FM area: Currency EUR 

You do not have to define any settings in this IMG activity because the FM area currency 

corresponds to the company code currency. 

- Company code 1: 1. local currency (currency type 10); currency EUR Company code 1: 2. local 

currency (currency type 40); currency US$ 

Company code 2: 1. local currency (currency type 10); currency US$ 

FM area: Currency EUR 

You have to define an additional local currency for both company codes. 

Company code 1: 3. local currency (currency type 30); currency EUR Company code 

2: 2. local currency (currency type 30); currency EUR and 

define currency type 30 in this IMG activity. 

Requirements 

If no automatic derivation of FM account assignments takes place from other components, then the 

prerequisite for including posting data from other components is that the fields for the additional account 

assignments  Commitment Item,  Funds Center and  Fund and Functional Area  are ready for input 

when posting transactions. This applies to all assigned activities in Financial Accounting and Materials 

Management (e.g. purchase orders, goods issue). You enter the required settings in the Customizing for 

Financial Accounting and Materials Management. 

For more information: 

- for postings in Financial Accounting, go to the Financial Accounting implementation guide 

(IMG)  Accounting Basic Settings under Define Field Status Variants. 

- for posting purchase requisitions and purchase orders which do not go to the warehouse, the 

IMG Purchasing under "Maintain Account Assignment Categories" 

- for posting Goods Issues and Goods Receipts in the IMG for Inventory Management under 

"Specify Screen Layout". 

Standard settings 

If you do not enter any settings in this IMG activity, the system updates the posting data from the feeder 

components as follows: 

- GR/IR updating: MM Invoice Receipt 

- Goods issues: WA not relevant for budget 

- Value-added Tax display: Gross Value-Added Tax 

- Currency type for currency integration: 10 company code currency 
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- Sales orders: are updated 

Activities 

Read the documentation on the relevant IMG activity and define the settings you need. 

Further notes 

You should not change the settings for update control after production startup because this may 

negatively influence the data in the information system. 

Integration Cost and Project Controlling 

If you have activated the integration for the CO business transaction in IMG activity Choose Business 

Transactions for Integration, you can find more information on the effects of this on the update in Funds 

Management in the SAP Library under SAP ERP Central Component -> Accounting -> Public 

Sector Management -> Funds Management  -> Actual and Commitment Update -> Integration 
Costs and Project Controlling. 

36.2.6.2 Basic Settings 

In the following steps you define the basic settings for the Funds Management line items. 

36.2.6.2.1 FM Line Items 

In the following steps, you: 

- Define the number ranges for updating actual data documents in Funds Management 

- Store the number range key in the FM area 

- Delete the commitment data and the actual data 

36.2.6.2.1.1 Define Number Ranges for Actual Transactions 

In this step, you define  number ranges in each FM area for the actual data documents in Funds 

Management. 

For each number range, you specify the following: 

- Number range key 

You must store the number range key in the FM area, to which it is to apply. You do this in the step  

Assign number range to FM area below. 

- Number range from which the document numbers are to be selected 

- The type of number assignment (internal or external) The numbers are always assigned internally 

for Funds Management. 
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You can define as many number ranges as you want for each FM area. However, one number range is 

usually enough. If you define more than one number range, make sure that they do not overlap. 

Activities 

1. Specify the FM area for which you want to maintain number ranges. 

2. Choose Interval ->Change. 

3. Choose Edit -> Add interval. 

4. In the dialog box, enter all the necessary information on the number range. 

5. Save your input. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.6.2.1.2 Assign Number Range to FM Area 

In this step, you store a number range interval for actual data documents for each FM area. 

Requirements 

You must first have defined at least a number range interval in the previous step. 

Standard settings 

In the standard system, there is no number range key assigned to the standard FM area 0001. You must, 

therefore, define and assign at least one number range interval. 

Activities 

Make your assignments. 

Further notes 

You can use the same number range key for different FM areas. Despite this, each FM area has its own 

number range, which is independently counted. 

36.2.6.2.1.3 Delete Commitment Data and Actual Data 
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In this step, you can delete all commitment data and actual data in Funds Management (FM) using 

program RFFMDLFM. Both line items and totals records are deleted. 

The program does not allow individual documents to selected, instead it deletes all data for an FM area. 

Note:  You should only use this program to delete data in the test system. In the production system, you 

must use transaction SARA with which you can archive or delete commitment/actual line items and, if 

required, reload them into the production system. 

Activities 

Delete the commitment data and actual data for the appropriate FM area. 

Further notes 

For further information refer to the program documentation. 

36.2.6.3 Integration 

In the following sections you find out which system settings are required for integrated use of Funds 

Management with other components of the SAP System. 

36.2.6.3.1 Define Settings for Payment Transfer 

Use 

In this IMG activity, you define the settings for payment transfer. Depending on the system requirements, 

this activity can have different entries: 

If the enhanced or original function of the payment conversion were already active, the existing possible 

entries remain. 

If no payment conversion was active in the system until now, you can only activate the online conversion 

of payments. 

Activation of payment matching 

New customers can only activate the online update of payments. Existing customers keep the most recent 

activated version of payment conversions automatically. 

In the standard system, a check to see whether the invoice and payment are in the same year takes place 

with the payment conversion. You can deactivate this check if necessary. Note that the check on whether 

they have the same fiscal year with the payment selection can only be deactivated if you do not want to 

carry out fiscal year change operations. Otherwise inconsistencies in the update may occur. 

Activation of online payment update 

The online payment update requires the use of the new general ledger and suitable Customizing for 

document splitting. You make your settings in the relevant IMG activity by choosing Financial 

Accounting (new) -> General Ledger Accounting (new)-> Business Transactions -> Document 
Splitting. Here you can use the standard splitting procedure 0000000012 as a basis. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 323 

You must also define the fields KNBELNR and VOBELNR as document splitting characteristics of the 

general ledger. 

The corresponding path in IMG is as follows: Financial Accounting (new) -> General Ledger Accounting 

(new) -> Business Transactions -> Document Splitting -> Define Document Splitting Characteristics for 

General Ledger Accounting. 

For payments without invoice reference, you must define the constant AKONT in the Customizing for 

document splitting for nonassigned processes and assign the corresponding Funds Management account 

assignments. 

The corresponding path in IMG is: Financial Accounting (new) -> Business Transactions ->Document 

Splitting ->  Edit Constants for Nonassigned Processes. 

Define a business transaction variant in the document splitting that assigns the defined constant to an 

account with the business transaction payment to the customers or vendors and cash account lines. You 

can use the delivered business transaction variant payment as a template for this and copy this to your 

own variant. Adjust this business transaction variant accordingly. 

Define a document type and assign this business transaction variant to the document type. This document 

type must be used for payments without invoice reference. 

Transfer postings in the document splitting must be processed using the business transaction variant 1010 

/ 0001 (clearing transaction). 

Activation of payment matching 

If you activate the payment matching, you can execute the program for payment matching at document 

level (RFFMRC07). 

You can use this program to compare account movement in bank and bank clearing accounts of Financial 

Accounting with Funds Management data. 

Note that you cannot use payment matching if you are using the original payment selection function. 

Payments without invoice reference 

In order to create a reliable data basis for these evaluations (payment matching), you must transfer the 

payments without reference to Funds Management (FM) during payment selection (RFFMS200). So that 

these postings can be transferred, you have to activate the update of payments on account from Financial 

Accounting (FI) and, if necessary, from Contract Accounting. 

Note that it only makes sense to update payments without invoice reference if payment matching is 

active. 

ActivateSplitting Procedure 

If you activate the splitting procedure, the partial payment of an invoice that is distributed between a 

number of account assignments is updated in Funds Management in proportion to the invoice amounts. 

ActivateUpdate Check-/Bank Clearing 

If you activate the update check-/bank clearing: 

- Payments made via a bank or check clearing account controlled by a commitment item with 

financial transaction 80 are documented in Funds Management. 

- The status for down payments is converted 

Control of Parallel Processing 
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You can distribute the processing of payment selection between a number of dialog processes in order to 

reduce the overall runtime of the program execution. 

Other Documents 

You can define that expense transfer postings are also evaluated during payment matching. 

Requirements 

You must have assigned an update profile to your FM area in which it is defined that the update is carried 

out on a payment basis. You do this in the step Assign Update Profile to FM Area. 

Activities 

Define the relevant settings for an FM area. 

Further notes 

You can find more information on payment matching and payment transfer in the SAP library under 

Accounting -> Public Sector Management -> Funds Management -> Actual and Commitment 
Update -> Integration Financial Accounting. 

36.2.6.3.2 Maintain Field Status for Assigning FM Account Assignments 

In order for data from other components to be updated in Funds Management, you must specify the Funds 

Management account assignment elements when making a posting to another component (additional 

account assignment). 

You can include the account assignment elements by making fixed assignments of account assignments to 

assignment objects in other components (for example: commitment item to G/L account, commitment 

item to cost element). The effect of this is that you do not have to enter the FM account assignment 

manually when you make a  posting; the system can derive it from the assignment of the account 

assignment object. 

It is not possible to make assign fixed account assignments for plant maintenance orders, SD order items, 

network headers or network activities. You can maintain the field status for the FM account assignment. 

In addition, you can define the field status of the FM account assignment elements for the object types 

purchase requisitions and purchase orders that are not assigned to an account. No assigned to an account 

means here that no account assignment category was specified during budget entry. 

The field status determines which fields are ready for entry as an additional account assignment, must be 

filled or hidden, for example, when you post a SD order item. Note that it is only possible to enter a FM 

account assignment element and therefore update data in Funds Management if the respective fields are 

ready for entry. 

Standard settings 

The field status is only an optional entry in the transations ME2*N and ME5*N for purchase requisition 

and purchase order without account assignments. All fields in the item screen on the tab page account 

assignment are ready for entry in the processing transaction if Funds Management is active. 
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No field status is maintained for all other object types. 

Example 

- Integration with Plant Maintenance 

You want to integrate the plant maintenance processes with Funds Management. To this end, you 

stipulate that the commitment item, funds center, and fund for an FM area and for object type  03 

will accept input. When you create a maintenance order, you can enter the FM account assignments 

by choosing Extras -> Assignments -> Funds Management. 

- Integration with Sales and Distribution(SD) 

You want to integrate Sales and Distribution with Funds Management. To this end, you stipulate 

that the commitment item, funds center, and fund for an FM area and object type 04 will accept 

input. When you enter an SD order item, you can then enter the account assignment by choosing 

Item -> Account Assignment -> FM Account Assignment. 

- Integrating Project System (Networks) 

You want to integrate the Project System component with Funds Management. If you assign 

networks to an account in the network header, you specify that the commitment item, the funds 

center and, if required, the fund are ready for input for an FM area and object type 05. When 

creating a network, you can enter FM account assignments by choosing Assignments -> 

Funds Management. 

If you want to assign networks to an account for specific activities, you specify that the commitment 

item, the funds center and, if necessary, the fund accept input for an FM area and object type 06. 

You can then enter the FM account assignments within the activity by choosing  Assignments -> 

Funds Management. 

Recommendation 

If you want to integrate Plant Maintenance, Sales and Distribution or Project System with Funds 

Management, flag funds center and, if necessary, fund as required entry fields. Account Assignment 

Derivation can be used to derive the commitment item either from the G/L account or the cost element 

for automatically generated purchase requisitions, material reservations, goods issues or revenue 

postings. 

Activities 

1. Enter the required object type for each FM area. 

2. Choose New entries and define the field status for the FM account assignment elements. 

Further notes 

For more information on integrating Plant Maintenance, Sales and Distribution and Project 

System, see the SAP Library Accounting -> Public Sector Management -> Funds 

Management -> Actual and Commitment Update -> Integration with Plant Maintenance, 

Integration with Sales and Distribution and Integration with Project System (Network). 

36.2.6.3.3 Configure Automatic Clearing of Down Payments/Down Payment 

Requests 

Use 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 326 

Use this step to configure automatic clearing of down payments and down payment requests. In doing so, 

you make the following selections: 

- Whether you want to update a down payment request (DPR) to the purchase order history. If you 

decide to do this and create a down payment referencing that DPR, the DPR is automatically 

cleared. 

- Where you want to clear a down payment automatically when a goods receipt or invoice receipt is 

created and references it. 

Activities 

In the maintenance view, set the DPR clearing flag and/or the down payment clearing flag for each 

company code where you want this feature to be active. 

36.2.6.3.4 Integration with Cost and Project Controlling 

In the following steps, you make the settings for the integration of Cost and Project Controlling with 

Funds Management. 

These include specifying which Controlling business transactions are to be reflected in Funds 

Management and which ones are not. 

36.2.6.3.4.1 Define Number Ranges for Posting Integration with Controlling 

In this step, you create, per FM area, the number ranges for the actual data documents in Funds 

Management which are created due to Controlling business transactions. 

Enter the following for each number range: 

- Number range key 

- Number range interval from which the document numbers are to be selected 

- Type of number assignment (internal or external) 

The numbers are always assigned internally for Funds Management. 

You can define as many intervals as you like for each FM area.  Setting just one interval is, however, 

sufficient.  If you define several intervals for each FM area, you must make sure that the number intervals 

do not overlap. 

Activities 

1. Enter the FM area for which you want to maintain the number ranges. 
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2. Choose Interval -> Change. 

3. Choose Edit -> Insert interval. 

4. Enter all the necessary information on the number range in the dialog box. 

5. Save your entries afterwards. 

Further notes 

You can transport number range objects in the following way: 

Choose "Interval - Transport" on the initial screen. 

Note that all the intervals from the selected number range object are deleted first in the target system so 

that only the exported intervals exist after the import.  The number levels are imported using the value 

which you have at the time of the export. 

Dependent tables are not transported or converted. 

36.2.6.3.4.2 Choose Business Transactions for Integration 

In this IMG activity, you select the Controlling business transactions for a FM area which are to be 

reflected in Funds Management. 

Requirements 

Integration of indirect activity allocation (activity RKIL) is only possible if you have not made any 

settings in the IMG activity Activate Account Assignment Elements. Neither the fund or the functional 

area or grant can be activated. 

Activities 

Select those business transactions which are relevant to you for each FM area.  If you choose "All 

transactions", posting integration is carried out for all business transactions which you can call up via F4. 

Note that the selected business transactions can only be reconstructed in Funds Management if you have 

activated the integration in the step Activate Integration Costs and Project Controlling. 

Further notes 

For further information on the integration of Cost and Project Controlling with Funds 

Management, see the SAP Library under SAP ERP Central Component -> Accounting -> 

Public Sector Management -> Funds Management -> Actual and Commitment Update -> 

Integration of Cost and Project Controlling. 

  

36.2.6.3.4.3 Activate Integration Costs and Project Controlling 
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Use 

In this IMG activity, you activate the integration between Controlling and Funds Management. 

Note that after the activation the only business transactions reconstructed in Funds Management are those 

that you chose in the IMG activity Select Business Transactions for Integration. 

In addition, only the postings to CO objects with a company code assigned to a FM in the IMG activity  

Assign Company Code to Controlling Area are taken into account. 

Requirements 

- The controlling areas relevant for your organization must be assigned to CO object and cost element. 

Set the derivation rules in such a way that the funds center and commitment item have to be derived 

from the CO object and cost element in the IMG activity Define Account Assignment Derivation. 

By specifying Transfer New Value When the New Value is Entered for the target fields Funds 

center and Commitment item. 

This ensures that no other funds center or commitment item can be assigned through a manual entry 

that is different to what the derivation logic would derive. 

- The funds center and commitment item can only be assigned (manually) in Funds Management 

itself. 

The funds center and commitment item should, therefore, be hidden on the posting screens of 

Financial Accounting and Material Management or should not be ready for input. You can set this 

in the Customizing of Financial Accounting by hiding the fields in the field status control. 

The system hides these fields in the HR screens. 

- Currency Type for Currency Integration 

If currency type 10 = company code currency is not defined for currency integration in the IMG 

activity Define Other Settings, the currency types of the controlling area must correspond to the 

currency type defined there. 

36.2.6.3.4.4 Set Checks for CO Plan Version 

Use 

In this IMG activity, you can set the checks for planning functions in Controlling. 

If you use Controlling integrated with Funds Management, a check takes place on each period for the 

derivation of FM account assignment elements. 

To improve performance, you can define how the derivation of account assignment elements and a check 

should occur for each plan version. 

- Unrestricted Check 

- Only first period of planning horizon 
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- No check 

Standard settings 

In the standard system, the system checks the derivation of the account assignment elements completely. 

Activities 

Note that you are not allowed to change this setting if you use the scenario Fund Accounting. 

If you use Fund Accounting, the planning must take place at the level of account assignment elements 

fund, functional area and (if required) grant in Controlling; this means that an existence check on the 

account assignment elements is necessary. As the account assignment elements funds center and 

commitment item cannot be entered in the planning functions, a check for the derivation of funds center 

and commitment item must also be carried out with planning. You can only switch off the checks for the 

test version with active Fund Accounting. 

36.2.6.3.4.5 Delete Internal Documents of Controlling in Funds Management 

In this step, you can use the RFFMDLCU program to delete the internal controlling postings in Fund 

Management which were updated in Funds Management. You can delete line items as well as totals 

records. 

The program does not allow the selection of individual documents, but deletes all data of a 

Company code. In addition, you can make other restrictions for the fiscal year and individual periods. 

Note: 

You should only use this program in the test phase and prior to production startup. 

Activities 

1. Specify to which extent data in Funds Management is to be deleted. 

2. Specify whether the system is to output an overview of the data that is to be deleted in the actual 

selection in a test run. 

3. If necessary, request the statistics of the deleted data. 

36.2.6.3.4.6 Business Add-Ins (BAdIs) for Cost and Project Controlling 

36.2.6.3.4.6.1 BAdI: Override Check Mode in FM for CO Planning 

Use 
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If you use Controlling (CO) integrated with Funds Management (FM), a check takes place on each period 

for the derivation of FM account assignment elements. 

To improve performance, you can define in Set Checks for CO Plan Version how the derivation of 

account assignment elements and a check should occur for each plan version. This CHECK_MODE can 

be defined as: 

- Unrestricted check 

- Only first period of planning horizon 

- No check 

Currently, the CHECK_MODE can be defined per controlling area and is only performed for planning 

transactions. 

This Businsss Add-In (BAdI) allows you to override the value of the CHECK_MODE based on the 

current CO business transaction (CO_VORGANG). 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.2.6.3.5 Integration with Human Resources (HR) 

If you integrate Funds Management and HR (Human Resources), you can assign HR expenditures - HR 

commitments and payroll expenditures - specifically to the individual areas that are responsible in Funds 

Management. Depending on the tasks of an employee, a number of assignments can be made to the 

expenditures account assignments in Funds Management. 
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The creation of commitment for personnel is carried out using the commitment process of component 

Position Budgeting and Control (PA-PM-PB). This commitment is then reduced successively by 

payroll postings. 

If you do not use the commitment processor, no personnel commitment is generated in Funds 

Management. The assignment of personnel expense takes place with payroll execution. 

There are 2 possible scenarios for the integration of HR with Funds Management. You can choose either 

of these scenarios for each company code. 

The commitment creation can be combined with both scenarios. The difference between the scenarios lies 

in how the account assignments for Funds Management (funds center, fund, functional area, grant) are 

determined with the business transactions in HR. 

- Scenario 1 

The assignment of personnel expense occurs from the CO integration (assignment of FM account 

assignments to CO account assignments) or from other assignments (for example, commitment item 

is derived from G/L account). If you want to use this scenario, you must not define any settings in 

the following steps. 

- Scenario 2 

The assignment of personnel expense takes place from the master data or the master data of 

Organizational Management. 

If you want to use this scenario, you must define from which date the funds center must be assigned 

to an account in step Define Start Date for HR Integration (Scenario 2). 

Note 

For more information on the individual scenarios, see the SAP Library under Accounting -> 

Financial Accounting -> Funds Management -> Actual and Commitment Update -> Integration 

Human Resources Management. You should read this documentation before choosing one of 

the scenarios. 

36.2.6.3.5.1 Define Start Date for HR Integration (Scenario 2) 

In this IMG activity, you define when you want to integrate Funds Management with Human Resources 

(HR) for a company code. 

Note that this setting is only necessary if you want to integrate using scenario 2. 

You can find more information on the different scenarios in the SAP Library under SAP ERP 

Central Component -> Accounting -> Public Sector Management -> Funds 

Management -> Actual and Commitment Update -> Integration Human Resources Management 
-> Integration Human Resources Management Account Assignment Determination. 

By defining funds centers, HR expenditures (payroll costs) are assigned specifically to the individual 

areas of responsibility in Funds Management. The HR expenditures are assigned by means of employees' 

master data and, if necessary, by means of Organizational Management master data (when using 

component Organizational Management). 

Once you have set the integration date, you must specify the FM account assignment objects (funds 

center and, if required, fund), when creating or changing existing HR master records for all infotypes 

used (0001, 0027, 1018 (Organizational Management), 0014, 0015, 2001, 2002, 2003, 2005, 2010). For 

infotypes that have an individual cost assignment, you can also specify a commitment item. 

Note 
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If you have been using HR for a long time, the infotypes of the existing HR master records are not 

automatically provided with an FM account assignment. As a result, you cannot execute payroll, as no 

funds center will be found during the settlement run. 

You must therefore define the FM account assignment objects for the infotypes from the entered date in 

the HR master records. 

If you want to use scenario 1 and the FM account assignments for postings by the system are derived 

either from the CO account assignments or other account assignments, you should enter no date  for 

integration. In this case, the HR expenditures are updated in Funds Management, as of the date on which 

Funds Management is activated. 

Requirements 

If, during integration, you want to divide up single salary elements individually, you must ensure that, in 

the Customizing of Human Resources, the FM account assignments are ready for input for the entry of 

account assignment default values in these infotypes. 

- For infotypes Recurring payments and deductions/additional payment (0014/0015), you 

make these settings in the Customizing of  Personnel Administration. For more information 

on this topic, see the Personnel Administration IMG under: Interfaces and Integration -> 

Integration with Accounting -> Entering Funds Management Data. 

- For infotypes 2001, 2002, 2003, 2004, 2005 and 2010, you make these settings in the 

Customizing of Personnel Time Management . 

For more information on this topic, see the Personnel Time Management IMG under Integrating 

Time Management with Other SAP Applications -> Recording Cost Assignment 
Specifications. 

Note: Infotype Cost Distribution (0027) 

If you want to use infotype 0027 to assign various funds centers/funds to employees, these fields are 

automatically ready for input as soon as the start of integration has been determined and you use screen 

2500. For more information, see the Personnel Administration IMG under Customizing User 

Interfaces -> Determine Screen Control for Cost Distribution. 

Activities 

Enter the required data for each company code. 

ADDITIONAL_HINTS& 

In this IMG activity, you only define the date from which the funds centers must be assigned to an 

account. If you use account assignment elements grant, fund, functional area or funded program, you 

must enter the date from when these account assignment elements should be assigned when activating the 

account assignment elements in IMG activity Activate Account Assignment Elements. 

36.2.6.3.5.2 Position Budgeting and Control 

36.2.6.3.5.2.1 Define Document Type for Earmarked Funds 
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In this IMG activity, you define a document type for each of your funds precommitments, funds 

commitments and, if necessary, funds blocks in an FM area. 

You need this assignment if you use Funds Management integrated with the component Position 

Budgeting and Control (PA-PM-PB) or Position Management (PA-PM-FP). 

The document type controls: 

- That funds precommitments are generated automatically to finance planned positions of Position 

Budgeting and Control or Position Management in Funds Management. 

- That funds commitments are generated automatically to finance personnel in Position Management 

or Position Budgeting and Control; these automatically reduce the funds precommitments. 

- That funds blocks are generated automatically for the lock rules set in Position Management or 

Position Budgeting and Control. 

Standard settings 

The document types defined in the standard system cover the types of document used for 

individual business transactions in Funds Management. 

Activities 

1. SAP recommends that you create separate document types with their own number range for 

Position Management or Position Budgeting and Control in the IMG activity "Choose Document 

Types ". In this way, you can prevent manual changes to the documents using authorizations and 

identify these document types during the fiscal year change operations. 

2. Enter one document type for funds precommitments, one for funds commitments and, if necessary, 

one for funds block. 

36.2.6.3.5.2.2 Define Automatic Budget Postings for Personnel Cost Savings 

Use 

In this IMG activity, you can define settings for the generation of budget postings with personnel cost 

savings. 

If earmarked funds documents in Position Budgeting and Control have changes that affect the budget, the 

budget that becomes available can be consumed by other commitments if these settings are not set. These 

settings ensure that a certain percentage of the budget made available through the personnel cost savings 

is automatically posted to one or more budget account assignments that you have defined. 

Requirements 

The Budget Control System (BCS) is set up and activated. 

Standard settings 
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In the standard system, the budget released through changes to earmarked funds documents is then 

available for general consumption. 

Activities 

Define the following settings: 

- Activate the automatic budget postings (ABP) for personnel cost savings for your FM area and the 

corresponding fiscal year. 

- Define the document header attributes for the budget documents to be generated. 

- Create a derivation strategy for the derivation of document line attributes of budget documents, 

maintain the derivation steps and assign the derivation strategy to the FM area and fiscal year. 

To create a suitable derivation strategy, you must fill the target fields of the derivation 

strategy in accordance with the source fields: 

- Determine whether the respective transaction (target field BUDGET_RELEVANT) is relevant for 

the generation of automatic budget documents. 

- Define whether a sender line (target field SENDER_DATA) should be generated, in other words, 

whether the budget document has the structure of a transfer posting. 

- Define the budget type for receiver and, if necessary, sender lines (target fields RBUDTYPE and 

SBUDTYPE) and fill the target fields for the budget account assignments. 

To be able to define a derivation strategy, you can choose the relevant source fields from the input help. 

You can use the following step types to fill the target fields: 

- Derivation rules 

- Table Access 

- Assignment 

- Clear 

- Function modules 

If you only want to repost part of the budget made available from the transaction, you must fill target field 

Percentage. If you want to generate more than one or pair of sender and receiver document lines, you 

must differentiate the relevant document line attrributes using the source fields NUMBER. 

36.2.6.3.6 Integration Materials Management 

36.2.6.3.6.1 Contracts 
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36.2.6.3.6.1.1 Define Integration Scenarios 

Use 

This organizational IMG activity describes how you specify that earmarked funds can be created from 

contracts in Funds Management. 

At the moment, you can only use the document category Funds Reservation. Other funds reservation 

document categories are not supported. 

Requirements 

In IMG activity Define Company Code Group, you have created one or more company code groups in 

accordance with your requirements. 

In IMG activity Assign Company Code to a Company Code Group, you have assigned the relevant 

company codes to the corresponding company code groups. 

If you want your own number range interval to be used for the funds reservations created from contracts, 

you must define your own document type in IMG activity Define Document Types. This also applies 

when there is no suitable document type for funds reservations. 

If you want to use a special blocking reason, define a blocking reason in IMG activity Define Blocking 

Reasons that is reserved only for funds reservations generated from contracts. 

Note 

To use the integration scenarios, in Customizing for Materials Management (MM) in the IMG activity 

Define Document Types, you need to select the CP Active field (Commitment Plan Active) for all the 

required document types. 

If this field is no longer visible, check that the Funds Management (PSM- FM) field has been selected 

in the IMG for Funds Management in the IMG activity Activate Global Funds 

Management Functions (PSM-FM) 

Activities 

You define the required Customizing settings in IMG activityMaintain Data for Integration Scenario. 

To do this, proceed as follows: 

1. Assign the document type funds reservation to the scenario contract integration (without scenario 

variant). 

2. For each company code group you need, assign the following: 

- a document type for funds reservations 

It is advisable to define a new document type beforehand and set up your own number range 

interval so that these documents are easier to distinguish from other earmarked funds 

documents. 

- a blocking reason 
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We advise that you define a blocking reason to prevent documents being processed manually. 

This prevents inconsistencies from arising. 

36.2.6.3.7 Business Add-Ins (BAdIs) 

36.2.6.3.7.1 BAdI: Define Expiry Month 

Use 

You use this Business Add-In (BAdI) to define an expiry month for the end of a fiscal year. You define 

the expiry month as a date with the format YYYYMMDD (year, month, day). 

This achieves the following: 

The system still updates all payments that refer to invoices from the old fiscal year and that were posted 

from the beginning of the fiscal year up to the date you defined in in the old fiscal year in Funds 

Management (FM). You should also define the date by which the payments should be updated in this 

BAdI. 

Requirements 

The payment selection is active in the Customizing of Funds Management . 

For more information on this, see the Implementation Guide (IMG) Funds Management under Define 

Settings for Payment Transfer. 

Standard settings 

The Business Add-In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 
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4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

In order to display coding examples, choose  Go To -> Code Example -> Display 

See also: 

Methods 

Define Expiry Period 

36.2.6.3.7.2 BAdI: Update Target/Actual 

Use 

You can use this Business Add-In (BAdI) to influence the update of FI documents in the component 

Funds Management (PSM-FM). 

Standard settings 

This Business Add-In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 
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3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

See also: 

Methods 

Define Data Summarization for FMIFIIT/FMIT 

 Account Determination for Payment Without Clearing 

 Fill Customer-Specific Field: FI Documents 

CFLEV Set CFLEV : Yes or No 

36.2.6.3.7.3 BAdI: Field Status for FM Account Assignment for Orders 

Use 

SAP provides the BAdI definition FM_ONLINE_ASSIGNMENT and methods that enable further 

customizing of field status for the FM objetcs used in the online order assignments (Sales Distribution, 

Plant Maintenance, Network, and Network Activity). For each order type you must create an 

implementation using the following predefined methods: 

- Method GET_FIELD_STATUS_SD - Order type Sales Distribution 

- Method GET_FIELD_STATUS_PM - Order Type Plant Maintenance 

- Method GET_FIELD_STATUS_NP - Order Type Network 

- Method GET_FIELD_STATUS_NV - Order Type Network Activity 

SAP provides the BAdI definition FM_ONLINE_ASSIGNMENT and the following methods that enable 

to copy aditional values from the online order (Sales Distribution, Plant Maintenance, Network, and 

Network Activity) to be used in the determination of the default FM Account Assignment: 

- Method SD_DATA_COPY_TO_COBL - Copy SD Order Data to the structure COBL 
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- Method PM_DATA_COPY_TO_COBL - Copy PM Order Data to the structure COBL 

- Method NP_DATA_COPY_TO_COBL - Copy NP Order Data to the structure COBL 

- Method NV_DATA_COPY_TO_COBL - Copy NV Order Data to the structure COBL 

Requirements 

The FM integration to online orders must be active. 

Standard settings 

We do not deliver any standard settings. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.2.6.3.7.4 BAdI: Fill Customer Field 
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Use 

The field USERDIM (customer field for FM actual and commitment data) in the table FMIFIIT is 

available to you, but it is not used by SAP. It is a key field in the update tables of Funds Management. 

You can, for example, use the field as an additional account assignment element along with the 

commitment item, funds center and fund. 

Activities 

You can use this BAdI to set the field USERDIM in the payment records created. 

With input parameter I_F_FMIFIIT, you receive all information that is updated in Funds Management per 

line item. 

Note that this field is a key field in the line items and totals records. Each new value in this field creates 

its own entry in the totals item. A very large number of totals items can have a negative affect on system 

performance. 

36.2.6.3.7.5 BAdI: FI Updates in Funds Management 

Use 

You can use this Business Add-In (BAdI) to adapt the actual update to customer requirements. The 

following methods are used: 

- FMRI_BADI_1: Value Type Determination for 30-30 Postings 

- FMRI_BADI_2: Ledger-Dependent Statistics Update 

- FMRI_BADI_3: Fill Field FMVOR 

- FMRI_BADI_4: Determine Due Date 

- FMRI_BADI_5: Account Assignment Derivation After Reassignment 

- FMRI_BADI_6: Update Date for Reduction Records of Parked Documents 

- FMRI_BDAI_7: Principle of Prudence 

- FMRI_BDAI_8: Due Date for Reversal 

- FMRI_BDAI_9: Modify Year of Cash Effectivity 

- FMRI_BADI_10: Tax Split in FM with Active FI Doc. Splitting 

- FMRI_BADI_11: Suppresses Bank Clearing Online 

- FMRI_BADI_12: Specify Reversal Document for Subsequent Posting 

- FMRI_BADI_13: MM documents with multiple FI documents 

- FMRI_BADI_15: Derive Financial Transaction for Consignment Postings 
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- FMRI_BADI_16: Update Date for Changed Parked Documents 

- FMRI_BADI_17: Updating Control for Account Maintenance (MR11) 

- FMRI_BADI_18: Adjust Invoice Reference for Carryforward Level 

- FMRI_BADI_19: Determine Default Funds Center for Tax Item 

- FMRI_BADI_20: Set the field FMIFIIT-PAYFLG 

- FMRI_BADI_90: Activation of Summary Update 

Documentation with a more detailed description of the parameters is available for each method. The 

documentation gives an exact description of the parameters. 

36.2.6.3.7.6 BAdI: Control Postings Using Master Data Attributes 

Use 

Use this Business Add-In (BAdI) to perform additional validations in the posting process into Funds 

Management (FM). It is foreseen that additional authorization checks are carried out depending on master 

data attributes such as a fund or funds center status. With this BAdI, you can set up the rules governing 

the nature and severity of messages when checking specific postings. 

The rules use source fields selected from the following: 

- Fund 

- Funds center 

- Commitment item 

- Funded program 

- Grant 

- User 

- Fund's status 

- Fund type 

- GL account 

- Commitment item 

- Message variables 

- Amount type 
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- Value type 

The target fields for the rules are selected from the following: 

- Message class 

- Message severity 

- Message number 

Activities 

1. Select the Create icon. 

2. In the dialog box, enter a name (Z_ABC_123) for the BAdI implementation in the Implementation 

Name field and press Enter. 

The screen for changing the BAdI implementations is now displayed. 

3. Enter a short text for the implementation in the Implementation Short text field. 

4. Choose the Interface tab. 

You can implement check rules as ABAP code, but implementation with the formula builder as 

described below is usually easier. 

5. Change the Implementation Type to Formula. 

6. Save your entries, and assign the implementation package to a customer development class 

. 

7. Provide transport information. 

8. Use the developer's key to proceed and save. 

9. Double click the method name to enter method processing. 

10. Choose the "Create Condition" icon. 

11. Enter a name for the first rule and press Enter. 

12. Change the "Show Me" fields to Parameters - Controlling Postings with Master Data Attributes 

13. Create the first rule # (Condition 1) and (Condition 2). 

a) Expand the subtree. 

b) Double click "True". 

c) Select "Create Exception" 

Enter the message number, message class, and message type. If you enter message type 

"Warning" or "Error" and leave the other fields empty, a default message of the specified type 

is issued. 

14. Repeat the above process for any additional rules and conditions. 

15. Choose Activate for this implementation. 

The code you stored in the method will be run when the application program is executed. 
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Further notes 

This BAdI can also be implemented with ABAP code. If there is the need to check authorizations for a 

given user under specific conditions for certain master data attributes, an authorization object should be 

created and evaluated at this calling point.  SAP recommends the use of customer authorization objects to 

perform any detailed role-user dependent controls. 

In previous releases, tables FMUSERGROUP and FMGROUP supported a grouping of users for specific 

checks within this BAdI. Although this functionality could still be used, the use of authorization objects is 

preferred and recommended. 

36.2.6.4 Internal Data Transfer to Funds Management 

The following sections explain how you can automatically transfer postings relevant to Funds 

Management (FM) into FM at a later stage if you are implementing FM after you have implemented other 

components. 

A prerequisite for the data transfer is that the documents have a complete  FM account assignment. 

In the following steps you can: 

- Supplement documents with incomplete FM account assignments - Transfer documents 

from the following components: 

- Financial Accounting 

- Materials Management 

- Sales and Distribution 

- Controlling 

In addition, you can reconstruct the actual data in Funds Management based on the earmarked funds and 

funds transfer documents. 

36.2.6.4.1 Supplementary Account Assignment 

The following steps illustrate how you can enter account assignments for components which do not have 

a complete FM account assignment. You can have the system copy documents with a supplementary 

account assignment into Funds Management. 

36.2.6.4.1.1 Select Documents 

In this step you can select documents, based on particular selection criteria, for which you want to provide 

a supplementary account assignment within a specific company code. The documents selected are 
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displayed in a worklist. You can provide the documents with a supplementary account assignment in an 

additional step by converting the worklist. 

The program provides documents from other components that you want to transfer to Funds 

Management (FM) with a complete FM account assignment (commitment item, funds center and, 

if necessary, fund and functional area). 

The FM account assignment is determined by the system from the valid FM account assignment 

derivation. For example, the commitment item is either derived from the assignment to the G/L account 

or from the assignment to a CO object or cost element. For more information on account assignment 

derivation, refer to the Account Assignment Derivation section of the Funds Management 

Government  documentation. This program does not provide cash discount lines with account 

assignments. 

Requirements 

The system must be able to derive a complete FM account assignment from existing data. In order to 

ensure this, you can do one of the following: 

- Adjust your account assignment derivation accordingly 

- Program your own account assignment derivation in enhancement SAPLFMCH (component 

EXIT_SAPLFMCH_001, development class FMFS). 

- Specify a default account assignment for the account assignment elements of Funds Management for 

the program run. These default account assignments must first be created in the master data 

maintenance in FM. 

Note that the default account assignment can only be transferred if the program cannot determine 

the FM account assignment elements from the account assignment derivation or the enhancement. 

Recommendation 

You can only provide documents with supplementary account assignments if no FM documents exist on 

the basis of postings in other components. 

Therefore only provide documents with supplementary account assignments if you are implementing FM 

after other components and want to post the documents which already exist there. 

If FM is already active and FM documents already exist, you have to first of all delete these documents 

before you can provide documents from other components with supplementary account assignments for 

posting purposes. 

Activities 

1. Make sure that FM has been activated. See also "Activate/Deactivate Funds Management". 

2. Start supplementary account assignment as required. 

Note 

Note that the FM account assignments are adjusted by the system in certain tables when supplementing 

account assignments: 
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- EKPO (e. g. purchase orders not assigned to an account) 

- EKKN (e. g. purchase orders assigned to an account) 

- BSEG, BSIK, BSAK, BSID, BSAD line item table of Financial Accounting and the 

index tables for vendors and customers 

- KBLK, KBPL (e. g. earmarked funds, funds reservations and funds precommitments) 

- EBAN e. g. (purchase requisitions not assigned to an account) 

- EBKN e.g. (purchase requisitions assigned to an account) 

If you want to reassign documents for fiscal year change operations which are not saved in these 

tables (for example, from other systems), you should first test whether the system executes the 

reassignment. If the reassignment is not executed, you must set up a corresponding project. 

36.2.6.4.1.2 Convert Worklist 

In this section you add account assignments to the documents contained in the work list for an FM area. 

The documents to which an account assignment is added are displayed in a list which shows the original 

account assignment and the changed account assignment for each document. 

With each program run, the system assigns a run number. You can use this run number as a selection 

criterion for selective deletion or selective display of the work list. 

Requirements 

You must first have selected the documents to which you want to add an account assignment. For this, see 

"Select documents". 

Recommendation 

To achieve good system performance, you should deselect  Change documents and Block documents 

for a large volume of documents. 

Activities 

1. Start conversion of the work list according to your requirements. 

Do not select Adjust assigned values. This control parameters for availability control are not 

taken into account during supplementary account assignment since there are not yet any assigned 

values in Funds Management (FM). 

2. When an account assignment has been added to all documents relevant to FM, you can post the 

documents. 
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36.2.6.4.1.3 Display Worklist 

In this section, you can display the worklist for a specific FM area based on particular selection criteria, 

for example, according to reference document category or number. 

If no data was deleted from the worklist, the worklist contains all the information on the supplementary 

account assignment: 

- The history of the documents already provided with a supplementary account assignment 

The system assigns a run number during each program run for converting the work list. You can use 

this number as a selection criterion when displaying the work list. 

- The documents already selected which are still to be converted 

You can display these documents by starting the program without specifying a run number. 

Activities 

1. Choose A (supplementary account assignment) as the reassignment category. 

2. Run the program as required. 

36.2.6.4.1.4 Delete Worklist 

In this section, you can delete the data from the work list for a specific FM area based on particular 

selection criteria, such as by reference document category or number. 

If no data was deleted from the work list, the work list contains all the information on the supplementary 

account assignment: 

- The history of the documents already provided with a supplementary account assignment 

The system assigns a run number during each program run for converting the work list. You can use 

this number as a selection criterion when deleting the work list. 

- The documents already selected which are still to be converted 

You can delete these documents from the work list by starting the program without specifying a run 

number. 
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Activities 

1. Choose A (supplementary account assignment) as the reassignment category. 

2. Run the program as required. 

36.2.6.4.2 Subsequent Posting 

This section explains: 

- How you can automatically and subsequently copy postings that are relevant for Funds Management 

to the Funds Management component, if you implement FM after other components. 

- How you can subsequently post documents that you post in Funds Management (Earmarked Funds 

and funds transfers). 

36.2.6.4.2.1 Post Purchase Requisitions 

In this step, you can reconstruct the commitment data in Funds Management (FM) on the basis of the 

purchase requisitions from Materials Management (MM). 

You can use this program to correct documents that have been carried forward to the new fiscal year or if 

you activated Period-Based Encumbrance Tracking (PBET). 

Activities 

1. Start reconstruction in test mode. 

2. If inconsistencies are found, run the program again in live mode. 

Further notes 

For more information, see the documentation for program RFFMRP34N. 

36.2.6.4.2.2 Post Purchase Orders 

In this step, you can reconstruct the commitment data in Funds Management (FM) on the basis of the 

purchase orders from Materials Management (MM). 

You can use this program to correct documents that have been carried forward to the new fiscal year or if 

you activated Period-Based Encumbrance Tracking (PBET). 

Activities 
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1. Start reconstruction in test mode. 

2. If inconsistencies are found, run the program again in live mode. 

Further notes 

For more information, see the documentation for program RFFMRP02N. 

36.2.6.4.2.3 Reconstruct FM Open Items for SD Orders 

Use 

Use this step to rebuild FM open item data relating to SD orders. 

Requirements 

- Back up your data before executing this step. 

- Make sure that no new SD orders can be posted while the rebuild is running. 

Activities 

- Select the company code and document(s) in respect of which you want to rebuild data. 

- In addition, you need to specify how existing FM open item data is handled: 

- Choose Check Existing FM Data to have the system verify whether such data exists. If it does, the 

system displays it. 

- Choose Delete Old FM Data to have the system simply delete any existing FM data and replace it 

with the rebuilt data. 

- Check the test run option if you want to check the effect of the program before running it live. 

36.2.6.4.2.4 Post Financial Accounting Documents 

In this step, you can subsequently copy Financial Accounting documents to Funds Management 

(FM). During this process, you can choose whether documents already existing in Funds Management 

should not be reconstructed or whether these documents should be deleted before the reconstruction. 

Activities 

1. Make sure that FM has been activated. See also "Activate/Deactivate Funds Management". 
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2. Enter a company code, fiscal year and, if required, a period. 

3. Choose the documents to be reconstructed according to your requirements. 

4. Start the reconstruction. 

Further notes 

You can find more information in the documentation on the program Document Transfer from Financial 

Accounting (RFFMRPFI). 

36.2.6.4.2.5 Post Parked Financial Accounting Documents 

In this step, you can copy parked documents from Accounting to Funds Management. In the process, you 

can opt either not to post documents already in Funds Management or to delete the documents before the 

subsequent posting. 

Documents already selected for the commitment carry forward in the new fiscal year or carried forward 

into the new fiscal year cannot be posted subsequently. This is because information is lost with 

subsequent posting. 

If you want to post documents subsequently, you must first reverse the carryforward with program 

RFFMCCFR and then delete the documents with report RFFMDLFI. You can then post the documents 

subsequently. 

You must remember that the commitment carryforward for these documents must then be carried out 

again. 

Note: The tax lines are not included (posted subsequently) during the subsequent posting. 

Recommendation 

- Posting in this process can adversely affect system performance if the data volume is large. For this 

reason, carry out such postings in background processing. 

- If a large number of documents are to be posted subsequently, you should first delete the 

commitment and actual data, to improve system performance. For more information on the report 

program which does this, go to the step Delete commitment and actual data. 

- If the number of documents to be posted subsequently is small and you want to delete existing actual 

data in FIFM first, choose Delete old data when you start the program. 

Requirements 

- You should only carry out such postings in the implementation phase, before going live, as the 

reconstruction of actual data may lead to data getting lost. 
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The documents to be posted must have an FM account assignment. 

You can add these to documents which do not have them. See Supplementary Account Assignment 

for details. 

- Back up your data first. 

- You have put organizational measures in place to ensure that no other activities are carried out in 

the system, most particularly that no documents are entered. 

Activities 

1. Make sure that FIFM has been activated. See also: Activate/Deactivate Funds Management. 

2. Start subsequent posting. 

3. After subsequent posting, you must reconstruct the assigned values. 

To do this, go to the Funds Management menu and choose Budgeting -> Tools -> Reconstruct 

assigned values. 

This reconstruction ensures that availability control can identify excessive funds commitments in 

your funds center and commitment item hierarchies. 

36.2.6.4.2.6 Post Controlling Documents 

In this step, you can transfer internal Controlling (CO) documents to Funds Management. In the process, 

you can choose whether to not post documents already in Funds Management subsequently  or whether 

to delete these documents prior to subsequent posting. 

Recommendation 

Posting in this process can adversely affect system performance if the data volume is large. Because of 

this reason, as a rule, carry out such postings in background processing. 

Requirements 

- You should only conduct subsequent postings in the implementation phase, before going live, as the 

reconstruction of actual data may lead to data getting lost. 

- Back up your data first. 

- You have put organizational measures in place to ensure that no other activities are carried out in 

the system, most particularly that no documents are entered. 

Activities 

1. Start subsequent posting. To delete existing actual data already in Funds Management prior to 

subsequent posting, select Delete old data before executing the program. 
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2. After subsequent posting, you must reconstruct the assigned values. 

To do this, go to the Funds Management menu and choose Budgeting -> Tools -> Reconstruct 

assigned values. 

This reconstruction ensures that availability control can identify excessive funds commitments in 

your funds center and commitment item hierarchies. 

36.2.6.4.2.7 Post Earmarked Funds and Funds Transfers 

In this step, you can reconstruct the commitment data in Funds Management (FM) on the basis of the 

funds reservations, funds precommitments, funds commitments, funds blockings, and forecasts of 

revenue. 

You can use this program to correct documents that have been carried forward to the new fiscal year or if 

you activated Period-Based Encumbrance Tracking (PBET). 

Activities 

1. Start reconstruction in test mode. 

2. If inconsistencies are found, run the program again in live mode. 

Further notes 

For more information, see the documentation for program RFFMRP03N. 

36.2.6.5 Check Company Code 

In this step, you can subject the company codes, which are relevant to Funds Management, to particular 

consistency checks. 

The checks are carried out in the following order: 

- is an FM area assigned to the company code? 

- does the FM area actually exist? 

- does the currency key for the FM area exist? 

- is there a fiscal year variant for the FM area? 

- is there a budget profile for the FM area (only if you use former budgeting)? 

- is there a budget profile for funds for the FM area? (only if you use former budgeting and have 

defined a budget profile for funds in the FM area) 

- is there a status profile for the FM area? (if you have defined a status profile in the FM area) 
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- is there a number range interval (for FM line items) for the FM area? 

- is there an update profile for the FM area? 

is cost of sales accounting active for all the company codes that are assigned to the FM area? (if you 

have activated the functional area for the assigned FM area) 

Activities 

Enter a company code and choose Company code -> Check. If any errors are found, choose Extras -> 

Display error log to access the error log.  Double click on the error message to access the long text, 

which directs you how to proceed. 

36.2.6.6 Activate/Deactivate Funds Management 

In this step, you activate the Funds Management (FM) account assignment derivation and update of 

documents from the feeder components for FM to FM for specific company codes. If you have combined 

a number of company codes under an FM area, you have the option of activating specific company codes 

only or of leaving other company codes deactivated. 

If you only activate the account assignment derivation, the documents are given an FM account 

assignment in accordance with the assignment in the account assignment derivation during posting in the 

feeder components for FM. If you also activate the update, the documents are also updated in FM. 

You can implement Funds Management in two steps if you only activate account assignment derivation. 

In the first step, you only activate account assignment derivation. If you want to activate the update of 

documents at a later time, you can activate the update in a second step and reconstruct the documents. 

You can deactivate the update again in FM if necessary. No checks are carried out on postings in the 

feeder components for FM after the update has been deactivated. The prerequisite is that the 

corresponding assignments from company codes to FM areas are not removed. If you want to stop the 

update and account assignment derivation, you have to deactivate the account assignment derivation as 

well. 

If you do not want to use FM anymore, you can delete all master data and transaction data as soon as you 

have deactivated the account assignment derivation and update. 

Requirements 

Activate Account Assignment Derivation 

Before you can activate the account assignment derivation for a company code, the following 

prerequisites must have been met: 

- An FM area must be assigned to the company code 

- Account assignment derivation must be defined 

Activate Update 
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Before you can activate the update for a company code, the following prerequisites must have been met: 

- An FM area must be assigned to the company code 
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A currency key must exist for the FM area 

- A fiscal year variant must be assigned to the FM area 

- A budget profile must be assigned to the FM area (only if you use former budgeting) 

- A budget profile for the fund is assigned to the FM area (only if you use former budgeting and work 

with funds) 

- A status profile must have been assigned to the FM area if you are working with status management 

- A number range interval (for FM line items) must have been assigned to the FM area 

- An update profile must have been assigned to the FM area 

- The account assignment derivation must be defined 

If any of these prerequisites are not met, an error message appears when you try to save your entries, 

directing your attention to the error log. You can access this by choosing Extras -> Display error log. 

Double click on an error message to access the long text, which tells you how to proceed. 

You can also use the Check company code step to verify that these requirements have been met in each 

company code before you activate Funds Management there. 

Note: 
Application component Funds Management can not be used at the same time as application 

components Cash Budget Management and/or Project Cash Management if you use yeardependent 

master data in Funds Management. 

If you want to implement Funds Management with Cash Budget Management and/or Project Cash 

Management, note that Cash Budget Management and Project Cash Management only process 

commitment items with 10 chararcters. 

Deactivate Update 

The assignment of company codes to FM areas cannot be removed. 

Activities 

1. Decide whether you want to activate the account assignment derivation only or the update as well. 

2. Select the company codes you want to activate and save your table entries. 

Note 

If you only activate the update, the account assignment derivation is activated automatically. 

Additional information 

Performance problems can occur in the following scenario: 

- In the account assignment derivation, you have allocated FM account assignment to CO 

assignments. 

- You are working with orders and projects 
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The availability control is active in Funds Management and for orders and projects. 

For this reason, you must make a clear decision on what the task of the availability control is to be in 

Funds Management and for orders and projects. 

For Funds Management, you can activate/deactivate the availability control in step Activate/Deactivate 

Availability Control. 

36.2.7 Budgetary Ledger 

36.2.7.1 Information on Budgetary Ledger 

Use 

The FM budgetary ledger is used to record budget consumption due to financial operations such as the 

creation of new budgets or commitment items, and the posting of earmarked funds or invoices. It is an 

additional ledger that is linked to the General Ledger (SAP Financial Accounting). 

In some countries, it is a legal requirement to store such financial data in the budgetary ledger as well as 

in the financial accounting area of an organization. This means that when a user creates a reservation or 

commitment item that consumes or increases the budget, this information is also stored in SAP Financial 

Accounting (FI). 

Note 

If you are using the budgetary ledger for the United States, you must work in the 

Implementation Guide for this country. This can be found in the Implementation Guide of Public Sector 

Management -> Functions for US Federal Government -> Ledgers -> Budgetary Ledger -> Activate 

Budgetary Ledger Variant and subsequent IMG activities. 

After making the Basic Settings, you can set up the General Budgetary Ledger or the specific Spanish 

Budgetary Ledger, which contains the same activities of the general one plus others created specifically 

for Spain. 

In the individual IMG activities, you can make the corresponding settings to set up a budgetary ledger in 

your organization. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with Budget Control System, you 

must have previously installed it. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

Process the IMG activities in the sequence they appear. 
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36.2.7.2 Basic Settings 

36.2.7.2.1 Activate Variant for Budgetary Ledger 

Use 

In this IMG activity, you define the specific budgetary ledger (BL) to be activated. You also specify the 

default document type to be used for BL postings, and define whether you want negative postings and/or 

whether you want to define that documents can be split because you are using a split ledger. 

Note 

If you are using the budgetary ledger for the United States, you must work in the 

Implementation Guide for this country. This can be found in the Implementation Guide of Public Sector 

Management -> Functions for US Federal Government -> Ledgers -> Budgetary Ledger -> 

Activate Budgetary Ledger Variant. 

Furthermore,  you can select only one budgetary ledger variant and one document type, and create only 

one entry. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. In the Basic Settings for the Budgetary Ledger, choose New Entries. 

2. In the next screen, use the dropdown to select the applicable BL variant and the document type. 

3. Specify whether you want to use negative postings and/or split documents. 

4. Save your entry. 
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36.2.7.2.2 Classify BL Accounts 

Use 

In this IMG activity, you define how posting is to be carried out for specific G/L account intervals of your 

chart of accounts.  You have to define whether posting is to be carried out for budgeted and/or for posted 

amounts, and using the budgetary ledger or not. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. In the initial popup, enter the chart of accounts you are using. 

2. In the first dialog structure By Posting Type, use New Entries to define one or several GL account 

intervals. 

3. Specify whether posting is to be carried out using budget amounts, actual (posted) amounts, or both. 

4. Save your entries. 

5. Next, place your cursor on the second dialog structure By Source. Proceed as for the first dialog 

structure, and specify whether the BL account is to be posted to through the budgetary ledger or not 

by selecting an item from the dropdown box. 

6. Save your entries. 

36.2.7.2.3 Define Posting Keys for Budgetary Ledger 

Use 

In this IMG activity you specify the posting keys to be used with the FM budgetary ledger. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 
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SAP does not deliver any standard settings. 

Activities 

1. For transaction key FMB, define the posting keys to be used for the FM budgetary ledger. 

2. Save your entries. 

36.2.7.3 Settings for General Budgetary Ledger 

36.2.7.3.1 Select Budget Categories and Value Types for BL Update 

Use 

In this IMG activity, you select the value types per FM area and budget category to enable budgetary 

ledger postings. Note that there are two different value types to be selected, one for budgeted amounts 

and one for commitments/actuals. 

For budgeted amounts, you can choose to work with or without offsetting entries in a G/L account, due to 

the self-balancing of BCS. 

For commitments/actuals, you can also activate the budgetary ledger for statistical postings. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Click on New Entries and enter the FM area and budget category to be used in the budgetary 

ledger. 

2. Save your entry. 

3. Next,  mark the item you have defined and double-click on Value Types for Budgets. 

4. Using the New Entries function, maintain the value types to be used in the budgetary ledger. 

5. Checkmark the column "BL active" if the budgetary ledger is active. 

6. If you want to work with offsetting accounts, checkmark the column Offset Account Required and 

save your entry. 

7. Repeat this action for Value Types for Commitments. 
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8. If appropriate, checkmark the column Stat. Ind (Statistical  Indicator). 

9. Save your entry. 

36.2.7.3.2 Select Source Fields for Account Assignment Derivation 

Use 

In this IMG activity, you specify the fields to be used by the Derivation Tool. This enables the budgetary 

ledger to derive G/L accounts from the corresponding FM account assignment elements. 

In the database of possible source fields there are two structures, one for budgeted amounts and another 

for posted commitments/actuals. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Select a budgetary ledger Derivation Tool structure to work with. 

2. Next, click on Select Fields and add any fields you need to have in the Derivation Tool for 

budgetary ledger. 

3. Save your entries. 

36.2.7.3.3 Define Derivation Strategy for BL Accounts 

Use 

In this IMG activity, you use the Derivation Tool to create derivation rules. These enable you to derive 

the G/L accounts to be used for the budgetary ledger. 

Note 

The Derivation Tool is designed to strictly derive G/L accounts. You cannot use it to check whether to 

post a BL document or not, because if the tool does not find a result, it issues an error message of 

incomplete Customizing. Nevertheless, by setting up the Derivation Tool in order to derive the pairs of 
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G/L accounts suitable for deletion, you can avoid the creation of additional budgetary ledger posting 

lines. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Furthermore, you must previously have selected the source fields to be used for creating a derivation 

strategy for the budgetary ledger in the IMG activity Select Source Fields for Account Assignment 

Derivation. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. In the popup for this IMG activity, select a strategy environment, determining whether you want to 

use the budgetary ledger for budget postings or for commitment postings. 

2. Click on Create Step to create a new step for your derivation strategy. 

3. In order to create a derivation rule, select the source and target fields and maintain the field values. 

If you want to use G/L offset accounts, select the corresponding target field for this. 

4. Save your entries. 

Note 

If you are posting budget returns, the posting lines in the budgetary ledger will have a reversed order.  

The reason for this is that when you make a debit posting, the credit side of the account is reduced. When 

you make a credit posting, the debit side of the account is reduced. 

You can test your derivation rules by clicking on the Test button. In the popup, enter the source values 

and click on Derive. The results will be displayed if Customizing has been properly carried out. If not, 

you will receive an error message. 

Clicking on the Display Trace button enables you to follow the derivation process step by step, 

searching for possible incorrect Customizing settings. 

36.2.7.3.4 Select Fields for Update of FI General Ledger 

Use 

In this IMG activity, you select the fields in the budgetary ledger (BL) that enable you to store FM 

account assignment elements, such as the commitment item, fund, or funds center, in the General Ledger 

of Financial Accounting (FI). 

Note 
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If you have activated an FI Special Ledger that is to be updated by a BL posting, you can write these 

account assignment elements to the FI Special Ledger (FI-SL) for reporting purposes. 

Furthermore, storing account assignments in the FI-SL requires the creation of further lines in the 

budgetary ledger. For example, if you need to store the funds center in SL and you post a document using 

two different funds centers, the result in BL will be a document with two pairs of lines, each of them 

showing one funds center. However, if the document you are post ing contains only one funds center, the 

BL document will consolidate the lines of the document and show only one pair of lines in the BL 

document. 

Also note that Customizing settings can in some cases affect the BL postings. For example, if you have 

the funds center transferred to the BL document, the lines in FM with different funds centers cannot be 

put into one line in the FI document, even if the BL settings in Customizing are defined this way. 

For technical reasons, the commitment item in a BL document is displayed in the field "Payment 

Reference" of table BSEG. 

Requirements 

Since for budgeting processes the budgetary ledger only works together with the Budget Control System, 

you must have previously installed it. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

1. Via New Entries, create a new entry for your FM area. 

2. Put your cursor on the FM area and double-click on Select Fields on the left side of the screen. 

3. Select new Data Dictionary fields via New Entries. 

4. Save your entries. 

Example 

An example would be the situation in Portugal, where it is mandatory for a public organization to display 

the FM account assignments in combination with the BL postings. 

36.2.7.4 Settings for Spanish Budgetary Ledger 

36.2.7.4.1 Prerequisites for Maintaining Spanish Budgetary Ledger 

Use 

Note 

The IMG activities falling under this node need to be carried out for the Spanish Budgetary Ledger after 

you have maintained the IMG activities for the General Budgetary Ledger. 
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Access the four General Budgetary Ledger activities in the IMG node immediately above this one and 

maintain them accordingly. 

36.2.7.4.2 Define Predecessors for Combined Documents 

Use 

For reporting purposes, some customers may need to create so-called predecessor documents 

accompanying their earmarked funds, purchase requisitions, purchase orders and invoices.  In this way, a 

funds commitment can be preceded by a funds pre-commitment and possibly by a reservation. It is also 

possible to create combined documents for purchasing documents. 

Manual posting of these individual documents in the chain is unnecessary and time-consuming, so 

customers must be able to post the principal document and have a "virtual" chain of predecessors 

generated automatically in the background and written to the budgetary ledger. Since these documents are 

used only in reporting, it is not necessary to actually post the predecessor documents. 

In this IMG activity, you select the combination of principal documents and predecessors to be used for 

defining combined documents. 

Requirements 

The Budgetary Ledger must be configured in order to use the combined document functionality. 

Note 

You may also need to customize the following: 

- Document types in Financial Accounting (SAP FI). 

- Combined documents for purchasing documents such as purchase requisitions or purchase orders, 

for which you can also customize the document types. 

- Funds Management document types. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

If you want to create your own combined documents, make new entries in this table. Note that the system 

will issue an error message if the combination you are using is not permitted. 
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36.2.7.4.3 Exclude Accounts from Automatic Offset/Deletion Procedure 

Use 

In this IMG activity, you can specify the G/L accounts that are to be excluded during the automatic offset 

and deletion procedure. 

By creating entries in this IMG activity, you can exclude specific G/L accounts in user-defined number 

ranges from the summarization process, where they offset each other or "balance each other out". The 

result is that these G/L offset accounts are not deleted and can be displayed in the corresponding BL 

documents. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

1. Enter the names of the G/L accounts that you would like to exclude from automatic offset and 

deletion and specify whether this is valid only for budget postings, only for actuals postings, or for 

both budget and actuals postings. 

2. Save your entries. 

Example 

Since this customizing has been developed to work in sync with combined documents, this example 

assumes that a funds  precommitment has been created, and that the specific G/L account for the funds 

reservation (G/L account 31) is to be excluded from automatic deletion. 

Note 

The logic of combined documents simultaneously creates and reduces the predecessors of the posting 

document. Furthermore, posting key 40 means "debit" and 50 means "credit". 

 Transaction G/L Offset Account G/L Account 

 Reservation 30 31 

 Precommitment 30 

The intermediate result, transparent for the user, is: 

4 

 Posting Key G/L Account Amount Description 

 40 30    100 Reduces the budget 

 50 31 -  100 Creates a funds reservation 

 40 31    100 Reduces the funds reservation 

 50 30  - 100 Increases the budget 

 40 30    100 Reduces the budget 

 50  4 - 100 Creates a funds precommitment 
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Since now the G/L account 31 has been added to the customizing table, in order to have it excluded from 

automatic deletion, the sorted final result will be the following. Note that only G/L account 30 has been 

balanced and deleted: 

Posting Key G/L Account Amount Description 

40 30    100 Reduces the budget 

50 31  - 100 Creates a funds reservation 

40 31    100 Reduce the funds reservation 

50  4  - 100 Create a funds precommitment 

36.2.7.4.4 Substitute BL Document Type 

Use 

In this IMG activity, you can replace the budgetary ledger document type. 

You can replace the BL document type for different document categories, such as budgets, earmarked 

funds and financial accounting documents. For example, you can change the BL document type for 

reporting reasons, in order to easily identify the BL data originating from specific posting documents. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Make the necessary settings and save your entries. 

36.2.7.5 Transfer of FM Totals Records to Budgetary Ledger 36.2.7.5.1 

Information on Transfer of FM Totals Records to Budgetary 

Ledger 

Use 

A requirement of Fund Accounting is that financial transactions, such as creating a new budget or 

commitment items, or the posting of earmarked funds and invoices, are entered as total values in the 

budgetary ledger. 

The transfer to the budgetary ledger can happen in real-time or be planned in periodically. For more 

information, see the information on the transfer in real-time, in the IMG of Funds Management, under 

Information on the Budgetary Ledger. Under this organizational activity you will find all the necessary 

activities for the periodical transfer of Funds Management information to the budgetary ledger. 

Requirements 

Budget data must be available in both the Budget Control System and in the corresponding components 

of Funds Management. All BAdI implementations for BAdI: integration functions for the posting of FM 
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in the FI general ledger (BADI_FM_FM2AC) must be deactivated. This confirms the conversion of 

predecessor program Post Commitment in the Budgetary Ledger (RFFMTOBL). 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Execute the IMG activities in the order they appear. The program Post Budget or Commitment/Actual 

Totals in FI (RFFMTTTOBL) carries out the transfer based on these definitions. 

36.2.7.5.2 Activate Transfer 

Use 

In this IMG activity, you activate the transfer to the budgetary ledger by FM area, budget 

category, and value types. 

For value types, the separation takes place in accordance with your definitions for budget or 

commitment/actual postings. 

The activation of the transfer of specific FM data segments is the first step when selecting the 

FM totals information that should be updated in the budgetary ledger. In IMG activity Define Derivation 

Strategy for transfer and BL Accounts, you can then define the transfer of this information more exactly 

by defining exclusion rules. 

Requirements 

As the budgetary ledger for budgeting transactions only works together with the Budget Control System, 

you must have first installed it. 

Standard settings 

SAP does not provide any standard settings for this. 

Activities 

1. Choose New Entries and enter the FM area and budget category for the transfer to the budgetary 

ledger. Save your entries. 

2. Select the item that you have defined and activate the transfer of the budget by double-clicking 

on the corresponding option. 

3. Define which budget value types you want to post, and then activate the budgetary ledger by 

setting the corresponding indicator. Save your entries. 
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4. Select the item that you have defined and activate the commitment/actual posting by double-

clicking on the corresponding option. Save your entries. 

36.2.7.5.3 Define Derivation Strategy for Transfer and BL Accounts 

Use 

In this IMG activity you use the derivation tool for creating derivation rules to enhance the account 

assignment objects in accordance with Fund Accounting requirements and to define the G/L accounts for 

budgetary ledger postings. The derivation tool requests separate derivation definitions for budget and 

commitment actual data records. 

Note 

The program Post Budget or Commitment/Actual Totals in FI (RFFMTTOBL) calls the budget or 

commitment/actual data records in the order they appear in the derivation tool. The two derivation 

strategies are called in two successive steps for each commitment/actual data record. 

- In the first step, the functions for the enhancement of account assignment objects are available, but 

you can also decide to skip this data record. 

- In the second step, the G/L accounts are defined for the transfer. 

The derivation for defining the G/L accounts allows the definition of postings on more than two G/L 

accounts by addressing an extra derivation requirement for the same data record. A maximum of ten 

derivation requirements are possible for one data record. This provides several budgeting categories for 

each step of a business process. 

Requirements 

As the budgetary ledger only works together with the Budget Control System, you must have first 

installed it. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

1. Choose a strategy environment that defines whether you want to use the budgetary ledger for budget 

postings or commitment postings and whether you want to define rules for the enhancement of Fund 

Accounting account assignment objects or G/L accounts in the budgetary ledger. 

2. Create a new step for your derivation strategy. 

3. To create a derivation rule, choose the source and target fields and maintain the field values. 

4. Save your entries. 
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36.2.7.5.4 Define Details for FI Update 

Use 

In this IMG activity, you choose the account assignment objects for FI updates in the budgetary ledger 

and the document details for postings in the budgetary ledger. The account assignment objects of FM area 

and fund are compulsory. All other details on the account assignment elements can be entered as 

required. 

The concept of the budgetary ledger ensures that the totaling of all BL postings are cleared against each 

other. You require at least one G/L account and one offsetting account for this transaction for which the 

budget or commitment/actual records can be defined. In addition to this offsetting account, the following 

details are required: 

- Fund details 

Additional account assignment objects, such as business area; you can define the funds center or 

functional area in this IMG activity. 

- The documents of the budgetary ledger should only be posted in the budgetary ledger and the 

corresponding reorting ledger. 

- Other FI components, such as CO and FM should be excluded as information recipients of the 

budgetary ledger. 

Requirements 

As the budgetary ledger only works together with the Budget Control System, you must have installed 

this first. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

1. Create a new entry for your FM area and define the document type of the budgetary ledger for it. 

2. Position your cursor on the FM area and double-click on the account assignment objects that should 

be posted on the left-hand side of the screen. 

3. Define the fields that are linked to the account assignment objects. 

4. Save your entries. 

36.2.7.6 Closing Operations 

36.2.7.6.1 Define Settings for Year-end Balance for BL Accounts 
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Use 

In this IMG activity, you define the BL accounts and posting details to be used during year-end balancing 

of the budgetary ledger accounts. 

In the posting details, you can choose whether you want to use the sum of debits, the sum of credits or the 

balance of an account as the posting amount. If you use the account balance, the system will not 

distinguish between credit and debit balances. Therefore, you must know whether to expect a debit or a 

credit balance in order to properly balance the account. 

Note 

You must know the numbers of your BL accounts to be used during year-end balancing in order to carry 

out this IMG activity. 

Standard settings 

SAP does not deliver any default settings. 

Activities 

In order to define a posting group, carry out the following steps: 

1. Define a posting group and enter a description for it. 

2. Click on the node Settings per Fiscal Year and Company Code, and then on New Entries. 

3. Enter the fiscal year and company code, as well as the document type and the debit/credit posting 

keys. 

4. Click on the node Posting Details and then on New Entries. 

5. Enter the document counter number, the sequence number, the BL account numbers and other 

posting details. 

6. Save your entry. 

36.2.7.6.2 Carry Forward Budget/Actual to Budgetary Ledger 

Use 

Each posting of the budgetary ledger (BL) is generally executed together with the corresponding FM 

posting. The carryforward process in Funds Management, however, does not trigger FM postings. 

In the Spanish budgetary ledger scenario, you can use report RFFMTTTOBL to post the necessary 

amounts to the BL accounts in summarized form. In order to do so, you have to customize which FM 

lines should be used and which accounts are to be used for posting. 
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Activities 

Access the IMG node under Fund Accounting called Transfer to Budgetary Ledger and proceed as 

follows: 

1. Read the overview information on transferring data to the Budgetary Ledger. 

2. Make settings in the following IMG activities: 

- Activate Transfer 

- Define Derivation Strategy for BL Accounts 

- Define Details for FI Update 

For further information, see the report documentation of Report RFFMTTTOBL. 

Example 

The example contains one document chain as follows: 

- a funds reservation for 100$ 

- a funds precommitment for 80$ 

- a funds commitment for 30$ 

The document amounts are posted to the budgetary ledger as follows: 

- The document of 100$ is posted from the budget account to the funds reservation account. 

- The document amount of 80$ is posted from the funds reservation account to the funds 

precommitment account. 

- The document amount of 30$ is posted from the funds precommitment account to the funds 

commitment account. 

The open amounts are now carried forward to the subsequent year with the following results: 

- the funds reservation with an open amount of 20$ 

- the funds precommitment with an open amount of 50$ 

- the funds commitment with an open amount of 30$ 

These amounts are represented by lines using the amount type 0350. Note that the consumed amounts 

(amount type 0351), which are created during the carryforward of chains, are not necessary here. 

This financial transaction must now be represented in the BL accounts for the current year. 

The derivation strategy needs to be customized in such a form that the results are parallel to the previous 

year: 

- The open amount of 20$ should be posted from the budget account to the funds reservation account. 

- The open amount of 50$ should be posted in the same way, and additionally from the funds 

reservation account to the funds precommitment account. 
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- Finally, the open amount of 30$ should be posted in the same way and additionally from the funds 

precommitment account to the funds commitment account. 

This means that a total of 100$ will be posted from the budget account to the reservation account. 

36.2.8 Closing Operations 

In the following steps, you make the system settings which are required for the closing operations at the 

end of a fiscal year in Funds Management and control these in different ways. 

You can carry out the following closing operations: 

- Commitment Carryforwards 

- Budget Carryforwards 

- Fund Balance Carryforward 

The carryforward of commitments to the new fiscal year is always dependent on the selected update 

profile. 

For instance, it is specified in the update profile, whether a carryforward is even possible at all and, if so, 

for which value types. 

In the following steps, you can enter settings which meet the special requirements of carrying forward 

budget and carrying forward commitments, such as for particular value types (purchase orders, funds 

commitments, invoices). 

For carrying forward budget, you can, for example, control that a part of non-consumed residual budget 

are carried forward to the new year or that residual budgets are carried forward to different Funds 

Management Account Assignments and this way the budget becomes available to different responsibility 

areas or functional areas in the new year. 

36.2.8.1 Enter Default Settings 

In this Customizing (IMG) activity, you define per FM area which closing operations can be carried out at 

the fiscal year change: 

- Carrying forward commitments 

Note 

- In the following IMG activities, you can enter detailed settings for carrying forward commitments  

for individual value types and fiscal years which override these default settings. 

- If you do not enter any other settings, the commitments  are carried forward 1:1 when you start the 

programs in the application menu, depending on the valid update profile used. The total amount 

from an FM Account Assignment is carried forward to the same FM account assignment in the new 

fiscal year. 

- If you do not enter any default settings or any detailed settings, nothing is carried forward to the new 

fiscal year when you start the program. 
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Activities 

Choose the closing operations which are to be carried out at the fiscal year change for each 

FM area. 

Further notes 

You can find more information on closing operations in the SAP Library under SAP Enterprise 

Central Component -> Accounting > Public Sector Management -> Funds Management -> 

Closing Operations. 

36.2.8.2 Commitment Closing Operations 

You can carry forward commitments which were posted in the current year but which will not be reduced 

until the following year, to the new fiscal year. 

In the following steps, you can enter system settings which also meet the different requirements for 

carrying forward particular value types (such as purchase orders, invoices). 

36.2.8.2.1 Create Number Range for Fiscal Year Change Document 

Use 

In this step, you create a number range interval for fiscal year change documents for each FM area. 

Fiscal year change documents are created for Funds Management documents that are carried forward to a 

new fiscal year using program Closing Operations: Carryforward of Open Items , or whose carryforward 

was reset again using program Closing Operations: Reset Carryforward of Open Items (RFFMCCFR). 

Enter the following for each number range interval: 

- Number range key 

- Number interval from which the document numbers are selected. 

- Type of number assignment (internal or external) 

The numbers are always assigned internally for fiscal year change documents. 

Activities 

Create a number range and save your entries. 

Further notes 
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You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 

36.2.8.2.2 Define Basic Settings for Commitment Carryforward 

Use 

In this IMG activity you can define the following basic settings for the commitment carryforward: 

- Permit Account Assignment Selection 

You can specify that the user can determine the target account assignment when they carry forward 

commitment online (Program RFFMCCF1). 

If you want to permit the account assignment selection, you must create a derivation step with step 

type "derivation rule" in your derivation strategy for the commitment carryforward which can be 

assigned to several receiver account assignments in the rule entries of the sender account 

assignment. When carrying forward commitment Online, the user can display a list of the assigned 

receiver account assignments and select an account assignment for each line item to be carried 

forward in column Account Assignment Selection. 

However, please note that an account assignment selection is not possible when carrying forward 

down payments  (Program RFFMCCF_DP). It is therefore necessary to ensure that only one 

receiver account assignment can be derived for value type 61 (down payments) in the derivation 

strategy when carrying forward commitment. 

- Activate Commitment Carryforward with Document Chains 

This way you can define whether the commitment carryforward should be executed after the 

standard procedure (program RFFMCCF1) or with document chains (program 

RFFMCCF1_CHAIN). 

For a commitment carryforward with document chains, the previous and subsequent document item 

are also carried forward with each commitment document item provided that the documents of the 

corresponding value type can be carried forward. 

- Activate Approval Procedure 

You can specify that the commitment carryforward should run a one-level or a two-level approval 

procedure. 

If you activate the one-level approval procedure, you can request the open items to be carried 

forward with program Closing Operations: Carry Forward Open Items. (RFFMCCF1) The selected 

documents are grouped together under a lot number and are locked for new selection. You then 

carry out the carryforward for each lot number using program Approve Open Items 

(RFFMCCF_APPROVE) which requires special authorization. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 373 

If you activate the two-level approval procedure, the open items are registered for the 

carryforward as with the one-level approval procedure using program RFFMCCF1. The 

actual carryforward takes place in two steps by executing the program 

RFFMCCF_APPROVE twice: 

- In the first step you approve the carryforward for the open items that can be carried forward. 

- In the second step, you define whether only commitment or commitment budget should also be 

carried forward. 

Requirements 

Prerequisite for the two-level approval procedure is that the budget control system (BCS) is active. For 

more information, see 'Activating BCS', under Activate Global Functions for Budget Control System 

(BCS)". 

Standard settings 

In the standard system, the commitment carryforward does not support an account assignment selection 

for the receiver FM account assignment. If your derivation strategy is not defined accordingly, the system 

issues an error message. 

In the standard system, the document items of a document chain are carried forward independently from 

each other. 

No approval procedure is used in the standard system. 

Example 

Examples of the commitment carryforward with document chains  can be found in the program 

documentation Program documentation (RFFMCCF1_CHAIN). 

Further notes 

For more information on defining the derivation strategy, see Define Derivation Strategy for 

Reassignment. 

36.2.8.2.3 Make Specific Settings for Standard Commitment Carryforward 

Use 

In this Customizing activity, you can define specific settings for commitment carryforward, if you have 

selected Standard and not With Document Chain for your FM areas in the basic settings for 

commitment carryforward. 

You can activate or deactivate the automatic zero-amount carryforward for FI documents and for 

commitment documents by choosing one of the following options: 

- Allow zero-amount carryforward 

This is the default system option. The system automatically carries forward commitments if the 

following prerequisites are met: 
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- The document item to be carried forward has no open amount. 

- The basic settings for commitment carryforward have been defined as Standard and not as 

With Document Chain for the FM area. 

- The FM update profile has been configured to use PBET posting logic for the processed FM 

value type. 

- The FM account assignment of the document item will not be changed by a reassignment rule. 

- Disable zero-amount carryforward 

The system does not automatically carry forward commitments even if the above conditions are met. 

If it is necessary to carry forward a document item manually, the system displays an error message. 

Requirements 

This Customizing activity is only relevant for standard commitment carryforward and not for 

commitment carryforward for FM areas for which the With Document Chain option is selected. 

Activities 

Define the settings for your FM areas and save the entries. 

36.2.8.2.4 Make Specific Settings for Commitment Carryforward with Document 

Chains 

Use 

In this Customizing activity, you can define specific settings for commitment carryforward if you have 

selected With Document Chain and not Standard for your Funds Management (FM) areas in the basic 

settings for commitment carryforward. 

You can activate or deactivate the generation of additional lines with amount types 0351 and 

0352 in the FM table FMIOI. The additional lines are used for reporting and budgetary ledger (BL) 

integration in specific customer scenarios. The default setting is to generate additional lines. If you 

change this setting, use report RFFMCCF_REBUILD_0351_0352 to delete unused lines or generate 

missing lines. 

Activities 

Define the settings for your FM areas, and save the entries. 
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36.2.8.2.5 Make Settings for Parallel Processing 

Use 

In this step, you can distribute the processing of the following programs for year-end closing operations to 

several dialog processes, in order to reduce the overall runtime of program: 

- Closing operations: Carryforward of open items (RFFMCCF1 ) 

- Closing operations: Reverse carryforward of open items (RFFMCCFR) 

- Closing operations: Carryforward general requests (RFFMCCF0) 

- Closing operations: Close open items (RFFMCCLS ) 

Activities 

Enter the number of processes  for an FM area as well as the RFC Server group. 

36.2.8.2.6 Enter Settings for Commitment Carryforward Payment Budget 

In this step, you specify per FM area, fiscal year and value type (such as purchase orders or invoices), 

whether carrying forward commitments for the payment budget to the new fiscal year is basically allowed 

or not. 

The settings made here override any default settings which already exist. 

Note 

If carrying forward particular value types is not allowed according to the update profile, an entry which 

allows the carry forward for this value type is not possible. 

Example 

You have defined in the default settings that commitments carried forward are basically allowed. The 

update profile permits the carry forward for all value types. 

You can prohibit the carrying forward of particular value types (such as purchase orders) to the new year 

by not setting the Carryforward allowed flag for the corresponding value types (such as "51"). 

Activities 

Make the required settings. 
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36.2.8.2.7 Enter Settings for Commitment Carryforward Commitment Budget 

In this step, you define per FM area, fiscal year and value type (such as funds reservations or funds 

commitments), whether carrying forward commitments for the commitment budget to the new fiscal year 

is basically allowed or not. 

The settings made here override any default settings which already exist. 

Note 

If carrying forward particular value types is not allowed according to the update profile, an entry which 

allows the carryforward for this value type is not possible. 

Example 

You have defined in the default settings that commitments carried forward are basically allowed. 

The update profile permits the carry forward for all value types. 

You can prohibit the carrying forward of particular value types (such as funds reservations) to the new 

year by not setting the "Carry forward allowed" flag for the corresponding value types (such as "65"). 

Activities Make the 

required settings. 

36.2.8.2.8 Business Add-Ins (BAdIs) 36.2.8.2.8.1 BAdI: Individual Carryforward 

Rules for Commtmt Carryforward 

Use 

With this Business Add-In (BADI) you can include document-dependent carryforward rules  with closing 

operations in Funds Management when carrying forward the budget with program Closing Operations: 

Carry Forward Open Items RFFMCCF1. You can also set the customer dimension for FM actual data 

and commitment data (field USERDIM). The user can use field Customer-Specific Field (USERDIM) 

(user dimension) as they wish, it is not supported by SAP. It is a key field in the update tables in Funds 

Management. 

In the standard delivery, on the one hand you can restrict the quantity of document items that can be 

carried forward depending on their value type by deactivating the commitment carryforward for the value 

types to be excluded in Customizing. Moreover, you can also exclude individual FM account assignments 

from the commitment carryforward by outsorting the corresponding carryforward rules with 0%. 

On the other hand, in the standard delivery the carryforward parameters that were assigned to the 

respective value type in Customizing take effect for all documents of a value type with the 

commitment carryforward. 

Through document-dependent carryforward rules you can do the following: 

1. Restrict the quantity of the document items that can be carried forward (filter). Program 

RFFMCCF1 then selects only those document items for the carryforward that correspond to these 

document-dependent rules. 
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2. Assign document-dependent carryforward parameters . 

Depending on the respective carryforward parameter, the carryforward rules take effect when the 

respective receiver FM account assignment is assigned. 

Requirements 

You have created carryforward rules in the Customizing of Funds Management Government under 

Assign Strategy for Reassignment to FM Area for your FM area and have defined carryforward rules for 

all FM account assignments that have been posted to. 

Standard settings 

In the standard, the Business-Add-In is not active. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

Documentation on BADI method FILTER_OPEN_ITEMS 
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Documentation on BADI method CFRULE_OVERRULE 

Documentation on BADI method USERDIM_CHANGE 

36.2.8.2.8.2 BAdI: Setting the Statistics Indicator for Commitment Carryforward 

Use 

In the standard, you can define that postings in other components that should not consume budget should 

only be updated statistically in Funds Management; for example you can override the definitions in your 

update profile for each value type for which Value types relevant to the budget or are only updated 

statistically or flag commitment items in the master record as statistical. 

With this Business Add-In (BADI) you can set the statistical indicator for data records generated with the 

commitment carryforward separately for the data record in the sender year (amount type Carryforward 

previous year (commitment) and the data record in the receiver year (amount type Carryforward 

following year (commitment). 

Note the following restrictions: 

In commitment documents (except for invoices) you can set the statistical indicator for the sender year 

only as a consistent update of the statistical indicator is not possible for commitment documents at the 

moment (except for invoices) if it is assigned through the commitment carryforward in the receiver year. 

For invoices, you are only allowed to set the statistical indicator for the receiver year if the statistical 

indicator has also been set in the sender year. If an implementation of BAdI 

'FM_CCF_SET_STATISTIC' provides the statistical indicator for only the receiver year, the system 

automatically assigns it for the sender year also. 

Requirements 

In the Customizing of Funds Management Government 

- a valid update profile is assigned to the FM area 

- the commitment carryforward in Funds Management is active 

- the commitment carryforward is allowed for the FM area 

Standard settings 

In the standard, the Business-Add-In is active provided that you use update profile 000400 (CB with 

target fiscal years e.g. German local authorities)  Default coding is carried out automatically and has the 

following effect: 

- The commitment carryforward of invoices that are only updated in the payment budget always 

occurs statistically. The budget assigned once remains tied to the sender year, the generated record is 

not relevant to the budget in the receiver year. 
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- The commitment carryforward with change from the commitment budget to payment budget is only 

statistical on the sender side. This means the assigned budget in the commitment budget remains tied 

. In the payment budget, the budget is assigned again. 

The Business Add-In is filter-dependent. Create the implementation for your update profile. 

Activities 

Create an implementation of the Business Add-In for your update profile, provided that update profile 

000400 is not assigned to your FM area. Do the following for this: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes Documentation on BADI method STATISTIC_FLAG_SET 

36.2.8.2.8.3 BAdI: Filter for Closing Open Items for Fiscal Year Change 

Use 
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With this Business Add-In you can include your own rules with the closing operations in Funds 

Management when closing open commitment, through which the quantity of document items that can be 

closed automatically is restricted even further. The program Closing Operations: Closing Open Items 

(RFFMCCLS) then only offers the document items to be closed that correspond to these rules. 

Requirements 

In the Customizing of Funds Management Government a valid update profile was assigned to the FM 

area and the commitment update in Funds Management is active. 

Standard settings 

In the standard, the Business Add-In is active, provided that you use update profile 000600 (budgetary 

ledger e.g. US Government). The default coding is carried out automatically and has the following effect: 

When you execute program RFFMCCLS, the rules consulted for closing commitment are those that you 

defined in the Customizing of Funds Management Government, in step "Define Rules for Closing 

Commitment ". If a rule is defined for the fund type and the status of the fund, to which the document 

item is assigned, the affected document item can be closed by using program RFFMCCLS. 

The Business Add-In is filter-dependent. Create the implementation for your update profile. 

Activities 

Create an implementation of the Business Add-In for your update profile provided that update profile 

000600 is not assigned to your FM area. You do this as follows: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 
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Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

Documentation of BADI method CHECK_CLOSEOUT_RULES 

36.2.8.2.8.4 BAdI: Control of Reassignment 

Use 

You use this Business Add-In (BAdI) to control the program run Reassign Open 

Commitment (RFFMCCOVR) with closing operations in Funds management for the multi-year 

budget. This involves you defining which value types can be excluded from the reassignment. 

Requirements 

You have activated the Multi-Year Budget . 

Standard settings 

The BAdI is not active in the standard system. No implementation of this BAdIs is delivered either. 

In the standard system, the following value types are allowed for the reassignment: 

50 Purchase requisitions 

51 Purchase orders 

 60 Parked documents 

 65 Funds commitment 

81 Funds reservation 

82 Funds precommitment 

83 Forecast of revenues 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 
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1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

Documentation on BAdI Method DEFINE_VALUE_TYPES 

36.2.8.2.8.5 BAdI: User Manipulations in Document Chain Carryforward 

Use 

You can use this Business Add-In (BAdI) to alter how document chains are carried forward in Funds 

Management. 

The BAdI uses interface IF_EX_FMCCF_CHAIN_GEN and supports the following methods: 

- END_OF_CHAIN 

Enables document chains to be interrupted at any document. The system carries forward the 

document chain up until that particular document. Once you have carried forward a document 

chain incompletely in this way, you need to do the same for any subsequent changes in fiscal year. 

Otherwise, the system issues an error message that you cannot override. 

- I_VREF*... 

These fields form the unique reference to the predecessor document of the current document. 
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- I_RLDNR 

The ledger currently being edited. 

- I_GJAHR 

The current fiscal year. 

- E_END_OF_CHAIN = 'X' 

The end of the chain has been reached. 

- CROSS_LEDGER_CHAIN 

Enables document chains to be selected across all ledgers. 

- R_ALLOW_CROSS_LEDGER = 'X' 

Activates the function enabling document chains to be selected across all ledgers. 

Requirements 

You use document chain carryforward for the change in fiscal year in Funds Management. 

Example 

You can use this BAdI to divide up document chains, for example. The point where you make the 

division forms the new root level of the new document chain. 

36.2.8.3 Closing Operations for Budget Control System (BCS) 

36.2.8.3.1 Prepare Budget Carryforward for Commitment for BCS 

The settings of this section are only significant if you use the Budget Control System (BCS) as the 

operative budgeting tool in Funds Management. 

In accordance with your settings for the commitment carryforward and the carryforward parameters used, 

a corresponding budget change in the previous or next year can be connected automatically to the 

carryforward of open items. If such a budget carryforward takes place, a corresponding budget entry 

document is generated. 

Details on generating a budget entry document: 

- Deriving the budget address 

The Budget addresses  of the budget entry document are derived from the Posting addresses of the 

commitment document carried forward from the old fiscal year or to the following year, according 

to the Derivation strategy of the budget structure used. 

- Activity in budget entry document 

Selection of the activity of a budget entry document depends on which settings you have set for the 

commitment carryforward. Important here are the settings of the statistics indicator that you have 

defined in the IMG activity BAdI: Set the Statistics Indicator for the Commitment Carryforward. 

a) No Statistics indicator is set: 
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The budget change takes effect in the previous year and the following year. An entry document 

is generated with the activity Carry Forward which includes a sender line (Carry Forward - 

Sender) and receiver line Carry Forward Receiver). 

b) Statistics indicator is set for the following year: 

The budget change only affects the previous year. An entry document is generated for the 

previous year with the Return activity. 

c) Statistics indicator is set for the previous year: 

The budget change only affects the following year - the budget of the previous year remains 

the same. An entry document for the following year is generated with the Entry activity. 

Whereas you execute the settings mentioned above in other Customizing sections of Funds Management, 

in this section you can define further settings for the budget carryforward in BCS, such as the following: 

- In IMG activity Activate Budget Carryforward for Commitment, you can choose for which value 

types (for each fiscal year and budget category) the budget carryforward should be activated or 

deactivated. 

- In IMG activity Define Budget Entry Documents for Commitment Carryforward , you define the 

standard settings for the entry documents to be generated for each FM area/fiscal year. These are the 

settings for document types, budget type, and posting periods. 

- You can override the standard settings for budget entry documents by using the Business Add-In 

Enhance Budget Documents for Commitment Carryforward to suit your own requirements. 

36.2.8.3.2 Activate Budget Carryforward for Commitment 

Use 

In this IMG activity, you define for which value type and budget category the carryforward of budget for 

commitment should be activated or deactivated for each FM area/fiscal year. You can define the settings 

for individual value types or for all value types that are used in the field value type. 

Note: 

If you do not make an entry for a value type per FM area/fiscal year and budget category, this value type 

is not supported for the budget carryforward for commitment and is therefore deactivated. 

The commitment and the corresponding budget is carried forward automatically in accordance with the 

settings defined. 

Requirements 

In this activity, value types are only included if: 

- They have a transfer in the update profile used. 

- The carryforward of budget for commitment is set in addition to the carryforward of commitment in 

the IMG activity  Enter Default Settings 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 385 

- A commitment carryforward is allowed in the IMG activity Enter Settings for Commitment 

Carryforward Payment Budget. 

- A commitment carryforward is allowed in the IMG activity Enter Settings for Commitment 

Carryforward Commitment Budget. 

Activities 

1. You maintain the IMG activity by entering the corresponding value type and budget category for 

your FM area and fiscal year. 

2. If you want to forbid the carryforward of commitment budget for an FM area/fiscal year, 

set the indicator for the automatic budget posting (ABB) to Not active. 

3. Save your entries. 

36.2.8.3.3 Define Budget Entry Documents for Commitment Carryforward 

Use 

By default, the budget carryforward for commitment is logged in a budget entry document with both a 

sender and receiver line. For the sender line of the transaction, Carryover - Sender (COSD) is chosen, 

and for the receiver line of the transaction, Carryover - Receiver (CORV) is chosen. If you have set the 

statistic indicator for the previous year or next year, an entry document is generated with either the 

Return indicator or Entry. 

For more information on the transactions used in accordance with the statistics indicator, see Prepare 

Budget Carryforward for Commitment BCS. 

In this IMG activity, you define the standard settings for the budget entry documents to be created for 

each FM area/fiscal year. You can define the following settings in for the document header and for the 

sender and receiver line: 

- In the document header, you can define which Document type the entry documents should have. 

Likewise, you can define a document header text. 

- In the settings for sender and receiver line, you make your selection of the respective Budget type. 

For both the sender and receiver line, you can define a document line text. 

- For the receiver document line, you can define a particular posting period or a Distribution key. 

The settings for Document type or budget types can be used to display the budget documents generated in 

Reporting or define special Budget consistency checks for the budget carryover of commitment. 

To undo open carryforward items (FMJ3), you assign a reversal reason to the document type. 

Requirements 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 386 

- You have created the entry document type or budget type in the Customizing of Funds Management 

under BCS budgeting. 

- You have assigned the transactions budget types to be used to the transactions Carryover Sender 

(COSN) and Carryover - Receiver (CORV) in the IMG activity Assign Budget Types to 

Transactions. 

Standard settings No default 

settings are delivered. 

36.2.8.3.4 Set Up Automatic Budget Postings After Fiscal Year Change 

Use 

In this IMG activity, you define the settings for budget recovery after the fiscal year change. 

Document changes to carried forward commitment documents (such as setting the completed indicator or 

reducing the amount) could cause commitment budget to be released in the new year and be consumed by 

new commitments if these settings are not defined. 

These settings ensure that the commitment budget carried forward is automatically posted when 

document changes relevant to budget consumption occur. The system then automatically generates 

budget documents in the background. 

Requirements 

- You are using the Budget Control Syste (BCS) as the operating budget tool. 

- The Budget Carryforward for Commitment is active. 

- The carryforward level is used for commitment documents and invoices. 

The required Customizing settings should be defined in the implementation guide (IMG) of Funds 

Management, under Actual and Commitment Update/Integration -> General Settings -> Make 

Other Settings. 

Standard settings 

The budget carried forward is released with corresponding document changes in the standard system and 

can also be consumed by documents from the new fiscal year. 

Activities 

Define the following settings: 

- Activate the automatic budget postings (ABP) for budget recovery for your FM area and the new 

fiscal year. 

- Define the document header attributes for the budget documents to be generated. 
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- Create a derivation strategy for the derivation of document line attributes of budget documents, 

maintain the derivation steps and assign the derivation strategy to the FM area and fiscal year. 

To create a suitable derivation strategy, you must fill the target fields of the derivation strategy in 

accordance with the source fields: 

- Determine whether the respective transaction (target field BUDGET_RELEVANT) is relevant for 

the generation of automatic budget documents. 

- Define whether a sender line (target field SENDER_DATA) should be generated, in other words, 

whether the budget document has the structure of a transfer posting. 

- Define the budget type for receiver and, if necessary, sender lines (target fields RBUDTYPE and 

SBUDTYPE) and fill the target fields for the budget account assignments. 

To be able to define a derivation strategy, you can choose the relevant source fields from the input help. 

You can use the following step types to fill the target fields: 

- Derivation rules 

- Table Access 

- Assignment 

- Clear 

- Function modules 

If you only want to repost part of the budget made available from the transaction, you must fill target field 

Percentage. If you want to generate more than one or pair of sender and receiver document lines, you 

must differentiate the relevant document line attrributes using the source fields NUMBER. 

36.2.8.3.5 Business Add-Ins for Closing Operations for Budget Control System 

(BCS) 

36.2.8.3.5.1 BAdI: Enhance Budget Entry Documents for Commitment 

Carryforward 

Title 

Business Add-In: Enhance Budget Carryforward for Commitment 

Use 
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Using this Business Add-In, you can enhance the budget entry documents of the budget carried forward 

automatically generated during the commitment carryforward. You use the BAdI method 

CHANGE_DOC for this. 

You can make the following enhancements in the entry documents: 

- Fill fields in document header 

- Fill fields in sender document line 

- Fill field in receiver document line 

- Change carryforward budget amount in FM area currency 

- Change carryforward budget amount in transaction currency 

Standard settings 

SAP does not deliver any implementations of this BAdI. This BAdI is therefore not active in the standard 

system. 

Activities 

Carry out the following steps to implement the BAdI: 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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Further notes 

Documentation on BAdI Method CHANGE_DOCUMENT 

36.2.8.3.5.2 BAdI: Document Budget Carryforward for Approval Procedure 

Use 

This Business Add-In (BAdI) is used in Funds Management in the component Closing Operations 

(PSM-FM-CL). 

You can use this BAdI to document the carryforward of budget to commitment in the commitment line 

items with active two-level approval procedure. 

For items that were approved in the second step, the field  Carryforward Level (FMIOI-CFLEV or 

FMIFIIT-CFLEV) is flagged with the value U. 

Requirements 

The two-level approval procedure is active in the basic settings for the commitment carryforward. 

For more information, see Define Basic Settings for Commitment Carryforward. 

The BAdI FM_UPDATE_CFLEV (numerical values for the carryforward level) should not be active. 

Standard settings 

The Business Add-In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 
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Note: You can also create an implementation for an Add-In and not activate it until later. 

If you want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

See also: 

Methods 

MARK_BUDGET_APPROVAL 

36.2.8.4 Closing Operations for Fund Balance Carryforward 

In the following, you enter the system settings which are required for carrying out a fund balance carried 

forward. The fund balance carried forward gives you a period-related overview of the fund balances. 

36.2.8.4.1 Define Carryforward Item Category 

If you work with funds and have allotted budget across fiscal years, the fund balance carried forward 

allows a period-specific overview of the fund balances in Funds Management. 

In this IMG activity, you specify the carryforward commitment item category for the balance carried 

forward and subsequently assign this to the carryforward commitment items. 

- If you have defined these settings for the balance carryforward (under Prerequisites), the balances 

of all commitment items which have the same carryforward item category are cumulated and carried 

forward to the carryforward commitment item assigned to the carryforward commitment item 

category in the new year. 

- If you do not define these settings, the balances are not carried forward (error message 

"no carry forward item category is entered in the commitment item ..") unless multi-year budget 

execution is activated in the FM area. If this is the case, the balances are carried forward to the new 

year without a change of account assignment. 

The carryforward commitment item category is used to cumulate the balances of the actual values of 

previous year's commitment items to one or several carryforward commitment items in the following 

year. You can define several carryforward commitment item categories, which gives you a summary of 

commitment items according to certain logical aspects. 

Dependencies 

If multi-year budget execution is activated in IMG activity Activate Multi-Year Budget Execution, the 

fund balance carryforward is used to enable a fiscal year overview of open items in addition to the 

balance overview. In multi-year budget execution in the standard system, the carryforward is executed 
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without summarization using commitment items. Therefore, you do not have to make any settings in this 

IMG activity. 

If you want to summarize with active multi-year budget execution (for instance, for the value types under 

which actuals are updated in Funds Management) and want to use the settings defined in this IMG 

activity, you have to assign the strategy environment FBCF to your FM area and fiscal year under the 

activity Balance Carryforward Funds. You do this in IMG activity Assign Strategy for Reassignment 

to FM Area. 

Requirements 

The carryforward commitment item assigned to a commitment item category must be created within 

master data maintenance in the FM area and fiscal year. 

Activities 

1. Enter the carryforward commitment item categories for each FM area. 

2. Choose Carryforward Item Category - Commitment Items and assign the carryforward 

commitment items to the carryforward item category for a respective fiscal year (fiscal year to 

which the balances are to be carried forward). The entry is valid until new requirements result in a 

new entry. 

3. Then define the defined carryforward item categories in the master record of the commitment items 

that can be posted directly. 

Further notes 

Only those funds with the indicator Balance Update set in their master record will be carried forward 

in the balance carryforward. 

36.2.8.4.2 Define Activities for Balance Carryforward 

In this step, you create customer-defined transactions for the balance carryforward for an FM area. 

You must only define customer-defined transactions if you want to use additional transactions with a 

special program logic in addition to the balance carryforward transaction delivered by SAP. 

You determine a special program logic in enhancement SAPFMVTR. 

Activities 

1. Specify your customer-defined transaction for an FM area. 

The name of the transaction must always begin with "VT". 

2. Save your entry. 

Further notes 

For more information, see the program documentation for SAPFMVTR. 
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36.2.9 Information System 

In the following steps, you maintain the parameters for the Funds Management information system. 

36.2.9.1 Define +/- Signs for Information System 

In this step you define the +/- sign with which revenue and expenditure items are displayed in the 

information system. 

Standard settings 

Expenditures are displayed as positive and revenues are displayed as negative in the reports. 

Activities 

If you want to display expenditures as negative and revenues as positive, you must select the field in the 

table in the "Define +/- signs for information system" step. 

Further notes 

The setting applies to all clients. You therefore only have to select ONE field. 

36.2.9.2 Deactivate/Activate Delta Update for Business Information Warehouse 

Use 

In this step, you can deactivate the delta update for Business Information Warehouse (BW) for the 

following DataSources. 

0PU_IS_PS_11 Budget in Funds Management (transaction data) 

0PU_IS_PS_31 Commitment line items in Funds Management (transaction data) 

0PU_IS_PS_32 FI line items in Funds Management (transaction data) 

0PU_IS_PS_33 CO line items in Funds Management (transaction data) 

0PU_IS_PS_41 Budget totals records for Budget Control System (BCS) 

0PU_IS_PS_42 Budget line items for BCS 

0PU_IS_PS_43 Budget entry documents for BCS 

0PU_IS_PS_44 Assigned funds BCS (totals records) 

0PU_IS_PS_45 Revenues Increasing the Budget BCS (totals records) 

You can activate the delta update again at any time. Please note that if you do this, you must initialize the 

delta process again in the BW system. 
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36.2.9.3 Maintain BW Extraction of FM Account Assignments 

Use 

In this IMG activity, you can activate the field FMAA (FM account assignment) for BW extraction. The 

field FMAA is included in the extraction structures of the following DataSources: 

- 0PU_IS_PS_31 - 0PU_IS_PS_32 - 0PU_IS_PS_33 - 0PU_IS_PS_41 - 0PU_IS_PS_42 -

 0PU_IS_PS_43 - 0PU_IS_PS_44 - 0PU_IS_PS_45 

After activation, the field FMAA is filled during Full and Delta Upload. 

You can also make settings for the display of the hierarchy catalog for DataSource 

0PU_FMAA_HIER. 

You can specify whether the hierarchy catalog should: 

- Display only the assignments of posting addresses to budget addresses 

- Display the assignments of budget addresses to availability control objects 

- Display the assignments of posting addresses to budget addresses and to availability control objects 

- Display the hierarchy of budget addresses of a multi-level budget structure 

- Display the assignments of posting addresses to budget addresses of a multi-level budget structure 

- Display the assignments of revenue budget addresses to RIB objects (aggregation objects for 

Revenues Increasing the Budget) 

- Display the assignments of revenue posting addresses to revenue budget addresses and to RIB 

objects 

Standard settings 

The field FMAA is not active by default. 

36.2.9.4 Drilldown Reports 

The steps which follow tell you how to create drilldown reports for analyzing the actual data in Funds 

Management. 

36.2.9.4.1 Form 
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The steps which follow tell you how to: 

- Create, change, and display forms 

- Transport forms 

- Import forms from client 000 

- Reorganize forms 

36.2.9.4.1.1 Create Form 

In this step, you can define the forms which you want to use for your drilldown reports in Funds 

Management. You can assign a form to several reports. 

Forms describe the basic content and structure of lists. Think of them as half-finished reports, which you 

complete when you define the report itself. 

Requirements 

If you want to include variables in your form, you must define these first. For more information, go to the 

Funds Management implementation guide and read the chapter "Maintain global variables". The standard 

R/3 System contains various variables. 

Standard settings 

The standard system contains forms which you can use as a model when creating your own forms. 

The name range provided by SAP for the technical name of the forms supplied is 0FMFXXXX. You must 

not use this range for your own forms. 

Activities 

Create your own forms. You can copy the forms contained in the standard system and use them as a 

model. 

Further notes 

For detailed information and examples on how to create forms, refer to the general drilldown reporting 

manual or the "Information System" section in the "Funds Management" and "Funds Management 

Government" document. 

You can generate a transport request for further transport of the forms you defined to a target system. For 

more information, read the step "Transport Form". 

36.2.9.4.1.2 Change Form 

In this step, you can change the forms you want to use in your Funds Management drilldown reports. 
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Forms describe the basic content and structure of lists. Think of them as half-finished reports, which you 

complete when you define the report itself. 

Requirements 

If you want to include variables in your form, you must define these first. For more information, go to the 

Funds Management implementation guide and read the chapter "Maintain global variables". The standard 

R/3 System contains various variables. 

Standard settings 

Do not change the forms supplied in the standard system. 

Activities 

Change the existing forms. You can copy the forms delivered with the system and change them to meet 

your requirements. 

Further notes 

- For detailed information on editing forms, refer to the general drilldown reporting manual or the 

"Information System" section in the "Funds Management" and "Funds Management Government" 

documents. 

- You can generate a transport request to transport the forms you have defined to a target system. For 

more information, read the step "Transport report". 

- When changing a form, you must ensure that it could be used in various reports. The change you 

enter is then made in all reports. 

36.2.9.4.1.3 Display Form 

In this step, you can display the setup for the forms which you want to use for the drilldown reports in 

Funds Management. 

Standard settings 

The standard system contains forms. 

Activities 

Display the forms. 

36.2.9.4.1.4 Transport Form 

In this step, you transport forms from one SAP System to another. 
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For more information on transporting reports and forms, go to the Funds Management implementation 

guide and read the chapter "Transport report". 

36.2.9.4.1.5 Reorganize Form 

In this step, you can use the selection screen to specify a number of forms, and delete them later from an 

overview list. 

The form type is available as an additional selection criterion. 

Note 

Only the forms which are no longer in use in reports are reorganized here.  The system checks this 

automatically during the deletion process, by means of a where-used list.  The corresponding reports can 

be accessed and checked directly. 

Activities 

Reorganize your forms. 

36.2.9.4.1.6 Import Form from Client 000 

In this step, you import forms from the source client (such as client 000) to the client where you want to 

work. 

See also step Import reports from client 000. 

Activities 

- The first selection criterion you should enter is the report type. That is, you should specify whether 

you want to transport the forms for Funds Management or Cash Budget Management. 

- Import the forms from the source client. 

36.2.9.4.2 Report 

The steps which follow tell you how to: 

- create, change, and display reports 

- transport reports from one SAP System to another 

- import reports from client 000 to the client you are working in 

- reorganize or delete reports 

- reorganize or delete report data 
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36.2.9.4.2.1 Create Report 

In this step, you can define your own reports for evaluating the data in Funds Management. 

Requirements 

You must first have defined forms for your reports. Forms describe the form and content of a list. You 

can regard a form as a half-finished report which you then complete in report definition. For more 

information on creating forms, go to the Funds Management implementation guide and read "Create 

form". 

Standard settings 

The standard system contains reports which you can use as a model when creating your own reports. 

The name range provided by SAP for the technical name of the reports supplied is 0FMBXXXX. You 

must not use this range for your own reports. 

Activities 

Create your own reports. You can copy the reports contained in the standard system and use them as a 

model. 

Further notes 

For detailed information and examples on how to create reports, refer to the general drilldown reporting 

manual or the "Information System" section in the "Funds Management" and "Funds Management 

Government" documents. 

You can generate a transport request for further transport of the reports you defined to a target system. 

For more information, read the step "Transport report". 

36.2.9.4.2.2 Change Report 

In this step, you can change the predefined drilldown reports to evaluate the data in Funds Management 

as you wish. 

Standard settings 

Do not change the standard reports delivered with the system. 

Activities 

Change the existing reports. 

You can copy the reports delivered with the system and change them to meet your requirements. 

Further notes 
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For detailed information on editing reports, refer to the general drilldown reporting manual or the 

"Information System" section in the "Funds Management" and "Funds Management Government" 

documents. 

You can generate a transport request to transport the reports you have defined to a target system. For 

more information, read the step "Transport report". 

36.2.9.4.2.3 Display Report 

In this step, you can display the setup of the drilldown reports available to you for evaluating the data in 

Funds Management. 

Standard settings 

The standard system contains reports. 

Activities 

Display the reports. 

36.2.9.4.2.4 Transport Report 

In this step, you put together a transport request, designed to transport the reports you have defined to a 

target system. 

Requirements 

The target and source systems must have the same put level. 

Recommendation 

The transport request is based on the current settings.  For this reason, you should not create any new 

drilldown objects (reports, forms, key figures) while the transaction is running, nor should you enter any 

more settings.  In the SAP transport system, a considerable time may elapse between the transport 

request's being put together (defining what is to be transported) and the actual export (when the data is 

extracted).  If you enter further settings in the drilldown between these two points in time, the system 

does partly include the changed objects, but no new objects are included in the transport request.  For 

this reason, we recommend that you do not enter any new settings during this period. 

If you change any forms, you must regenerate the reports to which you have assigned the forms in the 

source system, then transport them again to the target system. 

As it is not possible to test the transport request automatically when you must it together - that is, to 

determine which of the drilldown objects to be transport may already exist in the target system - 

drilldown objects created in the target system may be overwritten when you import from the source 

system.  To avoid situations where important data is unintentionally overwritten, we recommend that you 

set up one source system only, from which data can be sent to one or more target systems. 

Activities 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 399 

- Stipulate the report type (Funds Management or Cash Budget Management). 

Note that reports with report type Hierarchy of FM account assignments or Hierarchies of FM 

account assignment elements. must be imported separately. 

- Specify a transport request. 

- Choose whether you want to run the request in background processing. 

- Select the objects you want to tranport. 

- Choose the dependent object classes. 

- Use the transport system to carry out the transport request. 

Further notes 

For technical reasons, reports whose names contain special characters cannot be transported.  To get 

around this problem, you must create a new report with no special characters in the name, using the old 

report as reference. 

36.2.9.4.2.5 Reorganize Report 

In this step, you can use the selection screen to specify a number of defined reports and delete them later 

from an overview list. 

Example: 

Before the production startup, you can delete all the test reports by an author. 

Activities 

Reorganize your reports. 

36.2.9.4.2.6 Import Report from Client 000 

In this step you import reports from the source client (usually client 000) to the client where you want to 

work. 

To be able to use the standard structure reports in the present client, you must import them from the 

source client. 

Activities 

1. Import the reports from the source client. 

2. Select the reports you require. 

3. Choose "Transport" to import the reports online or choose "Background transport" to import them in 

background processing. 
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36.2.9.4.2.7 Reorganize Report Data 

In this step, you can use the selection screen to specify a quantity of stored report data and delete it later 

from an overview list. 

As selection-specific characteristic values you can currently choose fiscal year, period and period/year, 

that is you have the option of deleting obsolete data. This way you can prevent your memory table from 

overflowing. 

Example 

You have created and saved report data from a report which compares the commitment and actual data 

with your annual budget for the years 1993, 1994 and 1995 for FM areas F1, F2 and F3. You can now, 

for example, delete the report data for FM areas F1, F2 and F3 for the year 1993 by specifying the report 

name. 

Activities 

Reorganize your report data. 

36.2.9.4.3 Maintain Global Variables 

In this step, you define variables for drilldown reporting in Funds Management. 

Variables are used to add flexibility to the forms, which represent row and column structures, as well as 

reports. They are parameters which you specify when defining or running a report. The fields you need to 

fill at that stage appear in a dialog box. 

Standard setup 

Global variables for the following characteristic values are delivered in the standard system: 

- FM area 

- Fiscal year 

- Period 

- Fund 

- Funds center 

- Commitment item 

- Budget version 

Activities 

You define new variables by entering variable types and names. With the variable type, you are 

specifying how you want to use the variable in future: 

1. As a variable for a characteristic value 
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2. As a variable for a text, or 

3. As a variable for a formula. 

When you press Enter, the system inserts the fields which need to be filled. 

Further notes 

For more information, read the general drilldown reporting manual. 

36.2.9.4.4 Translate 

In this step, you can translate the forms and reports you have defined in one language into another 

language. 

Activities 

Enter the following on the initial screen: 

1. Original language 

2. Target language 

3. Translation object 

4. Search limits. 

Choose "Execute" to trigger a search for all the texts which need to be translated. Depending on the 

search limits you specify, the system searches either for the texts from the selected report only, or for the 

report texts and those from all the forms assigned to this report. 

The search process may take some time, as the system may have to search for texts in all the reports. 

On the next screen, the system displays a list of the object types found. They are flagged as follows: 

1. Untranslated      - none of the objects in this class is translated 

2. Partly translated - some of the objects in this class are translated 

3. Translated        - all objects in this class are translated The translated object types are also 

highlighted. 

On this screen, you select the object classes you want to process further. Use the Object list to branch to 

the display showing the individual objects. 

The object list shows all the objects from the object class you selected. The display has four columns, 

showing: 

1. Object class for the object 

2. Object name 

3. Source text (20 characters) 
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4. Translation (20 characters) 

The "Translation" field for untranslated objects is empty. Translated objects are highlighted. 

Now select the objects you want to process. If you select translated objects for processing, you can 

change the translation. 

Choose the type of processing. Two types are available: 

1. Translation: With this, you can translate the relevant texts in a short text editor. 

2. Fast translation: The system tries to find the text requiring translation in the SAP proposal database. 

If no translation is found there, the source text is copied into the target language. Fast translation 

only functions for objects which have not yet been translated. 

Further notes 

Only the reports and forms you defined are offered for translation. If texts normally translated by SAP are 

missing from the target language, you can only translate these by incorporating the relevant language into 

the system or by using the SAP translation tool. To do the latter, choose Tools -> ABAP/4 Workbench -

> Utilities -> Translation -> Short/long texts. 

36.2.9.5 Business Add-Ins (BAdIs) 

36.2.9.5.1 BAdI: Change List Header of Lists of SAP List Viewer (ALV) Grid 

Control 

Use 

With this Business Add-In, you can modify the screen of the header information in the list that is issued 

from reports and programs of Funds Management with the SAP List Viewer (ALV) Grid Control as 

follows: 

- Add logo in the list header 

- Change background screen (Wallpaper) 

Requirements 

Screen objects for the logo and back ground screen must be stored in the Business Document Service 

(BDS). 

Standard settings 

The Business Add-In not active in the standard. 

Activities 
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After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Notes 

Documentation of the BAdI method CHANGE_BACKGROUND 

Documentation of the BAdI method ADD_TEXT_AND_PICTURE 

36.2.9.5.2 BAdI: Enhance Document Journal 

Use 

Using this Business Add-In (BAdI), you can enhance the document journal with the following 

functions: 

- Import additional data and display in the ALV list 

- Delete lines of the ALV list 

- Carry out additional authorization checks 
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- Issue messages 

Requirements 

If you want to display additional fields in the ALV list, you have to enter it in the customer include in the 

structure IFMREPGAX first. 

Standard settings 

The BAdI is not active in the standard system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Also see: 

- Method: Check or change line item fields before list output 

- Method: Check or change expanded line item table 
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- The inactive implementation FM_EF_HIST_REP_SPAIN contains special functions for Public 

Sector Spain. 

36.2.9.5.3 BAdI: Activate Authorizations on FI Accounts 

Use 

Using this Business Add-In (BAdI), you can enhance the authorization check for the reports document 

journal and request journal with the following authorization objects: 

- F_BKPF_BES   Accounting document: account authorization for subledger accounts 

- F_BKPF_BED   Accounting document: account authorization for customers 

- F_BKPF_BEK   Accounting document: account authorization for vendors 

Standard settings 

The checks are delivered using the implementation FMRP_ACCOUNT_AUTH. The activity '03' 

(Display) is used for calling them from the reports. 

The BAdI is not active in the standard system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 
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5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Also see: 

Method: FI-Check Account Authorization 

36.2.9.6 Maintain Information for Headers and Footer for KSA Reports/Forms 

36.2.10 Workflow 

The SAP Business Workflow incorporates technologies and tools for the automated control and 

processing of cross-application process flows. 

Funds Management uses the workflow with clearly defined Standard tasks 

- in the Earmarked funds and funds transfers 

- in the requests 

- in the budget parking 

Note: If you belong to the customer circle of the German local authorities, you cannot implement 

the workflow for the budget parking. 

You carry out the required settings for the workflow in the Customizing workflow and in the following 

steps. In the Customizing workflow, you have to carry out the following steps: 

1. Maintain your enterprise-specific organizational plan. 

2. Link the standard tasks delivered to the permitted processors. 

3. If desired, activate existing event-user-couplings between triggering events and and work flow tasks 

which use budget. 

4. Name a technical person responsible for every workflow sample delivered. 

36.2.10.1 Workflow Variant 
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In the following steps, you define workflow variants for requests and assign these to the company codes 

and document types. 

36.2.10.1.1 Create Workflow Variant for Requests 

You define workflow variants in this step. In a workflow variant, you define whether a document release 

for requests is active and at which amount approval of a request is necessary. In addition, you define how 

many levels the approval process runs through. You can, for example, depict "four eyes" or "six eyes" 

principle. 

Activities 

Define one or more work flow variants accordingly for your requests. 

Further notes 

See section "Role Definition Requests" for more information about request workflow. 

Additional information concerning workflow can be found in the SAP Business Workflow 

documentation. 

Take note: 

Since release 4.62, it is possible for requests to be flagged as relevant for workflow independently from 

the Customizing settings made here. SAP provides process 00107030 and reference function module 

SAMPLE_PROCESS_00107030 in order to allow you to change the workflow indicator. 

The enhancement of the workflow function for requests is based on the business transaction events 

technique. For more information, see Business Transaction Event 

36.2.10.1.2 Assign Company Code to Workflow Variant for Requests 

You assign the workflow variants to your company codes and document type in this step. If a company 

code is not assigned a workflow variant, no processing is possible for this company code in the workflow. 

Activities 

Assign a workflow variant to the company codes and document types for which a workflow approval is to 

be required. 

36.2.10.2 Role Definition 

In the following steps, you define the role definition for the following processes: 

- Earmarked funds and transfers 

- Requests 

- Budget parking 
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Note: If you belong to the customer circle of German local authorities, you cannot implement the 

workflow for budget parking. 

In role definition, you define rules, according to which the appropriate employees can be 

determined in the Role resolution. 

You need the roles definition if, for instance, you want to define that certain documents are to be 

processed (approve, reject, change) by different employees, depending on the amount or the Funds 

Management account assignment (FM account assignment). 

36.2.10.2.1 Stipulate Document Classes 

You create document classes in this step. In a further step, you assign the system-defined document 

categories to document classes. 

A document class can group together several document categories. Role definition for these document 

categories will take place together. 

You need different document classes if you want to have different role definitions apply for individual 

document categories. 

Example 

If a different role definition is to apply for a funds reservation than for a funds commitment, then you 

need two different document classes. 

Standard settings 

For each process - earmarked funds, requests and parked budget - SAP provides a document class as an 

example. 

Activities 

You can use the document classes provided. 

If - as described above for individual document categories of Earmarked funds - a role definition of your 

own is to be valid, or if, for example, the processing of requests and funds commitments are to be 

grouped together dependent on the amount, you must create the document classes accordingly. 

Create the document classes according to your needs. 

36.2.10.2.2 Assigned Document Category to Document Class 

You assign the document classes to the document categories defined by the system in this step. 

Standard settings 
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SAP provides a document class assignment to a document category as an example for the document 

categories for Earmarked funds  and "Requests" and the document category "Budget". 

Activities 

You can use assignments as provided in the standard. 

If, however, different role definitions are to apply for individual document categories for earmarked funds 

or requests, you must assign a different document class for each document category. 

Assign a document class to all document categories which you are using. 

36.2.10.2.3 Define FM Account Assignment Groups 

You define FM account assignment groups for an FM area and fiscal year in this step. The account 

assignment elements commitment item, funds center and fund are grouped together in this way. 

You need these groups for role definition in a another step. There, by defining a FM account assignment 

group, you determine which employee - dependent on the account assignment - is allowed to process a 

document (for example approve or reject). 

Activities 

Define the FM account assignment groups according to your requirements. Maskings with 

the character + and * are allowed. 

36.2.10.2.4 Define FM Amount Groups 

You define amount groups for an FM area in this step. This groups amount intervals together. 

You require these groups for role definition in another step. There, by defining an amount group, you 

determine which employee is allowed to process a document dependent on the amount (for example, 

approve or reject). 

Activities 

Define the amount groups for a each FM area. 

To define a lower limit of zero, leave the From amount field blank. 

To define an upper limit as "Indefinite", leave the To amount field blank. 

36.2.10.2.5 Define FM Role Definition 

In this step, you define the actual role definition. 

You define the processor of a work item: per workflow level, document class, activity, FM area, fiscal 

year, FM account assignment group, and amount group. 
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The processor identification consists of: 

- Object type 

You can use the objects: organizational unit, job, and position as object types. 

- Processor ID 

You can use the existing organizational units, jobs, and positions as a processor ID. 

Requirements 

You must have already defined document classes, account assignment groups, and amount groups 

according to your needs. For more information, see Define Document Classes, Define FM Account 

Assignment Groups and Define Amount Groups in this node of the implementation guide. 

Activities 

1. Enter a document class, activity category, FM area and fiscal year for each Workflow level. 

2. Enter an FM account assignment group, amount group, object type and processor ID. The 

processor ID must be defined in the Human Resources component. 

Further notes 

For more information on the use of roles for earmarked funds, requests, and parked budget, see the 

following sections: 

- Role Definition for Earmarked Funds and Funds Transfers 

- Role Definition for Requests 

- Role Definition for Parked Budget 

36.2.10.2.6 Role Definition for Earmarked Funds and Funds Transfers 

Role definition is used for earmarked funds and funds transfer in workflow template WS50000016 for 

standard task TS50000006 "Decide on joint document approval" (TS80500064). 

To activate the workflow template you must make the following entry in the event type linkage table: 

Object type                FMRE 

Event                      CREATED 

Receiver type              WS50000016 

 Receiver call function module 

Receiver function module   SWW_WI_CREATE_VIA_EVENT 

Check function 

Destination 

Linkage activated           X 

To make these entries, choose the following in the SAP menu Tools ->ABAP Workbench -> 

Development -> Workflow -> Administration -> Event Manager -> Type Linkages (transaction 

SWETYPV). 
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In addition, you must assign the following standard tasks in the organizational structure: 

- TS80500064 -

 TS50000008 

To define the settings: 

1. In the SAP menu, choose Tools -> ABAP Workbench -> Development -> Workflow -> 

Definition Tools -> Tasks/Task Groups -> Display (transaction PFTC_DIS) and enter a 

standard task. 

2. Choose Additional Data -> Processing Assignment -> Maintain and assign the standard task to 

the processor types relevant for you. 

Control Parameter Workflow Template 

The workflow template has two control parameters that you can define as initial values: 

- MaxWFLevel  Number of workflow levels               template setting : "1" 

The levels determine the sequential order of the approval. The next higher level is reached if an 

approval has been given for the previous level. 

If a rejection occurs at a level, the document must be changed accordingly. The current level is reset 

to 1. All approval levels must be gone through again. 

- DefineRole  Type of role definition 

             Template setting:  " " space, no role definition You can enter 

the following values: 

"1"   Data of first document line is evalutated 

"X"   Data of all document lines is evaluated 

- Value ' ' 

If a role definition is not performed, the document data is not evaluated. All users assigned to 

task TS80500064 can be processors of the work item. 

- Value "1" 

Only the first document line of the earmarked funds document is evaluated. 

All amount groups are determined in which the amount of the document line lies. Because of 

the FM account assignment (combination of commitment item, funds center and fund) in the 

document line, all FM account assignments are determined that have this combination. 

In addition, the necessary parameters are determined as follows: 

Workflow level:    from Workflow;   in template: 1 

Document class:    from Document header:  Document category 

Activity type :    from Workflow;   in template: 01 = approve 

FM area       :    from Document header:  FM area 

Fiscal year   :    from Document header:  Document date 

The role definition table is read with the key fields above. All selected entries are used for role 

definition. 

 - Value "X" 

All document lines are evaluated. 
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The number of different processor groups are determined for the individual document lines. 

A parallel processing branch is dynamically generated for each group in the workflow, 

whereby the assignment of the document lines to the groups remains. Each group must 

approve the lines for which they are responsible. This means that a document is only 

approved at each level if each group (a user of each group) has approved it. 

Example:  Document with 3 lines. 

2 different processor groups are determined. 

2 parallel processing branches are generated. 

The document must therefore receive 2-fold approval before the current level is approved. 

36.2.10.2.7 Role Definition for Requests 

The role definition for requests is used in the workflow template WS80500027 for the standard task 

Decision: Document Release (TS80500065). 

Workflow template 

To activate the workflow template you must make the following entry in the event type linkage 

table: 

Object type FMPSO 

Event CREATED 

Receiver type WS80500027 

Receiver call function module 

Receiver function module 

Check function 

Destination 

SWW_WI_CREATE_VIA_EVENT 

Linkage activated X 

To define these entries, choose the following in the SAP menu: Tools -> ABAP Workbench 

-> Development -> Workflow -> Administration -> Event Manager -> Type Linkages (transaction 

SWETY) 

You must also assign the following standard tasks in the organizational structure: 

- 80500066  change request - 

80500065  release request To 

define these settings: 

1. Choose the following in the SAP menu Tools -> ABAP Workbench -> Development -> 

Definition Tools -> Tasks/Task Groups -> Display (transaction PFTC_DIS) and enter a 

standard task. 

2. Choose Additional Data -> Processor Assignment -> Maintain and assign the standard task to 

the processor types relevant for you. 

Role definition 

All G/L account lines of all documents that are grouped together in the request are used for role 

definition. 
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Example: The request consists of 2 documents each having 3 G/L account lines. 4 

different processor groups are determined 

4 parallel processing branches are generated. 

The request must also receive a 4-fold approval before it can be approved at its current level. 

Number of workflow approval levels 

The control parameters of workflow template MaxWFLevel determine the number of workflow approval 

levels. 

The levels determine the sequential order of the approval. The next higher level is reached if an approval 

has been given for the previous level. 

If a rejection occurs at a level, the request must be changed accordingly. The current level is reset to 1. 

All approval levels must be gone through again. 

You define the number of approval levels necessary for a certain request (document type) in step "Create 

workflow variant for requests". 

Dependency of FI parked workflow 

A request is comprised of parked FI documents, as long as the request has not yet been posted. 

If parked FI documents belong to a request which must be approved in the request workflow, these FI 

documents cannot also be relevant for the FI workflow at the same time. You must bear this dependency 

in mind if you want to implement both workflows in parallel. 

Take note: 

As of release 4.62, it is possible to flag requests as relevant for workflow independently from the 

Customizing settings made here. SAP provides process 00107030 and reference function module 

SAMPLE_PROCESS_00107030 in order that you can change the workflow indicator. The enhancement 

of the workflow function for requests is based on the business transaction event technique. For more 

information on this topic, see Business Transaction Events. 

36.2.10.2.8 Role Definition for Parked Budget 

Role definition for parked budget is used in workflow template WS50000014 for the following standard 

tasks: 

- TS50000037  Approve parked document 

- TS50000041  Check parked document 

- TS50000042  Reset parked document 

- TS50000043  Copy parked document 

To activate the workflow template you must make the following entry in the event type linkage table: 

Object type FMBU 

Event CREATED 

Receiver type WS50000014 

Receiver call function module 

Receiver function module SWW_WI_CREATE_VIA_EVENT 

Check function 

Destination 
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 Linkage Enabled X 

To make these entries, choose the following in the SAP menu Tools -> ABAP Workbench -> 

Development -> Workflow -> -> Administration -> Event Manager -> Type Linkages (transaction 

SWETYPV). 

In addition, you must assign the following standard tasks in the organizational structure: 

- 80500075 - 50000041 - 50000042 

- 50000043 

To define the settings, carry out the following steps: Choose the following in the SAP menu 

Tools -> ABAP Workbench -> Development -> Workflow -> Definition Tools -> Tasks/Task 
Groups -> Display (transaction PFTC_DIS) and enter a standard task. 

1. Choose Additional Data -> Processor Assignment -> Maintain/> and the assign the 

processor types relevant for you to the standard task. 

Standard settings 

SAP delivers two workflow levels for parked budget in the standard system. Note that you must define 

two approval levels when using the standard. 

If you just use the standard as a template and copy it, you can increase or decrease the number of approval 

levels if you change the condition in step 000006 of the copy created by the workflow template 

WS50000012. 

Role Definition 

All documents lines of an entry document are used for role definition. 

The processor groups are determined from the lines of the document and a processing branch is 

determined for each processor group. 

Example: 

The entry document contains 3 lines. 

Two different processor groups are determined. 

Two parallel processing branches are generated 

The entry document must be approved twice before it is approved on its current level. 

If the document in an approval level is rejected by a user of a processing group, the whole document is 

rejected and the approval procedure is terminated. The employee who wants to enter the budget is 

informed about the rejection by the workflow and can create a new document using the rejected 

document as a template. 

Note that an entry document that is in an approval procedure cannot be processed in Funds Management 

with the budgeting transactions for parked documents. A document like this cannot be posted or reversed. 

36.2.10.2.9 Role Definition: Preposted Budget in FM Budgeting 
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Use 

The following two workflow templates are available in the budget control system for a budget 

application, that is, posting budget provisionally: 

- WS12300025 

- WS12300026 

If you activate one of these workflow templates, the following approval procedure is started when a 

budget entry document is posted provisionally: 

Control of Approval Procedure using Entry Document Type 

You can control the approval procedure of the workflow using the entry document type. You can then 

define whether a document type is activated for the workflow or not in the IMG activity Define Entry 

Document Type. In this way, you can define whether provisionally posted budget should be processed 

further with workflow when you are entering budget documents. 

Process 

The user determined by the role definition receives the provisionally posted budget for approval. If this 

budget application is accepted, the document is posted. The person who sent the application is informed 

about the approval via e-mail. This procedure is the same in both workflow templates. 

If the application is rejected, the procedure is different in the two workflow templates. In Workflow 

template WS12300025, the applicant is only informed about the rejection via e-mail in workflow 

template WS12300026; the applicant is asked to restart the provisional posting of the budget document in 

their inbox. The rejected document can be used as a template for this. 

You activate the workflow template in the workflow builder (transaction SWDD). Enter the workflow 

template, choose Enter and then Basic Data. Choose the tab page Version-Independent (task) and 

check that the following entries are there: 

Object category BO 

Object type BUS0050 

Event PREPOSTEDDOCCREATED 

The data flow for event and workflow must be defined in the following way: 

 Event Workflow 

 &_EVT_OBJECT& &BUS0050& 

 &_EVT_CREATOR& &_WF_INITIATOR& 

Make this entries yourself if necessary and activate the workflow template by selecting the column 

active. The workflow template is active if a green traffic light appears in the column. 

Role definition for provisional posting of budget in the budget control system is used in the workflow 

templates for the following standard tasks: 

12300025 decision on provisionally posted budget 

The role definition only restricts the possible processors of a standard task. To use the workflow you 

therefore have to assign the possible processors to the standard tasks of the workflow tempate that require 

the dialog with a user. For the workflow template WS12300025 you have to maintain the processor 

assignment for the standard task TS12300025 and the standard tasks TS12300025 and TS12300027 for 

workflow template WS12300026. 
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Procede as follows: 

1. From SAP Easy Access choose Tools -> ABAP Workbench -> Development -> Workflow -> 

Definition Tools -> Tasks/Task Groups -> Display (transaction PFTC_DIS). 

2. Enter the appropriate standard task and select Display. 

3. Select Additional Data -> Processor Assignment -> Maintain and assign the relevant processor 

to the standard task. 

Standard Settings 

SAP delivers two approval levels in the standard system for the provisional posting of budget entry 

documents. Note that you must define two approval levels when using the standard in role definition. If 

no processor is found for a budget application via role definition, the workflow item has the status 

incorrect. 

If you only use the standard as a template and copy it, you can increase or decrease the number of 

approval levels by changing the initial value of the work flow container element l_counter_max. Note 

that is you increase the number of steps, you have to maintain the role definition as well. 

Role Definition 

The role 12300004 only includes entries in the role definition for the document class BCSBU, document 

type 910 and the activity 01 (approve). 

In the role definition, you can decide which processor is responsible for the approval using the account 

assignment in the posting and the amount. Before you carry out the actual role definition, create account 

assignment groups and amount groups. Then in the role determination assign a fiscal year and the activity 

01 (approve) for your FM area and organizational units, jobs and positions for the different amount and 

account assignment groups. You can assign these elements to users in the organizational structure. 

All line items of an entry document are used for role definition. Only users that are determined in each 

line item of a document using role definition receive the budget application in their inbox. 

Requirements 

You activated an entry document type for the approval procedure by setting the indicator workflow for 

the document type. 

Example 

An entry document has two lines 

User A and user B are determined as possible processors for the first line item. 

User A and user C are determined as possible processors for the second line item 

a) Role definition standard delivery: 

Only user A receives the budget application in the inbox. 

b) Modified role definition: 

Users A, B and C receive the budget application in their inbox. 
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If the document is rejected by one of the possible users in an approval level, the document is rejected and 

the approval procedure is terminated. The employee who posted the rejected budget provisionally is 

informed about the rejection by the workflow. This happens the in workflow template 12300025 via e-

mail. In workflow template 12300026, the user can create a new document using the rejected document. 

Otherwise the templates are identical. 

Note that a budget entry document that is in an approval procedure cannot be processed in the budgeting 

workbench. Documents like these cannot be posted or reversed. 

36.2.10.2.10 Role Definition: Approval Procedure for Commitment Carryforward 

The role definition for the approval procedure is used for the commitment carryforward in workflow 

template WS12300144 for standard task Approval for Commitment Carryforward (TS12300121) and 

in workflow template WS123000156 for the standard task Approval for Commitment Carryforward 

with Budget (TS12300135). 

Note that you must define whether the approval procedure is executed on one-level or on two-levels in the 

IMG of Funds Management Government under Closing Operations -> Commitment Closing 

Operations -> "Define Basic Settings for Commitment Carryforward". 

Workflow Template 

To activate the workflow template, you must make the following entry in the table for event type linkage: 

Object type FMCCFLOT 

Event CCF_SELECTED 

Receiver type WS12300155 

Call of receiver Function module 

Receiver FM 

Check Function 

Destination 

SWW_WI_CREATE_VIA_EVENT 

Link activated X 

To make these entries, on the screen SAP Easy Access, choose Tools -> ABAP Workbench -> 

Development -> SAP Business Workflow -> Administration -> Event Manager -> Type Linkages 

(Transaction SWETYPV). 

In addition to this, you must maintain the processor assignment for the following standard tasks: 

- 12300121  Approve commitment carryforward 

- 12300135  Approve Commitment Carryforward with Budget (only for two-level approval 

procedure) 

To define this setting, proceed as follows: From the SAP Easy Access screen, choose Tools 

-> ABAP Workbench -> Development -> Workflow -> Definition Tools -> 

Tasks/Tasks Groups -> Display (Transaction PFTC_DIS) and enter a standard task. 

Choose Additional Data  -> Processor Assignment -> Maintain and assign the processor types you 

require to the standard task. 

Role Definition 
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If you want to control the processor determination for each FM area and fiscal year, you must define the 

role definition for the document class FMCCF delivered in IMG activity Define FM Role Definition. Here 

you must enter the jobs, organizational units or positions (object type) for the different FM areas and 

fiscal years. The only users to get a work item in their inbox are those whose jobs, organizational units or 

positions were defined in the role definition. 

The following prerequisites apply for these settings: 

- The users are assigned to the jobs, organizational units or positions in the organizational structure. 

- In IMG activity Define FM Account Assignment Groups, an account assignment group that covers 

all account assignment elements (*)  is created for the FM area and fiscal year. 

- An amount group in which no amounts are specified is created for the FM area and fiscal year in 

IMG activity Define FM Amount Groups. 

The entries for the account assignment and amount group are therefore necessary because an account 

assignment group and amount group must also be entered in IMG activity Define Role Definition in 

addition to the assignment of the object type, although the processor determination for the commitment 

carryforward cannot be controlled by different FM account assignments or amounts. 

If your organization requires a differentiated control for processor determination for each FM area and 

fiscal year, you do not need to define any settings for the role definition. However, you must set the 

indicator Cancel Rule Resolution Without Result for the rule for role definition with fiscal year 

change (12300041). To do this, on the SAP Easy Access screen, choose Tools -> ABAP Workbench -

> Development -> SAP Business Workflow -> 

Definition Tools -> Rules for Processor Assignment -> Change (transaction PFAC_CHG). All 

users assigned to the standard task then get a work item in their inbox. 

36.2.10.2.11 Country-Specific Settings 

36.2.10.3 Stipulate Reasons for Decision 

In this step, you define decision reasons for approving or rejecting earmarked funds/funds transfers. 

You need decision reasons if you want explain (in detail) the approval or rejection of a document in your 

inbox. 

In addition to this, you can also enter a long text. 

The last reason is stored in the document and change documents are written. 

For each decision reason, you can specify if it is 'final' or not. If you select a reason for your 

approval/rejection that is not marked as final, the document retains its current status. Only when you 

choose a 'final' reason does it mean that the approval or rejection actually comes into effect. 

You can control the selection of approval reasons that are available for each person by means 

of an authorization. 

Activities 

Specify decision reasons. 
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Further notes 

When approving or rejectiong earmarked funds/funds transfers, you must only state a decision reason if 

you have maintained decision reasons. 

If you have not maintained decision reasons, the screen for approving/ rejecting the document does not 

appear. 

36.3 Grants Management 

36.3.1 Grantee Management 

36.3.1.1 Global Settings 

36.3.1.1.1 Maintaining Grant Ledgers 

Special Purpose Ledger 90 is delivered as the Grants Management (GM) ledger. This ledger collects all 

postings relevant to grant accounting. Budget, commitments, actual values and totals are all stored in this 

ledger, based on the sponsor's perspective. 

You need to assign this ledger to the grantee's company code(s) and perform other customizing actions. 

You do this under the chapter: Special Ledger Customizing . 

There are five screens for maintaining Special Purpose Ledgers: 

- Master data 

On this screen you specify basic information for the ledger. The GM ledger is delivered with 

predefined settings. You should only change them if needed. 

- Assign Company Code 

You have to assign a company code or global company to your (local or global) ledger in order for it 

to be posted to. 

- Assign activity 

In addition to activities assigned in ledger master data, you can also assign activities to a given 

company code/ledger or global company/ ledger combination so that you can post to your ledger. 

You can assign entire groups of activities (for example, all activities from FI) under "activity 

groups." 

The activity groups for direct posting of actual data for Financial Accounting (FI), Human 

Resources (HR), Materials Management (MM), and Sales and Distribution (SD) should be selected 

for GM.  Assign a  field movement to each activity and/or group. 

- Field movement 

A field movement determines which variable fields are to be transferred from a posting to your 

ledger and which fields in your ledger are receiver fields. For GM, field movement 90GM should be 

used. 

Requirements 
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If you want to assign a global company to a GM ledger, you must first create this global company in the 

FI-SL system in the "Maintain Global Companies" activity or in the FI-LC system. 

Actions 

1. Maintain the ledger master data. 

This is where you define which currencies or quantities your ledger will carry. You can also 

define which activities can be assigned to the ledger independent of the company code or 

global company. For the GM ledger values are predelivered. 

2. Assign one or more SAP company codes (for local ledgers) or one or more global companies (for 

global ledgers) to your GM  ledger. 

3. Assign one or more activities to each ledger/company code or ledger/global company combination. 

4. Maintain the field movement. 

5. Maintain the selection criteria for posting data to your ledger. 

36.3.1.1.2 Set Grant as Not Relevant for Grants Management 

Use 

Some parts of the SAP system require specification of a grant, even if no other functions are performed in 

relation to it. 

Use this step to define a dummy grant to serve this purpose. 

Requirements 

- Grants are active as an account assignment element. 

- The system setup does not allow BLANK as a value for the "grant" account assignment element. 

Activities 

Enter the following for the dummy grant: 

- A name 
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This is used to identify the grant in reports. - A 

longer description 

36.3.1.1.3 Maintain Company Code Settings 

Use 

Use this step to enter settings to be applicable throughout Grants Management (GM) for this company 

code. 

Requirements 

You need to have: 

- Created the company code 

- Installed, activated, and configured Funds Management (FM) if required and created the relevant 

budget there 

Activities 

For the company code(s) where you want to use GM, specify 

- Valid-from Date 

This is the official start date of the award or grant. 

- Grantee Active 

Check this to activate GM for the company code. 

- FM Integration 

Check this to activate GM-FM integration. 

- Whether the payment budget or commitment budget is to be used 

36.3.1.1.4 Maintain Update Settings 

Use 

In this step, you stipulate how the system is to update values relating to Grants Management (GM). 

Requirements 

You need to have created the G/L accounts, chart of accounts, and value types you want to use. 
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Activities 

To enter your settings, choose New Entries and enter the following: 

- Chart of accounts 

- G/L account or range of accounts for which you want to enter settings 

- Value type 

The system uses the accounts you specified above when updating the value type you enter 

here. 

Value types can be assigned to financial transactions; commitment value types (such as 

purchase requisition or purchase order) are defaulted automatically by the system. For 

example, if a consumption G/L account is used for both financial transactions (vendor 

invoices) and for purchase orders, the value type defined in this table should be the one to be 

used in the financial transaction. 

- In the "Derive" column, specify whether the split processor should derive the grant, fund, sponsored 

program, and sponsored class, or whether they should be derived directly in GM. If you choose the 

latter option, the GM derivation tool is used. 

- Whether resulting postings should be real or statistical. 

It is possible to except Controlling (CO) postings from this setup and enter settings specifically for CO. 

To do this, choose Controlling-Specific Settings in the Dialog Structure and enter the required CO 

details. 

36.3.1.1.5 Maintain GM Value Types 

Use 

Use this step to stipulate which value types are relevant for which functions in Grants Management (GM). 

Requirements 

You need to have created the value types in question. 

Activities 

1. Stipulate whether each value type is to handle obligations, actual data, or payments. 

2. Specify the relevance of each of your value types for the following: 

- Billing 

- Master data 

- Financial Accounting (FI) 
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- Controlling (CO 

36.3.1.1.6 Change Message Control for Grants Management 

Use 

You may want certain messages to behave differently for particular users in Grants Management (GM) 

than for others. For example, you might want a senior figure in your organization to receive a message as 

a warning while everyone else receives it as an error. If so, use this step to make the necessary 

specifications. 

Activities 

1. When you choose the step, a dialog box appears, inviting you to enter the message area you want to 

process. Enter GMCUSTOM. 

2. The subsequent change view shows the messages in the class for which such changes have already 

been made, if any. Choose New Entries to add to these. 

3. In each case, the Standard column shows how the message behaves in the system as a whole. You 

can specify the following, separately for online and/or batch: 

- W(arning) 

- E(rror) 

- - 

This means the message is inactive. 

- Enter the user name of the user to whom this stipulation is to apply. Generic entries are possible. 

36.3.1.1.7 Use Special Periods 

Use 

In this Customizing activity, you can allow Grantee Management postings in special periods. 

Requirements 

You have done the following: 
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- Created the company code 

- Assigned a fiscal year variant to the company code 

- Installed, activated, and configured Funds Management (FM) if required 

Activities 

For the company code(s) for which you want to use special periods, select the Use Special Periods 

indicator. 

This indicator applies to the following areas: 

- Financial Accounting (FI) 

- Resource-related Billing 

Examples 

Example 1 

The fiscal year variant defined for the grant is the same as the variant for the company code. 

You use a company code based on fiscal year variant K4 and post a financial invoice document on 

posting date 31.12.2014 with posting period 013. 

If you are using special periods, the related Grantee Management document is posted in posting period 

013. If you are not using special periods, the related Grantee Management document is posted in posting 

period 012. 

You run resource-related billing for the corresponding grant, which includes the option to bill in the same 

posting period as the invoice (013) or in a different posting period. 

Example 2 

The fiscal year variant for the grant is different than the variant of the company code. 

You use a company code based on fiscal year variant K4 and post a financial invoice document on 

posting date 31.12.2014 with posting period 014 and on a grant defined with fiscal year variant K1 where 

special period 014 is not allowed. 

The financial document cannot be posted. 

36.3.1.1.8 Business Add-Ins for Global Settings 

36.3.1.1.8.1 BAdI: Grants Management Coding Block Authority Check 

Use this enhancement to perform authorization checks at time of posting.The checks are Grants 

Management-oriented. 

Use the following objects: 
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- Authority for Grant 

- Authority for Class 

- Authority for Program 

- Function Modules within GMAU can be helpful. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface 

name> ~ <Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.3.1.1.8.2 BAdI: Grants Management Authority Check 

Use this step to configure the Business Add-In (BAdI) that enhances the authorization check carried out 

in Grants Management (GM). 

Standard settings 

The BAdI enables additional authorization checks on the following: 

- Grant 

- Budget 

- Sponsored class 

- Sponsored program 

Activities 

Specify an implementation name. When you press Enter, the system invites you to enter a long text, 

describing the implementation. 

When you subsquently execute the BAdI, you can add any or all of the additional authorization checks to 

your installation. 

36.3.1.1.8.3 BAdI: Grants Management: Override Updating Attributes 

In some business cases, the standard customizing settings are not enough. This BAdI allows you to 

override customizing settings when updating transactions in Grants Management (GM). The parameters 

that can be changed in this BAdI are: 

- CH_IS_RELEVANT: Responsible for determining who derives the grant and other GM dimensions 

- Return Value "X" indicates that the grant and other GM dimensions should be derived from the rules 

specified in the Grants Management Assignments. 

- Return Value " " indicates that the GM dimensions will be obtained through the splitting mechanism 

of the split processor. 

- CH_STATS: Responsible for indicating whether a line is a statistical or a real posting 

- Return Value "R": Real Posting 

- Return Value "S": Statistical Posting 
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Recommendation 

Only use this BAdI when you need one GL account to behave differently depending on a business 

scenario. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.1.8.4 BAdI: Currency Exchange 

Use 

Use these enhancements when you need to calculate the currency conversion in a different way than 

provided by SAP. 

Use the following methods: 
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- Currency conversion for budget 

- Currency conversion for actuals/commitments 

- Currency conversion for FI 

- Currency conversion for revaluation report 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.3.1.2 Master Data 

36.3.1.2.1 General Settings 

36.3.1.2.1.1 Maintain Grant Responsibilities 

Use 

Use this activity to define the responsibility types you want to use in your Grants Management (GM) 

application. You can associate workflow functions with those responsibilities. 

The defined responsibility types are available within the different GM Master Data and can be used to 

assign a responsibility type to the grant defaulted from the sponsor or sponsored program. 

A typical responsibility type would be the principal investigator. 

Requirements 

Since you are using the responsibility types within a workflow, the workflow objects must be set up first. 
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Activities 

1. In the initial overview, choose New Entries and enter an ID and a descriptive text for the new 

responsibility type. 

2. Having saved the new responsibility type, select it and choose "WF Details for Grant" in the dialog 

structure. (WF stands for "Workflow".) 

3. In the resulting overview, define the workflow actions required for this responsibility type. 

4. You can also define workflow actions for the GM budgeting process. 

36.3.1.2.1.2 Maintain Award Types 

Use 

Use this activity to define award types. You can then assign the award types to a grant and use them in 

grant reporting. 

Activities 

You can use the initial overview to create new award types and change existing ones. To create new 

award types, choose New Entries and enter an ID and a descriptive text for each award type desired. 

36.3.1.2.1.3 Maintain Legislative District Codes 

Use 

Use this step to define legislative district codes (LDCs). LDCs can be assigned to grants and used as 

reporting attributes. 

Activities 

You can use the initial overview to create new LDCs and change existing ones. To create LDCs, choose 

New Entries and enter an ID and a descriptive text for each LDC desired. 

36.3.1.2.1.4 Maintain Payment Rules 
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Use 

Use this step to define Grants Management payment rules. You can then assign the rules to outgoing 

grants to describe the payment process used. 

Activities 

You can use the initial overview to create new payment rules and change existing ones. To create rules, 

choose New Entries and enter an ID and a descriptive text for each rule you create. 

36.3.1.2.1.5 Maintain Letters of Credit 

Use 

In some cases, sponsor's funds are received in the form of a letter of credit. If this is so in your case, use 

this view to enter the number and text of the letter(s) of credit. 

Activities 

In the maintenance view, switch to change mode and choose New Entries. Then enter the relevant data for 

your letter(s)s of credit. 

36.3.1.2.1.6 Maintain CFDA Codes 

Use 

Use this step to enter and change the codes for the Catalog of Federal Domestic Assistance (CFDA) in 

your GM-GTE installation. 

Activities 

To enter a new CFDA code, choose New Entries and enter the code and text for each code you want to 

include. 

You can also change entries already made by accessing them in change mode. 
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36.3.1.2.2 Sponsor 

36.3.1.2.2.1 Account Group Assignment 

Use this step to tell the system how the role of sponsor is to be integrated with customer handling. 

Activities 

Make the following entries: 

- Business partner grouping 

- Customer account group 

- If you want the two groups to use the same number assignment, check the Same no. box for your 

new entry. See the field documentation for this box for details on restrictions. 

36.3.1.2.2.2 Business Partner Integration with Records Management 

Use this step to integrate Grants Management (GM) with Records Management (RM). 

Requirements 

You have defined the business partner categories and partner types you need. 

Activities 

1. Make the following entries: 

- Business Partner category 

You can group business partners together by assigning them to the same categories. - 

Partner type 

- If you want to activate integration with RM now, check the Activate Records box. 

2. To add detail, choose Integration Details in the dialog structure and enter the following: 

- Process 

That is, grant or sponsor. 

- Sequence 

In cases where several parameter values are useful to one grant type or business partner, you 

need to number the parameters sequentially. Use this field to enter the sequential numbers. 
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- RM class 

For example, record, element, or element detail. 

- Value 

36.3.1.2.3 Sponsored Class 

36.3.1.2.3.1 Maintain Class Authorization Groups 

Use this step to create authorization groups. By assigning groups to sponsored programs, sponsored 

classes, and grants, you can segregate users who may need access to different parts of the master data. 

Activities 

Enter an identifier for the new group and a longer description. 

36.3.1.2.3.2 Maintain Text ID for Sponsored Class 

Use 

Use this step to determine the types of text you can maintain in the sponsored class master data. 

Standard settings 

We deliver object GMSO_CLASS as standard. 

Activities 

To add a new text ID, choose New Entries and specify the following: 

- Object GMSO_CLASS 

- A four-character alphanumeric ID 
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- A descriptive text of up 30 characters 

36.3.1.2.4 Sponsored Program 

36.3.1.2.4.1 Maintain Program Authorization Groups 

Use this step to create authorization groups. By assigning groups to sponsored programs, sponsored 

classes, and grants, you can segregate users who may need access to different parts of the master data. 

Activities 

Enter an identifier for the new group and a longer description. 

36.3.1.2.4.2 Maintain Text ID for Sponsored Program 

Use 

Use this step to determine the types of text you can maintain in the sponsored program master data. 

Standard settings 

We deliver object GMSO_PROG as standard. 

Activities 

To add a new text ID, choose New Entries and specify the following: 

- Object GMSO_PROG 

- A four-character alphanumeric ID 

- A descriptive text of up 30 characters 

36.3.1.2.5 Grant 

36.3.1.2.5.1 Extending the Master Data Through the BDT 

Use 
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SAP Business Partner is designed to allow enhancements, because screen structure and screen sequences 

are defined in control tables. Program logic can be installed by using defined interfaces. 

You can enhance the business partner by way of attributes, new tables and BP roles. You also have the 

option of enhancing the field checks delivered by SAP. 

You can find further information about these enhancement options in the Developers' Manual for the 

Business Data Toolset (see Application Help -> SAP Business Partner (SAP BP) -> Business Data 

Toolset). 

It is possible to make use of the Business Partner feature in Grants Management. Customizing additional 

to that detailed in the Grants Management Implementation Guide is required. 

Activities 

The additional functions are offered in an area menu. Type GRANT_CUSTOMIZE in the transaction box 

to access the menu. 

36.3.1.2.5.2 Maintain Grant Number Ranges 

Use 

Use this step to enter the number range intervals you require for grant master data in Grants Management 

(GM). 

Activities 

1. In the Grant in Grants Management Module screen, choose Change Intervals. 

2. Choose Insert Interval and enter the following for a new interval: 

- ID number 

- "From" number 

- "To" number 

- Whether number assignment from this range is to be internal (the system assigns the number) 

or external (you assign the number manually) 

As GM processing progresses, you can check the status of your number ranges here. 

The "Current Number" column shows how much of a number range has been used. 
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36.3.1.2.5.3 Maintain Grant Types 

Use 

You must assign a grant type to each grant you create in the SAP System. In this step, you configure the 

grant type(s) you want to use for this purpose. 

Requirements 

You need first to create a status profile. 

Activities 

1. To create a grant type, choose New Entries and enter the following: 

- Two-character identifier 

- Descriptive text 

- Whether you want to use internal and/or external number assignment for this grant type 

If you choose internal number assignment, you also need to specify a number range. 

- Status profile 

- Enable or disable posting control 

- Field group control 

You can apply lifecycle status control alone, or with user-defined statuses, or select "None". 

- Whether you want to use user status management 

2. With these basic entries made, you then need to specify details: 

- Lifecycle 

To use this function, you need to create and maintain a status network. You must also specify 

which status is to be the initial status. 

Check the Workflow indicator if you want the Workflow scenario to be active for a particular 

configuration. 

- FM Budget Integration 

Specify whether budget integration with FM is required and, if so, whether the budget is to 

originate from FM or GM. 

- Set budget type defaults 

For each process (such as budget entry or a return) in an FM area, enter a budget type. 

- Grant type integration with Records Management (RM) 

For each grant type where you activate integration, you need to enter controlling details, such 

as the process (grant or sponsor), RM class, sequential numbers for the processes, and the 

value. 

- Default Reporting Records 
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Use this section to define what tasks, if any, you want to use as defaults in reporting for grants 

of a particular grant type. In each case, stipulate a task type, task name, and GM reporting rule 

and class. Remember to activate this set of defaults by checking the Default indicator. 

- Budget Layout 

Use this option to link budget layouts with budget versions in a particular grant type. 

36.3.1.2.5.4 GM Grant Control: Field Group for Authorizations 

It is possible to group fields together for authorization purposes. Use this step to specify such groups in 

Grants Management (GM). 

Standard settings 

We deliver the groups you can enter here, as standard. 

Activities 

Choose New Entries and enter the ID for the group you want to add. When you save, the system displays 

the longer description for the group. 

Further notes 

Authorization to a group allows access to all the fields in the group for users with the appropriate 

authorization. Only allow access to those you know need it for the whole group. 

36.3.1.2.5.5 Maintain Grant Authorization Types 

Use 

Authorization types control which business partners users are allowed to maintain. 

Activities 

You need to enter an identifier and description of your authorization type. Check the relevant box to 

activate the type. 

You can also specify one or two screen fields determining maintenance authorization. 
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36.3.1.2.5.6 Maintain Grant Authorization Groups 

Use this step to create authorization groups. By assigning groups to sponsored programs, sponsored 

classes, and grants, you can segregate users who may need access to different parts of the master data. 

Activities 

Enter an identifier for the new group and a longer description. 

36.3.1.2.5.7 Maintain Grant Relationships 

Example 

You can create relationships beween grants and business partners or between grants and other grants. For 

example, you could create a relationship between grants and business partners called "subcontractor". 

This relation would then be available in the relationship section of the grant master. 

Standard settings 

While there is no preconfigured relationship, we deliver standard settings for the time constraint and 

cardinalities (see below) from which you can make your selection. 

Activities 

In the overview, choose New Entries, then enter the following: 

- In the Relationship section: 

Enter a three-character identifier. The first character must be either "Y" or "Z". 

- In the GM Relationships Maintenance section: 

- Description 

- Description of up to 30 characters 

- Additional description of up to 40 characters, describing the   relationship as viewed from the 

grant 

- Additional description of up to 40 characters, describing the   relationship as viewed from the 

business partner 

- In the Semantic Checks section: 
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- Is the relationship one-way only? If so, check the appropriate box. 

- Select the applicable time constraint 

- Use one or both cardinalities to indicate whether the relationship is one-to-one, one-to-many, 

or both. 

- In the Business Partner Details section: 

Enter the relevant role and check the appropriate box to indicate whether the business partner is an 

organization, a person, or a group. 

Further notes 

For a fuller description of Business Partner functions, including relationships, see the Business Partner 

IMG documentation under Logistics - General. 

36.3.1.2.5.8 Workflow Settings for Grant Master Data 

36.3.1.2.5.8.1 Workflow Settings for Grant Master Data 

Use 

Use this step to activate the following Workflow settings in Grants Management (GM) master 

data processing: 

- Notification of change of status 

- Change of status approval 

Standard settings 

We deliver the system with the processes deactivated. 

Activities 

1. In the Task Customizing Overview, you see the task requiring processing. Choose Activate event 

linkage in the Event Linkage column. 

2. In the event triggering screen, open the point GM MD Change Grant Master Status and click the 

Activate switches next to the status(es) you required. You may activate all of them or just a desired 

selection. 

After you save, grant master records can pass through all the statuses you have activated. 

3. Open the point GM Grant Mtr Change of Status Approval and activate Grant Request for 

Approval. 
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If you have already activated the change of status approval or the statuses, and need to deactivate some or 

all of them, the procedure is the same, except that deactivation switches appear in the event triggering 

screen instead of the activation switch described above. 

36.3.1.2.6 Fund 

36.3.1.2.6.1 Maintain GM Fund Type for FM Fund Type 

Use 

In this step, you create and maintain the fund types you need for your Grants Management (GM) 

processing. 

Activities 

To create a new fund type, choose New Entries and specify the following: 

- FM area 

Enter one you are using for GM processing. 

- Six-character alphanumeric identifier for the new fund type 

- Descriptive text for the new fund type 

- Whether the fund type is internal, external, or auxiliary 

36.3.1.2.7 Assignments 

36.3.1.2.7.1 Maintain Grants Management Assignment Derivation Rules 

In this step, you define one or more strategies for determining how certain attributes can be used to derive 

Grants Management (GM) objects. 

You can use account assignment derivation to automatically determine the values of GM account 

assignments from other account assignments, as longas there is a logical dependency between them. 

The account assignment derivation consists of a sequence of derivation steps - known as the derivation 

strategy. It is used to sequentially derive the values for GM account assignments from other account 

assignments. 
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Each derivation step describes how a number of target fields adopt the values from a number of target 

fields. 

There are a number of different Derivation Step Types that can be used to represent different kinds of 

logical dependency between source and target fields, as follows: 

- Derivation Rule 

- Table Access 

- Assignment 

- Initialization 

- Enhancement 

- Function Module 

- FMDT_CONVERSION_EXIT_ALPHA_OUT 

Use this function to convert alphanumeric fields to output format. 

- FMDT_READ_MD_ACCOUNT_COMPANY 

Use this function to retrieve the G/L Account Master Data. 

- FMDT_READ_MD_ASSET 

Use this function to retrieve the Asset Master Data. 

- FMDT_READ_MD_CMMT_ITEM 

Use this function to retrieve the Commitment Item Master Data. 

- FMDT_READ_MD_COST_CENTER 

Use this function to retrieve the Cost Center Master Data. 

- FMDT_READ_MD_FUND 

Use this function to retrieve the Fund Master Data. 

- FMDT_READ_MD_FUNDS_CTR 

Use this function to retrieve the Funds Center Master Data. 

- FMDT_READ_MD_ORDER 

Use this function to retrieve the Order Master Data. 

- FMDT_READ_MD_ORDER_OPERATION 

Use this function to retrieve the Operation Order Master Data. 

- FMDT_READ_MD_ORDER_SD_HEADER 

Use this function to retrieve the SD Order header information. 

- FMDT_READ_MD_ORDER_SD_ITEM 

Use this function to retrieve the SD Order line item information. 

- FMDT_READ_MD_WBS_ELEMENT 

Use this function to retrieve the WBS Element Master Data. 

- FMDT_READ_ORDER_NP_FROM_FMZUOB 

Use this function to retrieve the Network header assignment to FM. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 441 

- FMDT_READ_ORDER_NV_FROM_FMZUOB 

Use this function to retrieve the Network Activity assignment to FM. 

- FMDT_READ_ORDER_PM_FROM_FMZUOB 

Use this function to retrieve the PM Order assignment to FM. 

- FMDT_READ_ORDER_SD_FROM_FMZUOB 

Use this function to retrieve the SD Order assignment to FM. 

Standard settings 

We deliver a standard strategy called SAP: 

- The strategy is blank if you are using this tool for the first time. 

- If you are migrating from an earlier release you had installed, the strategy contains the rules 

you defined in the release from which you are migrating. 

You must assign a company code to each strategy. Each company code can only be assigned to one 

strategy. 

Activities 

1. To create a new strategy, choose New Entries in the "Strategy Environments" overview and enter 

an identifier and descriptive text for your strategy. 

2. Having saved your new entry, return to the full list. 

3. To assign a company code to a strategy, select it and choose Company Code Assignment in the 

dialog structure. 

4. In the resulting overview, choose New Entries and enter the company code(s) you want to assign to 

this strategy. 

5. To enter derivation rules for your new strategy, select it in the "Strategy Environments" overview 

and choose Maintain Strategy. 

6. In the next overview, choose Maintain Step. 

7. Select Derivation rule in the popup, then enter the following: 

- Source fields and target fields 

- If the derivation is to be subject to any conditions, specify these on the Conditions tab. 

- Some attributes can be applied to the derivation too - for example, you can have the system issue an 

error message if derivation is not possible, or you can enter a starting validity date. Make these 

specifications on the Attributes tab. 
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36.3.1.2.7.2 Business Add-Ins for Assignments 

36.3.1.2.7.2.1 BAdI: GM Derivation Tool 

Use 

SAP provides methods that enable further customize the behavior of the Grants Management (GM) 

derivation tool. You must create an implementation using the following predefined methods: 

- CHECK_DRULE_BEFORE_SAVE 

- CHECK_DRULE_ENTRY 

- GET_STRATEGY 

- STEP_ACTIVITY_CHECK 

- STEP_CHECK_ON_ENTER 

- STEP_CHECK_ON_EXIT 

- SET_DISPLAY_MODE 

- STEP_DRULE_ACTIVITY_CHECK 

- SET_STRATEGY_BUTTONS 

- Derive 

Standard settings 

We do not deliver any standard settings. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 
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6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

(1) You use the method CHECK_DRULE_BEFORE_SAVE to prevent users from deleting assignments. 

*---- Check if table is initial 

DESCRIBE TABLE  I_TAB_DELETED_ENTRIES lines sy-tfill. 

IF NOT sy-tfill is initial. 

* Raise MESSAGE  not allowed to delete entries   e_reject = 

'X". 

ENDIF. 

(2) You use the method CHECK_DRULE_BEFORE_SAVE to check specific rule IDs. 

      CASE i_stepid 

           WHEN 'AAA'. 

* Specific Check for Step ID 'AAA'            WHEN OTHERS. 

      ENDCASE. 

36.3.1.2.8 Revaluation 

36.3.1.2.8.1 Default FM Settings for GM Revaluation 

Use 

The Grants Management (GM) budgeting facility includes a feature for revaluing amounts in other 

currencies where, for example, the sponsor's currency is different than the one your organization uses. 

Use this step to enter the settings you want to enter as defaults for this process. 

Requirements 
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You need to have created the funds center, funded program, and other objects you need. You cannot 

create them here. 

Activities 

Choose New Entries and enter the following: 

- Grant type 

- FM area 

- Funds center 

- Commitment item 

- Functional area 

- Funded program 

When you save your entries, the grant type text appears in the Description field. 

The system applies these defaults for this grant type when you do not make other, specific entries in the 

revaluation program. 

36.3.1.2.8.2 Business Add-Ins for GM Revaluation 36.3.1.2.8.2.1 BAdI: 

Enhancement for GM Revaluation: Display Exchange Rate 

Use this step to enable the BAdi which permits users to enter conversion factors in the Grants 

Management (GM) revaluation program. 

Activities 

1. When you choose the step, the dialog box Business Add-Ins: All Implementations for Definition 

BADI_GM_REV_CFA appears. You can either opt to edit one of the existing ones or create a new 

one. If you choose the latter, the system invites you to enter a name for it. 

2. In the processing screen, enter or change the long name for the implementation and specify whether 

the implementation is by ABAP coding or by formula. 

3. After you save your specifications here, the GM revaluation program includes two fields where 

users of this implementation can enter exchange rate factors. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 445 

36.3.1.2.8.2.2 BAdI: Allow Value Type Specification in Revaluation 

Use 

Use this Business Add-In (BAdI) to allow users to specify the value types to be revalued in the 

revaluation run. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.2.9 Business Add-Ins for GM Master Data 
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36.3.1.2.9.1 BAdI: Business Add-In for Sponsored Objects 

Use 

The purpose of this enhancement is to provide access to data before (PBO) and after (PAI) the screens of 

the sponsored class master and sponsored program master are called. Here you can enter default values 

for any of the values on the screens. 

The transactions that play a role here are: Sponsored Program Master Data and Sponsored Class Master 

Data. 

If you need to add more fields, you can make use of subscreens, and add an include to the structure for 

sponsored program GMSPPROGRAM or Sponsored Class GMSPCLASS. 

Example 

CL_EXM_IM_GM_SPONSOREDOBJ 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 
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The code you stored in the method will be run when the application program is executed. 

Further notes 

Subscreens for additional fields are called from subscreens SAPLGMSO 0130 and 0230. 

36.3.1.2.9.2 BAdI: Grant Master BAPIs 

Note: The settings affected here are exclusively reserved for the use of Grants Management 

Title 

Business Add-In: Customer Enhancement for Grant Master BAPIs 

Use 

With this Business Add-In (BAdI), you can define customer enhancements related to the business object 

Grant (BUS0035). 

It can only be implemented for Grant Master BAPIs. 

The methods of this BAdI are called during the processing of the business object methods. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore in the standard release the BAdI is not 

active. 

Activities 

If you want to handle customer-specific fields for entry documents, you must first define the 

corresponding customer include (CI_GMGR). 

To implement this BAdI, apply the following steps: 

1. After you call up the IMG activity, a dialog box appears, where you can enter a name for the 

implementation. 

2. If you have already made other implementations for this BAdI, another dialog box appears, in which 

the existing implementations are displayed. In this case, choose Create, and proceed as follows: 

3. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

4. Enter a short text for the implementation in the Short text for implementation field. 

5. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

6. Save your entries, and assign the implementation to a development class. 
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7. Place the cursor on the method, and double-click to enter method processing. 

8. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

9. Save and implement your code. Return to the Edit Implementation screen. 

10. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

11. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

Activate your BAdI implementation. 

Requirements 

Recommendation 

Only use character-like fields in the structure. 

Further notes  
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36.3.1.2.9.3 BAdI: Grant Number Modifications for External Assignment 

Use 

You can use this BAdI to override the number assignment settings made elsewhere relating to grant 

master data. It is called when you create a grant. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

You want to use grant numbers that begin with a user-defined prefix and end with a year. The prefix is 

dependent on grant type and sponsor. Since this is not possible with number ranges in normal internal and 

external assignment, you can use this BAdI to configure the system as necessary. 

36.3.1.2.9.4 BAdI: Override Copied Data from Reference Grant 
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Use 

When you create a grant as a copy of an existing grant, most, but not all data is transferred to the target 

grant. The following source grant data is not copied to the target grant: 

- Grant type 

- Sales order 

- Grant status 

- Modification and creation date 

- Workflow status 

- Application log data 

- Records Management linkage 

The new grant gets the current date as creation date and source grant number as the copy_source. If this is 

inadequate for your purposes, you can use this BAdI to modify the defaults. 

The importing parameters I_SOURCE_XXX represent all of the data contained in the source grant. The 

changing parameters C_TARGET_XXX represent all the data that has been proposed for the target grant. 

If you do nothing in the BAdI, you will retain the default behavior. Any changes to the changing 

parameters will be displayed in the newly created grant. Keep in mind that it is possible that some data 

will be changed again due to sponsor defaults. 

Requirements 

You are using Grants Management (GM) and want to create grants by copying from a reference grant. 

However, you want to modify the default copy behavior. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 
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6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.2.9.5 BAdI: Map Grant Master Data to Sales Order 

Use 

When a grant is changed to status "Award" or created as an award, a sales order is created 

simultaneously, provided a non-manual billing rule is maintained in the grant. 

The implementation of this Business Add-In (BAdI)I makes it possible to map grant master data to the 

sales order. 

The import parameter I_GMGR_FIELDS represent the data contained in the grant master table GMGR, 

including the Customer Include. 

The export parameter E_EXTENSIONIN is the extension table for BAPIs and should be filled with the 

sales order data that reflects the grant master data. 

The export parameter E_RETURN is the error messages table for BAPIs and should be filled with any 

error messages that arise within the implementation of the BAdI. 

Requirements 

You are using Grants Management (GM) and want to create grants relevant for billing. However, you 

want to map some grant master data to sales order data. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 
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The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.2.9.6 BAdI: Extended Check for Object Mapper 

Use 

This Business Add-In (BAdI) enables you to specify additional validations of entered posting object 

mappings. The default is to check against budget and posting activity and disallow mappings in which 

individual postings overlap with mapped postings. With this BAdI, you can to alter the default as well as 

add additional verifications. 

Requirements 

You use passthrough funding and want to enhance (or reduce) the verifications on mapped Grants 

Management (GM) combinations. 

Standard settings 

Activate the additional checks for a certain checking view. The system contains a Master Data, 

Budget and Billing checking view for additional checks. The Posting Object Mapper is classified under 

the Master Data view. Enable the additional checks in BAdI method DO_CHECK. The actual checks are 

placed in the RUN_MORE_CHECKS method. 

Activities 
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Create implementations to both methods as described below. The additional checks can be enabled with 

method DO_CHECK; method RUN_MORE_CHECKS then contains the coding for the additional 

verifications. 

Form CHECK_TO_GRANT in function module GM_OM_CHECK_MAPPED_OBJECTS provides a 

coding reference for additional checks. 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.3 Budgeting and Availability Control 

36.3.1.3.1 Budgeting 

36.3.1.3.1.1 Maintain Number Range Interval for Entry Documents 

Use this step to maintain number ranges for Grants Management (GM) budgeting. 
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Activities 

1. Specify GMBU_DOCNR as the object and choose Maintain. 

2. In the resulting screen, choose Number ranges, then Intervals. 

3. Make any additions or changes you require. 

36.3.1.3.1.2 Maintain Number Range Interval for Budget Change Documents 

Note 

The settings entered here are reserved exclusively for the use of the budgeting tool in Grants Management 

(GM). 

Use 

In this IMG activity, you define the number range interval of budget change documents in GM. 

Change documents are always generated, when changes are made to the totals records for existing budget 

values. Change documents provide a complete history of the changes made to budget values. 

Requirements 

- Use Number range  01 for GM budget change documents. Enter 01 

and not 1 as the number range. 

- Only internal number allocations are valid. You must not set the Ext 

(external number allocation) indicator. 

Activities 

1. Define number range 01 and the number interval. 

2. Save your entry. 

Further notes 

You transport number range objects as follows: 

Choose Interval -> Transport in the accounting document Number Range screen. 

All intervals for the selected number range object are deleted in the target system first. After the import, 

only the intervals you export are present. The number statuses are imported with their values at the time 

of export. 

Dependent tables are not transported or converted. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 455 

36.3.1.3.1.3 GM Budget Transaction Settings 

Use 

In this Customizing activity, you customize how your budgeting transactions in Grants Management 

(GM) behave. 

Activities 

Proceed as follows: 

1. In the initial view, choose New Entries and make the following entries in General Settings: 

- The user name to which these settings are to apply 

- Initial GM Document 

If this is selected, the user gets the last document used as a default when he or she accesses the 

budgeting transaction. If this is left blank, that user gets an initial (that is, blank) document. 

- Preload Held 

If this flag is set, the user sees a list of the held documents he or she has already created when 

accessing the budgeting transaction. The number of records so listed is specified in the Number 

of Records field (see below). 

- Preload Posted 

If this flag is set, the user sees a list of the posted documents he or she has already created 

when accessing the budgeting transaction. The number of records so listed is specified in the 

Number of Records field (see below). 

- Dimension Filter 

The dimension filter is used to show only relevant objects for the user, normally because is 

working with a large number of objects. If the flag is set, the filter is automatically loaded 

every time the transaction is called. If the flag is off, no objects are loaded and the user should 

use toolbar buttoms to load this filter. 

- Allow Changes 

This flag should be switched on when a specific user is allowed to change the GM Budgeting 

Workbench settings for his or her user. 

- Number of Records 

Enter a number here to define how many posted or held documents are preloaded when the 

user enters the budgeting transaction. 

2. Save your entries. 

3. It is possible to keep two or more sets of budget settings in parallel. To do this, choose Version 

Settings in the Dialog Structure. 

4. In the resulting overview, choose New Entries and make the following entries: 
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- User name 

- Budget version 

5. Set each of the flags below as required: 

- Load GM object 

- Load FM object 

- Load Object Mapper - Show Hierarchy Tab 

- Show cost sharing (CS) 

- Show indirect costs (IDC) 

- Show Object Mapper 

- Amount Type 

Use this field to select whether the amounts shown should be net amounts or totals. 

6. Save your entries and repeat the process for as many different versions as desired. 

36.3.1.3.1.4 Configure GM Budget Document Types 

In this Customizing activity, you can create and configure budget document types in Grants Management 

(GM). The configuration includes integrating the document types with Funds Management (FM) and 

Records Management (RM). 

Requirements 

You have done the following: 

- Created a number range to apply to the new document type 

- Created document types in FM so you can integrate with FM 

Activities 

1. To create a document type, choose New Entries, and enter the following: 

- Two-character ID in the GM Doc Type field 

- Budget phase for which this document type is to be used 

- Funding, which shows from where the money for this document type will come 

- Budget status of released or unreleased 
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- Financing object type of grant, fund, or other 

- If the budget for this document type will require approval, select the Budget Approval 

checkbox. 

- Description of the document type up to 40 characters 

- If the budget for this document type is integrated with FM, enter the FM document type of the 

corresponding FM documents in the Document Type field. 

- If you do not allow a negative budget for this document type, select the Nonnegative Budget 

checkbox. 

2. To integrate this document type with RM, choose Grant Type Interface to Records Mgmt 

under the Budget Integration to Records Managements area of the dialog structure, and enter 

the following: 

- Sequence number 

- RM class 

- RM element name 

- Value 

36.3.1.3.1.5 Assign Budget Phase to Version 

Budget versions are a means of keeping several different "snapshots" of your budget in the system. Use 

this step to maintain any budget versions you require. 

Standard settings 

We deliver the budget phases as standard. 

Activities 

Choose New Entries and enter the following: 

- Budget version 

- Budget phase to which you want to apply the budget version, such as the budget for the grant 

award. 

36.3.1.3.1.6 Configure GM Time Splitting Rules 
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Use 

Use this step to define rules governing the time split required when your budgeting periods do not exactly 

coincide with periods used by the sponsor or with the calendar year. 

Activities 

1. Choose New Entries and make the following entries: 

- An ID for the new rule 

- A text of up to 60 characters, describing the rule in more detail 

- The scenario to which the rule is to apply 

That is, only to released budget or to both released and unreleased budget 

2. With these basic entries made, you need to add some detail. Choose Splitting Rule 

Elements in the dialog structure and make the following entries for a selected rule: 

- The budget phase to which it applies 

- Budget status to which it applies 

- Split by 

- If you want to manual splitting to be allowed for a particular combination in the above entries, 

check the appropriate box. 

36.3.1.3.1.7 Tools 

36.3.1.3.1.7.1 Delete Budget Documents 

Use 

In this step, you start the program for deleting budget documents in Grants Management. 

You can use this program in the following situations: 

- If you are still in the test phase and want to delete your test data before the production startup. 

- If you have transferred budget for a future year to the production system using batch input and 

you want to delete the existing budget data for the current year. 

Standard settings 

SAP does not deliver any standard settings. 

Activities 
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1. Specify the scope of data you want to delete. 

2. Specify whether you first want to create a test run in order to get an overview of the data that will be 

deleted in the current selection. 

3. Run the report. 

36.3.1.3.1.8 Business Add-Ins for GM Budgeting 

36.3.1.3.1.8.1 BAdI: Budget Document Consistency Checks 

Use 

Use this step to implement the enhancement for non-standard budget document validations to be carried 

out before you post a budget document in Grantee Management (GM-GTE). The sample code for this 

BAdI illustrates how you can include messages in the standard log of the budget workbench. If an error 

then occurs, an appropriate message describes the problem. 

The parameters of the BAdI method are as follows: 

- I_F_HEADER: Importing parameter with data of the header document 

- I_T_LINES: Importing parameter with GM-GTE detail data 

- I_T_FYD_LINES: Importing parameter with Funds Management (FM) detail data if there is any (if 

FM integration is active in the award phase) 

- I_REF_LOG:Changing parameter to append messages to the budget workbench log 

- This BAdI is designed to code any number of validations that will be executed sequentially, 

allowing you to structure a series of validations. 

Import parameters are "read only" so that the implementations do not change any value. 

Activities 

After you call up the IMG activity, a dialog box appears: 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 
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3. Click on BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click on entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method <Interface name> ~ <Name of 

method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.3.1.3.1.8.2 BADi: Budget Transfer to Funds Management 

This method allows you to perform checks or changes to the transfer of the lines in the Grants 

Management (GM) budget into the distribution to Funds Management (FM) budget. The interface 

receives the original GM lines and the result of the standard transfer/distribution to 

FM. 

Read-only access to the header of the new document in FM, as well as the application log in 

GM, is also provided. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 
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5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.3.1.8.3 BAdI: Allow Grant Planning in Funds Management 

Use 

Use this enhancement whenever you need to plan on grants within Funds Management. This planning 

activity is only allowed for versions that are not operative and therefore not for grants that have been 

awarded. The awarded budget for a grant will always remain in Grants Management (GM) and later on, if 

the integration exists, will be transferred automatically to Funds Management. GM owns all the rules for 

every given grant. 

If you try to copy plan budget in BCS into and productive version, the grant information will not be 

transferred. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 
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4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.3.1.8.4 BAdI: Budget Document BAPI 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management. 

Title 

Business Add-In: Customer Enhancement for Entry Document 

Use 

With this Business Add-In you can define customer enhancements related to the business object 

BudgetEntryDocGM (BUS0036) . 

It can only be implemented for Grants Management budgeting. 

The methods of this BAdI are called during the processing of the business object methods. 

Standard settings 

SAP does not deliver any implementations of this BAdI. Therefore, in the standard release, the BAdI is 

not active. 

Activities 

If you want to handle customer specific fields for entry documents, you should first define the 

corresponding customer include (CI_GMBDGTHEADER). 

Now implement this BAdI applying the following steps: 
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After you call up the Customizing activity, a dialog box appears, where you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at alater time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

Activate your BAdI implementation. 

Requirements 

Recommendation 

Only use character-like fields in the structure. 

Further notes 

Documentation for method CREATE_IN 

Documentation for method CREATE_OUT 

Documentation for method GETDETAIL_IN 

Documentation for method GETDETAIL_OUT 

Documentation for method GETLIST_IN 
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Documentation for method GETLIST_OUT 

Documentation for method REVERSE_IN 

Documentation for method REVERSE_OUT 

36.3.1.3.1.8.5 BAdI: Creation of Accounting Documents 

Use 

This Business Add-In (BAdI) is used in the Grantee Managment (GM-GTE) component. You can use 

this BAdI to automatically post accounting documents while you are posting awarded contributions using 

the following transactions and/or Business Application Programming Interfaces (BAPIs): 

- To post a GM budget document, you can use the following: 

- GM_CREATE_BUDGET 

- GM_BDGT_COPY 

- BAPI_0036_CREATE 

- To post a previosly parked GM budget document, you can use GM_MODIFY_BUDGET. 

- To post a GM budget document with status Released, you can use GM_BDGT_RELEASE. 

- To reverse a GM budget document, you can use GM_MODIFY_BUDGET or 

BAPI_0036_REVERSE. 

To automatically post accounting documents, you must implement the POST method for this BAdI. 

The calling program uses the result as follows: 

- If you are using GM_CREATE_BUDGET, GM_MODIFY_BUDGET, GM_BDGT_RELEASE or 

GM_BDGT_COPY, the following is true: 

- If the posting of the accounting document fails, the GM budget document is not posted and the error 

from the BAdI is displayed in the application log of the calling program (ROLLBACK WORK is 

executed by the calling program). 

- If the posting of the accounting document does not fail, the GM budget document is posted with the 

accounting documents (COMMIT WORK is executed by the calling program). 

- If you are using BAPI_0036_CREATE or BAPI_0036_REVERSE, the messages in the 

application log are moved to the RETURN interface table. The customer program does or does not 

post the GM document with the accounting documents (using 

BAPI_TRANSACTION_COMMIT or BAPI_TRANSACTION_ROLLBACK). 

If you posted your accounting documents with the following reference fields, you can display the 

accounting documents related to a GM budget document from the budgeting workbench transactions by 

choosing Environment > Related Document. 
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- AWTYP = GMBD 

- AWREF = Concatenation of GM budget document number and company code 

To check your accounting documents without postings, you can use BAdI: Budget Document 

Consistency Checks. 

Requirements 

- GM and funds management (FM) budget documents were checked successfully. 

- You are creating one of the following GM budget documents: 

- GM budget document with a Posted or Preposted Posted document state and 

Released budget status 

- GM budget reversal document with a Posted or Preposted Posted document state and Released 

budget status 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

Implement this BAdI in the POST method by doing the following: 

1. Map the following information to the interface fields to be given to the BAPI or function module 

that you use to post your accounting documents. The information related to the GM budget 

document is available in the method interface: 

- I_F_DOCID 

GM budget document number 

- I_F_HEADER 

Header fields of the GM budget document 

- I_T_LINES 

GM line item fields of the GM budget document 

- I_T_FYD_LINES 

FM line item fields of the GM budget document 

- I_F_FM_OBJECTS 

FM interface objects 

- I_F_GMGR 

Attribute fields of the incoming grant 

- I_REF_LOG 

Instance of the application log of the GM budgeting workbench 
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2. To save the link between the GM budget document and the accounting documents, map the 

reference fields of your accounting documents in the following way: 

- AWTYP = GMBD 

- AWREF = Concatenation of GM budget document number and company code 

3. Call the BAPI or function module used to create your accounting documents. Do not perform the 

COMMIT inside this BAPI or function module. 

4. Use the result in the following way: 

- If the posting of the accounting documents fails, display the error messages in the application 

log I_REF_LOG and raise the exception EX_POSTING_FAILED. 

- If the posting of the accounting documents does not fail, you can display an information 

message containing the accounting document numbers in the application log I_REF_LOG. 

36.3.1.3.2 Availability Control 

36.3.1.3.2.1 Prepare Activation of Availability Control 

Availability Control in Grants Management Budgeting 

The active availability control (AVC) works on the summarization and saving of all the overall 

consumable budget (= Budget for Consumption) and amounts already consumed (= Budget 

Consumption) in ledgers. 

In the IMG activity Check Standard Customizing of Availability Control, you ensure that all necessary 

standard Customizing settings that SAP delivers and those you require for the IMG activities of AVC are 

available. 

In the IMG activity Define Filter Settings for Consumable Budget, you determine which budget values of 

Grants Management (GM) budgeting are relevant for AVC. 

In the IMG activity Define Account Assignment Derivation of Availability Control Objects, you define to 

which GM account assignment of the ledger (=Control Object) a posting activity is summarized. In 

principle, therefore, it is possible for the values of GM account assignment elements to be set to initial in 

the control object or to use different values for the GM account assignment elements in the control object 

than in the budget entry posting or in the budget usage posting. 

Tolerance Profiles allow you to group together availability tolerance limits for different Activity Groups. 

You must assign a tolerance profile to the AVC ledger and to your company code for each organizational 

fiscal year. Specific assignments are also possible - for example, for particular GM account assignments 

in the AVC ledger - using a derivation strategy for finding an alternative tolerance profile. 
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Before you can update values and carry out availability checks in a ledger, you have to activate the ledger 

in the IMG activity Maintain Activation Status for GM Availability Control Ledger. To do this, you have 

different Activation Statuses at your disposal. 

Recommendation 

Enter the Customizing settings for AVC in the same order as the individual IMG activities appear in the 

IMG structure. 

See also 

For more information, see GM-GTE Customizing: Availability Control in SAP Library for 

SAP ERP under SAP ERP Central Component -> Accounting -> Public Sector 

Management -> Grants Management -> Grantee Management -> Customizing Grantee 

Management -> GM-GTE Customizing: Basic Settings and Global Settings -> GM-GTE 

Customizing: Budgeting and Availability Control. 

36.3.1.3.2.2 Check Standard Customizing of Availability Control 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you check whether the standard Customizing delivered by SAP required for 

activating availability control exists in the current client. 

Any missing settings can be transferred from client 000 if required. 

Note 

Missing Customizing settings are not automatically transferred to a transport request. Therefore, it is 

recommended that you also execute this IMG activity in your target system or in your target client. 

36.3.1.3.2.3 Activity Groups 

36.3.1.3.2.3.1 Edit Activity Groups 

In this IMG activity you can display the activity groups delivered by SAP and create your own activity 

groups. The entries you make here apply only to budgeting in Grants Management (GM). 

Recommendation 

Avoid changing or deleting the activity groups delivered by SAP. 
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Activities 

1. Select New Entries and define the key and name of the activity groups. 

2. Save your entries. 

36.3.1.3.2.3.2 Edit Derivation Strategy for Activity Groups 

Use 

In this Customizing activity you can adjust the strategy for the activity groups derivation delivered by 

SAP. 

The activity groups are derived from different parameters, for example from the CO Activity or the GM 

Value Type of a document item. 

Note that the settings you enter here only apply for budget usage posting in Grants Management (GM), 

but not for budget entry postings in GM. 

The derivation strategy comprises steps that use one of the following derivation methods: 

- Assignment 

In the assignment step, you can assign a certain value to the activity group. 

- Derivation rule 

In the derivation rule step, you assign certain values as input parameters (source fields) to an activity 

group as target field. 

All derivation steps defined here can be linked to conditions that must be met in order that the derivation 

step can be executed. 

Example 

You wish to derive certain activity groups directly from the CO activity. To do this you create a 

derivation rule step with source field CO Activity and target field Activity Group. Then maintain 

derivation rules for all relevant CO activities. 

36.3.1.3.2.4 Edit Tolerance Profiles 

Use 

You define the tolerance profile for the availability control (AVC) in this IMG activity. 

In a tolerance profile you group together the tolerance limits for the different activity groups. You can 

define one or more tolerance limits for each activity group by specifying different usage rates. You also 
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define the check sequence of the different tolerance limits. Assign a message type to each of these 

defined check events. The message can be an error message, a warning, or an information message. 

Event control 

You can assign an availability control event to each check point which is triggered if you post your 

document despite the tolerance limit being exceeded. At the moment, you can only send mails from SAP 

office for this. 

Deactivating individual check events 

You can exclude individual check events from the active availability control by setting the Inactive 

indicator. 

Procedure for searching for matching entries 

The active availability control proceeds as follows when searching for matching entries: 

a) Determines the tolerance profile to be used 

b) Derives the activity group 

c) Determines all matching entries (check events with their tolerance limits) of the tolerance 

profile 

d) Checks the tolerance limit in inverted sequence of the check events, so starting with 

the highest percentage tolerance limit 

e) Determines the action (message type and, if necessary, event) when the first of these tolerance 

limits is exceeded 

f) Suppresses the action found, if the Inactive indicator is set for the entry 

Note 

Note that all percentage tolerance limits for each activity group must be entered in sequence (increasing 

order). 

Example 

The tolerance limits of the availability control for actual postings (activity group 40) could, for example, 

be defined in a tolerance profile such as this: 

Activity group Sequence Usage rate % Message Type 

40 01  70 Information 

40 02  85 Warning 

40 03  100 Error Message 

Standard settings 

If no matching entry is found for a tolerance profile, the checks are carried out according to the following 

standard setting: 

- Message type: Error message 

- Consumption rate: 0% 
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- Check active 

36.3.1.3.2.5 Settings for Availability Control Ledger 

36.3.1.3.2.5.1 Create User-Defined Ledger for Availability Control 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you define new (user-defined) availability control (AVC) ledgers by using an 

existing ledger as a template or reference ledger. Either the ledger 9K SAP delivers or another ledger you 

have already defined can serve as copy template or reference ledger. 

You define from which fiscal year the reference ledger settings should be copied for this copy process. 

You create the validity with a From Fiscal Year. 

To check whether the Customizing settings of the reference ledger are complete or which settings you 

still have to define in order to use the reference ledger in your company code, choose Check Reference 

Ledger Customizing. 

The following settings and assignments are copied from the reference ledger: 

- AVC filter settings for budget values 

- Assignment of the strategy for account assignment derivation for control objects 

- Assignment of the default tolerance profile 

- Assignment of the strategy for overriding the default tolerance profile 

- Activation status of the ledger 

The new ledger and the settings are automatically copied to the following IMG activities: 

- Define Filter Settings for Consumable Budget 

- Assign Attributes for GM Availability Control Ledger 

- Maintain Activation Status for GM Availability Control Ledger 

Note that the activity status of a newly created AVC ledger is Ledger not active. 

You can now change the generated settings in these IMG activities. 

Note: 

Copying an AVC ledger is only supported within a company code. 

The key and the description of your new ledger are entered with the copy process. The key cannot be 

changed later, but you can adjust the description of the new ledger in the IMG activity Adjust Ledger for 

User-Specific Availability Control. 
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Standard settings 

SAP delivers the ledger 9K for use with GM availability control. 

This ledger is ready for use in GM AVC - for normal business operations there is no need to create your 

own AVC ledger for GM. 

Activities 

If you really need your own AVC ledger, for example to establish parallel AVC checks, to supplement the 

standard AVC checks in ledger 9K, proceed as follows: 

1. Create a new AVC ledger by copying an existing reference ledger as a template. If the reference 

values copied from the reference ledger are not valid for your new ledger, you can change the 

Customizing definitions of your new ledger in the IMG activities of section Settings for 

Availability Control Ledger. 

2. Activate the new AVC ledger by setting the appropriate Activation Status in the IMG activity 

Maintain Activation Status for GM Availability Control Ledger. 

3. Reconstruct availability control in the new AVC ledger using the program Re-Initialize Availability 

Control Ledgers (GM) (transaction code GMAVCREINIT). 

You start the reconstruction of availability control from the GM Grantee menu: Choose Budgeting 

-> Tools -> Availability Control -> Reconstruct. 

36.3.1.3.2.5.2 Adjust Ledger for User-Specific Availability Control 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you can change the description of all GM availability control ledgers. 

By default, availability control (AVC) is set up in such a way as to check budget consumption from 

actual/commitment data (data source 0 or data source for defining consumed amounts) against budget 

values entered in Grants Management (GM) (data source 1 or data source for defining the consumable 

budget). 

In this activity, you can define a different user-specific AVC by defining the check as budget against 

budget. To do this, choose the entry GMBP as data source 0 for your user-specific AVC ledger, instead 

of the default value GMUP for data source 0 (or data source for defining consumed amounts). 

This kind of AVC can be used, for example, if you want to specify a 'frame budget' entered as budget 

values for data source 1, which should not be exceeded by normal budget allocations entered as budget 

values for data source 0. 

Notes: 
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If you want to define such a user-specific AVC in your organization, note the following: 

- For such checks, you must use user-specific AVC ledgers and not the ledger 9K delivered by SAP. 

- You must also specify budget filter settings in the activity Define Budget Values as Consumed 

Amounts for each ledger using the entry GMBP as data source 0. 

36.3.1.3.2.5.3 Define Filter Settings for Consumable Budget 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you determine the consumable budget, or in other words, you stipulate, which 

budget values entered in GM define the consumable budget against which availability control (AVC) 

checks budget usages (= commitment or actual values). 

You can set filter values for the following attributes: 

- Version 

- WF-STATUS combination 

With the WF-STATUS combination, you define whether only posted budget or also preposted budget is 

included in AVC. If you want to permit preposted budget for AVC, the following security principle (or 

'principle of maximum prudence') applies: preposted budget is only included by AVC, if it decreases the 

consumable budget. 

Example 

You want to define the budget of version 002 from a given fiscal year as consumable budget. 

Enter the value 002 for the version and a fiscal year (From Fiscal Year) in this IMG activity. 

Note that the settings defined here apply to all fiscal years beginning with this 'from fiscal year', if you do 

not make any other entries for future fiscal years. 

Standard settings 

SAP does not provide any default settings. 

Activities 

1. Enter your Control Ledger and the From Fiscal Year. 

2. Enter the Budget Version and choose whether AVC should also include preposted budget values. 

3. Save your entries. 

36.3.1.3.2.5.4 Define Budget Values as Consumed Amounts 
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Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you define which budget values should be considered as 'consumed amounts' for 

availability control (AVC). 

Note that this IMG activity is only relevant for AVC ledgers, which use budget values as data source 0. 

Such user-defined AVC ledgers can be used for specific budget consistency checks, permitting to check 

budget values against the consumable budget, instead of checking budget usages against the consumable 

budget. 

An AVC ledger checking ' budget against budget' must be configured in the following IMG activities: 

- Create User-Defined Ledger for Availability Control and 

- Adjust Ledger for User-Specific Availability Control, where you must select the value GMBP as 

data source 0. 

In addition to maintaining filter settings for the consumable budget in the IMG activity Define Filter 

Settings for Consumable Budget, you must also specify filter settings here for such user-defined AVC 

ledgers, which define how budget values are recognized as 'consumed amounts'. 

You can set filter values for the following budget attributes: 

- Version 

- WF-STATUS combination 

With the WF-STATUS combination, you define whether only posted budget or also preposted 

budget is included in AVC. If you want to permit preposted budget for AVC, the following security 

principle (or 'principle of maximum prudence') applies: preposted budget is only included by AVC, 

if it increases the 'consumed amount'. 

Example 

You want to define the budget of version 001 from a given fiscal year as 'consumed amount'. 

Enter the value 001 for the version and a fiscal year (From Fiscal Year) in this IMG activity. 

Note that the settings defined here apply to all fiscal years beginning with this 'from fiscal year', if you do 

not make any other entries for future fiscal years. 

Standard settings 

SAP does not provide any default settings. 

Activities 

1. Enter your Control Ledger and the From Fiscal Year. 

2. Enter the Budget Version and choose whether AVC should also include preposted budget values. 

3. Save your entries. 
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36.3.1.3.2.5.5 Define Account Assignment Derivation of Availability Control 

Objects 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you define a strategy for deriving Grants Management (GM) account assignments 

for GM availability control. 

Each GM account assignment, where you create budget or to which you post a budget usage, is assigned 

an account assignment in the availability control ledger. In this IMG activity, you define the logic on how 

the account assignments of the availability control ledger (or thecontrol objects) should be derived from 

the GM account assignments, where you create budget or where you post a budget usage. 

The derivation strategy consists of a sequence of steps that uses one of the following derivation methods: 

- Initialization 

In the initialization step, you can set individual GM account assignment elements of the control 

object to the blank value (SPACE). 

- Assignment 

In the assignment step, you can assign constant values to the account assignment elements of the 

control object, or you can determine whether the value of individual GM account assignment 

elements should be copied partially or in full to the account assignment elements of the control 

object. 

- Derivation rule 

In the derivation rule step, you can define a table of source and target fields to directly determine the 

account assignment elements of the control objects. After defining the derivation rule table, you 

must enter table entries with different values for the source and target fields, thus defining the 

desired values of the target fields for each combination of entered values of source fields. 

- Table lookup 

In the table lookup step, you can access individual records from database tables. 

- Function module 

In the function module step, you can execute a function module to carry out specific assignments, 

for example after reading the Grant master data. 

All derivation steps defined here can be linked to conditions, which must be met in order that the 

derivation step can be executed. 

Example 

You want to summarize the consumable budget in the availability control ledger in the following way 

when entering budget values: 
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Budget Account Assignments 

Fund/Spons.Prog./Spons.Class/Validity no. 

Fund/Spons.Prog./Spons.Class/Validity no. 

Control Objects 

FND1/SP1/SC1/VN1 -> FND1/SP1/SC1/VN1 

FND1/SP2/SC2/VN2 -> FND1/SP1/SC2/VN1 

FND1/SP3/SC3/VN3 -> FND1/SP1/SC3/VN1 

A possible derivation strategy in this case consists of four assignment steps, which copy the value of the 

fund and of the sponsored class in full to the relevant account assignment elements in the control object, 

and which assign a constant value to the sponsored program and the budget validity number of the control 

object. 

Standard settings 

SAP provides an empty strategy 9KSAP000, which you can enhance according to your requirements. 

Note 

If you do not have to carry out a summarization of budget and posting values in one of your availability 

control ledgers, that is, if all control objects in this ledger match the GM account assignments, where you 

create budget or post a budget usage, then you can either leave the derivation strategy empty, or leave the 

field Strategy for Deriving Control Objects empty in the IMG activity Assign Attributes for GM 

Availability Control Ledger. 

Activities 

1. Edit the strategy 9KSAP000 and add your derivation steps. 

2. Save your strategy. 

Changed strategies are not automatically written to a transport request. You must add them to a 

transport request manually. 

36.3.1.3.2.5.6 Maintain Derivation Strategy for Overriding the Standard 

Tolerance Profile 

Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this IMG activity, you define a strategy to override the standard tolerance profile. 
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Availability control normally uses the standard tolerance profile, that you have assigned in the IMG 

activity Assign Attributes for GM Availability Control Ledger, for checks, unless you specify a 

derivation strategy, which overrides this standard tolerance profile. 

You define tolerance profiles in the IMG activity Edit Tolerance Profiles. 

The derivation strategy consists of a sequence of steps that uses one of the following derivation methods: 

- Initialization 

In the initialization step, you can set the tolerance profile to the initial (or blank) value. 

- Assignment 

In the assignment step, you can assign a constant value to any target field (for example, the 

tolerance profile), or you can determine whether the value of a source field should be copied 

partially or in full to a target field. 

- Derivation rule 

In the derivation rule step, you can define a table of source and target fields to directly determine the 

value of some target fields (for example, of the tolerance profile). After defining the derivation rule 

table, you must enter table entries with different values for the source and target fields, thus defining 

the desired values of the target fields for each combination of entered values of source fields. 

- Table lookup 

In the table lookup step, you can access individual records from database tables. 

- Function module 

In the function module step, you can execute a function module to carry out specific assignments, 

for example after reading some master data. 

All derivation steps defined here can be linked to conditions, which must be met in order that the 

derivation step can be executed. 

Standard settings 

SAP provides an empty strategy 9KSAP000, which you can enhance according to your requirements. 

Activities 

1. Edit the strategy 9KSAP000 and add your derivation steps. 

2. Save your strategy. 

Changed strategies are not automatically written to a transport request. You must add them to a 

transport request manually. 

36.3.1.3.2.5.7 Assign Attributes for GM Availability Control Ledger 
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Note: 

The settings affected here are exclusively reserved for the use of Grants Management (GM). 

Use 

In this Customizing activity, you assign a standard tolerance profile and various derivation strategies to 

the availability control ledgers you are using in Grants Management (GM). 

You can override the standard tolerance profile defined in this activity by specifying a derivation 

strategy for searching for an alternative tolerance profile. 

The other derivation strategy determines the GM account assignments in the AVC ledger (= control 

objects) from the GM account assignments of your budget usage postings or budget entry postings. 

You make your assignments per fiscal year. Note that the settings are effective from the fiscal year you 

entered as From Fiscal Year onwards. 

Example 

You want to maintain attributes for ledger 9K, fiscal year 2010 and all following fiscal years. To do this, 

make the following entry: 

9K  |  2010  |  ... 

You want to change the settings for ledger 9K, effective from fiscal year 2015 onwards. To do this, 

add the following new entry: 

9K  |  2015  |  ... 

Activities 

1. Maintain entries for all the availability control ledgers you want to use and specify the standard 

tolerance profile. 

2. If required, specify the strategy for deriving the control objects or the derivation strategy for 

overriding the standard tolerance profile. 

3. Save your entries. 

36.3.1.3.2.5.8 Define Checking Horizon 

36.3.1.3.2.5.8.1 Assign Standard Value for Checking Horizon 

Use 

In this IMG activity, you define how the checking horizon is selected for availability checks in a specified 

control ledger. 

You can choose between the following values for the field Selection of Checking Horizon: 

- " " - Annual Period: The default value Annual Period is used for checks in this control ledger, 

which means that availability control will normally aggregate data over all periods of a fiscal year 

and thus perform checks on annual values. 
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- "O" - Overall Period: The default value Overall Period is used for checks in the selected control 

ledger, which means that availability control will normally aggregate data over all periods of all 

fiscal years and therefore perform checks on overall values. 

You can overwrite the default values in the IMG activity Define Special Assignments for Checking 

Horizon. 

Standard settings 

"O" (overall) is the default value for the Selection of Checking Horizon field, if you do not specify any 

value for a control ledger. 

Activities 

1. Select your company code. 

2. Enter values for all relevant control ledgers. 

3. Save your entries. 

36.3.1.3.2.5.8.2 Define Special Assignments for Checking Horizon 

Use 

In this IMG activity, you can define specific assignments for the checking horizon by implementing a 

derivation strategy. This specific assignment overwrites the standard value of the checking horizon 

selected in the activity Assign Standard Value for Checking Horizon. 

Notes 

The derivation strategy consists of a sequence of steps that uses one of the following derivation methods: 

- Initialization 

In the initialization step, you can set an individual target field to the initial (or blank) value. 

- Assignment 

In the assignment step, you can assign a constant value to any target field, or you can determine 

whether the value of a source field should be copied partially or in full to a target field. 

- Derivation rule 

In the derivation rule step, you can define a table of source and target fields to directly determine 

the value of some target fields. After defining the derivation rule table, you must enter table entries 

with different values for the source and target fields, thus defining the desired values of the target 

fields for each combination of entered values of source fields. 

- Table lookup 

In the table lookup step, you can access individual records from database tables. 

- Function module 
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In the function module step, you can execute a function module to carry out specific assignments, 

for example after reading master data. 

All derivation steps defined here can be linked to conditions, which must be met in order that the 

derivation step can be executed. 

Example 

You have selected the checking horizon Overall Period as default value for control ledger 9K in the IMG 

activity Assign Standard Value for Checking Horizon. But for availability checks on control objects with 

certain values of the account assignment element Grant, you can overwrite this default value and use the 

checking horizon Annual period for checks with control ledger 

9K. 

Create a derivation step of step type Derivation rule, select Definition and choose as source field the 

field RGRANT_NBR and as target field the field CHECKHORIZON. 

Then select Condition and enter it as the condition for this derivation rule: 

Name of column Value 

Field ALDNR 

Op. = 

Value 9K 

After saving this new derivation step, maintain rule entries for all desired grant values. 

Standard settings 

SAP does not provide any standard implementation of the derivation strategy. 

Activities 

1. Implement your derivation strategy. 

2. Save your strategy. 

Changed strategies are not automatically written to a transport request. You must add them to a 

transport request manually. 

36.3.1.3.2.6 Maintain Activation Status for GM Availability Control Ledger 

Use 

Before you can use active availability control (AVC) in Grants Management (GM), you must activate 

your availability control ledger from a specific fiscal year. 

In this Customizing activity, you can select one of the following activation statuses: 

- Ledger not active 

Neither budget usages nor budget values are written to the availability control ledger; no checks are 

performed. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 480 

- Active without availability checks 

Values are written to the availability control ledger, but no checks are performed. 

- Active with usual check logic 

If you make this setting, credits are always permitted and never trigger an availability control error 

message. Instead of an error message, a warning message is issued. 

- Active with soft check logic 

Similar to the previous activation status, credits are always allowed by availability control. In this 

case, if the available amount is not reduced by any posting events, the system stops all AVC 

messages. 

- Active with strict check logic for document chains 

Values are posted to the availability control ledger and availability checks are performed. With the 

exception of documents within a document chain, the usual check logic described above is applied. 

However, for documents referencing another document that has already consumed budget, strict 

check logic is applied. This means that such documents are checked again, even if they do not 

consume more budget than already consumed by the referenced document. 

- Active with strict check logic 

Values are posted to the availability control ledger and availability checks are always performed 

without any message type conversion. This also implies that the system may prevent documents 

from being posted, even if they increase the available amount on a control object. 

Activities 

1. Choose a fiscal year (From Year) and an activation status for an availability control ledger you 

want to use. 

2. Save your entry. 

36.3.1.3.3 Revenues Increasing the Budget 

36.3.1.3.3.1 Define Derivation Strategy for GM RIB Objects 

Use 

Use this step to define the account assignment derivation for RIB objects used for revenues increasing the 

budget (RIB) in Grants Management (GM). 

GM RIB objects serve two basic functions: 

- Aggregation of revenues and, if applicable, of revenue budget. 

Posted revenues are assigned to a GM RIB object using the derivation strategy defined in this IMG 

activity.  If you define RIB rules using relative limits (or thresholds), you have to enter revenue 

budget values for the posting/budget dimensions assigned to an RIB object, aggregating the 

revenue budget from several posting/budget addresses. 

- Assignment of RIB rules 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 481 

Each rule for revenues increasing the budget must be assigned to a RIB object (= a particular 

revenues posting/budget address). In a rule, you specify the amount available for a budget increase, 

the relevant type of revenues, and the receiving expenditures budget dimensions. 

Notes 

The derivation strategy for RIB objects consists of a sequence of derivation steps that are executed in the 

given order and which use one of the following step types: 

- Initialization 

In derivation steps of step type Initialization you can set the value of any target field to its initial 

value (usually = SPACE). 

- Assignment 

In steps of step type Assignment, you can assign the value of any source field or a constant value to 

some target field. 

- Derivation rule 

In derivation steps of step type Derivation rule, you can set up database tables, where you can enter 

combinations of values of source fields corresponding to certain combinations of target fields. 

- Table lookup 

In steps of step type Table lookup, you can access single individual records of database tables. 

- Function module 

In steps of type Function module, you can call a specific function module, for instance, for reading 

master data attributes of account assignment elements, or for searching for account assignment 

elements in master data hierarchies. 

All derivation steps defined here can be linked to conditions which must be met in order for the derivation 

step to be executed. 

Standard settings 

We do not deliver any standard implementation for the derivation strategy for GM RIB objects. 

Activities 

1. If required, edit the derivation strategy by adding appropriate derivation steps. 

2. Save your strategy. 

3. Test or transport your strategy using the appropriate buttons or menu functions. 

Further notes 

- The value of each account assignment element of the GM RIB object is identical with the value of 

the posting address, provided there is no step in the derivation strategy that changes the value of this 

target field. 
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36.3.1.3.3.2 Maintain Calculation Rule for GM RIB 

Use 

Use this step to maintain the calculation formulas to be used for defining rules for revenues increasing the 

budget (RIB) in Grants Management (GM). 

With a calculation formula, you can define: 

- The percentage of collected revenues that will be relevant for a budget increase (usually = 100%) 

- A lower limit for revenues with budget-increasing effect 

- An upper limit for revenues with budget-increasing effect 

You have the option to work without lower or upper limits. If you decide to set up a lower or upper limit, 

then you have to choose the type limit (for instance, absolute value or relative percentage) and enter a 

value for it. 

If you do not work with limits or if you only set up limits using absolute values, it is not necessary to 

enter revenue budget. Revenue budget values are only needed to calculate limits which are defined by 

relative percentages. 

Standard settings 

SAP only delivers the standard formula 1000 as template. 

Activities 

1. Create your own calculation formulas using the grant currency. 

2. Save your calculation formulas. 

Example 

You set up the following calculation formula: 

- Relevant percentage of revenues: 50% -

 Lower limit: absolute value = 

$1,000 

- Upper limit: relative percentage = 200% 

The current revenue budget amount may be $1,500, which means that the upper limit will be equal to 

$3,000. 

If you have collected revenues of $1,800, then this will not be sufficient for a budget increase, because 

only 50% of the revenues - that is, $900 - enter the calculation. 

If the collected amount of revenues is $4,000, then $2,000 will become relevant. Since this amount 

exceeds the lower limit of $1,000, the amount of $1,000 (out of $2,000) has a budget increasing effect 

and may be distributed to some expenditure budget address. 
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If no surplus budget address is used, then revenues up to $6,000 may have budget increasing effect, 

because of the upper limit given by the current revenue budget of $1,500, multiplied by a factor of 2, as 

defined by the upper limit. Therefore the maximum budget increase will be $2,000 (= upper limit - lower 

limit), which is reached with collected revenues of $6,000. 

Further notes 

- Each calculation formula must be assigned to a currency. This currency must be identical to the 

grant currency for which calculation formula is to be used. 

- Usually, only the revenues between the lower and upper limit will have a budget-increasing effect. 

You may, however, set up rules RIB that use surplus budget addresses. If you do, you must set the 

indicator Use Surplus Amount?. This indicator refers to revenues that exceed the upper limit as 

defined in the calculation formula, and will then increase the budget of the assigned surplus budget 

address. 

- Revenues below the lower limit or residual revenues from calculation formulas with percentages < 

100% have no budget-increasing effect. 

36.3.1.3.3.3 Maintain Derivation Strategy for Rule Generation 

Use 

Use this step to maintain the derivation strategy for proposing values for automatic generation of rules 

for revenues increasing the budget ("RIB rules"). 

This derivation strategy allows for assigning values relevant to the definition of RIB rules. You must 

assign the following values to a given RIB object, in this way defining the source fields: 

- Activation status 

- Filter profile - Calculation formula 

- Indicator Use surplus amount? 

- Receiving expenditures budget address (fixed percentage = 100%) 

- Surplus budget address (fixed percentage  = 100%), if the indicator Use surplus amount? is set 

Notes 

The derivation strategy for the generation of RIB rules consists of a sequence of derivation steps that are 

executed in the given order and which use one of the following step types: 

- Initialization 

In derivation steps of step type Initialization you can set the value of any target field to its initial 

value (usually = SPACE). 

- Assignment 

In steps of step type Assignment, you can assign the value of any source field or a constant value to 

a target field. 

- Derivation rule 
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In derivation steps of step type Derivation rule, you can set up database tables, where you may enter 

combinations of values of source fields that should correspond to certain combinations of target 

fields. 

- Table lookup 

In steps of step type Table lookup, you can access single individual records of database tables. 

All derivation steps defined here can be linked to conditions that must be met in order that the derivation 

step can be executed. 

Requirements 

You have performed both the other steps in the IMG for GM RIB. 

Standard settings 

We do not deliver any standard implementation of the derivation strategy. 

Recommendation 

If you want to generate rules for revenues increasing the budget using the program Generate RIB Rules 

(transaction GMRBGENMD), you must implement this derivation strategy. 

Activities 

1. Edit the derivation strategy by adding appropriate derivation steps. 

2. Save your strategy. 

3. Test or transport your strategy using the appropriate buttons or menu functions. 

Further notes 

- For further details on the automatic generation of RIB rules, refer to the documentation of the 

program Generate RIB Rules. 

- Only a single receiving expenditures budget address (with fixed percentage = 100%) can be assigned 

with this derivation strategy. If you want to maintain multiple receivers, you can add them manually 

in the transaction Process Single RIB Rule (transaction code 

GMRBRULE). 

- If you do not specify derivation steps for the account assignment elements of the receiving 

expenditures budget address, all the values of these account assignment elements will be identical to 

the values of the RIB object. Since the RIB object, however, is a revenues budget address, this will 

cause an error message. Therefore, you must in any case specify the value of the account assignment 

element sponsored class. 

- A surplus budget address can only be assigned if the indicator Use Surplus Amount is set. In 

addition, the surplus budget address must be different from the receiving expenditures budget 

address. 
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36.3.1.3.4 Workflow Settings 

36.3.1.3.4.1 Budget Workflow Settings 

Use 

Use this step to activate the Workflow settings required for the simple approval process in Grants 

Management (GM) budgeting. 

Standard settings 

We deliver the system with the process deactivated. 

Activities 

1. In the Task Customizing Overview, you see the task requiring processing. Choose Activate event 

linkage in the Event Linkage column. 

2. In the event triggering screen, open the point GM Simple Approval Process and click the Activate 

switch. 

Simple approval is now active in GM budgeting. The effect of this is that the workflow between proposed 

budget and posted budget is enabled. 

If you have already activated the simple approval process and need to deactivate it, the procedure is the 

same, except that a deactivation switch appears in the event triggering screen instead of the activation 

switch described in step 2 above. 

36.3.1.4 Indirect Costs 

36.3.1.4.1 Configure Indirect Cost Rules 

Use this step to configure the rules governing how indirect cost (IDC) processing for your grants is to 

behave. 

Activities 

1. In the overview screen, enter a number and a text of up to 30 characters describing your IDC rule. 
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2. To add detail, choose Rule Elements in the dialog structure and add the value types that are to be 

subject to the rule. 

36.3.1.4.2 Chart of Account Settings for GM Indirect Costs 

Use this step to enter the chart of accounts settings required for indirect cost (IDC) processing 

in Grants Management (GM). 

Requirements 

You must first have created the chart of accounts you want to use for IDC processing. 

Activities 

Choose New Entries and enter the following: 

- Chart of accounts 

- Grant type 

In the Chart of Account Settings section, specify the individual accounts to be used for specific purposes: 

- Cost reimbursement account 

- Indirect cost recovery (IDCR) class 

- Expense account 

- Indirect cost expense (IDCE) class 

- Cash clearing account 

36.3.1.4.3 Business Add-Ins for GM Indirect Costs 36.3.1.4.3.1 BAdI: Assign 

Alternative Cost Object and Check IDC Relevance 

Use 

In this step, you can execute Business Add-In BADI_GM_IDCPOST to further enhance the way the 

indirect cost calculation for Grants Management (GM) is executed. 
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Standard settings 

If you do not use this BAdI, the system defaults from the grant customizing. The following methods are 

available for enhancement purposes: 

- CHECK_IDC_RELEVANT: Check if record is IDC relevant. 

- FILL_CO_OBJECTS: Fill alternative CO objects. 

- FILL_FM_OBJECTS: Fill alternative FM objects. 

- CLEAR_IRRELEVANT_FIELDS: Clear irrelevant fields for the IDC calculation. 

- FILL_CALC_CO_OBJECTS: Replace CO and FM objects in calculated IDC lines. 

- CLEAR_CALC_CO_OBJECTS: Clear CO and FM objects in calculated IDC lines. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.3.1.5 Cost Sharing 

36.3.1.5.1 Configure Cost Sharing Rules 

Where a grantor requires that you, as grantee, must bear some of the costs of a project, use this step to 

configure the necessary rules. 

Standard settings 

We deliver the following cost sharing bases as standard. These are: 

- Total Direct Costs - Additive 

External funded amount * Cost sharing rate 

- Total Grant Costs - Additive 

Awarded cost * Cost sharing rate 

- Total Direct Costs - Subtractive 

(Grant cost - Overhead ) * Cost sharing rate 

- Total Grant Costs - Subtractive Grant cost * Cost sharing rate 

Activities 

Choose New Entries and enter a rule number and text. Choose which of the supported bases is to apply to 

the new rule. 

36.3.1.6 Billing 

36.3.1.6.1 Configure GM Billing Rules 

Use 

Use this step to configure billing rules governing how billing is to behave in your Grants Management 

(GM) installation. 

Standard settings 

We supply the following rules as standard: 

- 1 = Resource-related billing (RRB) payments 

- 2 = RRB commitments 
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- 3 = RRB liabilities 

- 5 = Milestone billing 

- 6 = Periodic billing 

- 7 = Manual billing 

- 11 = RRB with billing plan 

Activities 

Enter any or all of the above rules in the overview. Apart from rule 7, if you want to permit manual 

billing in grant types using a billing type, check the Manual Billing box for the relevant rule. 

Some of the rules require additional configuration: 

Resource-Related Billing 

RRB requires value types assigned to the rule. Select your RRB rule, choose Value Type Assignment for 

RRB, and enter the desired value type(s). 

For a fuller description of RRB, see the SD documentation. 

Manual Billing 

Where you have stipulated that manual billing is permitted for a rule, select the rule, choose Manual 

Billing Details in the dialog structure, and specify which document type(s) may be billed manually. 

Other 

Specify the SD objects of billing rules by selecting this option in the dialog structure and stipulating the 

SD document type, document item category, and material for the rule. 

36.3.1.6.2 Business Add-Ins for GM Billing 

36.3.1.6.2.1 BAdI: Fill Alternative CO Objects 

Use 

If you have chosen resource-related billing (RRB) as your billing option, you have specified an object in 

Controlling (CO) as your source data. This object is a cost center, WBS element, or internal order. 

You can use this Business Add-In (BAdI) to override the entry made there. You can either specify 

another object of the same kind (say, cost center 2 instead of cost center 1) or a different type of object 

(say, a WBS element instead of an internal order). 

Activities 
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After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.7 Actual and Commitment Update 

36.3.1.7.1 Tools 

36.3.1.7.1.1 Reconciliation of Purchase Requisitions in GM 

Use 

In this step, you can reconcile the commitment data in Grants Management (GM) for the purchase 

requisitions from Materials Management (MM). 

Activities 
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1. Specify a company code. This is required. The other document selection criteria, such as purchase 

requisitions or plants, are optional. 

2. Start the reconciliation in test mode. 

3. If the resulting list shows that there are errors, choose message log to display more detailed 

information. 

4. You can then do one of the following: 

- Correct the defective documents, then run the program again in live mode. 

- Run the program now for the documents that are correct, then run it again later when you 

have corrected the defective ones. 

36.3.1.7.1.2 Reconciliation of Purchase Orders in GM 

Use 

In this step, you can reconcile the commitment data in Grants Management (GM) for the purchase orders 

from Materials Management (MM). 

Activities 

1. Specify a company code. This is required. The other document selection criteria, such as purchasing 

documents, are optional. 

2. Start the reconciliation in test mode. 

3. If the resulting list shows that there are errors, choose message log to display more detailed 

information. 

4. You can then do one of the following: 

- Correct the defective documents, then run the program again in live mode. 

- Run the program now for the documents that are correct, then run it again later when you 

have corrected the defective ones. 

36.3.1.7.1.3 Reconciliation of Earmarked Funds in GM 

Use 

In this step, you can reconcile the commitment data in Grants Management (GM) for the earmarked funds 

from Funds Management (FM). 
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Activities 

1. Specify a company code. This is required. The other selection criteria, such as earmarked funds, are 

optional. 

2. Start the reconciliation in test mode. 

3. If the resulting list shows that there are errors, choose message log to display more detailed 

information. 

4. You can then do one of the following: 

- Correct the defective documents, then run the program again in live mode. 

- Run the program now for the documents that are correct, then run it again later when you 

have corrected the defective ones. 

36.3.1.7.1.4 Reconciliation of Controlling Documents in GM 

Use 

In this step, you can reconcile the Controlling (CO) documents in Grants Management (GM). 

Activities 

1. Specify a company code. This is required. The other selection criteria, such as specific documents or 

fiscal years, are optional. 

2. Start the reconciliation in test mode. 

3. If the resulting list shows that there are errors, choose message log to display more detailed 

information. 

4. You can then do one of the following: 

- Correct the defective documents, then run the program again in live mode. 

- Run the program now for the documents that are correct, then run it again later when you 

have corrected the defective ones. 

36.3.1.7.1.5 Reconciliation of FI Parked Documents in GM 
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Use 

In this step, you can reconcile the commitment data in Grants Management (GM) for parked documents 

from Financial Accounting (FI). 

Activities 

1. Specify a company code. This is required. The other selection criteria are optional. 

2. Start the reconciliation in test mode. 

3. If the resulting list shows that there are errors, choose message log to display more detailed 

information. 

4. You can then do one of the following: 

- Correct the defective documents, then run the program again in live mode. 

- Run the program now for the documents that are correct, then run it again later when you 

have corrected the defective ones. 

36.3.1.7.1.6 Delete GM Actual Line Items 

Use 

Use this step to delete existing data in GM that came from FI if desired. You must do this if the data is 

defective. 

If you want to transfer FI documents to the GM ledger, you must run this step first. 

Activities 

1. Specify the company code(s) and grant fiscal year. The other criteria are optional. 

2. Execute the program. The system confirms when the program has run. 

36.3.1.7.1.7 Transfer FI Documents to GM Ledger 

Use 

In this step, you can transfer FI data to Grants Management (GM). 
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Requirements 

You will be running this program because there is something wrong with the data recorded in GM from 

FI. Before doing so, you need to delete this defective data. 

If you have just installed GM, this deletion is not necessary. 

Activities 

1. Enter the company code(s) and grantee fiscal year(s). The other selection criteria, such as purchase 

requisitions or plants, are optional. 

2. Start the program in test mode. 

3. If the resulting list is in order, you can run the program again in productive mode. 

36.3.1.7.1.8 Transfer MM Documents to GM Ledger 

Use 

In this step, you can transfer MM data to Grants Management (GM). 

Requirements 

You will be running this program because there is something wrong with the data recorded in GM from 

MM. Before doing so, you need to delete this defective data. 

If you have just installed GM, this deletion is not necessary. 

Activities 

1. Enter the company code(s) and grantee fiscal year(s). The other selection criteria, such as purchase 

requisitions or plants, are optional. 

2. Start the program in test mode. 

3. If the resulting list is in order, you can run the program again in productive mode. 

36.3.1.7.2 Business Add-Ins for GM Update 

36.3.1.7.2.1 BAdI: Check GM Update Logic 
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Use 

You can use this BAdI to enhance the check logic in the Grants Management (GM) updating process. 

You can strengthen grant posting controls, check the entire check logic, or opt to skip the standard check 

logic altogether. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.7.2.2 BAdI: Check Posting Authorization 

Use this enhancement to perform authorization checks at time of posting.The checks are Grants 

Management-oriented. 
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Use the following objects: 

- Authority for Grant 

- Authority for Class 

- Authority for Program 

- Function Modules within GMAU can be helpful. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.3.1.8 Integration 

36.3.1.8.1 Activate Integration with Position Budgeting and Control 

If there is a business need to integrate Position and Budget Control (PBC) with Grants Management 

(GM), activate this flag.  This setting ensures that the time slices defined for a grant in GM coincide with 

the first day of the fiscal period that PBC uses to create the commitments to encumber budget for HR 

costs. 

Example 

If a time slice begins on the 15th day of a given month and the fiscal period begins on the 5th day of the 

same month, the time slice is recalculated to begin on the 5th day instead of the 15th dat as originally 

planned. This is a requirement for the integration to work. 

Activities 

For a given company code and date, maintain the Position and Budget Control flag. 

36.3.1.8.2 Business Add-Ins for Integration 

36.3.1.8.2.1 BAdI: Integration with Records Management 

This BAdI is used generically for the Grants - Records Management integration process. 

Method set_visibility is used to determine certain authorization roles for a given record element. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 
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1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.9 Reporting 

36.3.1.9.1 Report Tracking/Monitoring 

36.3.1.9.1.1 Maintain Report Classes 

Use 

You use this step to create report classes for report tracking. Report classes identify the type of report that 

will be used in report tracking; they are user-defined. 

Standard settings 

We do not deliver any standard settings. 

Activities 

In the overview, choose New Entries and enter the following: 
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- An alphanumeric identifier for your report class 

- An additional description of up to 30 characters 

36.3.1.9.1.2 Maintain Schedule Rules 

Use 

Use this step to enter schedule rules for report tracking in Grants Management (GM). 

Activities 

In the overview, choose New Entries and specify the following" 

- An identifier for the new rule 

- A text of up to 40 characters describing the new rule in more detail 

- The periodic property of the rule 

This governs how often the rule is applied. The options are: 

- Single occurrence 

- Daily 

- Weekly 

- Monthly 

- Annually 

- Start date for the rule. The options are: 

- Grant valid from date 

- Grant valid to date 

- System date 

- User-defined date 

If you choose this option, you must use the Business Add-In (BAdI) Define Date for GM 

Report Tracking to determine the relevant date. 

36.3.1.9.1.3 Maintain Report Rules 
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Use 

Use this step to maintain the report rule(s) you will need to enter in your grant master data. 

Activities 

At this time, you can only use the report rules to duplicate the schedule rules. However, you must enter do 

this since you need to enter the report rules in your grant master data. 

Future releases will enhance this development. 

36.3.1.9.1.4 Business Add-Ins for GM Report Tracking 

36.3.1.9.1.4.1 BAdI: Define Date for GM Report Tracking 

Use 

If have selected user-defined start and/or end dates in the schedule rule for report tracking, you use this 

BAdI to determine the relevant date(s). 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 
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7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.9.2 Reporting Business Add-Ins 

36.3.1.9.2.1 BAdI: Enhancement Functions for GM Reporting 

Use 

The SAP BAdI definition is used to enhance the master data index programs in Grants Management. You 

can add more fields in the associated DDic structure of the report and populate those fields in the BAdI 

exits. 

BAdI exit out of the master data index programs. 

Method: GM_EXTEND_GMRXXX 

changing 

<> C_T_FIELDCAT type SLIS_T_FIELDCAT = c_t_fieldcat <> 

C_T_GMRXXX type GMRXXX = G_T_XXX 

Raise: 

   OTHERS = 1 

Standard settings 

A sample implementation is delivered as part of this SAP BAdI. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 502 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.3.1.10 Archiving 

36.3.1.10.1 Define Residence Time 

Use 

Use this step to define the residence time for Grants Management for Grantee (GM-GTE) archiving. 

The residence time allows you to block records against archiving. You define a number of days for this 

block; this definition is absolute and does not allow archiving of data earlier, unless you change the 

period using the archiving exit. 

The checking logic for residence time is such that archiving is disabled  if the residence time is not 

defined. The residence time is checked against the most detailed definition, so where the grant type and 

archiving object are specified, these are the criteria that need to be met. 

You cannot enter a negative number of days; entering space or zero disables the check so that all records 

can be archived. 

Activities 

1. In the maintenance view, choose New Entries and choose the grant type and associated GM 

archiving object. 

2. Specify the residence time in number of days. 

This can be zero if you want to disable the check. 

3. Save your entries. 
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36.3.1.10.2 Business Add-Ins for GM-GTE Archiving 

36.3.1.10.2.1 BAdI: Archiving Exit for GM Archiving Programs 

Use 

The GM archiving exit (Enhancement Spot: GM_ARCHIVE_BADIS) enables you to enhance the 

archiving feature for possible additional requirements. It allows you to: 

- Activate dynamic selections to define additional selection criteria and include those in the regular 

data selection or use them in special selection definitions - Define additional archiving checks to 

include or exclude archiving objects. 

Standard settings 

We deliver some sample implementations. 

Activities 

To activate the business add-in, you must create an active implementation. 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.3.2 Grantor Management 

36.3.2.1 Master Data 

36.3.2.1.1 Maintain Grantor Derivation Strategies 

Use 

Use this step to enter the derivation strategies you need for Grants Management for Grantor. 

Activities 

Proceed as follows: 

1. In the first overview, choose New Entries and enter an identifier and descriptive long text for each 

strategy required. 

2. Having saved your new entry, select it and choose Company Code Assignments in the dialog 

structure. 

3. In the resulting overview, enter the company code(s) and strategies you want to assign to each other. 

4. Save your entries. 

36.3.2.1.2 Business Add-Ins for Grantor Management Master Data 

36.3.2.1.2.1 BAdI: Grantor Management Derivation Enhancement 

Use 

You can use this Business Add-In (BAdI) to supplement the derivation of GTR account assignments with 

the derivation tool. You do this by creating and programming a derivation step of derivation type 

Enhancement in the derivation strategy. For this you should implement the method CUSTOMER_EXIT. 

Standard settings 

The BAdI is not active in the standard system. 

Activities 

To create an implementation for the BAdI, please follow these steps: 
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1. Open IMG activity (BAdI: Grantor Management Derivation Enhancement) and create a new 

Enhancement Implementation: 

- Enhancement Implementation: 

- Enh. Impl: <Name of your enhancement implemenation> 

- ShText: <Short description> 

- Composite: <Name of your composite> (If none exists already, you should create one.) 

2. Create the implementation <Implementation Name> for the BAdI definition 

BADI_CUSTOMER_EXIT. 

3. Open the BAdI - Tab and activate the Implementation. 

4. Expand the tree on the left side and double-click the 'Class' entry. 

5. Create a new class. 

6. Implement the interface method IF_EX_CUSTOMER_EXIT~CUSTOMER_EXIT. 

7. Save and activate the class and go back. 

8. Save and activate the enhancement implementation. 

Now your BAdI Implementation is active and ready. 

Keep in mind that only one active implementation is allowed for this BAdI. 

36.3.2.1.2.2 BAdI: Funded Program Wrapper 

Use 

This BAdI can be used to realize customer enhancements for the Funded Program Wrapper. 

- The following method can be implemented: 

- PSM_MEASURE_REPL_IN 

The Method is called right after you enter the PSM_MESASURE_REPLICATE function 

module. At this point you can, for example, do additional validation checks. 

Standard settings 

We deliver a default implementation for this BAdI. Within this implementation, when the 

IM_FMMEASURE-SHORT_DESC field is not filled, the first 20 characters of the 

IM_FMMEASURE-DESCRIPTION are mapped to the IM_FMMEASURE-SHORT_DESC. 

Activities 
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To create an implementation for the BAdI, follow these steps: 

1. Open IMG activity (BAdI: Funded Program Wrapper) and create a new Enhancement Implementation: 

- Enhancement Implementation: 

- Enh. Impl: <Name of your enhancement implemenation> 

- ShText: <Short description> 

- Composite: <Name of your composite> (If none exists already, you should create one.) 

2. Create the implementation <Implementation Name> for the BAdI definition 

BADI_PSM_MEASURE_REPL. 

3. Open the BAdI - Tab and activate the Implementation. 

4. Expand the tree on the left side and dubble-click the 'Class' entry. 

5. Create a new class 

6. Implement the interface method PSM_MEASURE_REPL_IN . 

7. Save and activate the class and go back. 

8. Save and activate the enhancement implementation. 

Now your BAdI-Implementation is active and ready. The default implementation is now inactive. 

Keep in mind that several implementations can be used for this BAdI (Multi. Usability). So if you use 

several active implementations, all of them are called. 

36.3.2.2 Integration with Public Sector Collections and Disbursements (PSCD) 

36.3.2.2.1 Integration Scenarios 

Use 

Use this step to make the settings for the Grantor Management (GM-GTR) integration scenario. 

Requirements 

You must first: 

1. Define a company code group 

2. Assign the company code to a company code group 

Activities 

Make the required customizing settings in the following activities: 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 507 

 1. Maintain Data for Integration Scenarios 

Note: Only the Grantor Integration scenario and its variants AGREEMNT and APPLICAT 

are relevant for your needs in GM-GTR. Do not make any new entries and do not delete the existing 

ones. 2. Create Year-Dependent Earmarked Funds 

36.4 Functions for US Federal Government 

36.4.1 General Settings 

36.4.1.1 Activate Federal Government Functions 

Use 

Use this step to activate or deactivate the Federal Government functionality for your installation. Certain 

functions, such as the link between payment method supplements and the Agency Location 

Code/Payment Office, are only available if you carry out this step. 

Activities 

In the maintenance screen, check or uncheck the USFG ISPS active box. Remember to save the new 

setting before exiting the screen. 

36.4.1.2 Maintain SGL Account Master Table 

Use 

Use this step to maintain the Standard General Ledger (SGL) accounts for your installation. You must: 

- Maintain the first view (SGL Account Overview) for your whole Federal Government installation 

- Maintain the views for SGL Attributes and Allowable Values for your FACTS II edits to work 

correctly. The settings entered here ensure that valid combinations of SGL account and attribute 

value are used. 

This does not apply to the Governmentwide Treasury Account Symbol Adjusted Trial Balance 

System (GTAS). 

Standard settings 
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Each of the attributes has a set of default values associated with it. In some cases, the attributes limit the 

values that may be used with particular SGL accounts. The rules for this are stipulated by the US 

Treasury. This does not apply to GTAS. 

Activities 

Proceed as follows: 

1. In the SGL Account Overview, choose New Entries and specify the SGL account whose data you 

want to maintain. You can also enter a text of up 80 characters, describing the account. We strongly 

recommend that you do enter such a text. 

Only this first step applies to GTAS; the following steps are not relevant for GTAS. 

2. Save your new entry, then select it and choose SGL Attributes in the dialog structure. 

3. In the SGL Attribute Overview, choose New Entries and specify the attribute(s) you want to use. 

You do this using the pulldown lists supplied. 

4. Save your entries, then select one of them and choose Allowable Values in the dialog structure. 

5. In the Allowable Values Overview, choose New Entries and specify the value(s) to be allowed for 

this attribute. 

36.4.1.3 Maintain Derivations for SGL Attributes 

In this Customizing activity, you maintain the rules used to derive attributes for the US federal 

government ledger. 

The standard general ledger (SGL) attributes derivation consists of a sequence of derivation steps known 

as the derivation strategy. It is used to derive field values based on the values of other fields in the 

system, such as several attributes reported to the United States Department of the Treasury through the 

Governmentwide Treasury Account Symbol Adjusted Trial Balance System (GTAS). 

You can store these fields in the federal special ledger at the time a document is posted. This is the 

posting derivation. 

You can override the stored values for reporting purposes at the time of GTAS bulk file creation, SAP 

Business Information Warehouse extraction, or report execution. This is the reporting derivation or 

secondary derivation. 

Each derivation step describes how a number of target fields can be filled from a number of source fields. 

You can use the following derivation step types to represent different logical dependencies 

between source and target fields: 

- Derivation Rule 

- Table Lookup 
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- Assignment 

- Initialization 

- Enhancement 

- Function Module 

Standard settings 

You can put the FMFG_DERIVE_INTERM_FMFUSE function module for the attribute derivations into a 

derivation step to get information from an application of funds master record. 

Activities 

You can create, change, and delete steps and change their order. 

Create Steps 

1. Select the step after which you 

want to add a new step. 

2. Choose the Create Step icon. 3.

 Select the derivation step 

type. 

4. Enter a step description. 

5. Enter source and target fields and their characteristics. 

- For source fields, you can specify if you want to allow initial values. If you select the 

checkbox, the source field value can be empty when you are defining the rules. 

- For target fields, you can specify field characteristics for overwriting values. 

- For both source and target fields, you can define whether the entire field contents or only part 

of the field contents is included in the derivation. 

6. If the derivation step should only be performed according to specific conditions (for example, only 

for specific account assignment values), enter them on the Condition tab. The derivation step is only 

executed when all conditions for the fields are met. 

7. Define step characteristics on the Attributes tab (for example, if an error message should be issued 

when no target value can be determined). 
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8. If you are using the Derivation Rule derivation step type, you can do the following: 

- Choose the Rule Values icon to specify which values should be entered in the target fields 

based on the values in the source fields. 

- Enter additional specifications on the Attributes tab. 

For example, you can allow the entry of a validity date for a step to make it time-dependent. 

For the posting derivation, the system checks the posting date of a document against this 

validity date. If the posting date is before the validity date, the step is skipped. The document 

posting date is not available for the reporting derivation since it uses totals data and not line 

items as the source. However, you can use the fiscal year field as a source field for both the 

posting and reporting derivations. For example, you can create a condition using the fiscal year 

that is executed for fiscal years 2013 and later to accommodate new GTAS rules which are 

different from FACTS rules. 

Change or Delete Steps 

If you want to change a step, you can use the same options for creating a step. 

To delete a step, select it and choose the Delete Step icon. 

Change Step Sequence 

1. Select the step you want to move. 

2. Position your cursor below the target position. 

3. Choose the Move icon. 

Further notes 

Master Data Check 

When you enter values, the system does not check the existing master data. When the posting is made, 

the check occurs. 

Test Derivation Strategy 

You can use the Test function to check your derivation strategy. In test mode, you can do the following: 

- To test which values are derived, enter the source fields that should be checked and choose Derive. 

- To determine which rules were used in the derivation, choose Display Log. 

- To delete the selection screen, choose Clear. 

- To test the account assignment derivation during posting, choose Trace. 

If this function is active, the check screen appears before the update. On this screen, you can check 

all values. To execute the update, you must close the check screen by choosing Exit. 

You can only activate this function if you have authorization. 

Transport 

You can use the Transport function to generate a transport request and transport your derivation strategy 

to other clients. 
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36.4.1.4 Define Trading Partner Exceptions 

Use 

Federal agencies are required to monitor customers by type - for example, federal and nonfederal. The 

trading partners concept is used to satisfy this requirement 

In this step, which is additional to normal trading partner configuration, you can maintain exceptions for 

nonfederal trading partners - that is, partners which are generally regarded as federal, but which your 

agency needs to treat as nonfederal. 

Requirements 

You must already have created the trading partner(s) you want to enter. You cannot create them here. 

Activities 

1. In the maintenance view, choose New Entries and enter the six-character company ID of the trading 

partner you want to include. 

2. Specify which customer type applies in each case, choosing from the following: 

- Blank 

- Foreign/sovereign government 

- State and local government 

- Commercial customer 

- Consumer customer 

This selection is needed for the receivables report. 

3. Save your entries. 

When you do this, the name of the company appears in the relevant field. 

36.4.1.5 Select Reports and Fields for Derivation 

Use 

In this Customizing activity, you select the reports that call the derivation process defined in the 

implementation of the Governmentwide Treasury Account Symbol Adjusted Trial Balance System 

(GTAS) method (ADD_GTAS_ATTRIBUTES) of the Business Add-In (BAdI) Reporting Attributes 

(FMFG_RPTA_EXIT). You select the reports from a predefined list. You also select which fields within 

the reports will be derived. 

You can also define reporting levels for the GTAS trial balance report. 
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Activities 

To define reporting levels, do the following: 

1. Create an entry for report RFFMFG_TRIAL_BALANCE_LEVEL. 

2. In the source field selection, specify the attribute fields for the level on which you want to report. 

Values in attribute fields that are not source fields are cleared, and the amounts are combined with 

other reporting lines that contain the same attributes. 

36.4.1.6 BAdI: Reporting Attributes 

Use 

This Business Add-In (BAdI) is used in the Functions for U.S. Federal Government 

(PSM-FG) component for the Governmentwide Treasury Account Symbol Adjusted Trial Balance 

System (GTAS). The ADD_GTAS_ATTRIBUTES method is the only method used to define the GTAS 

derivation process. The fallback class CL_FMFG_FB_IMP_GTAS executes the derivation rules defined 

in transaction FMUSFG1 (GTAS Attribute Derivation at Time of Reporting). This BAdI works with 

the Customizing activity Select Reports and Fields for Derivation. 

Performance-related optimizations may require you to replace the use of the derivation tool with a more 

streamlined option. In this case, we recommend a coded solution. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enh. Spot 

Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

If you previously implemented this BAdI, you must copy the code from the fallback class 

CL_FMFG_FB_IMP_GTAS, method ADD_GTAS_ATTRIBUTES to your existing implementation. 

This code executes the derivation of Federal Government fields, which is the execution of the 

rules defined by transaction FMUSFG1. 

If you do not already have an implementation of this BAdI, the fallback class will be executed. 

If you want to have your own implementation of this BAdI to customize the code of the derivation 

process (for example, to use your own code to define the rules instead of using the derivation tool), do the 

following: 
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1. On the Create Enhancement Implementation screen, which appears after you call the 

Customizing activity, enter a name for the enhancement implementation, short text, and composite 

enhancement implementation. 

 If no composite enhancement implementation exists, create a new one by choosing the Create 

Composite Implementation button. 

2. Save your entries, and assign the implementation to a development class. 

3. Select the BAdI tab, and choose the Create BAdI button. 

4. In the dialog box, enter the BAdI definition, BAdI implementation, and implementation class and 

description, and choose Enter. 

5. In the left panel on the next screen, expand the implementation node and double-click Class. 

6. To enter method processing, double-click the method. 

7. Enter the code for the implementation between the method 

IF_EX_FMFG_RPTA_EXIT~ADD_GTAS_ATTRIBUTES  and endmethod statements. 

The sample implementation is automatically copied. 

8. Save and activate all objects. 

36.4.1.7 US Federal Government Fields 

36.4.1.7.1 Maintain US Federal Government Field Values 

Use 

In this Customizing activity, you can define the field values for United States Federal Government fields 

and their field value text. Fields are represented by their data element. 

Requirements 

You completed an implementation like the one described in the business add-in (BAdI) BAdI: Definition 

of US Federal Government Fields. 

36.4.1.7.2 BAdI: Definition of US Federal Government Fields 

Use 

This Business Add-In (BAdI) is used in the Functions for U.S. Federal Government (PSM-FG) 

component. You can use this BAdI to define the United States Federal Government field list for which 

you want to provide field values and field value texts. Fields are identified by their data element. Fields 

with the same data element contain the same field values. 
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You can use this BAdI to provide F4 functions on the fields and field value checks for data entry screens. 

If field values are not defined for a field, the check is not performed. 

You can provide hardcoded field values in your own BAdI implementation or by using a Customizing 

table that contains the field values. 

Requirements 

You assigned the FMFG_USFIELD_F4 search help in the data dictionary to the corresponding field in 

the structure. You can access the data dictionary using transaction SE11. We deliver the 

FMFGUSKONTKEY_DATA structure with this assignment. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

If you want to use your own implementation, complete the following steps: 

1. In the dialog box, enter the enhancement implementation, short text, and composite enhancement 

implementation. 

If no composite exists, create a new one by choosing Create. 

2. Save your entries, and assign the implementation to a development class. 

3. Select the BAdI tab and choose Create BAdI. 

4. In the dialog box, enter the BAdI definition, BAdI implementation, implementation class, and 

description, and press Enter. 

5. On the next screen, expand the implementation node and double-click Class. 

6. With your cursor on the method, double-click to enter method processing. 

7. Enter the code for the implementation between the method <Interface name> ~ 

<Name of method> and endmethod statements. The 

sample implementation is copied automatically. 

8. Save and activate all objects. 

Example 

You can find example implementations in the BAdI Builder on the Enhancement Spot Element 

Definitions tab in the Implementation Example Classes section. 

The following example implementation is available: 

 - CL_FMFG_USFLDVAL_EXIT_EXM 

If no implementation exists, this example is used. 

The example contains comments which should help you to build your own implementation. It 

differentiates between fields in which the field values are programmatically provided (for example, 
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fields containing year values) and fields in which the values are maintained in Customizing. The 

checking function allows blank values as valid entries and does not validate fields for which field 

values are not defined. 

36.4.2 Automatic Budget Postings 

36.4.2.1 Maintain Parameters for Automatic Budget Postings 

Use 

In this activity, you activate or deactivate Automatic Budget Postings (ABP). 

Requirements 

You have: 

- Customized and activated the Budget Control System (BCS). 

- Performed the following activities: 

- Define Budget Entry Document Header Defaults - Maintain Derivation Strategy 

Activities 

1. Choose New Entries and mark the checkbox for your FM area. 

2. Save your entry. 

36.4.2.2 Define Budget Entry Document Header Defaults 

Use 

In this IMG activity, you define default values for the budget entry document header created by the 

Automatic Budget Postings feature. 

Requirements 

You have customized and activated the Budget Control System (BCS). 

Standard settings 
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We do not provide any default settings. 

Activities 

1. Choose New Entries and assign default values to the following header fields for your FM area: 

- Process 

- Version 

- Budget Entry Document Type 

2. Save your entry. 

36.4.2.3 Maintain Derivation Strategy for Automatic Budget Postings 

Use 

With this IMG activity, you can establish a derivation strategy that triggers the generation of budget entry 

documents in the Budget Control System (BCS). The derivation strategy is called for each Funds 

Management (FM) commitment document or FM line item processed by the Federal Government 

solution. 

To establish a proper derivation strategy, you need to: 

- Determine whether or not the transaction is relevant for automatic budget postings (ABP) 

- Determine whether or not a sender line will be created in the budget entry document 

- Enter the budget type and account assignment fields by assigning target values 

To define derivation steps, you can choose relevant source fields from the list provided. You can create 

several types of steps: a derivation rule, a table lookup, an assignment, an initialization and a function 

module. When assigning target fields, you determine which values will be used to create budget entry 

document line items. 

Requirements 

You have customized and activated the Budget Control System (BCS). 

Activities 

See the example below. 

Example 
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1. You want to create a derivation step that will trigger the generation of a budget entry document 

during the posting of a Forecast of Revenue for an SD order. In othis way the transaction is made 

relevant for automatic budget postings: 

a) Select Create Step and choose Derivation Rule. 

b) Add a short description such as "Make Forecast of Revenue for SD order relevant" in the Text 

for Step edit box. 

c) As source fields, select CO Business Transaction and Value Type. 

d) As target field, select Automatic Budget Posting Relevancy Indicator. 

e) Go to Maintain rule values and select Forecast of Revenue as Value type, SDOR as CO 

Business Transaction and Yes as Indicator 

f) Save your derivation step. 

2. You want to create a derivation step that will trigger the creation of a sender line item in the budget 

entry document: 

a) Select Create Step and choose Assgmt. 

b) Add a short description such as "Trigger sender line creation" in the Text for Step edit box. 

c) As target field, select Automatic Budget Posting Sender Data Indicator. 

d) As Constant, select Yes. 

e) Save your derivation step. 

Alternatively, you can simply populate one of the sender account assignment fields. ABP will 

recognize that a sender line item should be generated. 

3. You want to populate the Fund Center of the budget entry document receiver line item: 

a) Select Create Step and choose Assgmnt. 

b) Add a short description such as "Sender Fund Center" in the Text forStep edit box. 

c) As source field, select Fund Center. 

d) As target field, select Sender Fund Center. 

e) Save your derivation step. 

Standard settings 

SAP does not provide any default settings. 

36.4.2.4 Business Add-Ins for Automatic Budget Postings 

36.4.2.4.1 BAdI: Override Default Budget Entry Document Header Values 
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Use 

With this Business Add-In (BAdI), you can override default document header values for the following 

Automatic Budget Postings application : 

- US Federal Government 

- Budget Recovery 

- Personal Cost Savings 

Requirements 

- You have customized and activated the Budget Control System (BCS). 

- You have performed the following Customizing activities: 

- Define Budget Entry Document Header Defaults 

- Maintain Derivation Strategy 

Standard settings 

We do not deliver any implementation of this BAdI. This means that the BAdI is not active in the 

standard release. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.4.3 Payment Processing 
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36.4.3.1 Prompt Payment Act 

36.4.3.1.1 Activate Prompt Payment Act 

Use 

Use this step to activate or deactivate the Prompt Payment Act (PPA) for your company code. 

Activities 

- The overview shows a list of all the company codes set up in your system. To activate the PPA 

feature for your company code(s), check the relevant "Active" box(es). 

- If the PPA feature is already active in a company code and you want to deactivate it, uncheck the 

"Active" box next to the company code. 

36.4.3.1.2 Define Account for Penalty Interest 

In this step, you can create an account number for penalty interest to be paid. When clearing open items, 

the program posts the calculated penalty interest to this account. The program also accesses this account 

during the profit and lost adjustment. 

Activities 

Enter an account from the chart of accounts you are using. 

36.4.3.1.3 Enter Treasury Processing Time 

Use 

Use this step to enter the number of days it takes the US Treasury to process payments once your agency 

has run the automatic payment program. You do this for each company code and payment method. 

Activities 
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Enter the relevant number of days for each company code and payment method your agency uses. 

36.4.3.1.4 Define Interest Rates and CVFR 

This step allows you to determine the percentage of the penalty interest rate. Penalty interest must be paid 

on overdue invoices that are subject to the Prompt Payment Act. The penalty interest rates are time-

dependent. The program calculates penalty interest with one interest rate. This rate is the one that is valid 

on the first day of the penalty interest period. 

Activities 

In the "Define Penalty Interest Rate and CVFR" overview, choose New Entries and specify the following: 

- Date from which the rate entered is to apply 

- Rate type 

This is the penalty interest rate or the current value of funds rate (CVFR). 

- The percentage rate for the calculation of the penalty interest or the CVFR currently in force. 

36.4.3.1.5 Maintain Minimum and Maximum Penalty Amounts 

This step allows you to define a minimum and a maximum amount for the penalty charges for each 

company code. The program derives the currency for these amounts from the defined company code. If a 

company's payment of an invoice which is subject to the Prompt Payment Act is late, resulting in penalty 

charges, the percentage of the penalty interest to be paid is determined by the settings you have made in 

this step: Only penalty interests lying within the given interval must be paid. 

If the calculated penalty charges are less than the minimum amount, the "Prompt Payment Act" program 

sets the penalty interest to zero. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

Define the minimum and maximum amounts for penalty interests. 

Further notes 

Further information on the calculation of penalty charges is available in the SAP Library under 

Financials -> Public Sector Management -> US Federal Government -> Prompt Payment Act. 
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36.4.3.1.6 Create Penalty Interest Reason Codes 

This step allows you to create penalty interest reason codes. You can assign these reason codes to 

invoices paid late which are subject to the Prompt Payment Act. You perform this assignment after the 

invoice has been paid. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

Create the required penalty interest reason codes. 

36.4.3.1.7 Maintain Rules for Invoice Line Item Handling 

In this step, you define how the individual line items in invoices are to be handled. 

Standard settings 

We do not deliver any standard settings. 

Activities 

For each company code you use, stipulate, either separately for each vendor or for all the vendors in the 

company code, which of the following should apply to invoices from vendors maintained in that company 

code: 

- "Pay at the earliest" 

The invoice is paid in full as of the date of the item requiring payment earliest. When you select this 

option, you must also enter an amount in the "Amount in local currency" field in the same line. The 

amount entered acts as the maximum permitted invoice amount when this method is used, but is 

ignored if Accelerated Pay applies to a particular invoice. 

- "Automatically split" 

Each item is paid at the date it becomes due. 

- "Manually split" 

Example 

You are billed for milk and widgets from the same vendor. The Prompt Payment Act requires that milk be 

paid for within seven days of the baseline date. The vendors own payment terms are net within 30 days. 

With invoice splitting active for this vendor in this company code, the system then processes the items 

for payment separately. The milk is paid for within seven days and the widgets after that but within 

thirty days. 
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Note: If you had chosen the "Pay at the earliest" option, both the milk and the widgets would have been 

paid for within seven days. 

36.4.3.1.8 Assign Payment Term to Material Group 

Use this step to assign payment terms to material groups and define a Prompt Payment Act (PPA) 

baseline date to them. 

Requirements 

You have already created the material groups and payment term keys you want to link in this step. 

Activities 

Choose New Entries and enter the following: 

- Material group 

- Payment term key for the group 

- Whether the goods receipt date or invoice receipt date is to act as the PPA baseline date for the 

group 

36.4.3.1.9 Business Add-Ins for Prompt Payment Act 

36.4.3.1.9.1 BAdI: Further Invoice Processing Configuration 

Use 

You can use the business add-in (PPA_CUST_BADI ) to further set up your system behavior during 

invoice processing (creating and/or parking invoice documents). 

Requirements 

- The business add-in is not active in the standard system. 

- The PPA indicator must be active for company code. 

Standard settings 

To activate the business add-in, you must create an active implementation. 

Activities 
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This BAdI is delivered with three methods. 

MESSAGE_HANDLING -  Allows user to change the severity, message and application area for 

messages issued: 

- 'Invoice &1 still contains improper reason code ' 

- 'Invoice &1 does not contain a reference number'. 

- 'Invoice &1 already exists with reference number &2' 

UPDATE_PUSHBUTTON_TEXT - Update Pushbutton Text on Subscreen.  The pushbutton text on 

either Accounts Payable or Accounts Receivable   can be changed to meet customer requirements.  Text 

delivered as 'Requried Information on Invoice' for Accounts Payable invoices and 'Status of Account 

Receivables' on Account Receivable Invoices. 

CHECK_DOCUMENT_TYPE - Check document type 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.3.1.10 Invoice Classification 
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36.4.3.1.10.1 Maintain Reason Codes for Invoices 

Use 

Use this step to tell the system how invoices should be classified. You do this by means of reason codes 

per document type. 

Requirements 

- You need to have created the document types for which you want to enter reason codes here. 

- The company code must be active for Prompt Payment Act processing. 

Standard settings 

We do not deliver any reasons as standard. 

Activities 

Enter the following: 

- The document type for which you want to specify reason codes 

- A two-character ID for the reason code 

- A text of up to 50 characters, describing the reason in detail 

36.4.3.1.10.2 Business Add-Ins for Invoice Classification 

36.4.3.1.10.2.1 BAdI: Additional Processing of Improper Invoice Panel 

Use 

You can use this BAdI to change the messaging on the invoice classification panel. You can add your 

own messages, message classes, and application area. 

You can also use it to change how entries appear on the invoice classification panel. For example, we 

deliver the panel with all reason codes unselected. You could change this so that the panel appears 

with all the reason codes selected. 

Activities 
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After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.3.1.11 Fast Pay and Accelerated Pay 

36.4.3.1.11.1 Maintain Material Groups for Fast Pay 

Use this step to designate which material groups are to be used in Fast Pay (FP) processing. 

Requirements 

You must first create the desired material groups in Materials Management (MM). 

Activities 

Choose New Entries and specify the desired material groups. 
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36.4.3.1.11.2 Maintain Payment Amounts for Fast Pay/Accelerated Pay 

Fast Pay (FP) and Accelerated Pay are subject to maximum amount restrictions. You use this step to enter 

these per company code. 

Activities 

Choose New Entries and enter the FP maximum amount for your company code(s). 

Further notes 

When you save your entries, the system displays the name and currency applying to the newly entered 

company code settings. 

36.4.3.1.11.3 Maintain Payment Terms for Fast Pay/Accelerated Pay 

Use 

In this Customizing activity, you stipulate the payment terms you want to apply to your processing in fast 

pay and accelerated pay. 

For related information, see the Customizing activity Maintain Payment Terms for Late Accelerated 

Payments. 

Requirements 

You have created the terms you want to use in Accounts Receivable and Accounts Payable in Financial 

Accounting (FI). 

Activities 

Specify fast pay and/or accelerated pay, and enter the payment terms you want to apply to each. When 

you save, the system displays the explanation for the payment terms, which you maintained in FI. 

36.4.3.1.11.4 Maintain Payment Terms for Late Accelerated Payments 

Use 
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In this Customizing activity, you stipulate payment terms that should be used when an accelerated 

payment is late. When accelerated payment applies to an invoice and you want to calculate penalty 

interest for late payments, the system calculates the due date using the net days of the payment term that 

corresponds to the accelerated payment term in the configuration table. 

If accelerated pay applies to an invoice and the payment term is not specified in the configuration table, 

you receive an error message when you try to post the invoice. 

If an accelerated payment term is entered in the Customizing activity Maintain Payment Terms for Fast 

Pay/Accelerated Pay, this Customizing activity (Maintain Payment Terms for Late Accelerated 

Payments) is not used. In this case, if accelerated pay applies to an invoice and the payment term is not 

specified in the configuration table, the due date, which is used to calculate penalty interest for late 

payments, is calculated based on a 30-day payment term. 

If no accelerated payment term exists in either Customizing activity, accelerated pay is not used, 

regardless of the invoice amount. 

Requirements 

You have already created the payment terms that you want to use in the Accounts Receivable and 

Accounts Payable in Financial Accounting (FI) Customizing activities. 

Activities 

1. For the payment type, choose Accelerated Pay. 

2. In the original payment term column, maintain the payment terms that you use on your invoices. 

Also, maintain the corresponding accelerated payment term. 

When you save, the system displays the description of the accelerated payment terms, which you 

entered in FI. The system requires a one-to-one relationship between the original payment term and 

the accelerated payment term because the system uses the accelerated payment term to get the 

original payment term for Prompt Payment Act (PPA) calculations. 

36.4.3.1.11.5 Business Add-Ins for Accelerated Pay 

36.4.3.1.11.5.1 BAdI: Accelerated Pay Message Handling 

Use 

Use this BAdI to change how delivered messages behave in the Prompt Payment Act. We deliver the 

messages as warnings (W). You can change them to any of the other categories available (example: error 

(E)). 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 
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If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.3.2 Treasury Confirmation 

36.4.3.2.1 Maintain DIT and FBT Accounts 

In this step, you specify which accounts you want to act as your disbursements-in-transit (DIT) and fund 

balances with Treasury (FBT) accounts. 

Activities 

Enter the desired company codes and G/L accounts, specifying, in each case, whether it is to act as the 

DIT account or the FBT account. 

36.4.3.2.2 Maintain Payment/Disbursing Offices 
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In this step, you maintain the payment office for your agency. 

Activities 

Choose New Entries and enter the relevant payment office(s) and description. 

36.4.3.2.3 Maintain Agency Location Codes 

Use 

In this step, you maintain the Agency Location Code (ALC) for your agency, as specified by the U.S. 

Federal Treasury. 

Activities 

Choose New Entries and enter the relevant ALC and description. 

36.4.3.2.4 Maintain Payment Method Supplements 

In this activity you define payment method supplements. 

Requirements 

You specified that you wish to use payment method supplements in the activity Set Up All Company 

Codes for Payment Transactions. 

Activities 

Choose New Entries and enter the following: 

- An ID for your new payment supplement 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 530 

- A descriptive text of up to 30 characters 

36.4.3.2.5 Assign ALC and Payment Office to Payment Method Supplement 
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In this step, you assign the payment office and ALC for your agency to the payment method supplement. 

The effect of this is that when you enter, for example, a vendor invoice and use the F4 input help on the 

payment method supplement field, the payment office and ALC information you enter here is included in 

the display. 

Further notes 

Payment method supplements are defined in the Accounts Receivable and Accounts Payable IMG and 

you cannot create new payment method supplements here. You can only select an existing payment 

method supplement and assign ALC and payment office to it. 

36.4.3.2.6 Assign RFC Payment Type to Payment Method 

Activities 

In this step, you assign a payment type and a payment application (the reason the payment is being made) 

to a payment method. Note the file format column, which determines the format of the file - for example, 

CTX - sent to the Treasury containing the details of the payment to be made by the Treasury on behalf of 

your agency. 

36.4.3.2.7 Assign RFC File ID 

In this step, you define how the system is to combine payment types and methods for your agency. 

For each payment method you need, specify the following: 

- Payment application - for example, vendor or salary 

- File ID 

- Agency ID 
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36.4.3.2.8 Maintain Regional Financial Center Derivation 

The U.S Treasury has regional financial centers (RFCs) all over the country. They receive DME files 

from agencies on whose behalf they are to make payments. 

Most agencies send their DME files to the RFC closest to them. However, some payments must be 

handled by a particular RFC. 

Activities 

In this step, you tell the print program where your DME files have to be sent. You do this, per company 

code, by assigning the ALC and payment office to the relevant RFC. 

36.4.3.3 Payment Statistical Sampling 

36.4.3.3.1 Activate/Deactivate Payment Statistical Sampling 

Use 

Use this step to turn Payment Statistical Sampling on or off. You do this per company code. 

In the activation screen, choose New Entries and enter the company code and name. To activate PSS for 

the company code, check the Statis. Sampling Act. box. 

Alternatively, to deactivate PSS for a company code where it is already active, call up the list of company 

codes and uncheck the activation box. 

36.4.3.3.2 Define Payment Statistical Sampling Rules 

Use 
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Before you can use Payment Statistical Sampling (PSS), you use this step to govern how you want it to 

work. 

Activities 

Action the step and choose New Entries. In the resulting view, enter the following: 

- Company code 

- Fiscal year 

- Document type - such as RE for invoice receipts 

- Minimum Audit Amount 

Documents with a value less than the amount you enter here are not subject to verification. 

- Frequency 

This is the number of documents from which one will be selected for verification. 

The counter later shows the number of times the settings you entered have been used. 

36.4.3.3.3 PSS: Clerk/Supervisor 

Use 

Use this step to specify which clerks and supervisors are to handle Payment Statistical Sampling in your 

system. 
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Activities 

In the maintenance screen, enter the following for your company code: 

- Clerk 1 

- Clerk 2 

This clerk may process documents assigned to clerk 1 if, for some reason, clerk 1 cannot 

process them 

- Supervisor 1 

This supervisor is responsible for verifying the documents initially processed by clerk 1 or 2. 

- Supervisor 2 

This supervisor may verify documents assigned to supervisor 1 if, for some reason, supervisor 

1 cannot process them 

- Supervisor 3 

This supervisor may verify documents assigned to supervisor 1 if, for some reason, neither 

supervisor 1 nor supervisor 2 can do so. 

36.4.3.3.4 Business Add-Ins for Payment Statistical Sampling 

36.4.3.3.4.1 BAdI: Invoice Batching 

Use 

This is a user exit that enables you to customize your own batching process. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 
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The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.3.3.4.2 BAdI: Certification 

Use 

This a user exit that enables you to: 

- Override the clerk/supervisor relationships defined in customizing 

- Rewrite the selection rules defined in customizing 

Activities 

INCLUDE BADI_ACTIVITY OBJECT DOKU ID TX 

36.4.3.4 Treasury Offset 

36.4.3.4.1 BAdI: Treasury Offset 

Use 
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You can use the business add-in (RFFMFG_TREA_OFFSET) to further process the following functions: 

- Method GET_DATE_FIELD - Define date used in ageing calculation. The delivered default code 

sets the baseline date as the default date used for the ageing calculation. 

- Methods CONTROL_RECORD, DEBT_INFO, and INDIVIDUAL_DEBTOR_INFO - allow users 

to further define the Treasury Offset File Format. The methods correspond to the sections of the 

Agency File Format  'Control Record', 'Debt Information' and 'Individual Debtor Information'. They 

have been set up in this manner to ease the creation of an implementation for the end-user in putting 

agency's data in correct format. The delivered default code fills the Treasury Offset File Format to 

JFMIP requirmenets. We recommend that you use the default code as a template for 

implementation. 

- Requirements 

Standard settings 

The business add-in is not active in the standard system. 

Activities 

To activate the business add-in, you must create an active implementation. 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.4.3.5 Intragovernmental Payments and Collections (IPAC) 

36.4.3.5.1 Maintain Payment/Disbursing Offices 

In this step, you maintain the payment office for your agency. 

Activities 

Choose New Entries and enter the relevant payment office(s) and description. 

36.4.3.5.2 Maintain Agency Location Codes 

Use 

In this step, you maintain the Agency Location Code (ALC) for your agency, as specified by the U.S. 

Federal Treasury. 

Activities 

Choose New Entries and enter the relevant ALC and description. 

36.4.3.5.3 Assign ALC and Payment Office to Payment Method Supplement 

Activities 

In this step, you assign the payment office and ALC for your agency to the payment method supplement. 
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The effect of this is that when you enter, for example, a vendor invoice and use the F4 input help on the 

payment method supplement field, the payment office and ALC information you enter here is included in 

the display. 

Further notes 

Payment method supplements are defined in the Accounts Receivable and Accounts Payable IMG and 

you cannot create new payment method supplements here. You can only select an existing payment 

method supplement and assign ALC and payment office to it. 

36.4.3.5.4 Maintain Fiscal Station Number 

Use 

Agency Location Codes (ALCs) can be subdivided into Fiscal Station Numbers (FSNs). Use this step to 

make the necessary entries. 

Activities 

In the "Change View 'US Federal Fiscal Station Number' Overview" screen,choose New Entries and 

enter the following: 

- The ALC you want to subdivide using FSNs 

- An ID number for the FSN 

- A text of up to 30 characters, describing the FSN 

36.4.3.5.5 Maintain IPAC Document Reference Number 

Use 

Use this step to maintain number ranges for the IPAC reference documents. You do this per company 

code. 

36.4.3.5.6 Prepare Automatic Posting for IPAC 
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Use 

In this step, you specify the disbursements-in-transit (DIT) and fund balances with Treasury (FBT) 

accounts used in the automatic IPAC postings for your company code. 

Activities 

Choose New Entries and specify the following: 

- Company code 

- Transaction ID. The options are: 

- IPAC Collection 

- IPAC Payment 

- IPAC Collection Confirmation 

- IPAC Payment Confirmation 

- IPACed Collection 

- IPACed Payment 

- G/L Account 

- Document Type 

- Posting Key 

- DIT or FBT 

36.4.3.5.7 Maintain DIT and FBT Accounts 

In this step, you specify which accounts you want to act as your disbursements-in-transit (DIT) and fund 

balances with Treasury (FBT) accounts. 

Activities 

Enter the desired company codes and G/L accounts, specifying, in each case, whether it is to act as the 

DIT account or the FBT account. 
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36.4.3.5.8 IPACed Auto Doc Creation - Account Assignment Derivation 

Use 

Use this step to enter the information required to enable unmatched IPACed records to derive account 

assignments so an invoice and payment can be posted automatically. 

When the IPACed program does not find a match to an invoice, an invoice and payment are 

automatically created and account assignment values for the invoice are derived from this derivation 

tool, using the sources and targets you enter here. The general ledger (G/L) account and document type 

for the payment document are taken from the step Prepare Automatic Posting for IPAC. 

Activities 

Enter the source and target fields you require for your derivation. 

Note 

You also need to configure the document type for the invoice in the step IPACed Auto Doc Creation: 

Document Type for Invoice. 

36.4.3.5.9 Activate IPACed Automatic Invoice Generation 

Use 

Use this step to activate and configure IPACed automatic invoice configuration. You do this per company 

code or country template. 

Activities 

In the maintenance view, specifiy, for each relevant company code and/or country template, whether 

automatic invoice generation is active for vendor invoices, customer invoices, or both. 

36.4.3.5.10 IPACed Automatic Document Creation: Default Fields for Invoice 

Use 

Use this step to enter the document type and payment method supplement required for automatic invoice 

creation when an unmatched IPACed record is found. 
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When the IPACed program does not find a match to an invoice, an invoice and payment are automatically 

created and for the invoice, the document type and payment method supplement are derived from this 

configuration table. You can configure a document type and payment method supplement per year; 

however, the year within this configuration table is the "From" year, meaning that a year entered here can 

remain valid for future years. 

For the subsequent payment document, which is created automatically and clears the invoice, the 

document type, and general ledger (G/L) account are taken from the configuration called Prepare 

Automatic Posting for IPAC. 

Requirements 

Make the required settings in Prepare Automatic Posting for IPAC. 

Activities 

Enter the derivation criteria you require. 

36.4.3.5.11 Maintain Payment Method for Zero Amount Transactions 

Use 

Use this step to define payment methods for transactions where the money amount is zero. 

Requirements 

A payment term for zero amount payments is defined and assigned to payment medium format 

IPAC_FG_ZERO. 

Activities 

Choose New Entries and enter the relevant payment methods. 

36.4.3.5.12 Business Add-Ins for IPAC 

36.4.3.5.12.1 BAdI: Override IPAC Standard Code 

Use 

This is a user exit, enabling you to enter your own code that overrides the standard code delivered by 

SAP. 
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Standard settings 

A sample implementation exists. Use SE19 and look at class CL_EXM_IM_BADI_IPAC. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

You might apply this feature to change the input source for the incoming or outgoing IPAC interface file. 

36.4.4 Closing Operations 

36.4.4.1 Preclosing (BCS/New Budgetary Ledger) 

36.4.4.1.1 Collected Fields Year-End 
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Use 

Use this step to specify, per company code, which data fields are collected for the purpose of year-end 

closing. 

Activities 

1. In the Overview, choose New Entries. 

2. Enter a company code and check the boxes next to the objects whose data you want to include in 

year-end processing for that company code. 

3. Save your entries. 

36.4.4.1.2 Year-End Closing Rules 

Use 

In this step, you define the rules that will govern both preclosing and closing. The procedure described 

below applies in both cases. 

Activities 

Proceed as follows: 

1. Specify a company code and the fiscal year for which you want to define rules. 

2. In the resulting overview, choose either Preclosing or Closing in the dialog structure. 

3. Choose New Entries and stipulate the following: 

- Fund Type to which the new rule is to apply. '*' applies to all fund types. 

- Status to which the new rule is to apply. 

- From Sender Account 

That is, the first account in the range of sender accounts for the preclosing/closing postings. 

- To Sender Account 

That is, the last account in the range of sender accounts for the preclosing/closing postings. 

- To Sender Account 

The last account in the range of sender accounts. 
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- Closing postings are normally made in the form of budget transfers. If you need a budget 

return or supplement instead, check the appropriate box. 

36.4.4.1.3 Year-End Account Assignment Derivation 

Use 

Use this step to define the derivations to be used in year-end account assignments. 

Activities 

The procedure used is the same as for the standard derivation tool. 

36.4.4.1.4 Specify Document Types for Year-End Closing 

Use 

Use this activity to specify document types used in year-end processing. 

During year-end processing, postings might be required that violate the rules for source and posting type 

set up in BL account classfication. For document types specified here, these rules are not checked and no 

error is issued. 

Note 

The checks are bypassed not only for year-end postings, but for all postings done with the specified 

document types. 

Activities 

Specify the document types for which you want to bypass the source and posting type checks. 

36.4.4.1.5 Canceled Funds 

36.4.4.1.5.1 Year-End Account Assignment Derivation 
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Use 

In this IMG activity, you define the account assignment derivation for  reassigning Funds Management 

account assignments (FM account assignments) Closing Operations for fiscal year change and mid-year 

reassignments in Funds Management (FM). 

With the account assignment derivation, the values of the new FM account assignment are determined 

automatically from previous account assignments. Several target account assignments can be determined 

for some closing operations; this allows amounts to be split over several target account assignments and 

partial amounts to be included. You can also use other objects as source fields for the derivation, provided 

that a logical dependency exists between them and the target account assignments. 

The account assignment derivation consists of a sequence of derivation steps - the derivation strategy - 

through which the values from FM account assignments are derived from other account assignments. 

Each derivation step describes how a number of target fields can be filled by a number of source fields. 

There are different derivation step types, which map the different logical dependencies between source 

and target fields: 

- Derivation rule 

- Table access 

- Move 

- Clear 

- Enhancement 

More information can be found in section "Prerequisites". 

- Function call 

You cannot define your own function calls. However, you can include the derivation steps (function 

calls) defined by SAP in your own derivation strategy. 

You can also use different derivation strategies for the different closing operations, by assigning a 

strategy to an FM area, fiscal year, and a particular closing operation in Assignment to FM area, Year and 

Closing Acitvity. 

The individual closing operations are represented by one program or transaction. When they are executed, 

the derivation strategy assigned to the FM area is automatically included. 

The following is a list of all programs and transactions that include reassignments defined in the 

derivation strategy for Canceled Funds. Note that some programs can only be executed when the 

corresponding global functions have been activated in Customizing. The list contains the relevant 

programs for each closing operation and global function under the respective heading 

 Global Function Heading 

 US Federal Government US Federal Government 

- Preclosing Activities for Canceling Fund (Receivables) 

- Transfer Balance from Canceled Fund: Accounts Receivable  

(FMFG_CANCELED_AR) 
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Standard settings 

If you do not define a derivation strategy for this closing operation for the fiscal year change, the program 

does not process any documents. 

- Preclosing Activities for Canceling Fund (Payables) 

- Transfer Balance from Canceled Fund: FI Accounts Payable 

(FMFG_CANCELED_AP) 

- Transfer Balance from Canceled Fund: MM Accounts Payable 

(FMFG_CANCELED_AP_MM) 

Dependencies 

The fund cannot be derived for the operation "Preclosing Activities for Canceling Fund (Payables)". This 

means that, if the fund (NEW_FUND, receiver fund) is specified as a target field in a derivation step of 

step of type "derivation rule", and the value of the receiver fund is different than the value of the sender 

fund, the system issues a "hard" error message. This is because the Future Funded Expense Posting has to 

be done in the original fund (sender fund). 

For the closing operation of Preclosing Activities for Canceling Fund (Receivables), the fund must be 

derived. This means that, if the fund (NEW_FUND, receiver fund) is not specified as a target field in a 

derivation step of step type derivation rule or if the value of the receiver fund is the same as the value of 

the sender fund, the system issues a "hard" error message. This is because the open receivable balances 

must be transferred to a different fund (miscellaneous receipts fund). 

- Preclosing Activities for Canceling Fund (Payables) You can use the following source fields to 

derive the target fields: 

- SOURCE_COMMIT_ITEM Sender commitment item 

- SOURCE_FUNDS_CENTER Sender funds center 

- SOURCE_FUNCTION_AREA Sender functional area 

- SOURCE_MEASURE Sender funded program 

The following target fields are available: (Select Field attribute Overwrite with New Value as these 

fields can be prepopulated.) 

- TARGET_FUNCTION_AREA Target functional area 

- TARGET_COMMIT_ITEM Target commitment item (FM fiscal year change) 

- TARGET_FUNDS_CENTER Target funds center 

- TARGET_FUNCTION_AREA Target functional area (FM fiscal year change) 

- Preclosing Activities for Canceling Fund (Receivables) 

- You can use the following source fields to derive the target fields: 

- SOURCE_FUND Sender Fund 

- SOURCE_COMMIT_ITEM Sender commitment item 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 547 

- SOURCE_FUNDS_CENTER Sender funds center 

- SOURCE_FUNCTION_AREA Sender functional area 

- SOURCE_MEASURE Sender funded program 

The following target fields are available: 

(Select Field attributes Overwrite with New Value as these fields can be pre populated.) 

- TARGET_FUND Target fund 

- TARGET_FUNCTION_AREA Target functional area 

- TARGET_COMMIT_ITEM Target commitment item (FM fiscal year change) 

- TARGET_FUNDS_CENTER Target funds center 

- TARGET_FUNCTION_AREA Target functional area (FM fiscal year change) 

- Subsequent Postings for Canceling Fund (Payables) CFAS You can use the following source 

fields to derive the target fields: 

- SOURCE_FUND Sender fund 

- SOURCE_COMMIT_ITEM Sender commitment item 

- SOURCE_FUNDS_CENTER Sender funds center 

- SOURCE_FUNCTION_AREA Sender functional area 

- SOURCE_MEASURE Sender funded program 

The following target fields are available: 

(Select Field attributes Overwrite with New Value as these fields can be pre populated.) 

- SOURCE_FUND Sender Fund 

- TARGET_FUNCTION_AREA Target functional area 

- TARGET_COMMIT_ITEM Target commitment item (FM fiscal year change) 

- TARGET_FUNDS_CENTER Target funds center 

- TARGET_FUNCTION_AREA Target functional area (FM fiscal year change) 

36.4.4.1.5.2 Subsequent Process Account Assignment Derivation 
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Use 

In this IMG activity, you define the account assignment derivation for </> (FM account assignments)  for 

fiscal year change and mid-year reassignments in Funds Management (FM). 

With the account assignment derivation, the values of the new FM account assignment are determined 

automatically from previous account assignments. Several target account assignments can be determined 

for some closing operations; this allows amounts to be split over several target account assignments and 

partial amounts to be included. You can also use other objects as source fields for the derivation, provided 

that a logical dependency exists between them and the target account assignments. 

The account assignment derivation consists of a sequence of derivation steps - the derivation strategy - 

through which the values from FM account assignments are derived from other account assignments. 

Each derivation step describes how a number of target fields can be filled by a number of source fields. 

There are different derivation step types, which map the different logical dependencies between source 

and target fields: 

- Derivation rule 

- Table access 

- Move 

- Clear 

- Enhancement 

- Function call 

You cannot define your own function calls. However, you can include the derivation steps (function 

calls) defined by SAP in your own derivation strategy. 

The following Function Module includes reassignments defined in the derivation strategy. 

 Global Function Heading 

 US Federal Government US Federal Government 

- Subsequent Postings for Canceling Fund (Payables) 

- Follow-on FI Postings (Function Module: FM_ADD_LINES_CANCELED_FUND) 

Dependencies 

For the closing operation of Subsequent Postings for Canceling Fund (Payables), the fund must be 

derived. This means that, if the fund (NEW_FUND, receiver fund) is not specified as a target field in a 

derivation step of step type derivation rule or if the value of the receiver fund is the same as the value of 

the sender fund, the system issues a "hard" error message. 

- Subsequent Postings for Canceling Fund (Payables) You can use the following source fields to 

derive the target fields: 

- SOURCE_FUND Sender fund 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 549 

- SOURCE_COMMIT_ITEM Sender commitment item 

- SOURCE_FUND Sender fund 

- SOURCE_FUNDS_CENTER Sender funds center 

- SOURCE_FUNCTION_AREA Sender functional area 

- SOURCE_MEASURE Sender funded program 

The following target fields are available: 

(Select Field attributes Overwrite with New Value as these fields can be pre populated.) 

- TARGET_FUND Target fund 

- TARGET_FUNCTION_AREA Target functional area 

- TARGET_COMMIT_ITEM Target commitment item (FM fiscal year change) 

- TARGET_FUNDS_CENTER Target funds center 

- TARGET_FUNCTION_AREA Target functional area (FM fiscal year change) 

36.4.4.1.5.3 Business Add-Ins for Canceled Funds 36.4.4.1.5.3.1 BAdI: Accounts 

Payable - Modify Document Type and Header 

Text for New Docs 

Use 

You can use this step to implement the Business Add-In BADI_CANCELED_FUNDAP, which replaces 

the original values for document types and header texts when a new accounts payable document is being 

posted. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 
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3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.4.1.5.3.2 BAdI: Accts Receivable - Modify Document Type and Header Text 

for New Docs 

Use 

You can use this step to implement the Business Add-In BADI_CANCELED_FUNDAR, which replaces 

the original values for document types and header texts when a new accounts receivable document is 

being posted. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 
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The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface 

name> ~ <Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.4.1.6 Business Add-Ins for Preclosing 

36.4.4.1.6.1 BAdI: Modify Output Columns for Unfilled Orders Program 

Use 

The purpose of this enhancement is to be able to modify the sales order quantity and add an obligation 

correction amount to the Close out Unfilled Orders Program (Year-End Closing Operation). These fields 

are transferred before the BAPI BAPI_SALESORDER_CHANGE is called. 

The transaction that plays a role here is: 

Close Out Unfilled Orders 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 
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1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name 

was automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

36.4.4.2 Preclosing (Former Budgeting) 

36.4.4.2.1 Define Rules for Closing Commitments 

Requirements 

You are using the Federal Government solution and want to close out outstanding obligations in a fiscal 

year. 

Activities 

The rules are based on FM area, fiscal year, fund type, obligation value types, and fund status. When 

transaction FMMC is run to complete obligation documents, only documents that meet the selection 

criteria and fall under these defined rules will be picked for processing. 
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Further notes 

A document meets the criteria of a defined FM closeout rule if the: 

- FM area matches 

- Fiscal year matches 

- Document's fund is in defined the fund type 

- Value type matches 

- Document's fund status matches in the following fiscal year 

36.4.4.2.2 Define Rules for Budget Rollup with Fund 

In this step, you can prepare the residual budget carryforward to the new fiscal year, as part of your fiscal 

year change work. 

You prepare a set of rules, where you specify one or more FM account assignments per FM area, fund 

type, and fund status. You can first repost the transferable residual budget to these assignments using the 

budget rollout program (BPCLOSE). You can then carry out the fiscal year change work, based on this 

new structure. 

Requirements 

The sender and receiver budget subtypes must have been created using the step Create Budget Subtype. 

Activities 

Create the rules you require. 

If you want to adopt the value from an account assignment (such as the function area) from the sender, 

enter "*". 

36.4.4.2.3 Define Rules for Budget Rollup with Fund Type 

In this step, you can prepare the residual budget carryforward to the new fiscal year, as part of your fiscal 

year change work. 

You prepare a set of rules, where you specify one or more FM account assignments per FM area, fund 

type, and status. You can first repost the transferable residual budget to these assignments using the 

budget rollout program (BPCLOSE). You can then carry out the fiscal year change work, based on this 

new structure. 

Requirements 
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The sender and receiver budget subtypes must have been created using the step Create Budget Subtype. 

Activities 

Create the rules you require. 

If you want to adopt the value from an account assignment (such as the function area) from the sender, 

enter "*". 

36.4.4.2.4 Define Rules for Closing Residual Accounts 

Requirements 

You are using IS-PS and want to pre-close residual balances from the federal ledger 

Activities 

Assign Dummy Cost Center 

First, set up a "Dummy" cost center to act as a cost collector for postings that involve P&L accounts with 

cost elements. When the preclosing process runs, all postings that have to impact the CO Module do so 

using this configurable cost center. 

Set General Rules for Preclosing 

The preclosing process reads the residual balances from the Federal ledger accounts configured in this 

table. After this process, the system applies a mapping rule to generate the preclosing posting. 

Basically, this table maps from a given source [sending elements] to a given target [receiving elements]. 

These rules are set up per company and from a given fiscal year. They involve a sending fund type, fund, 

fund center, commitment item, and functional area. In addition, the status of the fund is important; you 

can have a rule for expired, canceled, and uUnexpired funds. 

You can use a generic indicator '*' to mark "ALL VALUES" of a given field. In addition, you can mask 

the sending accounts. Example: 5* --> All accounts starting with 5 are retrieved and mapped. 

36.4.5 Ledgers 

36.4.5.1 Former Budgetary Ledger 

36.4.5.1.1 Define Document Types 

In this step you define the document types that you want to use for budget postings in the component 

Funds Management Government. 

If you define different document types, you can classify Funds Management budget entry documents. 

Activities 
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Define the document types that you require. 

36.4.5.1.2 Define Posting Key 

In this step, you define the debit/credit posting key for the postings in the Budgetary Ledger (BL). 

Standard settings 

In the standard, the key "40" is set for debit postings and the key "50" is set for credit postings. 

Activities 

Only change the posting key for the BL if you use a differing posting key logic for your FM area. 

36.4.5.1.3 Define Account Determination for US Government 

Use 

In this step, you define the account derivations between Funds Management (FM) and Budgetary Ledger 

(BL) 

The settings you can execute here are reconciled on the functional requirements of the US Federal 

Government. 

You define the G/L account derivations of the BL in the following customizing tables: 

- US Federal Government BL Budgeting 

Here, you define the BL accounts for budget postings. Use this if you are still using the old 

budgeting processor. We recommend you make your entries as specific as possible. 

- Budget Control System (BCS) 

Here, you define the BL accounts for budget postings if you are using the new BCS feature. 

However, we recommend you make your entries as specific as possible. 

- Revenues/Statistical Postings & OI/Actual Resources 

Here you define the BL accounts for revenues postings and statistical postings. Note that the DP 

with PO field is now obsolete. You cannot check this box when creating new entries. OSS note 

623050 gives detailed information on this. 

- Open Items/Actuals for Budget Status 

Here, you define the BL accounts for expenditure postings and open items 

Requirements 

You must ensure that BL documents have no effect on availability control in Funds Management (FM). 

To this end, the following prerequisites must be fulfilled for BL accounts: 
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- The commitment item assigned to the BL G/L account has financial transaction "50" (clearing). 

- The BL G/L account is not a cost element. 

Activities 

1. Select one of the Customizing tables, by double clicking the table in the dialog structure. By default, 

Customizing table US Federal Government BL Budgeting is displayed. 

2. Select New Entries. 

3. Make the necessary entries and enter the BL G/L account in the G/L account field. 

4. Save the entry. 

36.4.5.2 Budgetary Ledger 

36.4.5.2.1 Basic Settings 

36.4.5.2.1.1 Activate Budgetary Ledger Variant 

Use 

Use this step to make the settings required to activate the Budgetary Ledger (BL) in your installation. 

Activities 

Proceed as follows: 

1. In the Basic Settings for the Budgetary Ledger Overview, choose New Entries. 

2. In the next screen, use the dropdown to choose the applicable BL variant and the document type. 

3. Save your entries. This enables the specified document type for processing in the relevant budgetary 

ledger. 

36.4.5.2.1.2 BL Account Classification 

Use 

In this step, you enter classification data relating to your chart of accounts. This includes the following: 

- Specifying whether budget and/or actual postings are allowed for ranges of accounts 

- Stipulating whether postings to accounts in specified ranges are made through the budgetary ledger 

(BL) 
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- Entering Standard General Ledger (SGL) account classifications for ranges of accounts 

Requirements 

You have maintained and activated at least one chart of accounts. 

Standard settings 

We do not deliver any standard settings. 

Activities 

1. Having actioned the step, specify a chart of accounts. 

2. In the Budget/Actuals Allowed for Budgetary Accounts overview, choose New Entries and enter the 

ranges of accounts you need to process. In the case of each range, specify whether budget and/or 

actual postings are allowed. 

3. Click Budgetary Ledger/Other postings allowed in the dialog structure. 

4. In the resulting overview, select the range you want to process and choose the applicable BL 

account classification option. 

5. Click SGL Classification Propr. Accounts in the dialog structure. 

6. In the resulting overview, choose the appropriate account classification for each of the ranges 

displayed. 

7. Save your entries before leaving the transaction. 

36.4.5.2.1.3 Define Posting Key 

In this step, you define the debit/credit posting key for the postings in the Budgetary Ledger (BL). 

Standard settings 

In the standard, the key "40" is set for debit postings and the key "50" is set for credit postings. 

Activities 

Only change the posting key for the BL if you use a differing posting key logic for your FM area. 

36.4.5.2.1.4 Maintain Budget Type Attributes 

Use 
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Use this step to maintain the budgetary ledger (BL) account for each of your fund type/budget type 

combinations. This account is then derived in all your budget postings to the combination. 

Standard settings 

We do not deliver any standard settings 

Activities 

In the Change View: "Budget Type Attributes for Budgetary Ledger": Overview screen, choose New 

Entries and specify the following: 

- Fund Type 

- Budget Type 

- BL Account 

- If you assign more than one budget type to the same account within a fund type, check the Year-

End box for one of them. The entry so marked is then used to determine the budget type from the 

receiver account in year-end processing. 

36.4.5.2.1.5 Assign Fields for Zero Balance Check 

Use 

In this step, you assign fields to special ledgers for which you want to check zero balancing in the 

documents created by the budgetary ledger. You can only assign fields which are marked for "zero 

balancing" in the split method assigned to the ledger. 

Requirements 

To use this functionality you must set the flag "no splitting" in the customizing step "Activate Budgetary 

Ledger Variant". If you do not, documents created by the budgetary ledger are processed by the split 

processor in the same way as other FI documents. In this case, zero balancing is ensured with postings to 

the zero-balancing clearing account. 

Activities 

In the split ledgers overview, select the ledger you want to process and choose BL Documents: Assign 

Zero Balance Fields in the Dialog Structure. Then specify the fields to which you want to apply the zero 

balancing process. 
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36.4.5.2.2 Account Derivation 

36.4.5.2.2.1 Definition of BL Areas 

Use 

Use this step to make the settings required for derivation of budgetary ledger (BL) areas. 

Requirements 

The BL must be active. 

Standard settings 

We deliver a number of standard BL areas, as follows: 

- Budgetary Ledger - Actuals 

- Budgetary Accounts - Budgeting 

- Expended Appropriations - Actuals 

- Expended Appropriations - Budgeting 

- Miscellaneous Receipts - Actuals 

You can either tailor these standard areas to suit your requirements or create wholly new ones of your 

own. 

Activities 

To maintain BL areas, proceed as follows: 

1. Either select one of the standard strategies or choose New Entries and enter an identifier and name 

for a strategy of your own. 

2. Consider checking the Offset Account Required indicator for the strategy. If you do not, posting 

documents relating to the strategy must be balanced or the system will not accept them. 

3. Check the Protect indicator if you want derivations in this ledger to be blocked against unauthorized 

modifications. 

4. Use the Function Name field to specify the function for processing when the account derivation test 

feature is called. Enter a screen number also. 

5. With these settings made, select your strategy and choose Account Derivation Source Fields in the 

dialog structure. 

6. Enter the source table and field names to be used in the derivation strategy. 

7. Finally, choose Document Type in the dialog structure and specify the document type to be created 

for this BL area. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 560 

36.4.5.2.2.2 Federal Extension Derivation Access 

Use 

Use this step to access the budgetary ledger (BL) account derivations. You need to maintain one 

derivation strategy for each BL area. 

Requirements 

The BL is active. 

Activities 

The procedure used is the same as for the standard derivation tool 

Note, however, that the derivation for the BL area budget is generated automatically; you cannot change 

it 

36.4.5.2.2.3 Business Add-Ins for BL Account Derivation 

36.4.5.2.2.3.1 BAdI: Enhancements US Federal BL Account Derivations 

36.4.5.2.3 Adjustments 

36.4.5.2.3.1 Document Types for Adjustments 

Use 

Use this step to define the accounting document types needed to force the system to post documents as 

adjustments in the budgetary ledger (BL). 

Adjustments can be upward (budget is consumed) or downward (budget is returned). Requirements 

The document types must already exist in the system. You cannot create them here. 
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Activities 

In the view, enter the identifiers for the document types you want the system to post as adjustments in the 

BL. 

36.4.5.2.3.2 Maintain User Names for Adjustment Types 

Use 

Use this step to specify the users to whom the entries made in the step Document Types for Adjustments 

can be applied. 

Requirements 

The users must already exist in the system. You cannot create them here. 

Activities 

Select New Entries and enter the relevant users. 

36.4.6 Reporting 

36.4.6.1 GTAS 

36.4.6.1.1 Specify GTAS Account Balances 

Use 

In this Customizing activity, you specify which balances should be provided to the Governmentwide 

Treasury Account Symbol Adjusted Trial Balance System (GTAS). 

Activities 

1. Enter the company code. 

The system displays all general ledger (G/L) accounts defined for that company code. 
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2. For each G/L account, specify one of the following balance types based on the GTAS instructions 

from the Treasury: 

- Beginning balances 

- Ending balances 

- Both beginning and ending balances 

- Do not include 

If the balance type for a G/L account is blank, that account will not be included in the GTAS bulk 

file. 

36.4.6.1.2 Year of Budget Authority 

36.4.6.1.2.1 Configure YBA 

Use 

Year of Budget Authority (YBA) uses the attribute, YEAR_BDGT_AUTH. This field is part of FACTS 

II. 

YBA is a classification for no year fund postings to a defined set of G/L accounts (for example, 4802-

Prepaid/Advances; 4902-Delivered/Paid). Postings are classified using the prior year's budget with the 

attribute YEAR_BDGT_AUTH_9 containing the value, BAL, or the current year's budget containing the 

value, NEW. 

YBA functionality creates the budget values using RFFMFG_YBA_BDGT and consumes this budget 

within RFFMFG_YBA_UPD. The following are mandatory to use these programs: 

- Define G/L Accounts 

- BAdI: Define No Year Fund 

- BAdI: Define Starting Budget 

- BAdI: Define FIFO/LIFO Consumption 

- BAdI: Define Customer Dimension (optional) 

RFFMFG_YBA_BDGT creates the available budget and stores those figures in table FMFG_YBA_AVC. 

As an integration point, it includes the exit to define the starting budget. This exit can be used to select 

exiting budget entries within BCS. You can enter the budget amounts manually. 

The classification for the YBA is provided with program RFFMFG_YBA_UPD. This program updates 

the 95/97 ledger line items and totals with the classification. The program looks at all postings of the 

fiscal year or the postings to be processed, which apply for YBA. It provides two levels of results about 

the process. 

Requirements 

You have classified FG postings for the Year of Budget Authority and displayed them within FACTS II 

reports. 
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Standard settings 

We deliver the example, CL_FMFG_YBA_EXIT_SAMPLE_DEF, which includes the definitions of no 

year funds with a cancellation date of more than 50 years, a default FIFO for the consumption, and the 

available BCS budget as starting budget for the Year of Budget Authority. 

36.4.6.1.2.2 Define G/L Accounts 

Use 

You use this Customizing activity to define the G/L accounts applicable for the Year of Budget Authority 

(YBA). You can enter an individual G/L account as well as a range. You associate the G/L accounts to 

the company code. 

Standard settings 

You provide the G/L accounts to the following SGL accounts: 

- 4802 Prepaid/Advances 

- 4882 Upward Adj to Adv 

- 4902 Delivered-Paid 

- 4982 Upward Adj to Del-Paid 

- 4908 Authority Outlayed 

36.4.6.1.2.3 Business Add-Ins for YBA 

36.4.6.1.2.3.1 BAdI: Define No Year Fund 

Use 

You use this BAdI to define the no year fund. No year funds are a list of funds within the budget period. 

This information is necessary for all YBA functions. 

Standard settings 

We deliver the example, CL_FMFG_YBA_EXIT_SAMPLE_DEF, which includes the definitions of no 

year funds with a cancellation date of more than 50 years. 
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Activities 

You use the default delivered definition. If this is not sufficient, you can create and activate 

your own implementation based on the provided logic. 

36.4.6.1.2.3.2 BAdI: Define Starting Budget 

Use 

You use this BAdI to enable a flexible adoption if the budget values for the Year of Budget Authority 

exist within the system. 

Standard settings 

We deliver the example, CL_FMFG_YBA_EXIT_SAMPLE_DEF, which specifies how budget values 

from BCS are used to provide the starting budget for YBA. The delivered implementation collects the 

budget entries to all expenditure items in the processing year posted to budget version 0 by fund and 

additional YBA dimensions. 

Note: You use the (Re)initialization flag in the budget entry program to access the starting budget. 

Activities 

You use the default delivered definition. If this is not sufficient, you can create and activate your own 

implementation based on the provided logic. 

36.4.6.1.2.3.3 BAdI: Define FIFO/LIFO Consumption 

Use 

You use this BAdI to define how the budget is consumed. This BAdI enables flexibility in defining 

FIFO/LIFO based on the posting, which is classified for YBA. (FIFO defines consuming prior year's 

budget first; LIFO defines consuming current year budget first.) Additionally, this BAdI enables external 

posting classification by specifying the YBA value. In this case, the posting is exempt from consuming 

budget. 

Standard settings 
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We deliver the example, CL_FMFG_YBA_EXIT_SAMPLE_DEF, which includes the default to 

consume based on FIFO. 

Activities 

You use the default delivered definition. If this is not sufficient, you can create and activate your own 

implementation based on the provided logic. 

36.4.6.1.2.3.4 BAdI: Define Customer Dimension 

Use 

You use this BAdI to define the customer dimension. The customer dimension enables the customer to 

specify a granular level for consuming the budget and provide more control for the 

YBA. 

The customer dimension can be defined from available FM account assignment elements. The definition 

is built to enable the customer dimension to be implemented as a 1:1 definition of an FM accounting 

element and as a combination of FM accounting elements. The customer dimension can contain the index 

to the combination, enabling the output-related methods to display each combination. 

Standard settings 

The BAdI is not active in the standard system. 

Activities 

To activate the BAdI, you must create an active implementation. You use the example delivered in class 

CL_FMFG_YBA_EXIT_SAMPLE_DEF and focus on the implementation related to interface 

IF_FMFG_YBA_EXIT_CDIM_DEFINE. This interface requires the customer dimension definition to 

specify all possible values of customer dimensions, the field header for the customer dimension, and 

displayable value for output functions. The functionality enables the customer dimension to be 

implemented as index or address field representing a combination of the source fields. The FM account 

assignment elements are source fields for the customer dimension definition. 

36.4.6.2 SF-132 and SF-133 

36.4.6.2.1 Define Report Layouts for SF-132 and SF-133 

Use 
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Use this step to define the layout(s) you want to use when running SF-132 (Apportionment and 

Reapportionment Schedule) and SF-133 (Report on Budget Execution and Budgetary Resources). 

Standard settings 

SAP delivers a standard setup for each of the reports. You can use these or create your own. 

Activities 

To create your own layout, proceed as follows: 

1. In the Report Layout Overview, switch to change mode and choose New Entries. 

2. Specify the following: 

- A reporting layout ID 

- A program ID, identifying whether this layout applies to SF-132 or SF-133 

- A descriptive text 

3. Save your entries, then select that line and choose  Report Layout Definition in the Dialog Structure. 

4. In the Report Layout Definition overview, define what you want displayed in the relevant report by 

specifying the following: 

- Report Layout ID 

This is either one of the standard ones or one you defined in the first screen. 

- A sequence number for each field; this governs the order in which the fields appear when you run 

the report. 

- Reporting line number 

- Parameter set 

The options here are C1 or C2. They have the following effect: 

SF-132 

C1: Entries so marked appear in the "Budgetary Resources" section the report. C2: Entries so 

marked appear in the "Application of Budgetary Resources" section of the report. 

SF-133 

C1: Entries so marked can appear in any section of the report. 

- A descriptive text 

5. When you have finished, save your entries. 

36.4.6.3 SF-224 

36.4.6.3.1 Maintain Treasury Subclasses 

Use 
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Use this step to enter the Treasury subclasses you need for your SF224 report. 

Activities 

Choose New Entries and enter the codes Treasury has authorized your agency to use. If desired, you can 

enter descriptions for them also. 

Further notes 

The following is a listing of current Treasury Subclasses: 

- 41 Cashier 

- 46 Obligations of Closed Accounts 

- 62 Amortized Discount on Treasury Securities 

- 67 Purchase of FHLB and FLB Securities 

- 69 Purchase of Participation Certificates Sales Fund 

- 72 Unamortized Discounts 

- 75 Unrealized Discount on Treasury Securities 

- 76 Earnings on Treasury Securities 

- 77 Sale of FHLB and FLB Securities 

- 79 Sale of Participation Certificates Sales Fund 

- 80 Investment (Purchase) in Participation Certificates 

- 81 Investment (Purchase) in Non-Guaranteed Govt Agcy Sec 

- 82 Repayment of Borrowing from FFB 

- 85 Repayment of Borrowing from U.S. Treasury 

- 86 Actual Borrowings against Borrowing Authority 

- 87 Redemption of Non-Guaranteed Govt Agcy Securities in Mkt 

- 88 Investment (Purchase) in U.S. Public Debt Securities 

- 89 Invst (Purchase) in Guaranteed Govt Agcy Securities in Mkt 

- 90 Redemption (Sales) of Participation Certificates 

- 91 Redemption (Sales) of Non-Guaranteed Govt Agcy Securities 

- 92 Borrowing from FFB 

- 95 Borrowing from U.S. Treasury 
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- 96 Sales of Guar Govt Agency Sec in Mkt Par Domestic Postal Ord 

- 97 Sale of Non-Guaranteed Govt Agcy Securities in Market 

- 98 Redemption (Sale) of U.S. Public Debt Securities 

- 99 Redemption (Sale) of Guaranteed Govt Agcy Securities in Mkt 

36.4.6.3.2 Assign FI Document Type, Account and Fund to Treasury Subclass 

Code 

Use 

In this IMG activity, you assign a Treasury Fund Symbol Subclass Code (Treasury Subclass Code) to an 

FI Document Type, Account and Fund permutation. In other words, you define how a grouping of FI 

Document Type, Account and Fund represents a Treasury Fund Symbol Subclass for SF-224 reporting 

purposes. The definition is used to segregate amounts from special transactions, such as investments, 

from other amounts. These amounts need to be aggregated and displayed as separate lines in section I. 

Requirements 

There are approximately 27 Treasury Subclass Codes. Since agencies need to request permission from 

Treasury to use specific codes, customizing table FMUSFG_TS is delivered empty. You have to 

customize this table before you can assign a subclass code to a Type/Account/Fund grouping. The content 

of table FMUSFG_TS is expected to remain static after initial customizing. 

Standard settings 

We do not provide any default settings. 

Activities 

1. Choose New Entries and assign a Treasury Subclass Code to an FI Document Type, Account and 

Fund grouping. 

2. Save your entry. 

Further notes 

The following is a listing of current Treasury Subclasses: 

- 41 Cashier 

- 46 Obligations of Closed Accounts 

- 62 Amortized Discount on Treasury Securities 
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- 67 Purchase of FHLB and FLB Securities 

- 69 Purchase of Participation Certificates Sales Fund 

- 72 Unamortized Discounts 

- 75 Unrealized Discount on Treasury Securities 

- 76 Earnings on Treasury Securities 

- 77 Sale of FHLB and FLB Securities 

- 79  Sale of Participation Certificates Sales Fund 

- 80 Investment (Purchase) in Participation Certificates 

- 81 Investment (Purchase) in Non-Guaranteed Govt Agcy Sec 

- 82 Repayment of Borrowing from FFB 

- 85 Repayment of Borrowing from U.S. Treasury 

- 86 Actual Borrowings against Borrowing Authority 

- 87 Redemption of Non-Guaranteed Govt Agcy Securities in Mkt 

- 88 Investment (Purchase) in U.S. Public Debt Securities 

- 89 Invst (Purchase) in Guaranteed Govt Agcy Securities in Mkt - 90 Redemption (Sales) of 

Participation Certificates 

- 91 Redemption (Sales) of Non-Guaranteed Govt Agcy Securities 

- 92 Borrowing from FFB 

- 95 Borrowing from U.S. Treasury 

- 96 Sales of Guar Govt Agency Sec in Mkt Par Domestic Postal Ord 

- 97 Sale of Non-Guaranteed Govt Agcy Securities in Market 

- 98 Redemption (Sale) of U.S. Public Debt Securities 

- 99 Redemption (Sale) of Guaranteed Govt Agcy Securities in Mkt 

36.4.6.3.3 Maintain Derivation Strategy for SF-224 

Use 

In this IMG activity, you derive a Treasury Symbol Suffix (Treasury Subnumber) using available source 

fields. For partial 224 processing, you determine a target system value and determine whether line items 

qualify as reclassifications by setting the Reclassification flag. You can create several types of steps: 

- Derivation rule 

- Table lookup 

- Assignment 
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- Initialization 

- Function module 

The definition of subnumbers is used to segregate amounts from special transactions, such as investments, 

from other amounts. These amounts need to be aggregated and displayed as separate lines in section I of 

the report. 

Requirements 

Standard settings 

We do not provide any default settings. 

Activities 

See the example below. 

Example 

You want to create a derivation step to populate the Treasury Symbol Suffix: 

1. Select Create Step and choose Derivation Rule. 

2. Add a short description, such as "Rule for the Treasury Symbol Suffix" in the Text for Step edit box. 

3. As source fields, select FI-SL Document Type and Fund. 

4. As target field, select Treasury Subclass Suffix. 

5. Go to Maintain rule values and select Customer Payment as FI-SL document type and 

7060917 as Fund and 41 as Treasury Subclass Code 

6. Save your derivation step. 

Further notes 

Consult note 916086 if you wish to derive the Treasury Fund Symbol Subclass Code instead of using the 

current IMG activity Assign FI Document Type, Account and Fund to Treasury Subclass Code. 

36.4.6.3.4 Maintain Agency Location Code 

Use 
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Use this step to maintain the Agency Location Code (ALC) for your agency, as specified by the US 

Federal Treasury. For partial 224 processing, you assign a Business Activity Type and a Report Category 

to an internal ALC, using a From date. 

Requirements 

Standard settings 

Activities 

1. In the maintenance view, choose New Entries and enter the relevant ALC, description, and internal 

ALC indicator. 

2. To assign a Business Activity Type and Report Category to an internal ALC, select an ALC in the 

list and double click Assign. of Business Activity Type and Reporter Category in the Dialog 

Structure. 

3. Choose New Entries and enter the following: 

- From date 

- Business Activity Type 

- Report Category 

4. Save your entries. 

36.4.6.4 Treasury Report on Receivables and Debt Collection Activities 

36.4.6.4.1 Define TROR Groups 

Use 

You use this customizing activity to define TROR groups. You set up the following groups: 

- Reason Code 

- Document Type 

- G/L Account 

Requirements 

Ensure FI reason codes for A/R overpayment/underpayment are maintained in Public Sector 

Management -> Functions for US Federal Government -> Reporting -> Treasury Report on 
Receivables and Debt Collection Activities -> Define Reason Codes. 
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Activities 

To create group definitions, proceed as follows: 

- Create Reason Code 

1. Select TROR Reason Code Group Definitions from the dialog structure. 

2. Enter a code group ID and description. Click Save. 

3. Select the group ID and select TROR Reason Code Group Details from the dialog structure. 

You can enter a single value reason code or reason code ranges. 

4. Enter individual reason codes or ranges and click Save. 

 - Create Document Type 

1. Select TROR Document Type Group Definitions from the dialog structure. 

2. Enter a document type group ID and description. Click Save. 

3. Select the group ID and select TROR Document Type Group Details from the dialog structure. 

You can enter a single value document type or document type ranges. 

4. Enter individual document types or ranges and click Save. 

 - Create G/L Account 

1. Select TROR G/L Account Group Definitions from the dialog structure. 

2. Enter a G/L account group ID and description. Click Save. 

3. Select the group ID and select TROR G/L Account Group Details from the dialog structure. 

You can enter a single value account or account group ranges. 

4. Enter individual accounts or ranges and click Save. 

36.4.6.4.2 Configure TROR Report Versions and Line Definitions 

Use 

You use this customizing activity to define TROR line configuration. The TROR report categorizes open 

receivables and displays details of the receivable in the relevant lines on the report per the Treasury 

format. You set up the configuration for every line on the report. 

Requirements 

Ensure FI reason codes for A/R overpayment/underpayment are maintained in Public Sector 

Management -> Functions for US Federal Government -> Reporting -> Treasury Report on 
Receivables and Debt Collection Activities -> Define Reason Codes. 
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Ensure Define TROR Groups is maintained if you are using groups in the line configuration. 

Standard settings 

A standard template with report version STANDARD is available for use and reference. 

Activities 

To create line definitions, proceed as follows: 

1. TROR Report Version is the report layout. Standard report layout has been defined under 

STANDARD, which complies with the Treasury standard report. SAP delivers the STANDARD 

report version. It is possible to create copies of the standard for your own report layout for internal 

management purposes. 

2. TROR Report Lines: Click STANDARD and click on TROR Report Lines on the dialog structure on 

the left. You must be able to see all the lines of the TROR layout. It consists of the following: 

- Line ID identifies a line in the report layout. 

- Description is displayed for each line on the report. 

- Order Number indicates the order in which lines appear in the report. 

- Level specifies if a line is a header line, a title line, or a subline. This affects the indentation on 

the report. You can choose one of the values from the dropdown list as follows: 

- Part (I, II,...) title line without amounts 

- Section (A, B,...) title line without amounts 

- Numbered (1, 2,...) line with amounts 

- Subsection ((A), (B),...) line with amounts 

- You can use the lines defined in STANDARD layout or create additional lines. However, the 

calculation for populating additional lines must be coded in BADI_FMFG_TROR_CALC, 

which contains the following methods: 

- GET_FI_DOCUMENTS contains FI document selection 

- FILL_LINES reads line configuration and builds document lists for each line 

3. TROR Line Definitions: You specify the details of configuration required for calculating entries for a 

specific line. You must enter the following details for each of the lines: 

- G/L Account Group ID or Single G/L Account, Document Type Group ID or Single Document Type, 

Reason Code Group ID or Single Reason Code Group - You must create multiple definitions for 

each of the report lines. 

- Create line configuration for each of the lines and save the entries. 
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36.4.6.4.3 Business Add-Ins for TROR 

36.4.6.4.3.1 BAdI: Customize TROR Data Selection and Line Calculations 

Use 

You use the Treasury Report on Receivables and Data Collection Activities (TROR) to extract, 

manipulate, and display data on accounts receivable for the agency on a fiscal year-to-date basis. The 

output must be prepared using report format and line definitions specified by the Treasury's Financial 

Management Service (FMS). 

- BADI_FMFG_TROR_CALC enables users to customize specific business scenarios by creating a 

custom implementation and contains the following methods: 

- GET_FI_DOCUMENTS, which handles FI document selection 

- FILL_LINES, which reads TROR line configuration and assemble document lists, totals, and 

counts for each line in accordance with the specified line configuration 

- GET_CUSTOMER_TYPES, which contains logic for customer type determination 

- GET_ACCOUNT_ASSIGNMENTS, which contains account assignment fields from ledger 95 

Default BAdI implementation FMFG_TROR_CALC_IMP is delivered. 

Requirements 

Customer types must be maintained in the Implementation Guide (IMG). Choose Public Sector 

Management -> Functions for the US Federal Government -> General Settings -> Define 
Trading Partner Exceptions. 

Report layout and line definitions must be defined in the IMG. Choose Public Sector 

Management -> Functions for the US Federal Government -> Reporting -> Treasury Report on 

Receivables and Data Collection Activities -> Configure TROR Report Versions and Line 
Definitions. 

Group definitions must be defined in the IMG. Choose Public Sector Management -> Functions for 

the US Federal Government -> Reporting -> Treasury Report on Receivables and Data 

Collection Activities -> Define TROR Groups. 

FI reason codes must be maintained in the IMG. Choose Public Sector Management -> Functions for 

the US Federal Government -> Reporting ->Treasury Report on Receivables and Data 
Collection Activities -> Define Reason Codes. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create. 
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2. Save your entries and assign the implementation to a development class. 

3. Click the BAdI tab page and choose Create BAdI. 

4. In the dialog box, enter the required data then choose Enter. 

5. On the left navigation, expand Implementation and double-click Class. 

6. Double-click to on the method to enter method processing. 

7. Enter the code for the implementation between the statements method <Interface 

name>~<Name of method> and end method. 

Note: Sample implementation is copied automatically. 

8. Save and activate all objects. 

36.4.6.5 Define Report Layouts 

36.4.6.5.1 Define Report Layouts 

Use 

The report layout feature allows you to define  the layout of a report in conjunction with a report 

processing those definitions. This function is generic and provides a look similar to the reporting 

crosswalks containing the Federal Government reporting definitions. 

This functionality is used to define reports like the SF-132 (Apportionment and Reapportionment 

Schedule), SF-133 (Report on Budget Execution and Budgetary Resources).and Statement of Net Cost. 

Those reports have specific requirements that do not allow use of the Report Writer/Report Painter as the 

preferred reporting tool. 

In cases where the requirements are similar, you can use the report layout function to define your own 

reports. 

This IMG contains the customizing view for defining the reporting layouts as well as a tool program for 

supporting functions. The tool program contains additional information. 

Standard settings 

Standard settings can be found within the delivered definitions. 
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36.4.6.5.2 Customize Report Layout 

Use 

Use these steps to define the layout(s) you want to use when executing the reports to which you link the 

layouts. 

Requirements 

Have an individual program available using the report layout(s) 

Standard settings 

We deliver layout definitions containing standard settings. If the delivered layouts do not appear, use the 

report layout tool to copy them from client 000. 

Activities 

To create your own layout, proceed as follows: 

1. In the Report Layout Overview, switch to change mode and choose  New Entries. 

2. Specify the following: 

- A reporting layout ID 

- A program ID, identifying that this layout applies to a individual program 

- A descriptive text 

3. Save your entries, then select that line and choose Report Layout Definition in the Dialog Structure. 

4. In the Report Layout Definition overview, define what you want displayed in the relevant report by 

specifying the following: 

- Report Layout ID 

- This is either one of the standard ones or one you defined in the first screen. 

- A sequence number for each field; this governs the order in which the fields appear when you 

run the report. 

- Reporting line number 

- Parameter set 

The options here are what the receiving program supports. In the delivered programs, the 

parameter set for the header or text line is AL. The parameter sets to specify the characteristics 

are C1 or C2. The parameter sets define which values the parameter fields (up to 15) contain. 

The parameter sets DL, D1 or D2 provide information to the parameter field definitions. 

- A descriptive text 

5. When you have finished, save your entries 
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36.4.6.5.3 Report Layout Tool 

Use 

The report layout tool program provides basic functions for working with report layouts. The following 

basic functions are available: 

- Copy from client. 

- Export the report layout. - Import the report layout. 

- Renumber the report layout. 

In addition, the tool provides a formatted display on the defined report layout as well as supporting 

documentation for the use of report layouts. 

36.4.6.6 Additional Reporting Attributes 

36.4.6.6.1 Configure Additional Reporting Attributes 

Use 

Federal Government reports can be categorized as either created using the Report Writer/Report Painter 

reporting tool, or as stand-alone reports. Stand-alone reports use either the selection screen for flexible 

report definitions or the report layout function. Either report generally reports on data from the Federal 

Government ledgers (95/96/97). The additional reporting attributes feature allows extension of the 

reportable fields beyond what can be found in the Federal Government ledger tables using the 

information provided within the additional reporting attributes. 

The additional reporting attributes are defined in structure FMFGRPTA. They are populated at runtime 

by means of a derivation call. 

The derivation source is the information based on the Federal Government total tables. This information 

can be used to define the additional reporting attributes. Business Add-IN (BAdI) exits allow you to tailor 

or streamline the function. 

The additional reporting attributes can be used for data filtering or you can inclucde them in the 

reporting output. They are available as a full report characteristic within the Federal Government Report 

Writer/ Report Painter. The drilldown process is supported for these additional attributes (program 

RFFMFG_FMUSFGA). 

This feature can also be used for customer-specific reporting enhancements. 

Requirements 

You have reporting requirements where, for example, you have to categorize reporting data based on the 

fund (earmarked funds/all other funds). 

Standard settings 

We deliver the following additional reporting attributes: 
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- FUNDINYEAR: This attribute eliminates the year-specific fund selections. If funds are not to be 

elected to one particular fiscal year, this attribute should be defined as 'N'. 

- FUNDEARMARKED: This attribute defines the associated fund as earmarked. 

The BAdI definition comes delivered with an example class using the derivation tool to define the 

additional reporting attributes. The example class can be used for a BAdI implementation. 

Activities 

Maintain the derivation to populate the receiver fields used. 

Example 

BAdi: Use of Reporting Attributes (SIMG_PSMFG_RPTA_EXIT) 

36.4.6.6.2 Maintain Derivation for Additional Reporting Attributes 

Use 

In this activity, you use the derivation tool to create derivation rules that define the additional reporting 

attributes based on the sender data fields. Federal Government total table detail is provided as sender 

data. Receiver fields are the additional reporting attributes specified in structure FMFGRPTA. 

Requirements 

Use the standard delivered example class in the Business Add-In (BAdI) as the implementation to derive 

additional reporting attributes. 

Standard settings 

We do not provide any standard settings. 

Activities 

1. Create a new step for your derivation strategy. 

2. To create a derivation rule, choose the source and target fields and maintain the field values. 

3. Save your entries. 

Example 

Specify the following as standard derivation steps: 

 - For FUNDEARMARKED: Define all your earmarked funds with 'Y'. 

36.4.6.6.3 Business Add-Ins for Additional Reporting Attributes 
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36.4.6.6.3.1 BAdI: Use of Reporting Attributes 

Use 

We deliver an example class within this Business Add-In (BAdI). Using this class within the BAdI 

implementation allows you to define the ADDIN function and associates the receiver fields with it. The 

call to the derivation tool is defaulted to specify the additional reporting attributes. 

The definition of the main element, the ADDIN parameter, can be associated with a function that uses the 

additional reporting attributes or a specific report using it. We have defined a set of locations upfront 

which use the additional reporting attributes and them to be enhanced by customer own locations. 

Performance-related optimizations can require you to replace retrieval of additional reporting attributes 

using the derivation tool with a more streamlined option. In this case, a coded solution to define the 

additional reporting attributes is recommended. 

Activities 

After you call up the activity, a dialog box appears. 

1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click the BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.4.7 Integration 

36.4.7.1 General Settings 

36.4.7.1.1 Business Add-Ins for US Federal Government Fields Dialog 

36.4.7.1.1.1 BAdI: Functions for US Federal Government Fields Dialog 

Use 
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This Business Add-In (BAdI) is used in the Functions for U.S. Federal Government (PSM-FG) 

component. You can use this BAdI to prefill field values in the US Federal Government fields. You can 

specify display options (display only, mandatory, or hidden) for each field that appears in the US 

Federal Government Fields dialog box. You can also adjust the field checks in the dialog or on a 

document level. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

If you want to use your own implementation, complete the following steps: 

1. In the dialog box, enter a name for the enhancement implementation, short text, and composite 

enhancement implementation. 

If no composite exists, create a new one by choosing Create. 

2. Save your entries, and assign the implementation to a development class. 

3. Select the BAdI tab and choose Create BAdI. 

4. In the dialog box, enter the BAdI definition, BAdI implementation, implementation class and 

description, and press Enter. 

5. On the next screen, expand the implementation node and double-click Class. 

6. With your cursor on the method, double-click to enter method processing. 

7. Enter the code for the implementation between the method <Interface name> ~ 

<Name of method> and endmethod statements. The 

sample implementation is copied automatically. 

8. Save and activate all objects. 

Example 

You can find example implementations in the BAdI Builder on the Enhancement Spot Element 

Definitions tab in the Implementation Example Classes section. 

The following example implementation is available: 

 - FMFG_USKONTUI_EXIT_IMPL and class CL_FMFG_USKONTUI_EXIT_IMPL 

You can add to this example implementation, or you can create your own implementation to replace 

it. The implementation contains comments to help you build your own implementation. 

The delivered implementation includes the check for entering trading partner fields for a federal 

trading partner. For more information, see Customizing activity Define Trading Partner Exceptions. 

The exit suggests that changes to all US Federal Government fields can be influenced by a customer 

implementation. Trading partner fields are controlled in standard delivered code, which limits 

changes to the trading partner fields when you are posting an actual document that references a 
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predecessor document or when you are changing a document that is referenced by another 

document. You can provide stronger control using a customer implementation within this exit. 

When creating a document that references a predecessor document, the field values default from the 

predecessor document. 

Individual field value checks include the checks provided inBAdI: Definition of US Federal 

Government Field Values. 

36.4.7.1.1.2 BAdI: Customer Subscreen in US Federal Govt Fields Dialog 

Use 

This Business Add-In (BAdI) is used in the Functions for U.S. Federal Government (PSM-FG) 

component. You can use this BAdI to add customer fields to the US Federal Government Fields 

dialog. 

Requirements 

You already added your fields to the database by creating an append structure to the 

FMFGUSKONTKEY_DATA structure, which is included in the FMFGUSKONTKEY key table, and 

defining the customer fields in the append structure. Each field is defined by its own data element. When 

the data structure of FMFGUSKONTKEY changes, you may need to create a new version using the 

RFFMFG_USKONTKEY_CONV program. 

You included the FMFG_USFIELD_F4 search help. 

You already created the screen program and included the customer fields by doing the following: 

1. Copy the delivered FMFG_USKONTUI_SUB1_EXM function group. 

2. Add the new field into dynpro 8100 and reference the FMFGUSKONTKEY_DATA structure. 

3. Uncomment the CHECK_FIELD_8100 module and the CHECK_FIELD_8100 subroutine. 

Standard settings 

For more information about the standard settings (filters, single or multiple uses), see the Enhancement 

Spot Element Definitions tab in the BAdI Builder (transaction SE18). 

Activities 

If you want to add your own dialog, complete the following steps: 

1. In the dialog box, enter a name for the enhancement implementation, short text, and composite 

enhancement implementation. 

If no composite exists, create a new one by choosing Create. 

2. Save your entries, and assign the implementation to a development class. 

3. Select the BAdI tab and choose Create BAdI. 
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4. In the dialog box, enter the BAdI definition, BAdI implementation, implementation class and 

description, then press Enter. 

5. On the next screen, expand the implementation node and double click Class. 

6. With your cursor on the method, double click to enter method processing. 

7. Enter the code for the implementation between the method <Interface name> ~ 

<Name of method> and endmethod statements. The 

sample implementation is copied automatically. 

8. Save and activate all objects. 

Example 

You can find example implementations in the BAdI Builder on the Enhancement Spot Element 

Definitions tab in the Implementation Example Classes section. 

The following example implementations are available: 

 - CL_FMFG_USKONTUI_SUB1_EX_EXM 

You can use this example class for your BAdI implementation. You must define the screen and 

screen program in the implementation. 

36.4.7.2 Principle of Prudence 

36.4.7.2.1 Define Derivation Strategy for Principle of Prudence 

Use 

Use this step to define the derivation strategy you need to apply the principle of prudence in your 

installation. 

If you set the flag for postponing a funds return to "P", document processing can be customized so that 

parked documents, such as credit memos, do not impact the budget. Only posted documents impact the 

budget. 

If you set the flag for postponing a funds return to "C", document processing can be customized so that 

documents only impact the budget at point of collection. This requires the system to delay the update to 

Funds Management (FM) until the document is collected or offset against another document. This option 

is only available for documents with a purchase order reference or without an obligation reference. For 

documents referencing an earmarked fund or sales order the setting is ignored. 

Standard settings 

As a minimum, the following fields are available for use in determining whether the credit memo update 

to FM is delayed: 
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- Fund 

- Fund Type 

- Trading Partner 

- Document Type 

Activities 

You can create, change, and delete steps and also change their order. 

Create Step 

1. Choose Create Step. 

If you want to add a new step to the derivation strategy, select the step before which you want to 

insert the new step and choose Create Step. 

2. Choose the derivation step type that you want from those offered to you. 

3. Enter a text and source and target field for the derivation step. For the source and target fields, you 

can determine Field characteristics. 

- Source Field 

You can determine that initial values are permitted. This means that a derivation is carried out 

if the source field is not filled. 

- Target Field 

For the target field you can determine that: 

The new value is not copied if a value from a previous derivation step already exists. The new 

value is copied even if the new value is blank (space) 

The new value is copied when the new value is filled. 

Note: If you use this setting you can determine, for example, that the derived value cannot be 

overwritten manually. 

- Source Fields and Target Fields 

In addition to the derivation step type "Derivation Rule", you can determine that either the entire 

field contents, or only a part of the field contents is included. 

4. If the derivation step should only be performed according to specific conditions, for example, only 

for specific account assignment values, enter this on the Condition tabpage. The derivation step is 

only executed when all conditions for the fields are fulfilled. 

5. Define Step Characteristics on the Characteristics tabpage, for example, if an error message should 

be issued, if no target value can be determined. 

- An error message should be issued if the derivation step is not successfully derived. Otherwise 

the strategy will not be continued. 

- The execution of the strategy should be terminated if a suitable value is found in the derivation 

step. Otherwise the strategy is completed. 

Note: If you are using derivation step type "Derivation Rule", you can make the following 

additional entries: Assignment Derivation. 
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You can make additional specifications on the Characteristics tab; for example, you can allow the 

entry of a validity date for a step and therefore make it time-dependent. 

6. When you have saved the new entry, go back to the complete list. 

7. To assign a company code to a strategy, select the strategy and choose company code assignment in 

the dialog window. 

8. Choose new entries in the overview that follows and enter the company code you want to assign to 

the strategy. 

Change/Delete Step 

- When making a change, you have all the options described under "Create Step". 

- To delete an entry, select the relevant step and choose Delete. 

Change Step Sequence 

1. Select the step you want to move. 

2. Position the cursor below the target position. 

3. Choose Move. 

36.4.7.3 Asset Management 

36.4.7.3.1 Accountable Property 

36.4.7.3.1.1 General Settings for Accountable  Properties 

Use 

In this IMG activity, you enter general settings applying to accountable property processing. 

Activities 

Make the following entries: 

- Company code 

When you save, the company code name and currency are automatically entered in the relevant 

fields. 

- Date from which these settings are to be applied. 

- Low and high value 
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Only qualifying property whose value lies between the limits you enter here is treated as 

accountable property. 

- Sensitive property 

Property that does not fall within the limits imposed by the low and high values may 

nonetheless be treated as accountable property. To do this, designate it "sensitive" property. 

The field documentation tells you how to do this and what you need to consider. 

36.4.7.3.1.2 Transaction Types 

Use 

In this step, you assign transaction types to your company code(s) for use with accountable property 

processing. 

Requirements 

You have created the transaction types in Materials Management (MM). 

Standard settings 

SAP does not deliver any standard settings. 

Activities 

Assign both a transaction type and a negative transaction type to your company code. The negative 

transaction type is used for corrective postings when, for example, the amount in the final invoice is less 

than the amount in the purchase order referenced by the invoice. 

Further notes 

36.4.7.3.1.3 Account Assignment Categories 

Use 

In this IMG activity, you stipulate how your combinations of account assignment categories and item 

categories are to be handled in accountable property processing. 

Requirements 

You must first have defined the account assignment and item category combinations in Materials 

Management (MM). 
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Activities 

For each account assignment + item category combination, select one of the following: 

- Accountable Property 

Combinations so selected are treated as accountable property, subject to the selections made in 

other IMG steps. 

- Leased Item 

The lower value specified for accountable properties is applied to these combinations, but the 

higher value is not. 

36.4.7.3.1.4 Movement Types 

Use 

In this IMG activity, you stipulate whether movement types defined in Materials Management (MM) can 

be included in accountable property creation. 

Requirements 

You must first have created the movement types in MM. 

Activities 

For each movement type, select either "Goods Accepted" or "Goods Rejected", but not both. 

Movement types marked "Goods Accepted" are included in accountable property creation, subject to the 

other IMG settings you enter. 

36.4.7.3.1.5 Business Add-Ins for Accountable Property 36.4.7.3.1.5.1 BAdI: 

Allow Further Logic in Determining Accountable 

Property 

Use 

This BAdI allows the analysis of data accumulated by the accountable property program. Using the data 

accumulated by the program, the determination of whether or not this item is accountable property can be 

controlled. 

The field NOW_ACC contains "X" if the program considers the item to be accountable property. The 

program attempts to create assets for, and post values to, this item. 
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This BAdI exists to allow customer manipulation of the fields of the parameter ASSET_LINE, primarily 

the field NOW_ACC. 

Overwrite the contents of this field if necessary: if this item should be accountable property, make sure 

the field has an "X". If it should not be accountable property, make sure the field is empty. 

Requirements 

You must have the accountable property program, with all of its configuration, properly prepared for 

execution. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

See the sample code for a detailed example. 

36.4.7.3.1.5.2 BAdI: Change Values to be Transmitted to the Asset Record 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 588 

Use 

This BAdI allows you to change the values to be passed to the asset master record. 

Method: CHANGE_VALUES 

Requirements 

You must be using the Accountable Property program. In the program logic, many fields are calculated 

and MM Purchasing information is passed to the BAPI which creates the Asset Master. If you want to 

change any of the data that will be passed to the asset master, you change it here. 

Standard settings 

One asset or subasset will be created for each item. You can identify which purchasing data the asset 

represents by the importing fields PO number, PO item number, and account assignment. 

You can then change the data in the "changing" tables below, and these updates will be passed back to the 

Accountable Property program for asset creation or posting. 

 PO_NUMBER Importing 

 PO_ITEM Importing 

 ACCOUNT_ASSIGNMENT Importing 

 GEN_DATA Changing 

GEN_DATAX Changing 

ACQUIS_DATA Changing 

POSTING_DATA Changing 

REAL_ESTATE Changing 

REAL_ESTATEX Changing 

POST_DATA Changing 

POST_DATAX Changing 

TIME_DEP_DATA Changing 

TIME_DEP_DATAX Changing 

Example 

You want to assign a unique inventory number for each asset created: 

*---- If a field that is required is empty, pass it the value you would 

*---- like it to have, here we create a inventory number for the 

*---- asset master record 

  IF gen_data-invent_no IS INITIAL. 

*---- Execute customer function to get next inventory number     

call function 'ZZ_GET_INVENTNO'           importing                 
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invent_no = new_inventno.     gen_data-invent_no = 

new_inventno.     gen_datax-invent_no = 'X'.   ENDIF. 

Method MESSAGE_EXCEPTION 

The method MESSAGE_EXCEPTION allows you to suppress the error messages proposed by the 

program where required fields are not filled. This can be used where it is known that the required field 

will be populated later by the BAdI. 

In some circumstances, you may want to add required fields to the asset after the program has executed. 

To suppress errors in posting to assets that are incomplete, perform FI-AA customizing which will allow 

message AAPO 184 to be displayed as a warning, and not an error. Although it is not recommended, 

assets can be created in an incomplete state and updated later, after asset record creation and acquisition 

posting. 

The typing for the local table which you assign to the table parameter REQ_FIELD should be similar to 

the example in the sample implementation. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and 

choose Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 
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36.4.7.4 Materials Management 

36.4.7.4.1 Document-to-Document Tolerances 

Use 

Use this step to set up the tolerances between purchase requisitions and purchase orders in the Federal 

Government solution. 

Activities 

1. In the tolerance key folder, create a tolerance key and a descriptive text. 

2. To add detail, choose Tolerance Key Values in the dialog structure and enter absolute and/or 

percentage tolerance values for either the value-based check or percentage check or both. You must 

add an entry in this folder for each currency you expect to use. 

3. The system needs to know with which document type each new key is associated. To do this, choose 

Document Type Association in the dialog structure and enter your new key next to the relevant 

document type. Once you have assigned a key to a document type, the tolerances become active in 

your system. With these tolerances active, you receive a message if your purchase order does not 

reference a purchase requisition. You also receive a message if you attempt to enter a purchase order 

in a currency that has not been configured. 

To turn off tolerances in your system, delete the associated tolerance keys from all document types. 

Note 

There is also some message configuration work to do. To do it, go to the Funds Management Government 

IMG and choose Basic Settings -> Change Message Control. 

The messages you need to configure are numbers 059, 060, 061, 064, and 069 in message class 

FICUSTOM. For each user involved in the process, you need to specify whether the system should issue 

an information message (I), warning (W), or error (E). 

36.4.7.5 Sales and Distribution 

36.4.7.5.1 Reimbursable Orders 

36.4.7.5.1.1 Define Reimbursable Orders 

Use 

Use this step to define Sales and Distribution (SD) orders relating to reimbursable agreements. A 

reimbursable agreement is a contract between a Federal government agency and another entity, which 

may also be a Federal agency, whereby the delivering agency supplies goods or services to the other 

entity, whom it may then bill for the costs. 
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Requirements 

You need to have created the SD objects you want to specify (see below). 

Standard settings 

We do not deliver any standard settings. 

Activities 

Choose New Entries and specify the following SD objects: 

- Sales organization 

- Distribution channel 

- Division 

- Sales document type 

Having made these entries, hit Enter. The system then fills the Description columns with the appropriate 

texts. Remember to save your entries. 

36.4.7.5.1.2 Automatic Down Payments 

Use 

Use this step to activate or deactivate the automatic down payment function for sales document types. 

Requirements 

You must first have defined the sales document types you want to process here. 

Activities 

1. To enter document types for automatic down payment postings, choose New Entries and proceed as 

follows: 

- The sales document type 

- Check the automatic down payment box for the document type 

2. When you have finished, save your entries. 

36.4.7.5.1.3 Year-End Closing 

Use 
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In this step, you make the settings necessary for year-end processing of reimbursable orders. As with 

purchase orders, sales orders (SOs) should be monitored throughout the year, especially at year-end, and 

updated based on obligations, expenses, billings, and so on. Based on the stage of the internal fund and 

the SO ending date, the SO is reduced or has excess values transferred to new lines. To accommodate the 

overall reduction and/or the transfer to new lines, the document type for clearing the prior down payment  

and the document type for transferring the down payment to the new line(s) must be identified. 

Requirements 

You must first have created the sales document types you want to process here. To do this, access 

Customizing and choose Sales and Distribution -> Sales -> Sales Documents -> Sales Document 

Header -> Define Sales Document Types. 

Standard settings 

We do not deliver any standard settings. 

Activities 

In the maintenance view, choose New Entries and enter the following: 

- Sales document type(s) for processing 

- FI document type(s) for clearing the down payment 

- FI document type(s) for transferring the down payment to the new line(s) 

The FI down payment and clearing document types are used only if the automatic down payment function 

for the sales document type is deactivated. Read Automatic Down Payments for more information on this 

feature. 

36.4.7.6 Central Contractor Registration 

36.4.7.6.1 Activate CCR Vendor Feature 

Use 

Use this step to activate the Central Contractor Registration (CCR) feature in your installation. When 

activated, the SAP CCR feature supports an interface with the CCR for creating and maintaining CCR 

vendors in the system and enables users to block postings to CCR vendors whose registration status has 

expired. 

The CCR is the primary vendor database for the U.S. Federal Government. It collects, validates, stores 

and disseminates data in support of agency acquisition missions. Both current and potential government 

vendors are required to register in CCR in order to be awarded contracts by the government. Vendors 

must update or renew their registration annually to maintain an active status. 
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Activities 

To activate CCR, check the CCR Active box in the maintenance view. 

36.4.7.6.2 Maintain Vendor Master Display Fields for CCR 

Use 

When the Central Contractor Registration (CCR) is run, the fields it updates should be displayed in the 

vendor master change screen, but should not be open for maintenance there. 

If you are using the CCR interface to maintain your vendor master records, you should consider which 

fields you would like users to be able to change manually through the vendor master record change 

screen. 

If you do not use this configuration option, vendor master data that is loaded through CCR can be 

changed manually. As a result, vendor master data, such as payment information, gets of synch with what 

is maintained in the CCR database. 

This configuration option allows you to set certain fields as display only so that they can only be changed 

through the CCR maintenance process. 

Activities 

In the maintenance view, choose New Entries and add those fields you want displayed in the vendor 

master change transaction. The fields so entered cannot be maintained in the vendor master change 

screen. 

36.4.7.6.3 Business Add-Ins for CCR 

36.4.7.6.3.1 BAdI: Move CCR Data to IDoc Segment Fields 

Use 

In this step, you run Run Business Add-In (BAdI) FMFG_CCRVNDORMIGRATE, which maps the 

CCR fields to the corresponding vendor master fields. Sample code is available. 

Activities 
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After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

36.4.7.6.3.2 BAdI: Customizing CCR Expired Vendor Messaging 

Use 

Implement enhancement point FMFG_CCR_MESSAGE_CUST enables you to to overwrite hard coded 

default message types when handling messaging during CCR vendor status validation. These default 

message types are hard-coded in enhancement FM_DOCUMENT_VALIDATION implementation. 

If FMFG_CCR_MESSAGE_CUST is implemented, these default message types can be overwritten with 

custom message types which can be set based on a transaction type, user ID, and so on. It is also possible 

to add new validations and custom messages - for example, that a given vendor expires in one week. 

Note that values set up in this implementation are overwritten, when applicable, by messages configured 

in table T100C if the configured messages have a lower severity level. For example, an error (type "E") is 

overwritten by a warning (type "W"), but the reverse would not be the case. If no corresponding entries 

exist in table T100C, the custom message types are the ones used. 

Activities 

After you call up the IMG activity, a dialog box appears. 
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1. In the dialog box, enter a name for the enhancement implementation, Short Text and Composite 

Enhancement Implementation. If no Composite exists, create a new one by choosing Create button. 

2. Save your entries, and assign the implementation to a development class. 

3. Click on BAdI tab and choose the Create BAdI button. 

4. In the dialog box, enter BAdI Definition, BAdI Implementation, Implementation Class and 

description, then press Enter. 

5. In the left panel on the next screen, expand implementation node and double-click on entry Class. 

6. Place the cursor on the method, and double-click to enter method processing. 

7. Enter the code for the implementation between the statements method  <Interface name> ~ <Name 

of method> and endmethod. Note that sample implementation is copied automatically. 

8. Save and activate all the objects. 

36.4.7.7 Internal Data Transfer 

36.4.7.7.1 Payment-Related 

36.4.7.7.1.1 Payment Lines Correction 

Use 

Use this step to configure payment lines correction in the Budgetary Ledger 

Activities 

In the selection screen, make the entries you require and proceed as described in the documentation for 

the program. 

36.5 Fund Accounting 

36.5.1 General Ledger Accounting (New) 

36.5.1.1 Implement New General Ledger Accounting 

Use 
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The following describes which settings you have to define to fulfill the requirements of GASB 34/35 or 

of Fund Accounting based on general ledger accounting with the table group FMGLFLEX intended for 

this. Some of the requirements are: 

- Balance sheet for each fund 

- Profit and loss statement for each functional area 

- Budget/actual comparison 

Requirements 

- The  Global Functions for Funds Management (PSM-FM)are active. 

- The New General Ledger Accounting is active. 

- You have a new installation or are introducing the New General Ledger Accounting through 

migration and are using a migration plan from type with document splitting: Classic General 

Ledger Accounting  in General Ledger (new) or from SL with Document Splitting in General 

Ledger (new). 

Activities 

Define the following settings: 

- Define your leading and, if necessary, another ledger based on totals record table 

FMGLFLEXT. 

- Assign scenario PSM_FAC (Fund Accounting) to your leading ledger (and other ledgers if 

necessary). If you use Grants Management and a balance sheet is necessary for each grant, assign 

scenario PSM_GM (Grants Management) as well. 

- Define the fund, business area and if necessary grant as document splitting characteristics for 

general ledger accounting. Select these fields as required-entry fields. If you want to use the online 

payment update in Funds Management, define additional fields commitment item, FI document 

number and payment document number as document splitting characteristics. 

- Define the functional area as a document splitting characteristic for Controlling. 

Define other document splitting characteristics for. You have to assign one to your requirements in 

accordance with the corresponding Assign Document Splitting Method. If you plan to use document 

splitting rules different to the standard ones, we recommend that you copy the corresponding document 

splitting method to a customer-specific customer namespace. 

36.5.1.2 Activate Fnctnl Area as Doc. Splitting Characteristic for Gen. Ledger 

Acctg 

Use 
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In this IMG activity, you can activate the functional area as a financial statement characteristic for new 

General Ledger Accounting. 

The activation applies across all clients and is irreversible! 

Note that this activation causes you to lose the original meaning of the functional area as a Controlling 

characteristic and prevents you from using the functional area as a Controlling characteristic. 

Requirements 

For it to be possible to activate the functional area as a general ledger characteristic, the following 

conditions need to be met: 

- The function area must not already be specified as a Controlling split characteristic in any client. 

- Document splitting must not yet be activated in new General Ledger Accounting. 

- Cost of sales accounting must not be activated in any of your company codes. 

36.5.1.3 Cash-Basis Accounting and Cash Flow Reporting 36.5.1.3.1 Distinction 

Between Cash-Basis Accounting and Cash Flow 

Reporting 

Use 

Distinction Between Cash-Basis Accounting and Cash Flow Reporting 

Cash-Basis Accounting 

This solution provides a cash ledger for cash-basis accounting. Cash-basis accounting is a recognized 

standard of the IFAC (International Federation of Accountants) and can be used to fulfill the cash ledger 

requirements of the IPSAS (International Public Sector Accounting Standards). 

For cash-basis accounting with this solution, a leading accrual ledger is always a requirement. All SAP 

integration points post to the leading accrual ledger in accordance with the principles of the accrual basis 

of accounting. The information for the cash ledger is derived from the leading accrual ledger. 

The cash ledger is indispensable for organizations that are obliged by law to execute on their expenditures 

and revenues at the time of payment. At the time of cash flow, the cash ledger makes sure that the 

revenues and expenditures are posted against the correct cash accounts. If necessary, clearing postings are 

added to achieve zero balances for all balancing entities. As a rule, cash and P&L accounts are the only 

accounts to which postings are made in Cash-Basis Accounting. 

If you also want a full balancing cash ledger in addition to a leading accrual ledger, use the Cash-Basis 

Accounting solution. 
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You can use the reconciliation analysis report (program RFMFGRCN_RP1) to reconcile the data from the 

accrual ledger and the cash ledger. Both ledgers are only reconciled on the cash accounts and there is no 

automatic tool for adjustment postings if differences occur. However, it is possible to adjust the cash 

ledger manually. 

Data Volume: 

An additional ledger is introduced into the new General Ledger Accounting when using 

Cash-Basis Accounting. This cash ledger increases the data volume in the new General Ledger 

Accounting. Based on average experiences, it can be expected that the volume in the cash ledger can be 

disregarded in comparison to the volume in the leading accrual ledger. The cash ledger is also used only 

for very specialized and small operative purposes, so the data volume here does not influence the 

operations in the leading accrual ledger. 

Cash Flow Reporting 

Cash flow reporting in this solution is based on an accrual ledger, it is not an additional (cash) ledger. 

Cash Flow Reporting gives readers information on the origin of funds that occurred during the accounting 

period, on the application of funds, and the cash balance on the date in question. It is used by customers 

who do not legally require a cash ledger, but want to display capital flow separately by source account 

(for example, expenditure, revenue, tax, balance). The reporting procedure can also be executed with a 

combination of cash clearing accounts and source accounts. 

If you only want to execute cash flow reporting based on an accrual ledger, and do not require a separate 

cash ledger, use the Cash Flow Reporting solution. If you also want to report on balance accounts (such 

as balance, assets, tax), use the Cash Flow Reporting solution as this is not possible with the Cash-Basis 

Accounting solution. 

More information on Data Volume: 

The data volume in the (leading) accrual ledger is larger when an additional splitting criterion is 

introduced into the new General Ledger Accounting. 

General Information about Both Solutions: 

- It is not possible to use Cash Flow Reporting and Cash-Basis Accounting simultaneously. Both 

solutions work with the same field (revenue/expense account), but they can use/derive this field 

differently. Cash Flow Reporting, for example, can fill the new account field (such as tax account) 

which cannot be posted in Cash-Basis Accounting. 

- It is not possible to switch from Cash Flow Reporting to Cash-Basis Accounting or vice versa. At 

the moment SAP does not plan to provide migration tools to switch between the two solutions. 

- Cash Flow Reporting and Cash-Basis Accounting work completely independently of Funds 

Management. You do not need to implement Funds Management if you want to use either of these 

solutions. 

- General Ledger Accounting (new) is a prerequisite of both solutions (Cash Flow Reporting and 

Cash-Basis Accounting). The general document splitting mechanism is used and it is not possible to 

decouple the configuration for the source account field from other dimensions of the new General 

Ledger Accounting. 

36.5.1.3.2 Cash-Basis Accounting 
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36.5.1.3.2.1 Define Payment-Based General Ledger 

Use 

In this activity, you define the ledgers that you want to use as cash ledgers in general ledger accounting. 

Note the following when you create a cash ledger: 

- The leading ledger cannot be defined as a cash ledger. 

- All cash ledgers must be assigned to the same totals table. 

- Ledger groups for cash ledgers can only contain cash ledgers. 

- In the case of cross-company codes, all company codes must be assigned to the same cash ledgers or 

the same ledger group. 

Requirements 

You have configured the ledgers in general ledger accounting on the basis of a totals table. We 

recommend that you use the standard totals table PSGLFLEXT with the general ledger scenario 

PSM_CL. Alternatively, you can also use the standard totals table FMGLFLEXT. In this case, to update 

the cash transactions in the cash ledger for expense and revenue, you must include your own fields 

ZZRE_ACCOUNT and ZZRE_BUKRS in table FMGLFLEXT and assign them to the relevant ledger. 

Activities 

Create your ledgers in general ledger accounting and set the indicator Cash Ledger for the ledgers you 

want to use as cash ledgers. 

36.5.1.3.2.2 Classify Payment-Relevant G/L Accounts 

Use 

Every business transaction entered is analyzed during the update to the general ledger. During 

the update, the system determines whether each document is relevant to the cash ledger using the general 

ledgers as a reference. 

The general ledger account must be classified as cash relevant so that the system can identify the 

documents relevant for the cash ledger and handle the line items appropriately.  In this IMG activity, you 

can enter all the accounts that the system should interpret as cash relevant. 

Requirements 
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Only enter G/L accounts that are relevant for cash flow. You can check whether a G/L account is relevant 

for cash flow in the master record. 

Activities 

Enter your accounts or account intervals. 

36.5.1.3.2.3 Define Assignment Between Balance Sheet Accts and Profit and 

Loss Accounts 

Use 

Only expense or revenue-related financial transactions can be updated in cash ledgers. To guarantee this, 

cash ledger documents are only updated to expense and revenue accounts. If a posting in an FI document 

is made to a balance sheet account instead (for example, if part of the postings are in Materials 

Management or Asset Accounting), you can derive the expense or revenue account from the balance 

sheet account. In this activity you define the assignment between the balance sheet accounts and the 

expense or revenue accounts. 

Activities 

Enter the balance sheet accounts and assign them to the appropriate expense or revenue accounts. Do not 

use G/L accounts relevant to cash flow as balance sheet accounts. 

36.5.1.3.2.4 Edit Constant for Nonassigned Processes 

Use 

In this activity you define a standard account for the expenditure or revenue account in the cash ledger. 

The system uses the standard account for processes not assigned. This is the case if the correct G/L 

account is not available (for example, if payments are not assigned) when the posting is made. 

Example 
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In the case of a customer cash receipt on a house bank account, it is not immediately clear which invoices 

should be paid by this cash receipt. 

1. In order to update the information on the available funds in the cash general ledger in as timely a 

manner as possible, a checking account posting is performed against the cash receipt.  As no other 

information exists, postings must be made on a standard revenue account in the cash general 

ledger. Invoice basis (from receivables and payables view) 

Account  Amount   Revenue 

Checking account (payment-relevant)  100  

Cash receipt  100- 

Cash Ledger 

  Standard revenue account 

Account  Amount   Revenue 

Checking account (payment-relevant)  100  

 Standard revenue account  100-    Standard revenue account 

2. Then the cash receipt account is posted against the customer (with the clearing of the customer). 

The correct revenue account(s) can be determined from the cleared invoice for this. 

Invoice basis  

Account  Amount  Revenue 

Cash receipt  100  400000 

Customer  100-  400000 

As this is not a payment-relevant posting, no update takes place in the cash ledger. 

3. At the end both items are cleared against each other on the cash receipt account. As both items are 

assigned to different revenue accounts and a zero balance is required by definition for this account 

assignment, additional line items are generated on a clearing account defined in Customizing. 

These clearing lines set the document balance to zero for each revenue account. They reflect the 

adjustment of the payment information regarding the revenue on the current account. The clearing 

account is therefore replaced by the payment-relevant current account in the cash ledger. This 

account must be unique. 

Invoice basis 

Account  Amount   Revenue 

Checking account (payment-relevant)  100   Standard revenue account 

Cash receipt  100-   400000 

Clearing account  100-    Standard revenue account 

Clearing account  100 

Cash Ledger 

  400000 

Account  Amount   Revenue 

Standard revenue account 100   Standard revenue account 

400000  100-   400000 

Checking account (payment-relevant)  100-  Standard revenue account 
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Checking account (payment-relevant)  100  400000 

36.5.1.3.2.5 Assign Standard G/L Account for HCM Processes 

Use 

In this activity, you define a G/L account for each company code that is used by default in the cash ledger 

or cash flow reporting as the expense/revenue account (RE_ACCOUNT) for HCM processes (including 

travel expenses). This change only affects document splitting and the new General Ledger Accounting. 

The entry document it is based on is not changed. 

Requirements 

The cash ledger or cash flow reporting is active. 

Activities 

Enter a G/L account for each company code that you want to use for updating HCM documents in the 

cash ledger or for active cash flow reporting. 

36.5.1.3.2.6 Subsequent Implementation 36.5.1.3.2.6.1 Define Default Account 

for the Opening Balance in the Cash 

Ledger 

Use 

In this activity you define a default account for the opening balance of the migration of the cash ledger. 

36.5.1.3.2.6.2 Post Opening Balance in the Cash Ledger 

Use 

You can use this activity to create an opening balance for cash-relevant accounts in the cash ledger and 

thereby activate the update of the cash-relevant processes in this ledger. 

Requirements 

- You are using General Ledger Accounting (new) with active document splitting. 

- You have configured and activated the cash ledger. 

- You have blocked postings in the system. 
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Activities 

- Enter the ledger group that contains the active cash ledger. 

- If you set the Test Run indicator, the program creates the opening balances for the cash-relevant 

accounts, but does not save them in the database. 

- If you set the Reconstruct Opening Balance indicator, the opening balances are determined again 

and then reconstructed. The balances already posted are then deleted. 

Note 

For more information, see the corresponding report documentation report documentation . 

36.5.1.3.2.6.3 Display Opening Balance in the Cash Ledger 

Use 

In this activity you can display the opening balance of the cash-relevant accounts in the cash ledger. 

Requirements 

- You use the General Ledger Accounting (new) with active document splitting. 

- You have configured and activated the cash ledger. 

Activities 

You can limit the selection of opening balances by specifying the affected company codes and cash-

relevant accounts. 

Note 

For more information, see the corresponding report documentation. 

36.5.1.3.2.6.4 Reset Migration of Cash Ledger 

Use 
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In this activity you can reset the migration that you have performed with the subsequent implementation 

of the cash ledger.  Note that the program cannot be executed in the production system. 

Requirements 

You are using General Ledger Accounting (new) with active document splitting. 

Activities 

- If you set the Test Run Indicator, the program determines the posted opening balances for the cash-

relevant accounts, but does not save them in the database. 

- If you set the Deactivate Cash Ledger indicator, the cash ledger is completely deactivated. 

- Example 

Note 

For more information, see the corresponding report documentation 

36.5.1.3.2.6.5 Business-Add-Ins for Subsequent Implementation of Cash 

Ledgers 

36.5.1.3.2.6.5.1 BAdI: Derivation of Expense/Revenue Account 

Use 

You can use this Business Add-In (BAdI) to derive the missing expense/ revenue account or company 

code in which the account is created at runtime for documents before the activation of the cash ledger. 

The change only takes place in document splitting. The entry document it is based on is not changed. 

The update of the subsequent cash-relevant processes in the cash ledger is possible through the derivation 

of the expense/revenue account. 

Requirements 

You have activated the cash ledger in general ledger accounting. 

Activities 

Implement method COMPLETE_ASSIGNMENT. 
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The following method parameters are available: 

- Importing parameters (non-changeable) 

- IS_ACCHD_EX:  header of document to be posted - IT_ACCIT_EX:    Lines of the 

document to be posted - Changing parameter (changeable): 

- CS_ACCIT_EXT:  Line information for document splitting 

The line item contained in parameter CS_ACCIT_EXT serves as the basis item for document splitting. 

This line item contains all the necessary information to derive the relevant expense/revenue account or 

company code: 

- Company code 

- Document number 

- Fiscal year 

- GL Account 

- Document number of the clearing document (if clearing exists) 

- Clearing date (if a clearing exists) 

If it is not not  possible to derive the corresponding expense or revenue account , you can also use a 

default account. 

You must save the expense or revenue account determined in field 

CS_ACCIT_EXT-RE_ACCOUNT. 

36.5.1.3.3 Cash Flow Reporting 

36.5.1.3.3.1 Activate Cash Flow Reporting 

Use 

In this activity you activate cash flow reporting. You can use the following functions with this: 

- Implementation and use of a new account assignment object expense/revenue account 

(RE_ACCOUNT) in General Ledger Accounting. 

- Based on this: Reporting for cash transactions that are updated in the general ledger in accordance 

with their origin and balance. 

Requirements 
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- You have activated the general ledger with document splitting and have configured  it based on a 

totals table. If you use the totals tables FAGLFLEXT or FMGLFLEXT, you must enhance these 

tables with the field RE_ACCOUNT that is available as an extra field. If you use totals table 

PSGLFLEXT, field RE_ACCOUNT is contained in the table structure. 

- The cash ledger is not active. 

Activities 

To be able to use the function in this system, you set the indicator Activate cash flow reporting 

. 

36.5.1.3.3.2 Assign Standard G/L Account 

Use 

When cash flow reporting is active, account assignment object RE_ACCOUNT is filled with the content 

of the general ledger account to be posted to. Exceptions to this are the reconciliation accounts and cash 

transaction accounts. 

In this activity, you can define whether special processes for RE_ACCOUNT are only updated in 

aggregated form in the general  ledger. 

Requirements 

Cash flow reporting is active. 

Activities 

Assign the general ledger accounts to be posted to to a predefined value. 

36.5.1.3.3.3 Activate Tax Accounts Transfer 

Use 

In this activity you define that account assignment object RE_ACCOUNT is filled with the relevant tax 

account instead of the causing expense/revenue account with the update of the tax items in the general 

ledger. 

Requirements 

Cash flow reporting is active. 



______________________________________________________________

SAP System 

______________________________________________________________ 

SAP AG 607 

Activities 

To be able to use the function in this system, you set the indicator Transferring Tax Accounts is Active. 

36.5.1.3.3.4 Edit Constant for Nonassigned Processes 

Use 

In this activity you define a standard account for the expense and/or revenue account in the cash flow 

reporting. The system uses the standard account for nonassigned processes. This is the case when the 

required correct G/L account is not available at the time of posting, for example for nonassigned 

payments. 

36.5.1.3.3.5 Assign Standard G/L Account for HCM Processes 

Use 

In this activity, you define a G/L account for each company code that is used by default in the cash ledger 

or cash flow reporting as the expense/revenue account (RE_ACCOUNT) for HCM processes (including 

travel expenses). This change only affects document splitting and the new General Ledger Accounting. 

The entry document it is based on is not changed. 

Requirements 

The cash ledger or cash flow reporting is active. 

Activities 

Enter a G/L account for each company code that you want to use for updating HCM documents in the 

cash ledger or for active cash flow reporting. 

36.5.1.3.3.6 Business Add-Ins for Cash-Basis Accounting 

36.5.1.3.3.6.1 BAdI: Derive Standard G/L Account 
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Use 

If you use cash flow reporting, with this Business Add-In (BAdI) you can change the account assignment 

objects transferred to the interface at runtime. This change only affects document splitting and the new 

General Ledger Accounting. The entry document it is based on is not changed. 

Requirements 

You have activated the cash flow reporting in the new General Ledger Accounting. 

Standard settings 

The BAdI is not active in the standard. To use the BAdI, implement the method. 

Activities 

Implement the BAdI using method COMPLETE_CL_ASGMT. 

After you have called the IMG activity, proceed as follows: 

1. Enter a name in the dialog box in the field Implementation for the implementation of the BAdI 

and choose Copy. 

If implementations were already created for the BAdI, a dialog box appears with the existing 

implementations. In this dialog box, choose Create. 

2. Enter a  short text for the implementation in the corresponding field. 

3. Insert filter characteristics on the tab Characteristics if it is a filter-dependent BAdI. 

4. Choose the tab Interface. 

The  name of the implementing class is generated by the system based on the name of your 

implementation. The name can be changed. 

5. Save your entries and assign a package. 

6. Place the cursor on a method. Call the class builder with a double click. 

7. Enter the coding you want for the implementation between the statements method 

<Interface Name>~<Name  method>. and endmethod. 

8. Save and activate your coding and navigate back to the screen Change Implementation. 

9. Save on the screen Change Implementation. 

Note: You can first create a BAdI and then activate it later. In this case, finish processing now. 

10. Choose Activate. 

When you execute the application program, the coding you created will be run. 

See also 
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Methods 

Cash-Basis Accounting: Account Assignment Derivation (RE_ACCOUNT) 

36.5.1.4 Balancing of CO-FI Real-Time Postings 

36.5.1.4.1 Maintain Clearing Accounts for CO-FI Real-Time Postings 

 Use 

CO actual postings that exceed the limits of balancing units of the general ledger (for example, fund or 

business area) act as an effective payment flow between fund or business area in fund-based accounting. 

If in general, you want payments in the general ledger to be updated in a special cash desk, payment fund, 

or business area, you can do this using the function described here for real-time postings of Controlling in 

the general ledger. 

The update of real-time postings CO-FI is aligned using the original update of the reconciliation ledger in 

which each FI line item is offset by an offsetting entry in a fund/business area clearing account. 

Requirements 

- The Define Variants for Real-Time Integration is active and a corresponding document type is 

defined. The document splitting characteristic with balance zero (see below) are selected for the line 

item selection for the CO-FI real-time integration. 

- The New General Ledger Accounting is active. 

- The Document Splitting is active and a splitting method is assigned. 

- The document type for the update documents of Controlling in Financial Accounting is classified by 

a suitable business transaction. 

Standard settings 

If you have (for example, in an earlier release) already configured the reconciliation ledger, the clearing 

account from the business area clearing account defined is proposed, but it can be overwritten. 

Activities 

Carry out the following activities: 

- Create two clearing accounts for CO real-time postings: 

- Clearing account 1 for the offsetting entry lines for the original line items 

- Clearing account 2 for mapping to 
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- Maintain the account determination for the CO-FI reconciliation accounts by defining a clearing 

account for your chart of accounts for the specified account key FCA and FCC and the posting key 

for debit and credit posting items. 

- Make sure that the clearing accounts for document distribution are classified and that a suitable yet 

different item category (for example, 01000 for balance sheet account 1, 80000, 'customer-specific 

item category' for clearing account 2) is defined. 

- Make sure that the business transaction variant for the document type of CO-FI update documents 

are defined in such a way that both item categories are allowed for the clearing accounts. 

- Make sure that for your splitting method for the document type of CO-FI update documents a 

splitting rule is configured in such a way that the item category of clearing account 2 is controlled by 

the processing category 0 (transfer of fixed value (no distribution) and a constant is defined. No 

distribution rule should be created for the item category of clearing account 1. 

This Constant must be assigned values for all document splitting characterstics of the general ledger 

with balance zero (balancing units). 

- Activate the balancing of CO real-time postings in the general ledger and the implementation 

FM_COFI_POOLED_CASH of BAdI FAGL_COFI_ACDOC_MOD. 

Example 

Cost center C2 and fund F2 have a service in value of 100 EUR for cost center C1, fund F1. 

As compensation, a CO-actual posting of 100 EUR of cost center C1, fund F1 is entered for C2 / F" using 

primary cost type A. The corresponding G/L document has the following structure: 

Account Fund Debit/Credit Indicator Amount 

A F1  D 100  

A F2  C 100  

This posting has the connotation to a payment. A constant payment fund (PF) is updated in the general 

legder for payments with active balancing of CO real-time postings: 

Account Fund Partner Fund Credit/Debit Indicator. Amount 

A F1 F2 D 100   

Clearing1  F1   F2  C  100 

Clearing1  F1  PF  D 100   

Clearing2  PF  F1  D  100   

A  F2  P1  C 100   

Clearing1  F2  F1  D  100   

Clearing1  F2  PF  C  100   

 Clearing2  PF  F2 ,CH  100 

As the document breakdown is balanced in general according to combination of characteristic and 

partner, more lines are added in the general ledger view of the document: 
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Account Fund Partner Fund Debit/Credit Indicator Amount 

A  F1  F2  D  100  

Clearing1  F1  F2  C  100  

Clearing1  F1  PF  D  100  

Clearing2   PF  F1  D  100  

A  F2  P1  C  100  

Clearing1  F2  F1  C  100  

Clearing2  PF  F2  C  100  

Balance zero  F1  PF  D  100  

Balance zero  PF  F1  C  100  

Balance zero  F2  PF  C  100  

Balance zero  PF  F2  D  100  

36.5.1.4.2 Activate Balancing of CO-FI Real-Time Postings 

Use 

In this step, you activate the balancing of CO-FI real-time postings in the general ledger. 

Requirements 

A clearing account for CO-FI real-time postings is maintained and all the requirements described in the 

IMG activity are fulfilled. 

Standard settings 

The implementation FM_COFI_POOLED_CASH of BAdI FAGL_COFI_ACDOC_MOD is not active in 

the Standard. 

Activities 

Activate the balancing of the CO real-time postings in the general ledger and implementation 

FM_COFI_POOLED_CASH of BAdI FAGL_COFI_ACDOC_MOD here. If you want to display the 

activation status of the implementation, use monitor report Check Balancing of CO Real-Time Postings. 

If you do not want to activate the function in all systems, but just for some individual clients, 

you must create your own enhancement implementation of the enhancement spot 

FAGL_COFI_ACDOC_MOD in the customer area with transaction BAdI Builder: Initial 

Implementation Maintenance (SE19). You can refer to the sample implementation for this and use 

CL_IM_FM_COFI_POOLED_CASH. Then create a corresponding filter value for the filter CLIENT. 
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36.5.1.4.3 Check Balancing of CO-FI Real-Time Postings 

Use 

In this IMG activity you can check the requirements for the active balancing of CO-FI real-time postings 

using a monitor. You can also branch to the corresponding IMG activities. 

36.5.2 Asset Accounting 

36.5.2.1 Integration with Asset Accounting 

Use 

You can enter asset transactions according to fund and functional area and create corresponding reports. 

Requirements 

- You activate the fields fund and functional area for Asset Accounting under the following IMG 

activity: 

Activate Account Assignment Objects 

In this configuration step, you can prevent changes being made to the fund and functional area in the 

asset master data by selecting the balance sheet checkbox. If you select the Ident checkbox, you can 

define that the fund and functional area are inherited from the asset master record and are not 

overwritten when postings are made to the asset. 

- You define the use of the fields fund and functional area for the company code, evaluation area, and 

asset transaction under the following IMG activity: Specify Account Assignment Types for Account 

Assignment Objects 

In the configuration step, you can define which company codes, valuation areas and asset 

transactions can use the fields fund and functional area. 

- You create the types of messages for the fields fund and functional area (no message, information 

message, error message, warning) under the following IMG activity: Process Error Table 

- You configure the fields fund and functional area in the asset master record under the following 

IMG activity: 

Specify Required Entries for Asset Master Data 

- You include the fields fund and functional area using the following IMG activity in the asset reports: 

Define Sort Variants for Asset Reports 
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Activities 

When you activate and configure the fund and functional area integration, you can enter time-dependent 

values for the fund and functional area fields by calling the following transactions: 

- Create Asset 

- Create Subnumber 

The values for the fields fund and functional area entered in these transactions are updated in Controlling, 

Financial Accounting, and Fund Management for all asset transactions with financial values including 

acquisitions, transfer postings, retirements, and depreciations. When assets are settled, the fund and 

functional area values that were posted in the settled Controlling and Project System transactions are 

used. Sort versions that are used in existing asset reports can include the fund and functional area fields. 

36.5.3 Partial Payment for Each General Ledger Account Assignment 

36.5.3.1 Partial Payment per G/L Account Assignments 

Use 

Usually, FI documents split amounts to the General Ledger (G/L) concerning of the enclosing split 

characteristics (G/L entities). The amount is spread over all the entities involved, according to the 

appearance on the line items. Up to now, splitting by selected entities is not possible 

To use the option of paying FI documents by split characteristics, you need to activate the transaction 

Partial Payment by Split characteristic in the new G/L. Use this step to do this and make the necessary 

settings. 

Activities 

Make the general settings you require and activate the G/L entities you will need to use. 

36.5.4 Trust Fund 

36.5.4.1 Define Fund Types for Fiduciary Funds 

Use 

In this IMG activity, you can define an assignment of P&L accounts for balance sheet accounts for 

mapping fiduciary funds in the system. The system then makes sure that the fiduciary funds are updated 

in the general ledger independent of P&L. Each document line entered that is posted on a P&L account 
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and assigned to a fiduciary funds account is then offset through automatically generated document lines 

and supplemented with a posting line on balance sheet account assigned to the P&L account. 

Requirements 

In the Customizing of Funds Management Government you must create the corresponding fund types 

and assign the master records on the fiduciary funds in IMG activity Create FM Fund Types. 

The P&L accounts must allow postings without tax (indicator Postings Without Tax Allowed) as the 

posting lines generated automatically do not contain any tax information. 

Message 281 cannot be controlled as an error message in work area FI with the result that CO account 

assignments are permitted in the balance sheet account lines. You adjust the message accordingly in the 

Customizing of Controlling in IMG activity Change Message Control. 

Activities 

1. Define a derivation strategy for the G/L account derivation. Create derivation steps in the derivation 

strategy to ensure the following: 

a) Each P&L account is assigned to a balance sheet account. Note: The balance sheet account 

should be assigned to a commitment item in the Account Assignment Derivation of Funds 

Management with Financial transaction 50 (not relevant for update). 

b) Each P&L account is assigned to a statistical Commitment Item for the automatically 

generated offsetting entry. 

2. Assign the fund type(s) for the fiduciary funds to the derivation strategy. 

3. Define the posting key for the automatically generated lines. 

36.5.4.2 BAdI: Enhance Derivation of G/L Accounts for Fiduciary Fund 

Use 

This Business Add-In is used in component Fund Accounting(PSM-FA) 

You can use this BAdI to supplement the derivation of GL accounts fiduciary funds as follows: 

- You can supplement derivation structure IFM_GLACC_DERIVE with more fields using 

enhancement structure CI_IFM_GLACC_DERIVE. 

You can then fill these fields in accordance with coding block (COBL) information and evaluate them. 

- You can create and program a derivation step in the derivation strategy of derivation type 

Enhancement. 

Requirements 

A derivation strategy for fiduciary funds must be created and assigned to the corresponding fund types. 
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For more information, see Define Fund Types for Fiduciary Funds. 

Standard settings 

The Business Add-In is not active in the standard system. 

Activities 

After you call the IMG activity, the system displays a dialog box where you enter a name for the 

implementation. 

If implementations of this Business Add-In have already been created, the system displays them in a 

dialog box. You then choose one of them by choosing Create, and continue as follows: 

1. In the dialog box, enter a name for the implementation of the Add-In and choose Create. The system 

displays the initial screen for creating Business Add-In implementations. 

2. On this screen, enter a short description for you implementation in the Implementation Short Text 

field. 

3. If you choose the Interface tab, you will notice that the system has filled in the Name of the 

Implementing Class field automatically, by assigning a class name based on the name of your 

implementation. 

4. Save your entries and assign the Add-In to a package. 

5. To edit a method, double-click its name. 

6. Enter your implementation code between the method <Interface Name>~<Name of 

Method>. and endmethod. statements. 

7. Save and activate your code. Navigate back to the Change Implementation screen. 

Note: You can also create an implementation for an Add-In and not activate it until later. If you 

want to do this, do not carry out the following step: 

8. Choose Activate. 

When the application program is executed, the system carries out the code in the method you wrote. 

Example 

See also 

Methods 

Fill Additional Fields for Derivation 

Derivation Step as Enhancement 

36.5.5 Transfer from FM Totals Records to General Ledger Accounting 

36.5.5.1 Information on Transfer of FM Totals Records to General Ledger 
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Accounting 

Use 

A requirement of Fund Accounting is that financial transactions, such as creating commitment, are 

entered as totals values in general ledger accounting. You can use program Post Budget or 

Commitment/Actual Totals to FI (RFFMTTTOBL) to transfer the collected FM commitment information 

in Funds Management to the new general ledger accounting. This can happen weekly or monthly in a 

batach run. 

You define the required settings in the following IMG activities to make this function available. 

Requirements 

Commitment data must be available in the component Funds Management. 

Standard settings 

SAP does not provide any standard settings for this. 

Activities 

Process the IMG activities in the order they appear. Program Post Budget or Commitment/Actual 

Totals in FI (RFFMTTTOBL) executes the transfers based on these definitions. 

36.5.5.2 Activate Transfer 

Use 

In this IMG activity, you activate the transfer to general ledger accounting according according to FM 

area, budget category and value type. The available value types are used for the posting of commitment 

items. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

1. Choose New Entries and enter the FM area and the budget category for the transfer to general 

ledger accounting. Save your entries. 

2. Select the item that you have defined and activate the data transfer by double-clicking on the 

corresponding option. 

3. Define which commitment value types you want to transfer and activate them. Save your entries. 
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36.5.5.3 Define Derivation Strategy for Transfer and GL Accounts 

Use 

In this IMG activity, you use the derivation tool to create derivation rules in order to enhance the account 

assignment objects in accordance with the requirements of Fund Accounting and to define the G/L 

accounts in general ledger accounting . The derivation tool requires this information for the commitment 

data records. 

Note 

The program Post Budget or Commitment/Actual Totals in FI (RFFMTTTOBL) calls the read 

commitment data sequentially. The two derivation strategies are called in two consecutive steps for each 

totals record. 

- In the first step the functions for enhancing the account assignment objects are available; you can 

also decide to skip this totals record. 

- In the second step the G/L accounts are defined. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

1. Choose a strategy environment that defines whether you want to use the account assignment objects 

for the Fund Accounting postings or whether you want to define G/L accounts for general ledger 

accounting. 

2. Choose Create Step to create a new step for your derivation strategy. 

3. To create a derivation rule, choose the source and target fields and then maintain the field values. 

4. Save your entries. 

36.5.5.4 Define Details for FI Update 

Use 

In this IMG activity, you choose the account assignment objects for the update in general ledger 

accounting and the document details for the FI document posting. The account assignment objects FM 

area and fund are obligatory. You can specify more details on account assignment elements if necessary. 

The concept of the budgetary ledger in general ledger accounting ensures that the totaling of all BL 

postings balance each other. You require at least one G/L account and one offsetting account for this 

process for which commitment records can be posted. In addition to this offsetting account, the following 

details on the postings are required: 
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- Fund details are required. 

You can define additional account assignment objects such as business area, funds center, or 

functional area with this IMG activity. 

- The FI documents can only be posted in general ledger accounting and the corresponding reporting 

ledger. 

- Other FI modules, such as CO and FM, should be excluded as information recipients of this posting. 

Requirements 

The budgetary ledger for budgeting processes only works with the Budget Control System. You must 

have therefore already installed this. 

Standard settings 

SAP does not provide any standard settings. 

Activities 

1. Create a new entry for your FM area and define the FI document type for it. 

2. Place your cursor on the FM area and double-click on the account assignment objects that you want 

to transfer to the left side of the screen. 

3. Define the fields that are linked to the account assignment objects. 

4. Save your entries. 

36.6 Procurement for Public Sector 

36.6.1 Activate Functions for Procurement for Public Sector 

Use 

In this activity, you activate the individual procurement functions of mySAP SRM for the public sector. 

Standard settings 

This function is not active by default in the standard system. 

Activities 

Maintain more functions if necessary and save your entries. 
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36.6.2 Guaranteed Minimum 

36.6.2.1 Create Document Categories and Types 

Use 

In this activity you define the settings for funds reservation documents for the function of guaranteed 

minimum in the SRM system. 

Standard settings 

SAP does not deliver any default settings for this. 

Activities 

Define the following for each company code: 

1. The reference document type for posting earmarked funds documents 

2. The document categories to be used 

3. The document types to be used 

4. Save your entries. 

36.6.3 Create Reason for Change 

Use 

In this activity, you can create specific messages that are used in the goods receipt and invoice receipt 

process. 

Requirements 

You must have created an application area and at least one reason code in table 

/SAPPSPRO/RCODE . 

Activities 

1. Create a message. 

2. Enter a description. 

3. Specify an application area. 
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4. Enter a message category. 

5. Enter a message number. 

6. Save your entries. 

36.6.4 Activate Restricted Subcontracting 

Use 

In this activity, you activate the restricted subcontracting function for Government Procurement. 

You can transfer and edit purchase requisition items of the subcontracting category to the SRM system 

for this. However, only limited functions are available. 

Requirements 

You can only set this indicator if you use Government Procurement  as this function is only in the 

Add-on. 

Standard settings 

This function is not activated in the SAP standard system. 

36.7 Debt Management 

36.7.1 SAP Customer Relationship Management Integration 

36.7.1.1 Configure Integration with SAP Customer Relationship Management 

Use 

In debt management, you configure the distributed landscape between SAP CRM and SAP ERP with the 

replication and communication settings and synchronizing certain Customizing settings. The UI runs in 

SAP CRM but the dunning process, creation of debt sets, as well as billing and accounting, run in SAP 

ERP. 

Here's how you configure the distributed landscape between SAP CRM and SAP ERP: 

1. SAP CRM and SAP ERP: Middleware replication 

Configure the middleware replication between SAP CRM and SAP ERP, including the definition of 

logical systems and the configuration of the RFC destination to the partner system on both sites. 

You assign these subscriptions in the administration console: 
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- All business partners (BUPA_MAIN) 

- All business partner relationships (BUPA_REL) 

- All business transactions (BUS_TRANS_MSG) 

2. SAP CRM: Communication settings 

Using the respective transactions, assign the RFC destination for synchronous method calls to the 

SAP ERP system and maintain the mapped system ERP_PSCD. Enter the required data in the 

Logical System and in the Client columns. 

36.7.1.2 Maintain Item Categories 

Use 

In this Customizing activity, you maintain the item categories in the SAP ERP system, corresponding to 

the item categories in the SAP CRM system. 

Requirements 

You have maintained the item categories in SAP CRM. 

Activities 

You must create each entry so that it is identical to the key and description of the corresponding item 

category in SAP CRM. 

36.7.1.3 Maintain Text IDs for Fees 

Use 

In this Customizing activity, you maintain the text IDs for the replication of fee texts, which are created in 

an enforcement action application in SAP CRM. 
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The fee texts from SAP CRM are replicated in the text object DMEA_FEE and the corresponding text 

keys are stored in the data base table FMCA_DM_TEXT. As an API use function module READ_TEXT 

for processing the texts.  

For replication reasons, you must create and assign the identical texts IDs to the text object 

DMEA_FEE that are created in SAP CRM Customizing under Industry-Specific Solutions -> Public 

Sector -> Debt Management -> Enforcement Action -> Maintain Text IDs for 

Fees. 

Activities 

Create and assign the text IDs to the text object DMEA_FEE. 

36.7.1.4 Asset Income Register 

36.7.1.4.1 Define AET System Settings 

Use 

In this Customizing activity, you use the Application Enhancement Tool (AET) system settings to define 

the package to be used for the generated decision basis (DBA) modeling data in SAP ERP. You do not 

need to create UI components. 

(You execute the generation of DBA modeling data using the program Replication Monitor for 

Decision Basis Modeling in the Customizing activity Replicate Decision Basis Modeling.) 

Requirements 

- The system client you choose to define the package supports cross-client maintenance. 

- We strongly advice you to use your own DBA namespace for the generated AET enhancements to 

prevent conflicts with other components in which you are also using AET enhancements. You 

request your DBA namespace on SAP Service Marketplace at 

http://www.service.sap.com/namespaces (see also SAP Note 84282). 

Activities 
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Enter the package name to be used for the generated AET enhancements for the current logical system. 

The system automatically uses this information to derive the generation namespace. 

36.7.1.4.2 Replicate Decision Basis Modeling 

Use 

In this  Customizing activity you replicate the decision basis (DBA) modeling data from the source 

system SAP CRM to the target system SAP ERP.  You must replicate the DBA modeling data as part of 

the final closing activities once you have finalized or upgraded your DBA modeling in SAP CRM. 

Activities 

You execute the DBA modeling data replication using the program 

RPSSC00_DBA_REPL_MONITOR. For more information, see the program documentation. 

36.7.1.4.3 Assign Item Categories to Decision Basis Models 

Use 

In this Customizing acitvity, you maintain the decision basis model assignments to the item categories in 

SAP ERP according to the assignments in the SAP CRM system. 

Requirements 

You have maintained the item categories in the Customizing activity Maintain Item Categories. 

Activities 

You must create the same assignments as those in the SAP CRM system (see SAP CRM Customizing 

Implementation Guide under Customer Relationship Management -> Transactions -> Define Item 

Categories, activity Customizing Item). 

Note: The entries must be identical to the keys and descriptions for the corresponding item categories and 

decision basis models in SAP CRM. 

36.7.2 Define Billing Documents for Fees 

Use 
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In this Customizing activity, you define the settings for the creation of billing documents for enforcement 

actions and their corresponding fees. 

You define the creation of billing documents by implementing a customer event for event P430. For 

more information, see the sample module documentation FMCA_DM_SAMPLE_P430. 



 

 

 

 


